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Introduction to Optimization and Calibration

Overview

This section describes procedures for isolating the BTS from the span
lines, preparing and using the LMF, downloading system operating
software, CSM reference verification/optimization, set up and calibration
of the supported test equipment, transmit/receive path verification, and
verifying the customer defined alarms and relay contacts are functioning

properly.

NOTE

Before using the LMF, use an editor to view the “CAVEATS”
section in the “readme.txt” file in the c:\wlmf folder for any
applicable information.

Optimization Process Summary

After a BTS is physically installed and the preliminary operations, such
as power up, have been completed, the LMF is used to optimize the
BTS. The basic optimization process consists of the following:

1. Download MGLI-1 with code and data and then enable MGLI-1.

NOTE GLI’s may be GLI2s or GLI3s.

2. Use the status function and verify that all of the installed devices of
the following types respond with status information: CSM, BBX,
GLI, and MCC. If a device is installed and powered up but is not
responding and is colored gray in the BTS display, the device is not
listed in the CDF/NECEF file. The CDF/NECF file must be corrected
before the device can be accessed by the LMF.

3. Download code and data to all devices of the following types:

- CSM

— BBX (Multicarrier uses BBX-1X)

— GLI (other than MGLI-1)

— MCC (may be MCC-8E, MCC24, or MCC-1X)
4. Verify the operation of the GPS and HSO signals.
5. Enable the following devices (in the order listed):

— Secondary CSM

— Primary CSM

— All MCCs

6. Connect the required test equipment for a full optimization.

7. Select the test equipment.

8. Calibrate the TX and RX test cables if they have not previously been
calibrated using the CDMA LMF that will be used for the
optimization/calibration. The cable calibration values can also be
entered manually.

NOTE Only one carrier can be tested at a time. All PAs must be INS

during testing. For the carriers not under test, key one BBX per
carrier to a minimum power level (Refer tq-fable 3-36).

9. [If the TX calibration fails, repeat the optimization for any failed
paths.

3-2
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10. If the TX calibration fails again, correct the problem that caused the
failure and repeat the optimization for the failed path.

11. If the TX calibration and audit portion of the optimization passes for
a path but some of the TX or RX tests fail, correct the problem that
caused the failure and run the individual tests as required until all
TX and RX tests have passed for all paths.

Cell Site Types
Sites are configured as Omni/Omni or Sector/Sector (TX/RX). Each type
has unique characteristics and must be optimized accordingly.
NOTE For more information on the differences in site types, please
refer to the applicable BTS/Modem Frame Hardware Installation
and Functional Hardware Description manuals.
CDF/NECF

The CDF/NECF (Configuration Data File/Network Element
Configuration File) contains information that defines the BTS and data
used to download files to the devices. A CDF/NECEF file must be placed
in the applicable BTS folder before the LMF can be used to log into that
BTS. CDF/NECEF files are normally obtained from the CBSC using a
floppy disk. A file transfer protocol (ftp) method can be used if the LMF
computer has that capability.

The CDF/NECEF includes the following information:

* Download instructions and protocol

* Site specific equipage information

® C—CCP shelf allocation plan
— BBX equipage (based on cell-site type) including redundancy
— CSM equipage including redundancy

— MCC (MCC24E, MCCS8E, or MCC-1X) channel element allocation
plan. This plan indicates how the C—CCP shelf is configured, and
how the paging, synchronization, traffic, and access channel
elements (and associated gain values) are assigned among the (up to
12) MCCs in the shelf.

* CSM equipage including redundancy

 Effective Rated Power (ERP) table for all TX channels to antennas
respectively. Motorola System Engineering specifies the ERP of a
transmit antenna based on site geography, antenna placement, and
government regulations. Working from this ERP requirement, the
antenna gain, (dependent on the units of measurement specified) and
antenna feed line loss can be combined to determine the required
power at the top of the BTS frame. The corresponding BBX output
level required to achieve that power level on any channel/sector can
also be determined.

NOTE Refer to the WinLMF On-Line Help SR2.16.x for additional
information on the layout of the LMF directory structure
(including CDF/NECEF file locations and formats).
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BTS System Software Download

BTS system software must be successfully downloaded to the BTS
processor boards before optimization can be performed. BTS operating
code is loaded from the LMF computer terminal.

CAUTION

Before using the LMF for optimization/ATP, the correct
bts—#.cdf (or bts—#.necf) and cbsc—#.cdf files for the BTS must
be obtained from the CBSC and put in a bts—# folder in the
LMEF. Failure to use the correct CDF/NECEF files can cause
wrong results. Failure to use the correct CDF/NECEF files to
log into a live (traffic carrying) site can shut down the site.

The CDF/NECEF is normally obtained from the CBSC on a DOS
formatted diskette, or through a file transfer protocol (ftp) if the LMF
computer has ftp capability. Refer to the CDMA LMF Operator’s Guide,
or the LMF Help screen, for the procedure.

Site Equipage Verification

If you have not already done so, use an editor to view the CDF/NECEF,
and review the site documentation. Verify the site engineering equipage
data in the CDF/NECF matches the actual site hardware using a
CDF/NECF conversion table.

CAUTION

— Use extreme care not to make any changes to the
CDF/NECF content while viewing the file. Changes to the
CDF/NECEF can cause the site to operate unreliably or
render it incapable of operation.

— Always wear a conductive, high impedance wrist strap
while handling any circuit card/module to prevent damage
by ESD. Extreme care should be taken during the removal
and installation of any card/module. After removal, the
card/module should be placed on a conductive surface or
back into the anti—static bag in which it was shipped.

3-4
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Preparing the LMF

Overview

Before optimization can be performed, the LMF application software
must be installed and configured on a computer platform meeting
Motorola—specified requirements (see Recommended Test Equipment
and Software in Chapter ).

Software and files for installation and updating of the LMF are provided
on CD ROM disks. The following installation items must be available:

* LMF Program on CD ROM (see pagq}-9 for current supported
version of LMF)

* CDEF/NECEF for each supported BTS (on diskette or available from the
CBSC)

* CBSC File for each supported BTS (on diskette or available from the
CBSC)

The following section provides information and instructions for
installing and updating the LMF software and files.

NOTE

For the CDMA LMF graphics to display properly, the computer
platform must be configured to display more than 256 colors.
See the operating system software instructions for verifying and
configuring the display settings.

Overview of Packet BTS files

R16.0 and earlier releases had the configuration file called CDF for each
BTS and CBSC used by LMF. In 16.1 Packet BTS, BTS with GLI3
booting in packet binary, the CDF is replaced by two new configuration
files called Network Element Configuration Base (NECB) and Network
Element Change Journal (NECJ). The NECB contains the baseline
configuration and is analogous to the CDF, while the NECJ contains all
the changes made to the configuration since the last time the NECB was
re—generated. Once the NECJ gets to 80% of its maximum size, the
NECB is re—generated and all the updates are rolled into it.

These files play much broader and vital role than previous CDF files.
GLI3 booting in circuit binaries works similar to R16.0.

A few LMF related important facts about these files are listed below.
* Both files (NECB and NECJ) are in XML format.

* NECB contains all the up-to-date static configuration information and
NECIJ contains all the recent changes (including operations) which are
not updated in the NECB.

* Both files can be viewed in any XML viewer (most easily available is
Internet Explorer V5.0 and higher). They can be also viewed by any
other word processor, but the XML tags will also be seen with them.

* These files will be created by OMC-R from MIB as per the BTS
provisioning.

¢ These files will be regenerated for each software release upgrade on
the system for each BTS.
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* These files will reside on both OMC-R and Packet—GLI3 (unlike
CDF) and will be synchronized periodically between them.

* Both NECB and NECI file contain a “SoftwareVersion” field in their
header section indicating the system release version of these files.

* Instead of the bts#.cdf file, the packet LMF uses a bts#.XML file,
which is a copy of the NECB.XML file.

e Packet—GLI3 will need these files for site initialization.

® The scope of NECB has grown much broader than CDF and has much
more BTS centric information. The use of generic version of these
files should be strictly avoided for the correct site initialization.

3-6
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LMF File Structure Overview

Figure 3-1: LMF Folder Structure

LMF Home Directory

The LMF uses a <x>:\Imf home directory> folder that contains all of the
essential data for installing and maintaining the BTS. The following list
outlines the folder structure for LMF. Except for the bts—# folders, these
folders are created as part of the the LMF installation. Refer to the
CDMA LMF Operator’s Guide for a complete description of the folder
structure.

B x:\<Imf home directory> folder
B cdma folder

bts—# folders (A separate folder is required
for each BTS where bts—# is the unique BTS
number; for example, bts—163.)

loads folder

version folder (A separate folder is
B required for each different version; for

example, a folder name 2.8.1.1.1.5.)

code folder

data folder

NOTE

The “loads” folder and all the folders below it are not available
from the LMF for Software Release 2.16.1.x. These folders may
be present as as a legacy from previous software versions or
downloaded from the CBSC/OMC-R.
— Any existing code in the directory is not affected by an SR
16.1 installation.

— The user will need to manually add the directories to a
newly installed LMF when they add the code loads to be
downloaded.

The CDMA LMF installation program creates the default home
directory, c:\wlmf, and installs the application files and subdirectories
(folders) in it. Because this can be changed at installation, the CDMA
LMF home directory will be referred to with the generic convention of:

<x>:\<Imf home directory>

Where:

<x> = the LMF computer drive letter where the CDMA LMF home
directory is located.

<Imf home directory> = the directory path or name where the CDMA
LMF is installed.
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NECF Filename Conventions and Directory Location

NECF

The NECF actually consists of two files: the NECB and NECJ. The
naming convention for the NECB and NECI is:

NECB#*bts#.xml
NECJ*bts#.xml

Where:
* = any characters can be substituted there
# = the actual integer BTS number

The NECB and its corresponding NECJ must have the exact same name,
except for the “B” and “J” difference after the initial NEC characters.

The NECB and the NECJ must reside in the
<LMF_HOME>\cdma\bts—# directory corresponding to the BTS frame
they are for.

Load Information File (LIF)

The LIF contains all the devices binaries available for the specified
System Software Release. It is the functional equivalent of the OLF file
that was used pre—Packet.

The naming convention for the LIF is:
NE_LIF.xml

The LIF must reside in the <LMF_HOME>\cdma\loads\<Software
Release Number> directory, where <LMF_HOME> = the home
directory in which the LMF is installed, usually C:\wlmf <Software
Release Number> = the System Software Release Number (e.g.
2.16.1.0.10).

Cal File

The Cal File still resides in the <LMF_HOME>\cdma\bts—# directory
and is named bts—#.cal, where # is the actual integer number of the BTS.
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LMF Operating System Installation

This section provides information and instructions for installing and
updating the LMF software and files.

NOTE

First Time Installation Sequence:

1. Install Java Runtime Environment (JRE)
2. Install U/WIN K-shell emulator

3. Install LMF application programs

4. Install/create BTS folders

NOTE

Any time you install U/WIN, you must install the LMF software
because the installation of the LMF modifies some of the files
that are installed during the U/Win installation. Installing U/Win
over—writes these modifications.

There are multiple binary image packages for installation on the
CD-ROM. When prompted, choose the load that corresponds to
the switch release that you currently have installed. Perform the
Device Images install after the WinLMF installation.

If applicable, a separate CD ROM of BTS Binaries may be
available for binary updates.

Follow the procedure irrfable 3-1 to install the LMF application
program using the LMF CD ROM.

Table 3-1: LMF Operating System Installation

| Step

Action

la

1b

Insert the LMF Program CD ROM into the LMF CD ROM drive.

— If the Setup screen appears, follow the instructions displayed on
the screen.

— If the Setup screen is not displayed, proceed to Stepr3.

Click on the Start button.

Select Run.

Enter d:\autorun In the Open box and click OK.

NOTE

If applicable, replace the letter d with the correct CD ROM drive
letter.

Sept 2003 1X SC 4812T-MC Multicarrier BTS Optimization/ATP
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Copy BTS and CBSC CDF/NECF Files to the LMF Computer

Before logging on to a BTS with the LMF computer to execute
optimization/ATP procedures, the correct bts-#.cdf (or bts—#.necf) and
cbsc-#.cdf files must be obtained from the CBSC and put in a bts-#
folder in the LMF computer. This requires creating versions of the
CBSC CDF files on a DOS—formatted floppy diskette and using the
diskette to install the CDF/NECEF files on the LMF computer.

NOTE — If the LMF has ftp capability, the ftp method can be used to
copy the CDF files from the CBSC.

— On Sun OS workstations, the unix2dos command can be
used in place of the cp command (e.g., unix2dos
bts—248.cdf bts—248.cdf). This should be done using a copy
of the CBSC CDF file so the original CBSC CDF file is
not changed to DOS format.

NOTE When copying CDF or NECF files, comply with the following
to prevent BTS login problems with the LMF:
— The numbers used in the bts—#.cdf (or bts—#.necf and
cbsc—#.cdf filenames must correspond to the locally
assigned numbers for each BTS and its controlling CBSC.

— The generic cbsc-1.cdf file supplied with the LMF work
with locally numbered BTS CDF files. Using this file will
not provide a valid optimization unless the generic file is
edited to replace default parameters (e.g., channel numbers)
with the operational parameters used locally.

The procedure iqj"able 3-2 lists the steps required to transfer the CDF or
NECEF files from the CBSC to the LMF computer. For further
information, refer to the LMF Help function on line documentation.

Table 3-2: Copying CBSC CDF or NECF Files to the LMF

v~ Step Action
AT THE CBSC:
1 Login to the CBSC workstation.
2 Insert a DOS formatted diskette in the workstation drive.
3 Type eject —q and press the <Enter> key.
4 Type mount and press the <Enter> key.
NOTE
* Look for the “floppy/no_name” message on the last line displayed.
* If the eject command was previously entered, floppy/no_name will be appended with a
number. Use the explicit floppy/no_name reference displayed when performing step 3.
5 Change to the directory containing the file by typing cd <directory name> (ex.cd
bts—248) and pressing <Enter>.
6 Type Is <Enter> to display the list of files in the directory.
... continued on next page
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Table 3-2: Copying CBSC CDF or NECF Files to the LMF

v~ Step Action
7 With Solaris versions of Unix, create DOS—formatted versions of the bts—#.cdf (or bts—#.necf)
and cbsc—#.cdf files on the diskette by entering the following command:
unix2dos <source filename> [floppy/no_name/<target filename>
For example, unix2dos bts—248.cdf/necf /floppy/no_name/bts—248.cdf.
NOTE
¢ Other versions of Unix do not support the unix2dos and dos2unix commands. In these cases,
use the Unix ¢cp (copy) command. The copied files will be difficult to read with a DOS or
Windows text editor because Unix files do not contain line feed characters. Editing copied
CDF/NECEF files on the LMF computer is, therefore, not recommended.
¢ Using cp, multiple files can be copied in one operation by separating each filename to be copied
with a space and ensuring the destination directory (floppy/no_name) is listed at the end of the
command string following a space (e.g., cp bts—248.cdf cbsc-6.cdf /floppy/na_name).

8 Repeat stepg througl7 for each bts—# that must be supported by the LMF.

9 When all required files have been copied to the diskette, type eject and press the <Enter> key.

10 | Remove the diskette from the CBSC.

AT THE LMF:

11 Start the Windows operating system.

12 | Insert the diskette into the LMF.

13 | Using Windows Explorer (or equivalent program), create a corresponding bts—# folder in the
<Imf home directory>\cdma directory for each bts—#.cdf/necf/cbsc—#.cdf/necf file pair copied from
the CBSC.

14 | Use Windows Explorer (or equivalent program) to transfer the cbsc—#.cdf (or bts—#.necf) and
bts—#.cdf files from the diskette to the corresponding <Imf home directory>\cdma\bts—# folders
created in steg33.
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Creating a Named HyperTerminal Connection for MMI Connection

Confirming or changing the configuration data of certain BTS Field
Replaceable Units (FRUs) requires establishing an MMI communication
session between the LMF and the FRU. Using features of the Windows
operating system, the connection properties for an MMI session can be
saved on the LMF computer as a named Windows HyperTerminal
connection. This eliminates the need for setting up connection
parameters each time an MMI session is required to support
optimization.

Once the named connection is saved, a shortcut for it can be created on
the Windows desktop. Double clicking the shortcut icon will start the
connection without the need to negotiate multiple menu levels.

Follow the procedure irrFable 3-3 to establish a named HyperTerminal
connection and create a WIndows desktop shortcut for it.

Table 3-3: Creating a Named Hyperlink Connection for MMI Connection

Step Action
1 From the Windows Start menu, select:
Programs>Accessories
2 Select Communications, double click the Hyperterminal folder, and then double click on the
Hyperterm.exe icon in the window that opens.
NOTE
¢ If a Location Information Window appears, enter the required information, then click Close.
(This is required the first time, even if a modem is not to be used.)
* If a You need to install a modem..... message appears, click NO.
3 When the Connection Description box opens:
— Type a name for the connection being defined (e.g., MMI Session) in the Name: window.
— Highlight any icon preferred for the named connection in the Icon: chooser window.
— Click OK.
NOTE
For LMF configurations where COM1 is used by another interface such as test equipment and a
physical port is available for COM2, select COM2 to prevent conflicts.
4 L .
From the Connect using: pick list in the Connect To box displayed, select the RS—232 port to be used
for the connection (e.g., COM1 or COM2 (Win NT) — or Direct to Com 1 or Direct to Com 2 (Win
98), and click OK.
5 In the Port Settings tab of the COM# Properties window displayed, configure the RS—232 port
settings as follows:
* Bits per second: 9600
* Data bits: 8
¢ Parity: None
* Stop bits: 1
* Flow control: None
... continued on next page
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Table 3-3: Creating a Named Hyperlink Connection for MMI Connection

Step Action

6 Click OK.

7 Save the defined connection by selecting:
File>Save

8 Close the HyperTerminal window by selecting:
File>Exit

9 Click Yes to disconnect when prompted.

10 | Perform one of the following:
* If the Hyperterminal folder window is still open (Win 98) proceed to ste 32
* From the Windows Start menu, select Programs > Accessories

11 Perform one of the following:
* For Win NT, select Hyperterminal and release any pressed mouse buttons.
* For Win 98, select Communications and double click the Hyperterminal folder.

12 | Highlight the newly created connection icon by moving the cursor over it (Win NT) or clicking on it
(Win 98).

13 | Right click and drag the highlighted connection icon to the Windows desktop and release the right
mouse button.

14 | From the pop—up menu displayed, select Create Shortcut(s) Here.

15 | If desired, reposition the shortcut icon for the new connection by dragging it to another location on the
Windows desktop.
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Span Lines — Interface and Isolation

T1/E1 Span Interface

NOTE

At active sites, the OMC/CBSC must disable the BTS and place
it out of service (O0S). DO NOT remove the 50-pin TELCO
cable connected to the BTS frame site I/O board J1 connector
until the OMC/CBSC has disabled the BTS!

Each frame is equipped with one Site I/O and two Span I/O boards. The
Span I/O J1 connector provides connection of 25 pairs of wire. A GLI
card can support up to six spans. In the SC 4812T configuration, the odd
spans (1, 3, and 5) terminate on the Span “A” I/O; and the even spans
(2, 4, and 6) terminate on the Span “B” I/O.

NOTE

Span Lines will interface to the BTS throught the Site I/O ONLY
in circuit split mode.

Before connecting the LMF to the frame LAN, the OMC/CBSC must

disable the BTS and place it OOS to allow the LMF to control the

CDMA BTS. This prevents the CBSC from inadvertently sending

control information to the CDMA BTS during LMF based tests. Refer to
igure 3-2 anddigure 3-3 as required.
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Isolate BTS from T1/E1 Spans

To ensure the LMF will maintain control of the BTS, disable the BTS
and isolate the spans as described irfJable 3-4.

Table 3-4: T1/E1 Span Isolation

Step Action

1 Have the OMC/CBSC place the BTS OOS.

2 Remove the T1/E1 span 50—pin TELCO cable connected to the SPAN 1/O cards
[(higure 3-2).

NOTE

— If a third party is used for span connectivity, the third party must be informed
before disconnecting the span line.

— Verity that you remove the SPAN cable, not the “MODEM/TELCO” connector.

Figure 3-2: Span I/O Board T1 Span Isolation

50-PIN TELCO
SPAN A CONNECTOR ~<———— CONNECTORS
(TELCO) INTERFACE

TO SPAN LINES I~ REMOVED
\ | > M n | '
I
~ - -~ Q

il il
1] 1]

SPAN B CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

RS—232 9-PIN SUB D
CONNECTOR SERIAL
PORT FOR EXTERNAL e
DIAL UP MODEM ~
CONNECTION (IF USED) - -
TOP of Frame

(Site 1/0 and Span I/O boards)

FW00299
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LMF to BTS Connection
Connect the LMF to the BTS

The LMF is connected to the LAN A or B connector located on the left
side of the frame’s lower air intake grill, behind the LAN Cable Access
door (seqigure 3-3).

Table 3-5: LMF to BTS Connection

Step Action

1 To gain access to the connectors on the BTS, open the LAN Cable Access door, then pull apart the
Velcro®  tape covering the BNC “T” connector (seqigure 3-3).

2 Connect the LMF to the LAN A BNC connector via PCMCIA Ethernet Adapter with an unshielded
twisted—pair (UTP) Adapter and 10BaseT/10Base2 converter (powered by an external AC/DC
transformer).

3 Start the LMF application (seqJable 3-6 orFable 3-7) and test the connection.
— If there is no login response, connect the LMF to the LAN B connector.
— If there is still no login response, seqable 6-1, Login Failure Troubleshooting Procedures.

NOTE

— Xircom Model PE3-10B2 or equivalent can also be used to interface the LMF Ethernet
connection to the frame connected to the PC parallel port, powered by an external AC/DC
transformer. In this case, the BNC cable must not exceed 91 cm (3 ft) in length.

— The LAN shield is isolated from chassis ground. The LAN shield (exposed portion of BNC
connector) must not touch the chassis during optimization.

Figure 3-3: LMF Connection Detail

NOTE:

Open LAN CABLE ACCESS
door. Pull apart Velcro tape and
gain access to the LAN A or LAN
B LMF BNC connector.

LMF BNC “T” CONNECTIONS
ON LEFT SIDE OF FRAME

(ETHERNET “A” SHOWN;
ETHERNET “B” COVERED \
WITH VELCRO TAPE)

10BASET/10BASE2
CONVERTER CONNECTS
DIRECTLY TOBNC T

e
\/\/

==

&z
)
S50
Iy
LRSIy
%27%%%
OMPUTE

LMF Ci R

TERMINAL WITH /4
MOUSE PCMCIA ETHERNET
ADPATER & ETHERNET UNIVERSAL TWISTED PAIR (UTP) NN ti-CDMA-WP-00076-v01-ildoc-ftw

UTP ADAPTER CABLE (RJ11 CONNECTORS)
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Using the LMF
Basic LMF Operation

LMF Coverage in This Publication — The LMF application program
supports maintenance of both CDMA and SAS BTSs. All references to
the LMF in this publication are to the CDMA portion of the program.

Operating Environments — The LMF application program allows the
user to work in the two following operating environments which are
accessed using the specified desktop icons:

* Graphical User Interface (GUI) using the WinLMF icon
* Command Line Interface (CLI) using the WinLMF CLI icon

The GUI is the primary optimization and acceptance testing operating
environment. The CLI environment provides additional capability to the
user to perform manually controlled acceptance tests and audit the
results of optimization and calibration actions.

Basic Operation — Basic operation of the LMF in either environment
includes performing the following:

¢ Selecting and deselecting BTS devices

Enabling devices
* Disabling devices
* Resetting devices
¢ Obtaining device status

The following additional basic operation can be performed in a GUI
environment:

¢ Sorting a status report window

For detailed information on performing these and other LMF operations,
refer to the WinLMF On-Line Help SR2.16.x .

NOTE Unless otherwise noted, LMF procedures in this manual are
performed using the GUI environment.

Online Help — Task oriented online help is available in the LMF by
clicking on Help from the menu bar.

The LMF Display and the BTS

BTS Display — When the LMF is logged into a BTS, a frame tab is
displayed for each BTS frames. The frame tab will be labeled with
“CDMA” and the BTS number, a dash, and the frame number (for
example, BTS-812-1 for BTS 812, RFMF 1). If there is only one frame
for the BTS, there will only be one tab.

CDF/NECF Requirements — For the LMF to recognize the devices
installed in the BTS, a BTS CDF/NECEF file which includes equipage
information for all the devices in the BTS must be located in the
applicable <x>:\<lmf home directory>\cdma\bts—# folder. To provide
the necessary channel assignment data for BTS operation, a CBSC CDF
file which includes channel data for all BTS RFMFs is also required in
the folder.
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RFDS Display — If an RFDS is included in the CDF/NECEF file, an
RFDS tab labeled with “RFDS,” a dash and the BTS number—frame
number combination (for example, RFDS-812-1) will be displayed.

Graphical User Interface Overview
The LMF uses a GUI, which works in the following way:

¢ Select the device or devices.
* Select the action to apply to the selected device(s).

* While action is in progress, a status report window displays the action
taking place and other status information.

* The status report window indicates when the action is complete and
displays other pertinent information.

* Clicking the OK button closes the status report window.

Understanding GUI Operation

The following screen captures are provided to help understand how the
GUI operates:

—rFigure 3-4 depicts the differences between packet and circuit
CDMA “cdf” file identification. Note that if there is a packet
version “bts” file, the “(P)” is added as a suffix. There is a
corresponding “(C)” for the circuit mode version.

—Hjigure 3-5 depicts the Self-Managed Network Elements (NEs) state
of a packet mode SC4812T. Note that an “X” is on the front of each
card that is under Self-Managed Network Elements (NEs) control
by the GLI3 card.

—Hjigure 3-6 depicts three of the available packet mode commands.
Normally the GLI3 has Self-Managed Network Elements (NEs)
control of all cards as shown irfigure 3-5 by an “(X)”. In that state
the LMF may only status a card. In order to download code or test a
card, the LMF must request Self-Managed Network Elements (NEs)
control of the card by using the shown dropdown menu. It also uses
this menu to release control of the card back to the GLI3. The GLI3
will also assume control of the cards after the LMF logs out of the
BTS. The packet mode GLI3 normally is loaded with a tape release
and NECB and NEC] files which point to a tape release stored on
the GLI3. When the GLI3 has control of a card it will maintain that
card with the code on that tape release.

—fjigure 3-7 depicts a packet mode site that has the MCC-1 and the
BBX-1 cards under LMF control. Notice that the “X” is missing
from the front of these two cards.

For detailed information on performing these and other LMF operations,
refer to the LMF Help function on—line documentation.
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Figure 3-4: BTS Login screen — identifying circuit and packet BTS files
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Figure 3-5: Self-Managed Network Elements (NEs) state of a packet mode SC4812T
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Figure 3-6: Available packet mode commands
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Figure 3-7: Packet mode site with MCC-1 and BBX-1 under LMF control
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Command Line Interface Overview

The LMF also provides Command Line Interface (CLI) capability.
Activate the CLI by clicking on a shortcut icon on the desktop. The CLI
cannot be launched from the GUI, only from the desktop icon.

Both the GUI and the CLI use a program known as the handler. Only one
handler can be running at one time. Due to architectural limitations, the
GUI must be started before the CLI if you want the GUI and CLI to use
the same handler. When the CLI is launched after the GUI, the CLI
automatically finds and uses an in—progress login session with a BTS
initiated under the GUI. This allows the use of the GUI and the CLI in
the same BTS login session. If a CLI handler is already running when
the GUI is launched (this happens if the CLI window is already running
when the user starts the GUI, or if another copy of the GUI is already
running when the user starts the GUI), a dialog window displays the
following warning message:

The CLI handler is already running.

This may cause conflicts with the LMF.

Are you sure that you want to start the application?
Yes No
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Selecting the yes button starts the application. Selecting the no button
terminates the application.

CLI Format Conventions

The CLI command can be broken down in the following way:
* verb
* device including device identifier parameters
* switch
® option parameters consisting of:
— keywords
— equals signs (=) between the keywords and the parameter values

— parameter values

Spaces are required between the verb, device, switch, and option
parameters. A hyphen is required between the device and its identifiers.
Following is an example of a CLI command.

measure bbx—<bts_id>—<bbx_id> rssi channel=6 sector=5

Refer to the LMF CDMA CLI Reference SR2.16.1.x manual for a
complete explanation of the CLI commands and their use.
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Logging into a BTS

Logging into a BTS establishes a communications link between the BTS
and the LMF. An LMF session can be logged into only one BTS at a
time.

Prerequisites
Before attempting to log into the BTS,

Before attempting to login to a BTS, ensure the following have been
completed:

* The LMF is properly connected to the BTS (seqjigure 3-3).
* The LMF application program is correctly installed and prepared.
* A bts-# folder with the correct CDF/NECF and CBSC file exists.

* The LMF computer was connected to the BTS before starting the
Windows operating system and LMF software. If necessary, restart the
computer after connecting it to the BTS in accordance witl]j" able 3-5

anqigure 3-3.

NOTE Be sure that the correct bts—#.cdf/necf and cbsc—#.cdf/necf files
are used for the BTS. These should be the CDF/NECEF files that
are provided for the BTS by the CBSC. Failure to use the correct
CDF/NECF files can result in invalid optimization. Failure to
use the correct CDF/NECYF files to log into a live (traffic
carrying) site can shut down the site.

BTS Login from the GUI Environment

Follow the procedure iqj"able 3-6 to log into a BTS when using the GUI
environment.

Table 3-6: BTS GUI Login Procedure

Step

Action

Start the CDMA LMF GUI environment by double clicking on the WinLMF desktop icon (if the
LMF is not running).

NOTE

If a warning similar to the following is displayed, select No, shut down other LMF sessions which
may be running, and start the CDMA LMF GUI environment again:

The CLI handler is already running.

This may cause conflicts with the LMF

Are you sure you want to start the application?
Yes No

Click on the Login tab (if not displayed).

If no base stations are displayed in the Available Base Stations pick list, double click on the
CDMA icon.

Click on the desired BTS number.

... continued on next page

3-24

1X SC 4812T-MC Multicarrier BTS Optimization/ATP Sept 2003




68P64115A21-B Using the LMF

Table 3-6: BTS GUI Login Procedure

| Step

Action

Click on the Network Login tab (if not already in the forefront).

Enter the correct IP address (normally 128.0.0.2 for a field BTS) if not correctly displayed in the
IP Address box.
NOTE

128.0.0.2 is the default IP address for MGLI-1 in field BTS units. 128.0.0.1 is the default IP
address for MGLI-2.

Type in the correct IP Port number (normally 9216) if not correctly displayed in the IP Port box.

Click on Ping.
— If the connection is successful, the Ping Display window shows text similar to the following:
Reply from 128 128.0.0.2: bytes=32 time=3ms TTL=255
— If there is no response the following is displayed:
128.0.0.2:9216:Timed out

If the MGLI fails to respond, reset and perform the ping process again. If the MGLI still fails to
respond, typical problems are shorted BNC to inter—frame cabling, open cables, crossed A and B
link cables, missing S0O—-Ohm terminators, or the MGLI itself.

Change the Multi-Channel Preselector (from the Multi-Channel Preselector pick list), normally
MPC, corresponding to your BTS configuration, if required.

NOTE

When performing RX tests on expansion frames, do not choose EMPC if the test equipment is
connected to the starter frame.

NOTE
“Use a Tower Top Amplifier” is not applicable to the SC4812T-MC.

10

Click on Login.
A BTS tab with the BTS is displayed.

NOTE
e If you attempt to login to a BTS that is already logged on, all devices will be gray.

* There may be instances where the BTS initiates a log out due to a system error (i.c., a device
failure).

e If the MGLI is OOS_ROM (blue), it will have to be downloaded with code before other devices
can be seen.

e If the MGLI is OOS—-RAM (yellow), it must be enabled before other installed devices can be
seen.
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BTS Login from the CLI Environment

Follow the procedure irﬂ" able 3-7 to log into a BTS when using the CLI
environment.

NOTE

If the CLI and GUI environments are to be used at the same
time, the GUI must be started first and BTS login must be
performed from the GUI. Refer tqable 3-6 to start the GUI
environment and log into a BTS.

Table 3-7: BTS CLI Login Procedure

Step

Action

Double click the WinLMF CLI desktop icon (if the LMF CLI
environment is not already running).

NOTE

If a BTS was logged into under a GUI session when the CLI
environment was started, the CLI session will be logged into the same
BTS, and step 2 is not required.

At the /wlmf prompt, enter the following command:
login bts—<bts#> host=<host> port=<port>
where:

host = MGLI card IP address (defaults to address last logged into for
this BTS or 128.0.0.2 if this is first login to this BTS).

port = IP port of the BTS (defaults to port last logged into for this
BTS or 9216 if this is first login to this BTS).

A response similar to the following will be displayed:

LMF>
13:08:18.882 Command Received and Accepted
COMMAND=login bts—33

13:08:18.882 Command In Progress

13:08:21.275 Command Successfully Completed
REASON_CODE="No Reason”

3|
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Logging Out

Logging out of a BTS is accomplished differently for the GUI and the
CLI operating environments.

NOTE The GUI and CLI environments use the same connection to a
BTS. If a GUI and the CLI session are running for the same BTS
at the same time, logging out of the BTS in either environment
will log out of it for both. When either a login or logout is
performed in the CLI window, there is no GUI indication that
logout has occurred.

Logging Out of a BTS from the GUI Environment

Follow the procedure iqj"able 3-8 to logout of a BTS when using the
GUI environment.

Table 3-8: BTS GUI Logout Procedure

v~ Step Action
1 Click on BTS on the BTS tab menu bar.

2 Click the Logout item in the pull-down menu (a Confirm Logout
pop—up message appears).

3 Click on Yes or press the <Enter> key to confirm logout.
You are returned to the Login tab.

NOTE

If a logout was previously performed on the BTS from a CLI window
running at the same time as the GUIL, a Logout Error pop—up
message appears stating the system should not log out of the BTS.
When this occurs, the GUI must be exited and restarted before it can
be used for further operations.

4 If a Logout Error pop—up message appears stating that the system
could not log out of the Base Station because the given BTS is not
logged in, perform the following actions:

— Click OK.

— Select File>Exit in the window menu bar.

— Click Yes in the Confirm Logout pop-up.

— Click Yes in the Logout Error pop—up which appears again.

5 If further work is to be done in the GUI, restart it.

NOTE

* The Logout item on the BTS menu bar will only log you out of the
displayed BTS.

* You can also log out of all BTS sessions and exit LMF by clicking
on the File selection in the menu bar and selecting Exit from the
File menu list. A Confirm Logout pop—up message will appear.
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Logging Out of a BTS from the CLI Environment

Follow the procedure iqj"able 3-9 to logout of a BTS when using the
CLI environment.

Table 3-9: BTS CLI Logout Procedure

»~| Step Action

NOTE

If the BTS is also logged into from a GUI running at the same time
and further work must be done with it in the GUI, proceed to step 2.

1 Logout of a BTS by entering the following command:
logout bts—<bts#>

A response similar to the following is displayed:

LMF>

12:22:58.028 Command Received and Accepted
Command=logout bts—33

12:22:58.028 Command Received and Accepted

12:22:58.028 Command Successfully Completed
REASON_CODE="No Reason”

2 If desired, close the CLI interface by entering the following
command:

exit

A response similar to the following is displayed before the window
closes:

Killing background processes....
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Establishing an MMI Communication Session

For those procedures that require MMI communications between the
LMF and BTS FRUs, follow the procedure irffable 3-10 to initiate the
communication session.

Table 3-10: Establishing MMI Communications

v~ Step Action

1 Connect the LMF computer to the equipment as detailed in the
applicable procedure that requires the MMI communication session.

2 Start the named HyperTerminal connection for MMI sessions by
double clicking on its desktop shortcut.

NOTE

If a desktop shortcut was not created for the MMI connection, access
the connection from the Start menu by selecting:

Programs>Accessories>Hyperterminal>HyperTerminal><Named
HyperTerminal Connection (e.g., MMI Session).

3 Once the connection window opens, establish MMI communication
with the BTS FRU by pressing the LMF computer <Enter> key until
the prompt identified in the applicable procedure is obtained.

Figure 3-8: CDMA LMF Computer Common MMI Connections

/ To FRU MMI port

NULL MODEM
BOARD
(TRN9666A)
-~
~
~
i
8-PIN TO 10-PIN |
RS—232 CABLE |
(P/N 30-09786R01) ‘

CDMA LMF
COMPUTER

DB9-TO-DB25
ADAPTER

FW00687

Online Help

Task oriented online help is available in the LMF by clicking on Help in
the window menu bar, and selecting LMF Help from the pull-down
menu.
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Figure 3-9: BTS LAN Diagram

For proper operation, the integrity of the Ethernet LAN A and B links
must be be verified[Higure 3-9 represents a typical BTS Ethernet
configuration. The drawing depicts one (of two identical) links, A and B.

Ping is a program that routes request packets to the LAN network
modules to obtain a response from the specified “targeted” BTS.

UNUSED LAN “OUT” PORTS MUST
HAVE NON-GROUNDED 50 OHM BNC
TERMINATORS INSTALLED
OR
BE CONNECTED TO EXPANSION
FRAME (WHERE USED) VIA COAX
CABLES

LAN “IN” PORTS MUST HAVE
GROUNDED 50 OHM TERMINATION
AT ALL TIMES IN A STARTER
FRAME.

IN EXPANSION FRAME AND
LOGICAL BTS, LAN “IN” PORTS ARE
NOT GROUNDED

LMF
CONNECTOR

| O | [ N
e
C-CCP AJ>B

BTS
(STARTER)

i

Follow the procedure iqj"able 3-11 and refer tqjigure 3-9, as required,
to ping each processor (on both LAN A and LAN B) and verifty LAN
redundancy is operating correctly.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module to prevent damage by ESD.
NOTE The Ethernet LAN A and B cables must be installed on each

frame/enclosure before performing this test. All other processor
board LAN connections are made via the backplanes.
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Table 3-11: Pinging the Processors

v~ Step Action
1 If you have not already done so, connect the LMF to the BTS (seqJable 3-5 on page

[3-16).

2 From the Windows desktop, click the Start button and select Run.

In the Open box, type ping and the <MGLI IP address> (for example, ping
128.0.0.2).

NOTE

128.0.0.2 is the default IP address for MGLI-1 in field BTS units. 128.0.0.1 is the
default IP address for MGLI-2.

4 Click on the OK button.

If the connection is successful, text similar to the following is displayed:

Reply from 128 128.0.0.2: bytes=32 time=3ms TTL=255
If there is no response the following is displayed:
Request timed out

If the MGLI fails to respond, reset and perform the ping process again. If the MGLI
still fails to respond, typical problems are shorted BNC to inter-frame cabling, open
cables, crossed A and B link cables, missing S0—-Ohm terminators, or the MGLI itself.
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Download the BTS

Overview

ROM Code

Before a BTS can operate, each equipped device must contain device
initialization (ROM) code. ROM code is loaded in all devices during
manufacture or factory repair. Device application (RAM) code and data
must be downloaded to each equipped device by the user before the BTS
can be made fully functional for the site where it is installed.

Downloading ROM code to BTS devices from the LMF is NOT routine
maintenance nor a normal part of the optimization process. It is only
done in unusual situations where the resident ROM code in the device
does not match the release level of the site operating software AND the
CBSC cannot communicate with the BTS to perform the download. If
you must download ROM code, refer to AppendiyH.

Before ROM code can be downloaded from the LMEF, the correct ROM
code file for each device to be loaded must exist on the LMF computer.
ROM code must be manually selected for download.

NOTE

The ROM code file is not available for GLI3s. GLI3s are ROM
code loaded at the factory.

RAM Code

Before RAM code can be downloaded from the CDMA LMEF, the correct
RAM code file for each device must exist on the LMF computer. RAM
code can be automatically or manually selected depending on the Device
menu item chosen and where the RAM code file for the device is stored
in the CDMA LMF file structure. The RAM code file is selected
automatically if the file is in the \Imficdma\loads\n.n.n.n\code folder
(where n.n.n.n is the version number of the download code). The RAM
code file in the code folder must have the correct hardware bin number.

RAM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded changes to OOS-ROM
(blue). When the download is completed successfully, the device
changes to OOS-RAM (yellow). When code is downloaded to an MGLI,
the LMF automatically also downloads data, and then enables the MGLI.
When enabled, the MGLI changes to INS (green).

For non—-MGLI devices, data must be downloaded after RAM code is
downloaded. To download data, the device state must be OOS-RAM
(yellow).

Prior to downloading a device, a code file must exist. The code file is
selected automatically if the code file is in the /Imf/cdma/n.n.n.n/code
folder (where n.n.n.n is the version number of the download code that
matches the “NextLoad” parameter in the CDF/NECEF file). The code file
in the code folder must have the correct hardware bin number. Code can
be automatically or manually selected.
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The devices to be loaded with RAM code and data are::

* Master Group Line Interface (MGLI)

* Group Line Interface (GLI)

Clock Synchronization Module (CSM)

Multi Channel Card (MCC24E, MCC8E or MCC-1X)
Broadband Transceiver (BBX)

NOTE The MGLI must be successfully downloaded with code and data,

and put INS before downloading any other device. The
download code process for an MGLI automatically downloads
data and enables the MGLI before downloading other devices.
The other devices can be downloaded in any order.

Verify GLI ROM Code Loads

Devices should not be loaded with a RAM code version which is not
compatible with the ROM code with which they are loaded. Before
downloading RAM code and data to the processor cards, follow the
procedure iipJable 3-12 to verify the GLI devices are loaded with the
correct ROM code for the software release used by the BSS.

Prerequisite

Identify the correct GLI ROM code load for the software release being
used on the BSS by referring to the Version Matrix section of the SC™
CDMA Release Notes (supplied on the tapes or CD—-ROMs containing
the BSS software).

Table 3-12: Verify GLI ROM Code Loads

Step

Action

If it has not already been done, start a GUI LMF session and log into the
BTS ( refer tqable 3-6).

Select all GLI devices by clicking on them, and select Device > Status
from the BTS menu bar.

In the status report window which opens, note the number in the ROM
Ver column for each GLIL

4a

4b
4c
4d

If the ROM code loaded in the GLIs is not the correct one for the software
release being used on the BSS, perform the following:

Log out of the BTS as described ilﬂable 3-8 orfable 3-9, as
applicable.

Disconnect the LMF computer.

Reconnect the span lines as described iable 5-7.

Have the CBSC download the correct ROM code version to the BTS
devices.

When the GLIs have the correct ROM load for the software release being
used, be sure the span lines are disabled as outlined irjable 3-4 and
proceed to downloading RAM code and data.
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Download RAM Code and Data to MGLI and GLI

Prerequisite

Prior to performing this procedure, ensure a code file exists for each of

the devices to be downloaded.

Procedure

Follow the procedure ir¥able 3-13 to download the firmware

application code for the MGLI. The download code action downloads

data and also enables the MGLI.

Table 3-13: Download and Enable MGLI

v~ Step Action

1 Select Tools>Update Next Load>CDMA function to ensure th
Load parameter is set to the correct code version level.

e Next

2 Download code to the primary MGLI by clicking on the MGLI.

A status report confirms change in the device(s) status.

— Click OK to close the status window. (The MGLI should
automatically be downloaded with data and enabled.)

— From the Device pull down menu, select Download>Code/Data.

this time.

3 Download code and data to the redundant MGLI but do not enable at
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Download Code and Data to Non—GLI Devices

Non—GLI devices can be downloaded individually or all equipped
devices can be downloaded with one action. Follow the procedure in
|j"able 3-14 to download code and data to the non—GLI devices.

NOTE — When downloading multiple devices, the download may
fail for some of the devices (a time out occurs). These
devices can be downloaded separately after completing the
multiple download.

— CSM devices are RAM code—loaded at the factory. RAM
code is downloaded to CSMs only if updating to a newer
software version.

Table 3-14: Download Code and Data to Non—GLI Devices
v~ Step Action

1 Select all devices to be downloaded.

2 From the Device pull down menu, select Download>Code/Data.

A status report displays the result of the download for each selected
device.

3 Click OK to close the status window when downloading is complete.

NOTE

— After the download has started, the device being downloaded
changes to blue. If the download is completed successfully, the
device changes to yellow (OOS-RAM with code loaded).

— After a BBX, CSM or MCC is successfully downloaded with
code and has changed to OOS-RAM, the status LED should be
rapidly flashing GREEN.

— The command in Steg3 loads both code and data. Data can be
downloaded without doing a code download anytime a device is
OOS-RAM using the command in Steq4.

4 To download the firmware application data to each device, select the
target device and select: Device>Download>Data
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Select CSM Clock Source and Enable CSMs

A CSM can have three different clock sources. The Clock Source
function can be used to select the clock source from each of the three
inputs. This function is only used if the clock source for a CSM needs to
be changed. The Clock Source function provides the following clock
source options:

* Local GPS

Mate GPS

Remote GPS

HSO (only for sources 2 & 3)
HSOX (only for sources 2 & 3)
10 MHz (only for sources 2 & 3)
NONE (only for sources 2 & 3)

Prerequisites

MGLI=INS_ACT

CSM= OOS_RAM or INS_ACT

Follow the procedure ifable 3-15 to select a CSM Clock Source.

Table 3-15: Select CSM Clock Source

| Step

Action

Select the applicable CSM(s).

Click on Device in the BTS menu bar and select
CSM/MAWTI > Select Clock Source... in the pull down menu — a
clock source selection window is displayed.

Select the applicable clock source in the Clock Reference Source
pick lists. Uncheck the related check boxes for Clock Reference
Sources 2 and 3 if you do not want the displayed pick list item to be
used.

Click on the OK button — a status report window displays the results
of the selection action.

Click on the OK button to close the status report window.

NOTE

For non—RGPS sites only, verify the CSM configured with the
GPS receiver “daughter board” is installed in the CSM-1 slot
before continuing.
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Enable CSMs

NOTE — CSMs are code loaded at the factory. This data is retained
in EEPROM. The download code procedure is required in
the event it becomes necessary to code load CSMs with
updated software versions. Use the status function to
determine the current code load versions.

— The CSM(s) to be enabled must have been downloaded
with code (Yellow, OOS-RAM) and data.

Each BTS CSM system features two CSM boards per site. In a typical
operation, the primary CSM locks its Digital Phase Locked Loop
(DPLL) circuits to GPS signals. These signals are generated by either an
on-board GPS module (RF-GPS) or a remote GPS receiver (R-GPS).
The CSM2 card is required when using the R—-GPS. The GPS receiver
(mounted on CSM-1) is the primary timing reference and synchronizes
the entire cellular system. CSM-2 provides redundancy but does not
have a GPS receiver.

The BTS may be equipped with a remote GPS, LORAN-C HSO 10
MHz Rubidium source, or HSOX for expansion frames, which the CSM
can use as a secondary timing reference. In all cases, the CSM monitors
and determines what reference to use at a given time.

Follow the procedure irrfable 3-16 to enable the CSMs.

-l

Table 3-16: Enable CSMs

»~| Step Action

1 | Verify the CSM(s) have been downloaded with code (Yellow, OOS-RAM) and data.

2 Click on the target CSM.
From the Device pull down, select Enable.

NOTE

— If equipped with two CSMs, enable CSM-2 first and then CSM-1. A status report confirms
change in the device(s) status. Click OK to close the status window.

— FAIL may be shown in the status table for enable action. If Waiting For Phase Lock is shown
in the Description field, the CSM changes to the enabled state after phase lock is achieved.
CSM-1 houses the GPS receiver. The enable sequence can take up to one hour to complete.

— The GPS satellite system satellites are not in a geosynchronous orbit and are maintained and
operated by the United States Department of Defense (D.O.D.). The D.O.D. periodically
alters satellite orbits; therefore, satellite trajectories are subject to change. A GPS receiver that
is INS contains an “almanac” that is updated periodically to take these changes into account.

— If an installed GPS receiver has not been updated for a number of weeks, it may take up to
one hour for the GPS receiver “almanac” to be updated.

— Once updated, the GPS receiver must track at least four satellites and obtain (hold) a 3-D
position fix for a minimum of 45 seconds before the CSM will come in-service. (In some
cases, the GPS receiver needs to track only one satellite, depending on accuracy mode set
during the data load.)

— If equipped with two CSMs, the LMF should display CSM-1 as bright GREEN (INS-ACT)
and CSM-2 as dark green (INS—-STB). After the CSMs have been successfully enabled, the
PWR/ALM LEDs are steady green (alternating green/red indicates the card is in an alarm
state).

3 If more than an hour has passed, refer tq-jable 3-20 to determine the cause.
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Enable MCCs
Follow the procedure irrable 3-17 to enable the MCCs.
NOTE The MGLI, and primary CSM must be downloaded and enabled
(IN-SERVICE ACTIVE), before downloading and enabling the
MCC.
Table 3-17: Enable MCCs
v~ Step Action
1 Verify the MCC(s) have been downloaded with code (Yellow,
OOS-RAM) and data.
2 Select the MCC:s to be enabled or from the Select pulldown menu
choose MCCs.
3 From the Device menu, select Enable — a status report confirms
change in the device(s) status.
4 Click on OK to close the status report window.
Enable Redundant GLIs

Follow the procedure ifable 3-18 to enable the redundant GLI(s).

Table 3-18: Enable Redundant GLIs

v~ Step Action

1 Select the target redundant GLI(s).

2 From the Device menu, select Enable — a status report window
confirms the change in the device(s) status and the enabled GLI(s) is
green.

3 Click on OK to close the status report window.
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CSM System Time/GPS and HSO Verification

CSM & HSO Background

Front Panel LEDs

The primary function of the Clock Synchronization Manager (CSM)
boards (slots 1 and 2) is to maintain CDMA system time. The CSM in
slot 1 is the primary timing source while slot 2 provides redundancy. The
CSM2 card (CSM second generation) is required when using the remote
GPS receiver (R—-GPS). R—GPS uses a GPS receiver in the antenna head
that has a digital output to the CSM2 card. CSM2 can have a daughter
card as a local GPS receiver to support an RF—GPS signal.

The CSM2 switches between the primary and redundant units (slots 1
and 2) upon failure or command. CDMA Clock Distribution

Cards (CCDs) buffer and distribute even—second reference and 19.6608
MHz clocks. CCD-1 is married to CSM-1 and CCD-2 is married to
CSM 2. A failure on CSM—1 or CCD-1 cause the system to switch to
redundant CSM-2 and CCD-2.

In a typical operation, the primary CSM locks its Digital Phase Locked
Loop (DPLL) circuits to GPS signals. These signals are generated by
either an on—board GPS module (RF-GPS) or a remote GPS receiver
(R—GPS). The CSM2 card is required when using the R—-GPS. DPLL
circuits employed by the CSM provide switching between the primary
and redundant unit upon request. Synchronization between the primary
and redundant CSM cards, as well as the HSO back—up source, provides
excellent reliability and performance.

Each CSM board features an ovenized, crystal oscillator that provides
19.6608 MHz clock, even second tick reference, and 3 MHz sinewave
reference, referenced to the selected synchronization source (GPS,
Receiver, or High Stability Oscillator (HSO), T1 Span, or external
reference oscillator sources). The 3 MHz signals are also routed to the
RDM EXP 1A & 1B connectors on the top interconnect panel for
distribution to co—located frames at the site.

Fault management has the capability of switching between the GPS
synchronization source and the HSO backup source in the event of a
GPS receiver failure on CSM-1. During normal operation, the CSM—1
board selects GPS as the primary source (seqJable 3-20). The source
selection can also be overridden via the LMF or by the system software.

All boards are mounted in the C—CCP shelf at the top of the BTS frame.

djigure 1-10 on pagq§-29 illustrates the location of the boards in the

BTS frame.

The status of the LEDs on the CSM boards are as follows:
¢ Steady Green — Master CSM locked to GPS (INS).
¢ Rapidly Flashing Green — Standby CSM locked to GPS (STBY).

* Flashing Green/Rapidly Flashing Red — CSM OOS-RAM attempting
to lock on GPS signal.

¢ Rapidly Flashing Green and Red — Alarm condition exists. Trouble
Notifications (TNs) are currently being reported to the GLL
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High Stability Oscillator

CSM and HSO - The CSM handles the overall configuration and status
monitoring functions of the HSO. In the event of GPS failure, the HSO
is capable of maintaining synchronization initially established by the
GPS reference signal.

HSO - The HSO is a high stability 10 MHz oscillator with the necessary
interface to the CSMs. The HSO is typically installed in those
geographical areas not covered by the LORAN-C system. Since the
HSO is a free—standing oscillator, system time can only be maintained
for 24 hours after 24 hours of GPS lock.

Upgrades and Expansions: HSO2/HSOX

HSO2 (second generation cards) both export a timing signal to the
expansion or logical BTS frames. The associated expansion or logical
frames require an HSO—expansion (HSOX). The HSOX accepts input
from the starter frame and interfaces with the CSM cards in the
expansion frame. HSO, HSO2, and HSOX use the same source code in
source selection (seqFable 3-19).

NOTE Allow the base site and test equipment to warm up for 60
minutes after any interruption in oscillator power. CSM board
warm-up allows the oscillator oven temperature and oscillator
frequency to stabilize prior to test. Test equipment warm-up
allows the Rubidium standard timebase to stabilize in frequency
before any measurements are made.

3-40
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CSM Frequency Verification

The objective of this procedure is the initial verification of the CSM
boards before performing the RF path verification tests. Parts of this
procedure will be repeated for final verification after the overall
optimization has been completed.

Null Modem Cable

A null modem cable is required. It is connected between the LMF
COMI1 port and the RS232-GPIB Interface boxfigure 3-10 shows the
wiring detail for the null modem cable.

Figure 3-10: Null Modem Cable Detail

9-PIN D-FEMALE 9-PIN D-FEMALE
GND| 5 5 | GND
i 2| X
3
gg ;: ONBOTH CONNECTORS [ | 7 gg
RSD/DCD | 1 <— SHORTPINS 7, 8; - 8 oTS oD
DTR| 4 SHORT PINS 1, 4, &6 1
4 | DTR
PeRLe | 6 | DSR

FW00362

Prerequisites
Ensure the following prerequisites have been met before proceeding:

* The LMF is NOT logged into the BTS.

* The COM1 port is connected to the MMI port of the primary CSM via
a null modem board.
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Test Equipment Setup: GPS & HSO Verification

Follow the procedure iqj"able 3-19 to set up test equipment while
referring tqfjigure 3-11 as required.

Table 3-19: Test Equipment Setup (GPS & HSO Verification)

Step Action

1 Perform one of the following operations:

— For local GPS (RF-GPS), verify a CSM board with a GPS receiver is installed in primary CSM
slot 1 and that CSM-1 is INS.
This is verified by checking the board ejectors for kit number SGLN1145 on the board in slot 1.

— For Remote GPS (RGPS), verify a CSM2 board is installed in primary slot 1 and that CSM-1 is

INS.
This is verified by checking the board ejectors for kit number SGLN4132ED (or later).

2 Remove CSM-2 (if installed) and connect a serial cable from the LMF COM 1 port (via null modem
board) to the MMI port on CSM-1.

Reinstall CSM-2.

4 Start an MMI communication session with CSM-1 by using the Windows desktop shortcut icon (see
[Jable 3-3)

NOTE

The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

5 When the terminal screen appears, press the <Enter> key until the CSM> prompt appears.
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Figure 3-11: CSM MMI terminal connection
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LMF
NOTEBOOK
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ADAPTER
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1. One LED on each CSM:
Green = IN-SERVICE ACTIVE
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GPS Initialization/Verification

Follow the procedure iqj"able 3-20 to initialize and verify proper GPS
receiver operation.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

* The LMF is not logged into the BTS.

* The COM1 port is connected to the MMI port of the primary CSM via
a null modem board (seqfjigure 3-11).

* The primary CSM and HSO (if equipped) have been warmed up for at
least 15 minutes.

CAUTION Connect the GPS antenna to the GPS RF connector ONLY.
Damage to the GPS antenna and/or receiver can result if the
GPS antenna is inadvertently connected to any other RF
connector.
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Table 3-20: GPS Initialization/Verification

Step

Action

To verify that Clock alarms (0000),Dpll is locked and has a reference source, and
GPS self test passed messages are displayed within the report, issue the following MMI
command

bstatus

— Observe the following typical response:

Clock Alarms (0000):

DPLL is locked and has a reference source.

GPS receiver self test result: passed

Time since reset 0:33:11, time since power on: 0:33:11

Enter the following command at the CSM> prompt to display the current status of the Loran and the
GPS receivers.

sources
— Observe the following typical response for systems equipped with HSO:

Num Source Name Type TO Good Status Last Phase Target Phase Valid

0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 No N/A timed—out* Timed—out* No

*NOTE “Timed—out” should only be displayed while the HSO is warming up. “Not—Present” or
“Faulty” should not be displayed. If the HSO does not appear as one of the sources, then configure the
HSO as a back—up source by entering the following command at the CSM> prompt:

ss 1 12

After a maximum of 15 minutes, the Rubidium oscillator should reach operational temperature and the
LED on the HSO should now have changed from red to green. After the HSO front panel LED has
changed to green, enter sources <cr> at the CSM> prompt. Verify that the HSO is now a valid
source by confirming that the bold text below matches the response of the “sources” command.

The HSO should be valid within one (1) minute, assuming the DPLL is locked and the HSO rubidium
oscillator is fully warmed.

Num Source Name Type TO Good Status Last Phase Target Phase Valid

0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 Yes N/A ) 9:9.9:9.9:9.9:9.9:4 XXXXXXXXXX Yes

HSO information (underlined text above, verified from left to right) is usually the #1 reference source.
If this is not the case, have the OMCR determine the correct BTS timing source has been identified in
the database by entering the display bts csmgen command and correct as required using the edit
csm csmgen refsrc command.

NOTE

If any of the above mentioned areas fail, verify:

— If LED is RED, verify that HSO had been powered up for at least 5 minutes. After oscillator
temperature is stable, LED should go GREEN Wait for this to occur before continuing !

— If “timed out” is displayed in the Last Phase column, suspect the HSO output buffer or oscillator
is defective

— Verify the HSO is FULLY SEATED and LOCKED to prevent any possible board warpage

... continued on next page
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ﬂable 3-20: GPS Initialization/Verification

Step Action
5 Verify the following GPS information (underlined text above):
— GPS information is usually the O reference source.
— At least one Primary source must indicate “Status = good” and “Valid = yes” to bring site up.
6 Enter the following command at the CSM> prompt to verify that the GPS receiver is in tracking mode.
gstatus
— Observe the following typical response:
24:06:08 GPS Receiver Control Task State: tracking satellites.
24:06:08 Time since last valid fix: 0 seconds.
24:06:08
24:06:08 Recent Change Data:
24:06:08 Antenna cable delay 0 ns.
24:06:08 Initial position: lat 117650000 msec, lon —350258000 msec, height 0 cm (GPS)
24:06:08 Initial position accuracy (0): estimated.
24:06:08
24:06:08 GPS Receiver Status:
24:06:08 Position hold: 1lat 118245548 msec, lon —350249750 msec, height 20270 cm
24:06:08 Current position: lat 118245548 msec, lon —350249750 msec, height 20270 cm
(GPS)
24:06:08 8 satellites tracked, receiving 8 satellites, 8 satellites visible.
24:06:08 Current Dilution of Precision (PDOP or HDOP): O.
24:06:08 Date & Time: 1998:01:13:21:36:11
24:06:08 GPS Receiver Status Byte: 0x08
24:06:08 Chan:0, SVID: 16, Mode: 8, RSSI: 148, Status: 0xa8
24:06:08 Chan:1, SVID: 29, Mode: 8, RSSI: 132, Status: 0xa8
24:06:08 Chan:2, SVID: 18, Mode: 8, RSSI: 121, Status: 0xa8
24:06:08 Chan:3, SVID: 14, Mode: 8, RSSI: 110, Status: 0xa8
24:06:08 Chan:4, SVID: 25, Mode: 8, RSSI: 83, Status: 0xa8
24:06:08 Chan:5, SVID: 3, Mode: 8, RSSI: 49, Status: 0xa8
24:06:08 Chan:6, SVID: 19, Mode: 8, RSSI: 115, Status: 0xa8
24:06:08 Chan:7, SVID: 22, Mode: 8, RSSI: 122, Status: 0xa8
24:06:08
24:06:08 GPS Receiver Identification:
24:06:08 COPYRIGHT 1991-1996 MOTOROLA INC.
24:06:08 SFTW P/N # 98—P36830P
24:06:08 SOFTWARE VER # 8
24:06:08 SOFTWARE REV # 8
24:06:08 SOFTWARE DATE 6 AUG 1996
24:06:08 MODEL # B3121P1115
24:06:08 HDWR P/N # _
24:06:08 SERIAL # S558G0217769
24:06:08 MANUFACTUR DATE 6B07
24:06:08 OPTIONS LIST IB
24:06:08 The receiver has 8 channels and is equipped with TRAIM.
7 Verify the following GPS information (shown above in underlined text):
— At least 4 satellites are tracked, and 4 satellites are visible.
— GPS Receiver Control Task State is “tracking satellites”. Do not continue until this occurs!
— Dilution of Precision indication is not more that 30.
Record the current position base site latitude, longitude, height and height reference (height reference
to Mean Sea Level (MSL) or GPS height (GPS). (GPS=0 MSL =1).
... continued on next page
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ﬂable 3-20: GPS Initialization/Verification

Step

Action

If stepgd throughq pass, the GPS is good.

NOTE

If any of the above mentioned areas fail, verify that:

— [If Initial position accuracy is “estimated” (typical), at least 4 satellites must be tracked and
visible (1 satellite must be tracked and visible if actual lat, log, and height data for this site has
been entered into CDF/NECEF file).

— If Initial position accuracy is “surveyed”, position data currently in the CDF/NECEF file is
assumed to be accurate. GPS will not automatically survey and update its position.

— The GPS antenna is not obstructed or misaligned.

— GPS antenna connector center conductor measures approximately +5 Vdc with respect to the
shield.

— There is no more than 4.5 dB of loss between the GPS antenna OSX connector and the BTS frame
GPS input.

— Any lightning protection installed between GPS antenna and BTS frame is installed correctly.

Enter the following commands at the CSM> prompt to verify that the CSM is warmed up and that GPS
acquisition has taken place.
debug dplip

Observe the following typical response if the CSM is not warmed up (15 minutes from application of
power) (If warmed—up proceed to steg40)

CSM>DPLL Task Wait. 884 seconds left.
DPLL Task Wait. 882 seconds left.
DPLL Task Wait. 880 seconds left. ....cccecee etc.

NOTE

The warm command can be issued at the MMI port used to force the CSM into warm—up, but the
reference oscillator will be unstable.

10

Observe the following typical response if the CSM is warmed up.

c:17486 off: -11, 3,
c:17486 off: -11,
c:17470 off: -11,
c:17486 off: -11,
c:17470 off: -11,
c:17470 off: -11,

TK SRC:0 S0O0: 3 S1:-2013175,-2013175
TK SRC:0 SO: S1:-2013175,-2013175
TK SRC:0 SO: S1:-2013175,-2013175
TK SRC:0 SO: S1:-2013175,-2013175
TK SRC:0 SO: S1:-2013175,-2013175
TK SRC:0 S0O0: 1 S1:-2013175,-2013175

4

=W W
oY oy [y o oy oy
=W W

N N N~ N

11

Verify the following GPS information (underlined text above, from left to right):
— Lower limit offset from tracked source variable is not less than —60 (equates to 3us limit).
— Upper limit offset from tracked source variable is not more than +60 (equates to 3us limit).
— TK SRC: 0 is selected, where SRC 0 = GPS.

12

Enter the following commands at the CSM> prompt to exit the debug mode display.
debug dplip

Sept 2003

1X SC 4812T-MC Multicarrier BTS Optimization/ATP 3-47




-l

CSM System Time/GPS and HSO Verification 68P64115A21-B

HSO Initialization/Verification

The HSO module is a full-size card that resides in the C—CCP Shelf.
This completely self contained high stability 10 MHz oscillator
interfaces with the CSM via a serial communications link. The CSM
handles the overall configuration and status monitoring functions of the
HSO. In the event of GPS failure, the HSO is capable of maintaining
synchronization initially established by the GPS reference signal for a
limited time.

The HSO is typically installed in those geographical areas not covered
by the LORAN-C system and provides the following major functions:

¢ Reference oscillator temperature and phase lock monitor circuitry
* Generates a highly stable 10 MHz sine wave.

* Reference divider circuitry converts 10 MHz sine wave to 10 MHz
TTL signal, which is divided to provide a 1 PPS strobe to the CSM.

Prerequisites
* The LMF is not logged into the BTS.

* The COM1 port is connected to the MMI port of the primary CSM via
a null modem board.

* The primary CSM and the HSO (if equipped) have warmed up for 15
minutes.

If the BTS is equipped with an HSO, follow the procedure i Jable 3-21
to configure the HSO.

Table 3-21: HSO Initialization/Verification

Step Action
1 At the BTS, slide the HSO card into the cage.
NOTE
The LED on the HSO should light red for no longer than 15-minutes, then switch to green. The CSM
must be locked to GPS.
2 On the LMF at the CSM> prompt, enter sources <cCr>.
— Observe the following typical response for systems equipped with HSO:
Num Source Name Type TO Good Status Last Phase Target Phase Valid
0 Local GPS Primary 4 Yes Good 0 0 Yes
1 HSO Backup 4 Yes N/A XXXXXXX —69532 Yes
2 Not used
Current reference source number: 0
When the CSM is locked to GPS, verify that the HSO “Good” field is Yes and the “Valid” field is Yes.
3 If source “1” is not configured as HSO, enter at the CSM> prompt: ss 1 12 <cr>
Check for Good in the Status field.
4 At the CSM> prompt, enter sources <cr>.
Verify the HSO valid field is Yes. If not, repeat this step until the “Valid” status of Yes is returned. The
HSO should be valid within one (1) minute, assuming the DPLL is locked and the HSO Rubidium
oscillator is fully warmed.
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Test Equipment Set-up

Connecting Test Equipment to the BTS
The following equipment is required to perform optimization:
* LMF
® Test set

* Directional coupler and attenuator

RF cables and connectors
Null modem cable (seqifigure 3-10)
¢ GPIB interface box

Refer tqjable 3-22 an¢-Fable 3-23 for an overview of connections for
test equipment currently supported by the LMF. In addition, see the
following figures:

*figure 3-14 andigure 3-15 show the test set connections for TX
calibration.

*figure 3-18 andHigure 3-19 show test set connections for IS-95 A/B
optimization/ATP tests.

*figure 3-20 shows test set connections for IS-95 A/B and
CDMA 2000 optimization/ATP tests.

*figure 3-21 andHigure 3-22 show typical TX and RX ATP setup with
a directional coupler.

Test Equipment GPIB Address Settings

All test equipment is controlled by the LMF through an IEEE—488/GPIB
bus. To communicate on the bus, each piece of test equipment must have
a GPIB address set which the LMF will recognize. The standard address
settings used by the LMF for the various types of test equipment items
are as follows:

¢ Signal generator address: 1

* Power meter address: 13

¢ Communications system analyzer: 18

¢ Signal generator address: 19

Using the procedures included in the Setting GPIB Addresses section of

AppendixH, verify and, if necessary, change the GPIB address of each
piece of test equipment used to match the above
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Supported Test Equipment

CAUTION To prevent damage to the test equipment, all TX test connections
must be through the directional coupler and in-line attenuator as
shown in the test setup illustrations.

IS-95 A/B Testing

Optimization and ATP testing for IS-95A/B may be performed using
one of the following test sets:

¢ CyberTest

¢ Hewlett—Packard HP 8935

* Hewlett—Packard HP 8921 and HP 437B or Gigatronics Power Meter
¢ Advantest R3465 and HP 437B or Gigatronics Power Meter

The equipment listed above cannot be used for CDMA 2000 testing.

CDMA 2000 Testing

| NOTE IS-95 C is the same as CDMA 2000.

Optimization and ATP testing for IS-95A/B and CDMA2000 1X sites or
carriers may be performed using the following test equipment:

¢ Agilent E4406A with E4432B Signal Generator

e Agilent 8935 series E6380A communications test set (formerly HP
8935) with option 200 or R2K and with E4432B signal generator for
1X FER

* Advantest R3267 Analyzer with Advantest R3562 Signal Generator

The E4406A/E4432B pair, or the R3267/R3562 pair, should be
connected together using a GPIB cable. In addition, the R3562 and
R3267 should be connected with a serial cable from the Serial I/O to the
Serial I/O. This test equipment is capable of performing tests in both
IS-95 A/B mode and CDMA 2000 mode if the required options are
installed.

Optional test equipment

* Spectrum Analyzer (HP8594E) — can be used to perform cable
calibration.

Test Equipment Preparation

See AppendixT for specific steps to prepare each type of test set and
power meter to perform calibration and ATP.
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Test Equipment Reference Chart

[Jable 3-22 and-jable 3-23 show the current test equipment available
meeting Motorola standards.

To identify the connection ports, locate the test equipment presently
being used in the TEST SETS columns, and read down the column.
Where a ball appears in the column, connect one end of the test cable to
that port. Follow the horizontal line to locate the end connection(s),
reading up the column to identify the appropriate equipment/BTS port.

Table 3-22: IS-95 A/B Test Equipment Setup
COMMUNICATIONS SYSTEM ANALYZER ADDITIONAL TEST EQUIPMENT
Advant- GPIB 30 dB Direction-
Cyber— est HP HP HP 8921 | Power | Inter- al Coupler & 20
SIGNAL Test R3465 8935 8921A W/PCS Meter face LMF dB Pad* BTS
\ I \ ‘ I I I \
‘ | _EVEN |  EVEN ‘ EVEN | \ ‘ |
EVEN SECOND EVEN EVEN SEC | SECOND | SECOND | SECOND SYNC
SYNCHRONIZATION SECREF | SYNCIN | SYNCIN ‘ SYNCIN | SYNCIN ‘ \ | ‘ MONITOR
T
P | | 1 | 1 | | 1 @
| e— ‘ ‘ ‘ ; i —0
*— \ \ | \ °
| | *o— : 1 | : >3
\ \ ‘ ‘ @ T I ‘ T \
| | | | | — |
19.6608 MHZ | CDMA | | coma | coma \ | \ \
TIME TIME BASE EXT TIME TIME FREQ
cLock BASEIN | | REFIN ! BASEIN | BASEIN ! | | ! MONITOR
\ \ \
— ‘ \ } \ } ‘ ¢
| o— | O
\ | &— } | { i | O
| \ \ [ — @
| | ° ‘ O
| | | | | | | |
\ \ \ \ \ \
CONTROL IEEE | | SERIAL
IEEE 488 BUS 488 | apB | HPaB ‘ HP-IB ! HP-IB HP-IB ‘ criB | PORT | ‘
° | | \ \ \ ° \ PO \
| — ‘ } ——o—o |
\ | & ———@ | |
| e— *——@ ® ‘
\ \ ° | \
; ; | — e |
‘ ‘ | ‘ | ‘ ‘ | TX1-n (SEE
| NOTE
TX TEST RFE | NPUT | RF_ | mF RF \ | | 30DBCOUPLER | BELOW
CABLES INOUT | 50-OHM | INOUT | wout | jout | | | AND20DBPAD | TABLE)
® : : 1 T ‘ : *——=o
| e—t | : | : : < ®
\ | e— ! 1 ; : *——o
| | | @ | — b
\ \ \ \ \ | \ | RX1-n (SEE
‘ ‘ | NOTE
RX TEST RFGEN | RFOUT | RF DUPLEX | RFoOUT | \ BELOW
CABLES OUT | 50-OHM | INOUT | OUT | ONLY \ | | | TABLE)
*—i i ‘ 1 1 1 i —e
@ f @
\ - \ ! \ \ -
\ \ \ o ‘ : : —
| | | | d \ T I \ ®
NOTE — TX Test cables are setup as follows: TX 1-3 for 3-sector

BTS and TX 1-6 for 6-sector.

— RX Test Cables are set up as follows: RX 1-6 for 3-sector
and RX 1-12 for 6-sector.
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Table 3-23: CDMA2000 1X/IS-95A/B Test Equipment Interconnection

TEST SETS ADDITIONAL TEST EQUIPMENT
Advantest Agilent 30dB
R3562 Advantest Agilent E4432B GPIB Directional
Signal R3267 E4406A Signal Power | Inter- Coupler & 20
SIGNAL Generator | Analyzer Analyzer | Generator | Meter | face | LMF dB Pad* BTS
! \
| | | | o |
EVEN SECOND EXT ‘ TRIGGER | PATTERN \ | \ \ SYNe
SYNCHRONIZATION TRIG IN | EXTTRIG | IN | TRIG IN | ! ! | MONITOR
‘ T l [ | |
° | } i | | | _®
‘ @ ‘ i ‘ 1 i i 7Y
| \ ¢ 1 1 \ \ \ o
\ \ 1 d i \ \ @
! \
MOD TIME | | EXT [ [ | FREQ
19.6608 MHZ |
g BASE IN } | REFIN i } } } | MONITOR
P | : E—
‘ ‘ ® } ‘ ‘ ‘ | ®
| ; i | | 1 |
SIGNALSOURCE | SERIALIO |  SERIALIO | ‘ \ | | |
CONTROLLED \ ‘ | \ \ \ \
SERIAL I/O ._'_. ‘ ‘ ‘ ‘ ‘ ‘
| 1omHzouT | | 10 MHZ IN | | | |
oMz | 1OMHZIN | } 10 MHZ OUT | | 1 1 |
— | o — o | \ \ \
| 1 | | ] |
CONTROL IEEE | | | | | serial | |
IEEE 488 BUS 488 | GPIB ‘ HP-IB | GPIB HP-IB | GPIB | PORT | \
o ; | } } o ; ° } }
| ‘
| | | —e—T—9 | |
| | | o o0 | |
TX TEST RF OUT \ RFIN | RFINPUT " RFoutPUT ‘ \ |  30DBCOUPLER | TX1-n (SEE NOTE
CABLES | | 500HM | 50 0HM | | | AND20DBPAD | BELOW TABLE)
T ‘ ‘ T T T
| | | ] |
|
‘ ® } i } | | 7Y | P
R R S -
| | |
| | } | | | |
RX TEST RFGEN | RFOUT ‘ RF OUT | RFOUTPUT | | | | RX1-n (SEE NOTE
CABLES our | 50-OHM ‘ ONLY | 50-OHM | | | | BELOW TABLE)
' [ l T T T
® i i i 1 i i —®
| | | | I |
| | | | I |
| ! \ | ! ‘ ‘
NOTE — TX Test cables are setup as follows: TX 1-3 for 3-sector

BTS and TX 1-6 for 6-sector.

— RX Test Cables are set up as follows: RX 1-6 for 3-sector
and RX 1-12 for 6-sector.
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Equipment Warm-up

NOTE Warm-up BTS equipment for a minimum of 60 minutes prior to
performing the BTS optimization procedure. This assures BTS
site stability and contributes to optimization accuracy. (Time
spent running initial power-up, hardware/firmware audit, and
BTS download counts as warm-up time.)

WARNING Before installing any test equipment directly to any BTS TX
OUT connector, verify there are NO CDMA BBX channels
keyed. At active sites, have the OMC-R/CBSC place the antenna
(sector) assigned to the PA under test OOS. Failure to do so can
result in serious personal injury and/or equipment damage.

Automatic Cable Calibration Set—up

igure 3-12 anqjigure 3-13 show the cable calibration setup for various
supported test sets. The left side of the diagram depicts the location of
the input and output ports of each test set, and the right side details the
set up for each test.

Manual Cable Calibration

If manual cable calibration is required, refer to the procedures in
AppendixH.
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Figure 3-12: Cable Calibration Test Setup

SUPPORTED TEST SETS

Motorola CyberTest

] == ] =

GOMMUNIGATIONS
SYSTEM ANALYZER
7700-2000 Mz

RF GEN OUT

ANT IN

Note: The Directional Coupler is not used with the
Cybertest Test Set. The TX cable is connected
directly to the Cybertest Test Set.

A 10dB attenuator must be used with the short test
cable for cable calibration with the CyberTest Test
Set. The 10dB attenuator is used only for the cable
calibration procedure, not with the test cables for
TX calibration and ATP tests.

‘ o

RF OUTPUT
50-OHM

RF INPUT
50-OHM

Hewlett—Packard Model HP 8921A

@”

CALIBRATION SET UP

A. SHORT CABLE CAL

-

|

|

SHORT |
CABLE |
|

|

|

B. RX TEST SETUP

N-N FEMALE
ADAPTER

C. TX TEST SETUP

DIRECTIONAL COUPLER

(30 DB)
IRININIRIRINIn] [1 O
B

-~

100-WATT (MIN)
NON-RADIATING
RF LOAD

N-N FEMALE

SHORT
CABLE ADAPTER | _____

«

SET
]
FW00089
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Figure 3-13: Cable Calibration Test Setup (Advantest R3267, Agilent E4406A)

SUPPORTED TEST SETS
fffffffffffffffffffffff CALIBRATION SET UP

A. SHORT CABLE CAL -

[ =) <

SHORT

)
=
=
T=S35000 CABLE
—= 00t
IToooo B0oo
Y ocoo
=
[ )

=5 o0o00Ooee O © RF IN

\ EXT TRIG IN

MOD TIME BASE IN B RX TEST SETUP

(EXT REF IN)

© 0o o 0

o ® RF OUT

N-N FEMALE
ADAPTER

Agilent E4432B (Top) and E4406A (Bottom)

©=

©=

@

©

@ o o o a
I@a['/

(o=

- RF
[m] — 6 <Lr
5 oo o jc' = @© INngl_'Llso

RF
OUTPUT
50 OHM

alaTitatitatal i) iy

C. TX TEST SETUP

DIRECTIONAL COUPLER
(30DB)

[1 1

=L

100-WATT (MIN)
NON-RADIATING
RF LOAD

N-N FEMALE

SHORT
CABIE ADAPTER -————

REF FW00089
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Set-up for TX Calibration

igure 3-14 an¢Higure 3-15 show the test set connections for TX
calibration.

Figure 3-14: TX Calibration Test Setup (CyberTest, HP 8935, and Advantest)

-l

TEST SETS TRANSMIT (TX) SET UP
ffffffffffffffffffffff e
\ POWER 1 Power
| | 100-WATT (MIN) SENSOR :,,%VTV,'EES |
. ;. NON-RADIATING (OPTIONAL)*
| . . RF LOAD L=
| [ 1 I_ _______ =
[ ] |
| ) I
| 1 our | |
T — | compmcamons |
\ 30 DB TEST SET
| =< J¢ DIRECTIONAL INPUT/
| COUPLER OUTPUT | |
| PORTS | |
IN/OUT CONTROL
FRONT PANEL | O T/ﬂ:[]\ SO IEEE 488
| ‘ TX TEST N L __ __ _ _ _GPBBUS
- CABLE
NOTE: THE DIRECTIONAL COUPLER IS NOT USED WITH THE | g
CYBERTEST TEST SET. THE TX CABLE IS CONNECTED DIRECTLY | =
TO THE CYBERTEST TEST SET. | .
TEST
| CABLE
| * A POWER METER CAN BE USED IN PLACE
iiiiiiiiiiiiiiiiiiiii OF THE COMMUNICATIONS TEST SET FOR TX
| CALIBRATION/AUDIT
Hewlett—Packard Model HP 8935 |
HP-IB | GPIB
gg XGP|B | CABLE
|
T |
|
|| — |
] O I =] S —— .
| ] ™ /:%TRETNNA
| | ] | [ DIP SWITCH SETTINGS ~ gy1one]
|| | \ DATAFORMAT | |
| | | PAPPAEL L[]
RF IN/OUT : | | | ON [ [m mm m |
777777777777777777777 ] BTS | YT '\}
| | | ‘L GPIB ADRS ]
| | LAN | RS232-GPIB G MODE
| | B | INTERFACE BOX
| | LN R | RS232
| A | NULL
| 10BASET/ MODEM
| | 10BASE2 | CABLE
| | CONVERTER |
GPIB | |
-«— CONNECTS TO | | | CDMA
BACK OF UNIT | | | LMF
INPUT , I B _
50-OHM
\ UNIVERSAL TWISTED
\
\

PAIR (UTP) CABLE
(RJ45 CONNECTORS)

INTERNAL PCMCIA
ETHERNET CARD

REF FW00094
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Figure 3-15: TX Calibration Test Setup (Advantest R3267 and Agilent E4406A)

TEST SETS TRANSMIT (TX) SET UP
ffffffffffffffffffffff ———————————————————————————-
Advantest Model R3267 | FOWER 7
S | | 100-WATT (MIN) SENSOR i :,,%VTVEE ™
— | ‘ EIC:)TBIZBDIATING L (OPTIONAL)* J
N =] = EE E = | ‘ r— _i
D DD C 1
o | r ] |
—S Ooooo : ‘
—SOoooo == | ‘ our | |
Cjo=0ooo | i Ll communicarions |
o000 000 | | 30 DB TEST SET TEST SET |
e | [<j¢ |, DIRECTIONAL OINPUT/ | |
] - COUPLER UTPUT
((LZ_0000ee o O | PORTS | controL
— = | O TK 1 T >0 1) ('S,EIBE éﬁas
| l__‘l TX TEST N L _BTebe
CABLE
G
RF IN —
|
******************** — TX
| TEST
Agilent E4406A | CABLE * A POWER METER CAN BE USED IN PLACE
OF THE COMMUNICATIONS TEST SET FOR TX
| CALIBRATION/AUDIT
— |
[ o (o) |
[ oo GPIB
= [ oo | CABLE
== |
=
D00 ®
ooo |
ooao |
0000 |
| ]
T = S
| | TXANTENNA |
PORT ——
DIP SWITCH SETTINGS |
RFINPUT | | : ‘F s MoDE
DATA FORMAT
soQ | | | | BAUD RATE ‘
———————————————————— — ]
| : | ON - mm = |
- - - -
' BTS | YT T
| | | L GPIB ADRS ]
| | RS232-GPIB G MODE
| LAN
| | B8 | INTERFACE BOX
| LAN R |
RS232
| - | NULL
| 10BASET/ MODEM
| | 10BASE2 | CABLE
| | CONVERTER |
o : CDMA
I | | LMF
| |_ - - _
| UNIVERSAL TWISTED
| PAIR (UTP) CABLE INTERNAL PCMCIA
| (RJ45 CONNECTORS) ETHERNET CARD

REF FW00094
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Figure 3-16: TX Calibration Test Setup — Agilent E7495A (IS-95A/B and CDMA2000 1X)

TEST SETS TRANSMIT (TX) SET UP
777777777777777777777 Y vy
POWER 1
. — POWER METER
SENSOR |
Agilent E7495A |‘ NOTE: IF BTS IS EQUIPPED I I
WITH DUPLEXED RX/TX
|  SIGNALS, CONNECT THE TX + —
TEST CABLE TO THE
PORT 1 |
| DUPLEXED ANTENNA RF OUT
| CONNECTOR. |
(- =] | |  communicaTioNs |
= =] | 100 WATT (I | SYSTEM ANALYZER |
(= = | NON-RADIATING PORT 2 INTERNAL |
[—-— =1 | RF LOAD R S ETHES;‘% D_
e
LH — | TX TEST
[H = | CABLE
[ =l |
| ﬁ
OO0 OO0 o | ‘ DIRECTIONAL
oo OO = | 50 Q <J COUPLER
@ OO DO Ooo = | TERM (30 DB)
I :
OOoOg odg | -
| |
| 20 DB IN-LINE
ATTENUATOR
— — |
P oy G el | TX TEST
o/ \o © ® © | CABLE
i o/ \o Sonsr @ . —_— ——1
° @ | RX T |
| | ANTENNA ANTENNA
o/ o © N CONNECTOR  CONNECTOR |
L — || : ETHERNET HUB
|
SYNGC MONITOR |
PO 2 EVEN SEC TICK PORT 1 I |
PULSE REFERENCE RF OUT || |
FROM CSM BOARD N BTS |
| |
|| |
[ ] SYNC |
W MONITOR |
|| csm |
I |
I |
I |
| |
I : LAN |
B
LAN
oA I
N 10BASET/ |
|| 10BASE2 |
N CONVERTER
& | CDMA
LMF
[ S |
| UNIVERSAL TWISTED PAIR (UTP)
CABLE (RJ45 CONNECTORS) INTERNAL PCMCIA
\ —— | ETHERNET CARD
\
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Figure 3-17: IS-95A/B and CDMA2000 1X Optimization/ATP Test Setup —

Agilent E7495A
fffffff TESTSET  _____ ATPTESTSETLP =
ettt -
‘ POWER METER I
Agilent E7495A | | |
. . |
| NOTE: IF BTS IS EQUIPPED - !
| WITH DUPLEXED RX/TX RXTEST PORT 1 I
SIGNALS, CONNECT THE TX | RF OUT |
| TEST CABLE TO THE DUPLEXED | | | |
} S
| ANTENNA CONNECTOR COMMUNICATION
[ = | 100 WATT (N “ RE INPUT 50 0 SYSTEM ANALYZER |
LH —J NON-RADIATING ORINPUT 50 Q INTERNAL |
(= =] | RF LOAD Egm 2 ETHERNET
- =] | TX TEST U CAHD| —
(= = |
(- =1 |
| ’T‘ DIRECTIONAL
OO0 OO0 OOOd | 50 © < COUPLER NOTE: USE THE SAME
il OooO = | TERM ( ) CABLE SET FOR TX AND RX
(- = ATP. SWITCH THE CABLES
OO0 I I | DURING ALL ATP TESTS AS
OoOOg oog | T/’ SHOWN.
[
| 20 DB IN-LINE
| ATTENUATOR
— — TEST
— | RX TEST T ES
. Pover REF Bl it | ['_- == 4 
oLy g @ © |
o of o = s@ re G | () TX TEST
o/ o © | e —— L ——y
— — | | AntenNA ANTENNA | ETHERNET HUB
| | CONNECTOR  CONNECTOR |
SYNC MONITOR |
PO 2 EVEN SEC TICK PORT 1 | | I
PULSE REFERENCE RF OUT | BTS |
FROM CSM BOARD | | |
! |
! !
| SYNC |
| | MONITOR |
: | CSM |
K '
| |
L I
I I
: : LAN |
B
LAN
| I A 0 :
1 10BASET/ |
| 10BASE2 |
N CONVERTER
] | CDMA
LMF
| . _!
| UNIVERSAL TWISTED PAIR (UTP)
CABLE (RJ45 CONNECTORS) INTERNAL PCMCIA
\ ETHERNET CARD
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Setup for Optimization/ATP

igure 3-18 an¢Hjigure 3-19 show test set connections for IS-95 A/B
optimization/ATP tests{Higure 3-20 shows test set connections for
IS-95 A/B and CDMA 2000 optimization/ATP tests.

Figure 3-18: IS-95 A/B Optimization/ATP Test Setup Calibration
Using Directional Coupler (CyberTest, HP 8935 and Advantest)

TEST SETS

Motorola CyberTest

SYNC MONITOR
EVEN SEC TICK
PULSE REFERENCE
FROM CSM BOARD

Optimization/ATP SET UP

T NOTE: IF BTS RX/TX SIGNALS ARE
DUPLEXED (4800E): BOTH THE TX AND RX

FREQ MONITOR TEST CABLES CONNECT TO THE DUPLEXED

COMMUNICATIONS
SYSTEM ANALYZER
1700-2000 MH:

AUDIOIN AFGFN OUT_AUDIO OUT VFASIN

NOTE: The Directional Coupler is not used
with the Cybertest Test Set. The TX cable is
connected directly to the Cybertest Test set.

Hewlett—Packard Model HP 8935

SYNC MONITOR FREQ MONITOR
EVEN SEC TICK 19.6608 MHZ CLOCK
PULSE REFERENCE REFERENCE FROM
FROM CSM BOARD CSM BOARD

ADVANTEST NOT SUPPORTED

\
\ COMMUNICATIONS
19.6608 MHZ CLOCK |  ANTENNA GROUP.
REFERENCE FROM | __ TESTSET -
CSM BOARD | outl” |
‘ CDMA EVEN |
TIMEBASE SECOND/SYNG
\ 100-WATT (MIN) TEST SET | IN IN |
NON-RADIATING INPUT/ |
\ RX RF LOAD OUTPUT | ® ®
‘ TEST PORTS | |
| CABLE |
| -
| IEEE 488
GPIB BUS
| R REe ]
RF RF
INJOUT ouT \
| 30 DB
DIRECTIONAL
\ COUPLER
\
\ T 10 DB PAD
****** 4
\
\
‘ X
TEST
HP_IB | CABLE
TOGPIB \
\
______ -7
RX ANTENNA TXANTENNA |
PORT PORT
|
|
|
BTS : - DIP SWITCH SETTINGS - <
\ DATA FORMAT | |
| | SAPRE | |
FREQ | N
MONITOR | © - =m .
| ‘ - == - |
SYne | [T T T \
MONITOR ' \ |
| GPIB ADRS G MODE,
CSM "RS232-GPIB
LN : INTERFACE BOX
=
3 | RS232 NULL
MODEM
10BASET/
10BASE2 | CABLE
CONVERTER |
|
| CDMA
| LMF
- 1
UNIVERSAL TWISTED
PAIR (UTP) CABLE
(RJ45 CONNECTORS) N T D

REF FW00096
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Figure 3-19: Optimization/ATP Test Setup HP §8921A
TEST SET Optimization/ATP SET UP

NOTE: IF BTS RX/TX SIGNALS ARE
DUPLEXED (4800E): BOTH THE TX AND RX
TEST CABLES CONNECT TO THE DUPLEXED
ANTENNA GROUP.

Hewlett—Packard Model HP 8921A

SYNC MONITOR FREQ MONITOR
EVEN SEC TICK 19.6608 MHZ CLOCK
PULSE REFERENCE REFERENCE FROM
FROM CSM BOARD CSM BOARD

‘?_I

100-WATT (MIN) TEST SET |
I_/ NON-RADIATING INPUT/ I ‘T:SSII"TMSUENT'CATIONS |
[ 5 ] RX RF LOAD ouTPUT |
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COI\?I\ITIIE% TS CABLE I TIMEBASE ~ SECOND/SYNC |
Eooosocoood ‘ IN N
EEeREEIEaEEs TO BACK OF 1 Py o
i R § | c—
o _gfees / UNIT IEEE 488
O= soooo
SO |eose — L__} _ _|GrBBUS
o = [m L I s e ‘
® O oo [<JI
S J 30 DB
DIRECTIONAL
COUPLER .
-
}
RF RF OUT I 10 DB PAD

RX ANTENNA TX ANTENNA
PORT PORT

I I

| I

| I

I I

: BTS : ~ DIP SWITCH SETTINGS - O—DEj‘

I DATA FORMAT

BAUD RATE

I o ! IONIIIIIII |

: MONITOR I | _-__--_- I

|
| ot : T hehons| ewooe
| | - GPIB ADRS G MODE
CSM "RS232-GPB
: '-gN : INTERFACE BOX
-0
| LﬁN | RS232 NULL
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I 10BASE2 | CABLE

I CONVERTER I

| I

| | CDMA

I | LMF

b - I

UNIVERSAL TWISTED
PAIR (UTP) CABLE
(RJ45 CONNECTORS) INETTEHRENFII\IEI;CCMA%IS

I
I
I
I
I
I
I
I
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| I
| : I
‘ [: 1
I
I
I
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I
INJOUT ~ ONLY I
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I TX CABLE
I TEST
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I o — ——"
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
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I

REF FW00097
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Figure 3-20: IS-95 A/B and CDMA 2000 Optimization/ATP Test Setup Using Directional Coupler

TEST SETS Optimization/ATP SET UP

Advantest R3267 (Top) and R3562 (Bottom) T OTE: I 7S T SONALS A

FROM CSM BOARD

TO EXT TRIG | DUPLEXED: BOTH THE TX AND RX TEST
ON REAR OF | CABLES CONNECT TO THE DUPLEXED
10 MHZ SPECTRUM | ANTENNA GROUP.
REF OUT ANALYZER
— |
=
= ——— ——————
oS | outh ™ GiGNAL GENERATOR
s RFIN | T
: =
= | 100-WATT (MIN) | |
0000 e | ax NON—-RADIATING COMMUNICATIONS TEST SET I
RF LOAD
TEST
BNG : CA%LE ‘ ) EXT g\E/(EJgND/ |
‘ ‘ REF
° EXT TRIG IN ED ™ : o SYNG IN |
—- ° .
o MOD TIME BASE IN A | ‘ - Lid I]—
SYNTHE (EXT REF IN) IEEE 488
REF IN ° RF OUT | L0 1 __lerBBUS|
| |
| 30 DB L=
| DIRECTIONAL
| COUPLER
FREQ MONITOR SYNC MONITOR
19.6608 MHZ CLOCK EVEN SEC TICK |
REFERENCE FROM PULSE REFERENCE | 10 DB PAD
CSM BOARD FROM CSM BOARD
NOTE: |
SYNTHE REF IN ON REAR OF SIGNAL GENERATOR IS | BNC GPIB
CONNECTED TO 10 MHZ REF OUT ON REAR OF | T CABLE
SPECTRUM ANALYZER. | PE<ST
S CABLE v
Agilent E4432B (Top) and E4406A (Bottom) |
(P A
1
| RX ANTENNA TX ANTENNA I
| PORT PORT I
OUTPUT | | |
: | |
DIP SWITCH SETTINGS - — —
| | BTS | - DIP SWITCH S GS oD |
| 106608 | | DATA FORMAT | |
| iz | | ewoparE |
FREQ CLOCK | ON °
| I MONITOR = | - mm .
| | ‘ ) m || - |
N MONITOR | AN |
| | | ! GPIB ADRS G MODE,
| | CSM | - RS232-GPIB_
| | INTERFACE BOX
TO TRIGGER IN LAN
ON REAR OF EXT REF IN | l B l
TRANSMITTER ON REAR OF | =g=] | RS232 NULL
TESTER TRANSMITTER | | LAN | MODEM
TO PATTERN TRIG IN TESTER | A CABLE
ON REAR OF SIGNAL | 10BASET/ |
y |
) | CDMA
JE— | )
T -
FREQ MONITOR | —
e TR 19.6608 MHZ CLOCK | UNIVERSAL TWISTED
ey TR
\

REF FW00758
NOTE:

FOR MANUAL TESTING, GPIB MUST BE CONNECTED
BETWEEN THE ANALYZER AND THE SIGNAL
GENERATOR
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TX ATP Setup

fjigure 3-21 shows a typical TX ATP setup andigure 3-22 shows a
typical RX ATP setup.

Figure 3-21: Typical TX ATP Setup with Directional Coupler (shown with and without RFDS)

TX ANTENNA DIRECTIONAL COUPLERS

COBRA RFDS Detail
RX - O0®O00| .,
TX RF FROM BTS FRAME RFMTX) | || QOOOOJ

% [=OOCOOQ | 0o
(RFMRX) | [[= 000000 I:l

RFDS RX (RFM TX) COUPLER
OUTPUTS TO RFDS FWD(BTS)
———————— ml ASU2 (SHADED) CONNECTORS
RF FEED LINE TO

DIRECTIONAL I

COUPLER I

REMOVED

Connect TX test cable between

the directional coupler input port
and the appropriate TX antenna
directional coupler connector.

Appropriate test sets and the port
names for all model test sets are
described ir‘ljable 3-22.

I
I
I
I
I 40W NON-RADIATING
COMMUNICATIONS I RF LOAD
-

RVS (REFLECTED)
PORT 50-OHM
TERMINATION 30 DB

/) DIRECTIONAL
A

COUPLER

FWD
(INCIDENT)
PORT

OUTPUT
PORT

TEST
DIRECTIONAL
COUPLER

BTS INPUT

/ PORT

TXTEST
CABLE

NOTE:
THIS SETUP APPLIES TO BOTH

STARTER AND EXPANSION FRAMES. - CDMAWP-00124-v01-idoc-ftw
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Figure 3-22: Typical RX ATP Setup with Directional Coupler (shown with or without RFDS)

COBRA RFDS Detail
RX ANTENNA DIRECTIONAL COUPLERS T T
R [|FOOOC00] 4,
RX RF FROM BTS (RFM TX) | [0 000000

FRAME 1

|
|

900008 | . . |
(AFEX) {\ - 000000 1 |

.- _ _

RFDS TX (RFM RX) COUPLER
OUTPUTS TO RFDS FWD(BTS)
ASU1 (SHADED) CONNECTORS

| RF FEED LINE TO-l
% TX ANTENNA |
| REMOVED |

Connect RX test cable between
the test set and the appropriate
RX antenna directional coupler.

Appropriate test sets and the port
names for all model test sets are
described ir‘ljable 3-22.

COMMUNICATIONS
TEST SET

NOTE: FWO00115
THIS SETUP APPLIES TO BOTH

STARTER AND EXPANSION FRAMES.
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Test Set Calibration
Test Set Calibration Background

Proper test equipment calibration ensures that the test equipment and
associated test cables do not introduce measurement errors, and that
measurements are correct.

NOTE If the test set being used to interface with the BTS has been
calibrated and maintained as a set, this procedure does not need
to be performed. (Test Set includes LMF terminal,
communications test set, additional test equipment, associated
test cables, and adapters.)

This procedure must be performed prior to beginning the optimization.
Verify all test equipment (including all associated test cables and
adapters actually used to interface all test equipment and the BTS) has
been calibrated and maintained as a set.

CAUTION If any piece of test equipment, test cable, or RF adapter, that
makes up the calibrated test equipment set, has been replaced,
re-calibration must be performed. Failure to do so can introduce
measurement errors, resulting in incorrect measurements and
degradation to system performance.

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment after it has been
allowed to warm—up and stabilize for a minimum of 60 minutes.

Calibration Procedures Included

Automatic

Procedures included in this section use the LMF automated calibration
routine to determine path losses of the supported communications
analyzer, power meter, associated test cables, adapters, and (if used)
antenna switch that make up the overall calibrated test equipment set.
After calibration, the gain/loss offset values are stored in a test
measurement offset file on the LMF computer.

Manual

Agilent E4406A Transmitter Tester — The E4406A does not support
the power level zeroing calibration performed by the LMF. If this
instrument is to be used for Bay Level Offset calibration and calibration
is attempted with the LMF Calibrate Test Equipment function, the
LMF will return a status window failure message stating that zeroing
power is not supported by the E4406A. Refer to the Equipment
Calibration section of AppendixT for instructions on using the
instrument’s self-alignment (calibration) function prior to performing
Bay Level Offset calibration.

Power Meters — Manual power meter calibration procedures to be
performed prior to automated calibration are included in the Equipment
Calibration section of AppendixF.
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GPIB Addresses

IP Addresses

Selecting Test Equipment

Cable Calibration — Manual cable calibration procedures using the HP
8921A and Advantest R3465 communications system analyzers are
provided in the Manual Cable Calibration section of AppendixH, if
needed.

GPIB addresses can range from 1 through 30. The LMF will accept any
address in that range, but the numbers entered in the LMF Options
window GPIB address box must match the addresses of the test
equipment. Motorola recommends using 1 for a CDMA signal generator,
13 for a power meter, and 18 for a communications system analyzer. To
verify and, if necessary, change the GPIB addresses of the test
equipment, refer to the Setting GPIB Addresses section of Appendix.

For the Agilent E7495A Communications Test Set, set the IP address
and complete initial setup as described in Appendix g (Specifically, see

[Jable F-1 on pagqH-3).

Use LMF Options from the Options menu list to select test equipment
automatically (using the autodetect feature) or manually.

Serial Connection and Network Connection tabs are provided in the
LMF Options window to specity the test equipment connection method.
The Serial Connection tab is used when the test equipment items are
connected directly to the LMF computer through a GPIB box (normal
setup). The Network Connection tab is used when the test equipment is
to be connected remotely via a network connection or the Agilent
E7495A Communications Test Set is used.

Prerequisites
Ensure the following prerequisites have been met before proceeding:
¢ Test equipment is correctly connected and turned on.

¢ GPIB addresses set in the test equipment have been verified as correct
using the applicable procedures in Appendixd. (GPIB not applicable
with Agilent E7495A)

* CDMA LMF computer serial port and test equipment are connected to
the GPIB box.

Selecting Test Equipment

Test equipment may be selected either manually with operator input or
automatically using the LMF autodetect feature.

Manually Selecting Test Equipment in a Serial Connection Tab —
Test equipment can be manually specified before, or after, the test
equipment is connected. The LMF does not check to see if the test
equipment is actually detected for manual specification. Follow the
procedure iirJable 3-24 to select test equipment manually.
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Table 3-24: Selecting Test Equipment Manually in a Serial Connection Tab

»~| Step

Action

From the Tools menu, select Options.
The LMF Options window appears.

Click on the Serial Connection tab (if not in the forefront).

Select the correct serial port in the COMM Port pick list (normally COML1).

Click on the Manual Specification button (if not enabled).

D AW N

Click on the check box corresponding to the test item(s) to be used.

NOTE

GPIB addresses can range from 1 through 30. The LMF will accept any address in that range, but
the numbers in the GPIB address boxes must match the addresses of the test equipment.
Motorola recommends that you use 1 for a CDMA signal generator, 13 for a power meter, and 18
for a CDMA analyzer. To verify and, if necessary, change the GPIB addresses of the test
equipment, refer to AppendixyT].

Type the GPIB address in the corresponding GPIB address box.

Recommended Addresses

1 = CDMA Signal generator
13 = Power Meter

18 = CDMA Analyzer

Click on Apply. (The button darkens until the selection has been committed.)
NOTE

With manual selection, the LMF does not detect the test equipment to see if it is connected and
communicating with the LMF.

To verify and, if necessary, change the GPIB address of the test equipment, refer to Appendi)ﬁ .

Click on Dismiss to close the test equipment window.

Automatically Selecting Test Equipment in Serial Connection Tab —
When using the auto-detection feature to select test equipment, the LMF
examines which test equipment items are actually communicating with
the LMF. Follow the procedure irpJable 3-25 to use the auto-detect
feature.

Table 3-25: Selecting Test Equipment Using Auto-Detect

»~| Step

Action

From the Tools menu, select Options.
The LMF Options window appears.

Click on the Serial Connection tab (if not in the forefront).

Select the correct serial port in the COMM Port pick list (normally COML1).

Click on Auto—Detection (if not enabled).

... continued on next page
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[Table 3-25: Selecting Test Equipment Using Auto-Detect

Step

Action

NOTE

GPIB addresses can range from 1 through 30. The LMF will accept any address in that range, but
the numbers in the GPIB address to search box must match the addresses of the test equipment.
Motorola recommends that you use 1 for a CDMA signal generator, 13 for a power meter, and 18
for a CDMA analyzer. To verify and, if necessary, change the GPIB addresses of the test
equipment, refer to AppendixyT].

Type the GPIB addresses in the box labeled GPIB address to search (if not already displayed).
NOTE

When both a power meter and an analyzer are selected, the LMF uses the first item that is capable
of peforming the test and is listed in the GPIB addresses to search box for RF power
measurements (i.e., TX calibration). The address for a CDMA signal generator is normally 1, the
address for a power meter is normally 13, and the address for a CDMA analyzer is normally 18. If
1,13,18 is included in the GPIB addresses to search box, the power meter (13) is used for RF
power measurements. When the test equipment items are manually selected, the CDMA analyzer
is used only if a power meter is not selected.

Click on Apply.
NOTE

The button darkens until the selection has been committed. A check mark appears in the Manual
Configuration section for detected test equipment items.

Click Dismiss to close the LMF Options window.

Detecting Test Equipment when using Agilent E7495A

Check that no other equipment is connected to the LMF. Agilent
E7495A equipment must be connected to the LAN to detect it. Then
perform the procedures described in Appendi)ﬁ (Specifically, see

[Jable F-1 on pagqH-3,Fable F-2, andjable F-3 on pagqH -4).
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Calibrating Test Equipment

The calibrate test equipment function zeros the power measurement level
of the test equipment item that is to be used for TX calibration and audit.
If both a power meter and an analyzer are connected, only the power
meter is zeroed.

NOTE The Agilent E4406A transmitter tester does not support power
measurement level zeroing. Refer to the Equipment Calibration
section of Appendix F for E4406A calibration.

Prerequisites

* LMF computer serial port and test equipment are connected to the
GPIB box.

* Test equipment to be calibrated has been connected correctly for tests
that are to be run.

* Test equipment has been selected in the LMF ﬂable 3-24 or
[Jable 3-25).

Calibrating test equipment

Follow the procedure iqj"able 3-26 to calibrate the test equipment.

Table 3-26: Test Equipment Calibration

v~ Step Action

1 From the Util menu, select Calibrate Test Equipment
from the pull-down menu. A Directions window is

displayed.

2 Follow the directions provided.

3 Click on Continue to close the Directions window and
start the calibration process. A status report window is
displayed.

4 Click on OK to close the status report window.
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Calibrating Cables Overview

The cable calibration function measures the loss (in dB) for the TX and
RX cables that are to be used for testing. A CDMA analyzer is used to
measure the loss of each cable configuration (TX cable configuration and
RX cable configuration). The cable calibration consists of the following:

* Measuring the loss of a short cable — This is required to compensate
for any measurement error of the analyzer. The short cable (used only
for the calibration process) is used in series with both the TX and RX
cable configuration when measuring. The measured loss of the short
cable is deducted from the measured loss of the TX and RX cable
configuration to determine the actual loss of the TX and RX cable
configurations. The result is then adjusted out of both the TX and RX
measurements to compensate for the measured loss.

* Measuring the short cable plus the RX cable configuration loss —
The RX cable configuration normally consists only of a coax cable
with type-N connectors that is long enough to reach from the BTS RX
port of the test equipment.

* Measuring the short cable plus the TX cable configuration loss —
The TX cable configuration normally consists of two coax cables with
type-N connectors and a directional coupler, a load, and an additional
attenuator (if required by the specified BTS). The total loss of the path
loss of the TX cable configuration must be as required for the BTS
(normally 30 or 50 dB).
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Calibrate Test Cabling using Communications System Analyzer

Cable Calibration is used to calibrate both TX and RX test cables.
Appendix covers the procedures for manual cable calibration.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

¢ LMF computer serial port and test equipment are connected to the
GPIB box.

¢ Test equipment is turned on and has warmed up for at least 60
minutes.

* Test equipment has been selected in the LMF ﬂable 3-24 or
[Jable 3-25)

Calibrating cables

Refer tqfigure 3-12 oﬂigure 3-13 and follow the procedure in
|j"able 3-27 to calibrate the test cable configurations.

Table 3-27: Cable Calibration
v~ Step Action

1 From the Util menu, select Cable Calibration. A Cable
Calibration window is displayed.

2 Enter a channel number(s) in the Channels box.

NOTE

Multiple channels numbers must be separated with a
comma, no space (i.e.; 200,800). When two or more
channels numbers are entered, the cables are calibrated for
each channel. Interpolation is accomplished for other
channels as required for TX calibration.

3 Select TX and RX Cable Cal, TX Cable Cal, or RX
Cable Cal in the Cable Calibration pick list.

4 Click OK. Follow the direction displayed for each step. A
status report window displays the results of the cable
calibration.
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Calibrate Test Cabling Using Signal Generator & Spectrum Analyzer

Follow the procedure irﬂ“ able 3-28 to calibrate the TX/Duplexed RX
cables using a signal generator and spectrum analyzer. Refer to

igure 3-23, if required. Follow the procedure irpJable 3-29 to calibrate
the Non—Duplexed RX cables using the signal generator and spectrum
analyzer. Refer tq¥jigure 3-24, if required.

TX and Duplexed RX Cable Calibration

Table 3-28: Calibrating TX/Duplexed RX Cables Using Signal Generator and Spectrum Analyzer

v~ Step Action

1 Connect a short test cable between the spectrum analyzer and the signal generator.

2 Set signal generator to 0 dBm at the customer frequency of 869-894 MHz.

3 Use a spectrum analyzer to measure signal generator output (seqjigure 3-23, A) and record the
value.

4 Connect the spectrum analyzer’s short cable to point B, (as shown in the lower right portion of the
diagram) to measure cable output at customer frequency of 869—894 MHz. Record the value at
point B.

5 Calibration factor = A — B. Example: ~ Cal = -1 dBm — (-53.5 dBm) = 52.5 dB
NOTE

The short cable is used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the equipment setup, as is, to ensure test procedures
use the correct calibration factor.

Figure 3-23: Calibrating Test Equipment Setup for TX BLO and TX ATP Tests
(using Signal Generator and Spectrum Analyzer)

Signal e
Generator e
Spectrum e
Analyzer ~
SHORT e
TEST
caBle 40W NON-RADIATING
e RF LOAD THIS WILL BE THE CONNECTION TO
s THE TX PORTS DURING TX BAY LEVEL
OFFSET TEST AND TX ATP TESTS.

50 OHM

Signal
Generator

Spectrum
Analyzer

ONE 20DB 20 W IN
LINE ATTENUATOR

SHORT TEST CABLE

(G
THIS WILL BE THE CONNECTION TO THE HP8481A POWER / \
SENSOR DURING TX BAY LEVEL OFFSET TEST AND TO THE B CABLE FROM 20 DB @ 20W ATTENUATOR TO THE
PCS INTERFACE BOX INPUT PORT DURING TX ATP TESTS. PCS INTERFACE OR THE HP8481A POWER SENSOR.

FW00293
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Non-Duplexed RX Cable Calibration

Table 3-29: Calibrating RX Cables Using a Signal Generator and Spectrum Analyzer

v~ Step Action

1 Connect a short test cable to the spectrum analyzer and connect the other end to the Signal
Generator.

2 Set signal generator to —10 dBm at the customer’s RX frequency of 824-849 MHz.

3 Use spectrum analyzer to measure signal generator output (seqijigure 3-24, A) and record the
value for A.

4 Connect the test setup, as shown in the lower portion of the diagram to measure the output at the
customer’s RX frequency of 824-849 MHz. Record the value at point B.

5 Calibration factor = A — B. Example: ~ Cal = -12 dBm — (14 dBm) = 2 dBm
NOTE

The short cable is used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the equipment setup, as is, to ensure test procedures
use the correct calibration factor.

-l

Figure 3-24: Calibrating Test Equipment Setup for RX ATP Test
(using Signal Generator and Spectrum Analyzer)

Signal

Generator P
Signal
Spectrum -~ Generator
Analyzer ~
e
e
P
e
SHORT
A T -
CABLE ~
P CONNECTION TO THE HP PCS
INTERFACE OUTPUT PORT
~ DURING RX MEASUREMENTS.

Spectrum
Analyzer

SHORT TEST
CABLE

e BULLET
S CONNECTOR
T CABLE 2
CONNECTION TO THE RX PORTS
DURING RX MEASUREMENTS. FW00294
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Setting Cable Loss Values

Cable loss values for the TX and RX test cable configurations are
normally set by accomplishing cable calibration using the applicable test
equipment. The resulting values are stored in the cable loss files. The
cable loss values can also be set/changed manually. Follow the procedure
iJable 3-30 to set cable loss values.

CAUTION If cable calibration was performed without using the LMF, cable
loss values must be manually entered in the LMF database.
Failure to do this will result in inaccurate BTS calibration and
reduced site performance.

Prerequisites
* Logged into the BTS

Table 3-30: Setting Cable Loss Values

| Step

Action

Click on the Util menu.

Select Edit>Cable Loss.

In the data entry pop—up window, select TX Cable Loss or RX Cable Loss.

A~ W

To add a new channel number, click on the Add Row button, then click in the Channel # and
Loss (dBm) columns and enter the desired values.

To edit existing values, click in the data box to be changed and change the value.

To delete a row, click on the row and then click on the Delete Row button.

To save displayed values, click on the Save button.

(e <IN I o NV

To exit the window, click on the Dismiss button.
Values entered/changed after the Save button was used are not saved.

NOTE

* If cable loss values exist for two different channels, the LMF will interpolate for all other
channels.

¢ Entered values are used by the LMF as soon as they are saved. You do not have to logout and
login.
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Setting Coupler Loss Values

If an in—service coupler is installed, the coupler loss (e.g., 30 dB) must

be manually entered so it will be included in the LMF TX calibration

and audit calculations and RX FER Test. Follow the procedure in
[Jable 3-31 to set coupler loss values.

Prerequisites
* Logged into the BTS.

Table 3-31: Setting Coupler Loss Value

| Step

Action

1

Click on the Util menu.

2

Select Edit>Coupler Loss.

3

In the data entry pop—up window, select TX Coupler
Loss or RX Coupler Loss.

Click in the Loss (dBm) column for each carrier that has
a coupler and enter the appropriate value.

To edit existing values click in the data box to be changed
and change the value.

Click on the Save button to save displayed values.

Click on the Dismiss button to exit the window.

Values entered/changed after the Save button was used
are not saved.

NOTE

* The In-Service Calibration check box in the
Tools>Options>BTS Options tab must checked before
entered coupler loss values are used by the TX
calibration and audit functions or RX FER test.

* Entered values are used by the LMF as soon as they are
saved. You do not have to logout and login.
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Bay Level Offset Calibration

Introduction

Bay Level Offset (BLO) calibration is the central activity of the
optimization process. BLO calibration compensates for normal
equipment variations within the BTS RF paths and assures the correct
transmit power is available at the BTS antenna connectors to meet site
performance requirements.

RF Path Bay Level Offset Calibration

When to Calibrate BLOs

Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in a BLO database calibration
table in the LMF. The BLOs are subsequently downloaded to each BBX.

For starter frames, each receive path starts at a BTS RX antenna port and
terminates at a backplane BBX slot. Each transmit path starts at a BBX
backplane slot, travels through the Power Amplifier (PA), and terminates
at a BTS TX antenna port.

For expansion frames each receive path starts at the BTS RX port of the
cell site starter frame, travels through the frame-to-frame expansion
cable, and terminates at a backplane BBX slot of the expansion frame.
The transmit path starts at a BBX backplane slot of the expansion frame,
travels though the PA, and terminates at a BTS TX antenna port of the
same expansion frame.

Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in a BLO database. Each
transmit path starts at a C—CCP shelf backplane BBX slot, travels
through the PA, and ends at a BTS TX antenna port. When the TX path
calibration is performed, the RX path BLO is automatically set to the
default value.

At omni sites, BBX slots 1 and 13 (redundant) are tested. At sector sites,
BBX slots 1 through 12, and 13 (redundant) are tested. Only those slots
(sectors) actually equipped in the current CDF are tested, regardless of
physical BBX board installation in the slot.

Calibration of BLOs is required:
¢ After initial BTS installation
* Once each year
* After replacing any of the following components or associated
interconnecting RF cabling:
— BBX board
— C-CCP shelf
MCIO card
MCIO to Power Amplifier backplane RF cable
Parallel Linear Amplifier Combiner
Power Amplifier
TX filter
Enhanced Trunking Module (ETM)
TX thru-port cable to the top of frame
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TX Path Calibration

The TX Path Calibration assures correct site installation, cabling, and the
first order functionality of all installed equipment. The proper function
of each RF path is verified during calibration. The external test
equipment is used to validate/calibrate the TX paths of the BTS.

WARNING Before installing any test equipment directly to any TX OUT

connector you must first verify that there are no CDMA
channels keyed. Have the OMC-R place the sector assigned to
the PA under test OOS. Failure to do so can result in serious
personal injury and/or equipment damage.

CAUTION Always wear a conductive, high impedance wrist strap while

handling any circuit card/module. If this is not done, there is a
high probability that the card/module could be damaged by ESD.

NOTE

At new site installations, to facilitate the complete test of each
CCP shelf (if the shelf is not already fully populated with BBX
boards), move BBX boards from shelves currently not under test
and install them into the empty BBX slots of the shelf currently
being tested to insure that all BBX TX paths are tested.

— This procedure can be bypassed on operational sites that are
due for periodic optimization.

— Prior to testing, view the CDF file to verify the correct
BBX slots are equipped. Edit the file as required to include
BBX slots not currently equipped (per Systems
Engineering documentation).

BLO Calibration Data File

During the calibration process, the LMF creates a bts—#.cal calibration
(BLO) offset data file in the bts—# folder. After calibration has been
completed, this offset data must be downloaded to the BBXs using the
Download BLO function. An explanation of the file is shown below.

NOTE

Due to the size of the file, Motorola recommends that you print
out a hard copy of a bts.cal file and refer to it for the following
descriptions.

The CAL file is subdivided into sections organized on a per slot basis (a
slot Block).

Slot 1 contains the calibration data for the 12 BBX slots. Slot 20
contains the calibration data for the redundant BBX. Each BBX slot
header block contains:

* A creation Date and Time — broken down into separate parameters of
createMonth, createDay, createYear, createHour, and createMin.

* The number of calibration entries — fixed at 720 entries corresponding
to 360 calibration points of the CAL file including the slot header and
actual calibration data.
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* The calibration data for a BBX is organized as a large flat array. The
array is organized by branch, sector, and calibration point.

— The first breakdown of the array indicates which branch the
contained calibration points are for. The array covers transmit, main
receive and diversity receive offsets as follows:

Table 3-32: BLO BTS.cal File Array Assignments

Range Assignment
C[1]-CJ240] Transmit
C[241]-C[480] Main Receive
C[481]-C[720] Diversity Receive

— The second breakdown of the array is per sector. Configurations
supported are Omni, 3—sector or 6—sector.

Table 3-33: BTS.cal File Array (Per Sector)

BBX ‘ Sectorization ‘ TX ‘ RX ‘ RX Diversity
Slot[1] (Primary BBXs 1 through 12)

1 (Omni) 3 Sector, | CLL-CI20] C[241]-C[260] | C[481]-C[500]
2 1st C[21]-C[40] C[261]-C[280] | C[501]-C[520]
3 6 Slecttors Carrier | Cr411-C[60] C[281]-C[300] | C[521]-C[540]
4 Carsrier 3 Sector, | CLO11-CI80] C[301]-C[320] | C[541]-C[560]
5 3rd C[81]-C[100] C[321]-C[340] | C[561]-C[580]
6 Carrier | C[101]-C[120] | C[341]-C[360] | C[581]-C[600]
7 3-Sector, | CII21-CI140] | C[361]-C[380] | C[601]-C[620]
8 2nd C[141]-C[160] | C[381]-C[400] | C[621]-C[640]
9 6 Séeliiéora Carrier [ (C[161]-C[180] | C[401]-C[420] | C[641]-C[660]
10 Carrier | 3-Sector, | CII811-C[200] | C[421]-C[440] | C[661]-C[680]
11 4th C[201]-C[220] | C[441]-C[460] | C[681]-C[700]
12 Carrier [ c12211-C[240] C[461]-C[480] | C[701]-C[720]

... continued on next page
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Table 3-33: BTS.cal File Array (Per Sector)
BBX Sectorization TX RX RX Diversity
Slot[20] (Redundant BBX-13)

1 (Omni) 3 Sector, | CLL-CI20] C[241]-C[260] | C[481]-C[500]
2 1st C[21]-C[40] C[261]-C[280] | C[501]-C[520]

3 6 Slectton Carrier | cr411-C[60] C[281]-C[300] | C[521]-C[540]
4 Carsﬂer 3 Sector, | CL611-CI80] C[301]-C[320] | C[541]-C[560]

5 3rd C[81]-C[100] C[321]-C[340] | C[561]-C[580]

6 Carrier | C[101]-C[120] | C[341]-C[360] | C[581]-C[600]

7 3 Sector, | CLI211-C[140] | C[361]-C[380] | C[601]-C[620]

8 2nd C[141]-C[160] | C[381]-C[400] | C[621]-C[640]

9 6 Sector, | Carrier [ cr1611-C[180] C[401]-C[420] | C[641]-C[660]
10 Cﬁfr‘i‘er 3 Sector, | CIISU-CI200] | C[421]-C[440] | C[661}-C[680]
11 4th C[201]-C[220] | C[441]-C[460] | C[681]-C[700]
12 Carrier | C[221]-C[240] | C[461]-C[480] | C[701]-C[720]

* Ten calibration points per sector are supported for each branch. Two
entries are required for each calibration point.

* The first value (all odd entries) refer to the CDMA channel
(frequency) where the BLO is measured. The second value (all even
entries) is the power set level. The valid range for PwrLvlAdj is from
2500 to 27500 (2500 corresponds to —125 dBm and 27500
corresponds to +125 dBm).

* The 20 calibration entries for each sector/branch combination must be
stored in order of increasing frequency. If less than 10 points
(frequencies) are calibrated, the largest frequency that is calibrated is
repeated to fill out the 10 points.

Example:
C[1]=384, odd cal entry
= 1 “calibration point”
C[2]=19102, even cal entry
C[3]=777,
C[4]=19086,

C[19]=777,
C[20]=19086, (since only two cal points were calibrated this
would be repeated for the next 8 points)

* When the BBX is loaded with data, the cal file data for the BBX is
downloaded to the device in the order it is stored in the cal file. TxCal
data is sent first, C[1] — C[240]. Sector 1’s ten calibration points are
sent (C[1] — C[20]) followed by sector 2’s ten calibration points
(C[21] - C[40])), etc. The RxCal data is sent next (C[241] — C[480]),
followed by the RxDCal data (C[481] — C[720]).

* Temperature compensation data is also stored in the cal file for each
set.
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Test Equipment Set-up for RF Path Calibration

Follow the procedure iqj"able 3-34 to set up test equipment.

Table 3-34: Test Equipment Setup (RF Path Calibration)

»~| Step

Action

Verify the GPIB controller is properly connected and turned on.

! CAUTION

To prevent damage to the test equipment, all transmit (TX) test connections must
be via the 30 dB directional coupler.

Connect the LMF computer terminal to the BTS LAN A connector on the BTS (if
you have not already done so). Refer to the procedure in Table 3-2 on pagg3-16.

* If required, calibrate the test equipment per the procedure irrFable 3-26 on page

[3-69.

¢ Connect the test equipment as shown il]jigure 3-14 on pagq3-56.

Transmit (TX) Path Calibration Description

The assigned channel frequency and power level (as measured at the top
of the frame) for transmit calibration are derived from the site CDF files.
For each BBX, the channel frequency is specified in the [ CdmaChans ]
in the cbsc—#.cdf file and the power is specified in the SIFPilotPwr
CDF file parameter for the sector associated with the BBX (located
under the ParentSECTOR field of the ParentCARRIER CDF file
parameter).

NOTE

If both the BTS—#.cdf and CBSC—#.cdf files are current, all
information will be correct on the LMF. If not, the carrier and
channel will have to be set for each test.

The calibration procedure attempts to adjust the power to within +0.5
dB of the desired power. The calibration will pass if the error is less than
+1.5 dB.

The TX Bay Level Offset is approximately 40dB +5 dB for 3 Sector
BTS and 43dB +5dB for 6 Sector BTS.

3-80

1X SC 4812T-MC Multicarrier BTS Optimization/ATP Sept 2003




68P64115A21-B Bay Level Offset Calibration

TX Calibration and the LMF

The LMF Tests > TX > TX Calibration... and Tests > All Cal/Audit...
selections perform TX BLO calibration testing for installed BBX(s). The
All Cal/Audit... selection initiates a series of actions to perform TX
calibration, and if calibration is successful, download BLO and perform
TX audit. The TX Calibration... selection performs only TX
calibration. When TX Calibration... is used, BLO download and TX
audit must be performed as separate activities. The CDMA Test
Parameters window which opens when TX Calibration... or All
Cal/Audit... is selected contains several user—selectable features which
are described in the following subsections.

Rate Set Drop-down Pick List

The Rate Set Drop—down Box is enabled if at least one MCC card is
selected for the test. The available options for TX tests are 1 = 9600, and
3 = 9600 1X. Option 3 is only available if 1X cards are selected for the
test. The available transfer rate options for RX tests are 1 = 9600 and

2 = 14400. Option 2 is only available if no 1X cards are selected.

Verify BLO

In both the TX Calibration and All Cal/Audit dialog boxes, a Verify
BLO checkbox is provided and checked by default. After the actual TX
calibration is completed during either the TX Calibration or All
Cal/Audit process, the BLO derived from the calibration is compared to
a standard, acceptable BLO tolerance for the BTS. In some installations,
additional items may be installed in the transmit path. The additional
change in gain from these items could cause BLO verification failure
and, therefore, failure of the entire calibration. In these cases, either the
Verify BLO checkbox should be unchecked or the additional path losses
should be added into each applicable sector using the

Util>Edit>TX Coupler Loss... function.

Single-sided BLO Checkbox

Another option that appears in the pull-down menu is Single-sided
BLO. Normally valid BLO values are some value plus—or—minus some
offset. The ranges that we currently use for calibration are wider than
necessary to accommodate the redundant BBX. The lower half of that
range is where non—-redundant BBXs should be. Single-sided BLO spec
is >35dB. Double-sided BLO spec is 40+5dB. To get the more
stringent conditions, the operator checks Single-sided BLO when
calibrating non-redundant transceivers. Single-sided BLO carries the
likelihood of more failures. This option should only be used by
experienced CFEs.
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Test Pattern Drop-down Pick List

The Tests > TX > TX Calibration... menu window has a Test Pattern
pull-down menu. This menu has the following choices:

TX Calibration

Pilot (default) — performs tests using a pilot signal only. This pattern
should be used when running in—service tests. It only requires a BBX
to do the test.

Standard — performs the tests using pilot, synch, paging and six
traffic channels. This pattern should be used on all non—in—service
tests. Standard requires a BBX and an MCC. Standard uses gain
values specified by the IS97 standard.

CDFPilot —performs the tests using the pilot signal, however, the gain
is specified in the CDF file. Advanced users may use CDFPilot to
generate a Pilot pattern using the value specified by the PilotGain
parameter in the CDF file instead of a pre—determined value.

CDF - performs the tests using pilot, synch, paging and six traffic
channels, however, the gain for the channel elements is specified in
the CDF file. Advanced users may use CDF to generate a standard
pattern. Instead of using the values specified by IS97, the settings for
the following CDF parameters are used:

— PilotGain
— PchGain
— SchGain
— NomGainlWay

WARNING

Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

CAUTION

Always wear an approved anti—static wrist strap while handling
any circuit card or module. If this is not done, there is a high
probability that the card or module could be damaged by ESD.
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TX BLO Calibration for Multicarrier BTS

Overview

Set-up for TX Calibration

LMF software release described on pagg3-9 may be used to calibrate the
Multicarrier trunked BTS running R2.16.0.x or R2.16.1.x circuit
software. These unique procedures are necessary due to the fact that the
SC4812T-MC requires all equipped PAs to be enabled during TX
testing.

TX BLO is obtained with BBXs-under-test having pilot gain set at 262
LSB, while BBXs-not-under—test are keyed at low transmit power
(recommended pilot gain of 127 LSB and XCVR Power Gain set of —25
dBm).

The following procedure assumes that the SC4812T-MC frame is
equipped with 4 carriers and all modules have appropriate software
downloaded. The tasks required are:

¢ Set-up for TX Calibration

¢ TX Calibration

* Download TX BLO Data

¢ Copy TX BLO data for CBSC/OMCR

Table 3-35: Initial Set-up for Multicarrier TX Calibration

| Step

Action

1

Delete the existing calibration file (if any) from the BTS folder on LMF
laptop from the location C:\wlmf\cdma\bts—#, where # is the BTS
number.

Edit the nominal TX BLO
— From the Util menu, select Edit > TX Nominal Offset.
— Change the value from 45.0 to 40.0 (dB) for 3 sector
— Change the value from 45.0 to 43.0 (dB) for 6 sector

Download the data, which includes BLO values, to all the BBXs. From the De-
vice menu, select Download > Data

NOTE

Terminate all sector outputs on the frame, since more than one sectors will
be keyed during the calibration procedure.
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TX Calibration
Follow the procedures ifpJable 3-36 to perform TX Calibration. Be sure
to follow the primary If performing TX Calibration option in Steg3a.
Table 3-36: Procedure for TX Calibration and TX Audit
y~| Step Action
NOTE

The following commands will key selected BBXs to a power level that is low enough to not cause
interference when calibrating using a power meter.

1 Select the following GUI options to key the carriers which are not under test to a low pilot level.
la — From the table, select a group of BBXs to key to a low level during test for the carrier and
BBXs to be tested:
3 Sector
Carrier BBXs Under Test BBXs to low-level key during test
1 1,2,3 5,7,12
2 7,8,9 1,5,12
3 4,5,6 1,8,12
4 10,11,12 1,6,8
6 Sector
1 1,2,3,4,5,6 7,12
2 7,8,9,10,11,12 1,6
1b — From the Device menu, select BBX > Set Pilot Gain.
1c — Enter pilot gain value of 127 (LSB).
1d — Select the carrier’s BBXs.
le — From the Device menu, select BBX > Key.
1f — Enter XCVR gain value of —25 (dBm) with the TX BLO box unchecked.
1g — Click on the carrier’s BBXs and BBXR if equipped.
NOTE
The 4th carrier (BBX10-12) is not supported in a converted SC 4812T MC BTS at this time. An
upcoming feature release will address 4th carrier support.
2 With BBXs still selected as described in Stegig, proceed as follows:
2a — If performing TX Calibration: Click Tests in the BTS menu bar, and select TX > TX
Calibration from the pull-down menus.
— If performing TX Audit: Click Tests in the BTS menu bar, and select TX > TX Audit from
the pull-down menus.
2b — Select the carrier’s channel number from those displayed in the Channels/Carrier pick list.
2c — Select test to perform as TX Cal.
2d — Uncheck the Verify TX BLO box.
2e — Enter the selected carrier’s XCVR gain value of 40 (dBm).
2f — In the Test Pattern box, select the test pattern to use as Pilot.

The LMF will automatically key the designated BBX and ask the operator to move the test
equipment cable to appropriate TX path.

.. . continued on next page
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ﬂ‘able 3-36: Procedure for TX Calibration and TX Audit

| Step Action

3 Download BLO to all the calibrated BBXs. (Seqable 3-37 for details).
Save the carrier’s TX BLO calibration results.

4 Reset the carrier pilot gain to 262 (from 127 LSB) by selecting the following GUI options:

4a — Select same BBXs selected in Steq:]la.
4b — From the Device menu, select BBX > Set Pilot Gain.
4c — Enter pilot gain value of 262 (LSB).

Download TX BLO Data

Select all BBXSs including the BBXR. From the Device menu, select
BBX >Download >BLO.

Copy TX BLO data for CBSC/OMCR
Follow the procedure described in Create Cal file (seqFable 3-38).
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TX Calibration Audit

Introduction

NOTE

RF path verification, BLO calibration, and BLO data download
to BBXs must have been successfully completed prior to
performing the calibration audit.

The BLO calibration audit procedure confirms the successful generation
and storage of the BLO calibration offsets. The calibration audit
procedure measures the path gain or loss of every BBX transmit path at
the site. In this test, actual system tolerances are used to determine the
success or failure of a test. The same external test equipment set up is
used.

WARNING Before installing any test equipment directly to any TX OUT

connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

The Tests menu item, TX Audit, performs the TX BLO Audit test for a
BBX(s). All measurements are made through the appropriate TX output
connector using the calibrated TX cable setup.

Prerequisites

Before running this test, ensure that the following have been done:

NOTE

Only one carrier can be tested at a time. All PAs must be INS
during testing. For the carriers not under test, key one BBX per
carrier to a minimum power level. (Refer tqfable 3-36).

CSM-1, GLIs, and BBXs have correct code load and data load.
Primary CSM and MGLI are INS.
All BBXs are OOS_RAM.

* Test equipment and test cables are calibrated and connected for TX
BLO calibration.

LMF is logged into the BTS.

Test Procedure

Connect the test equipment as shown irFigure 3-14 orfjigure 3-15.
Follow the procedure iJable 3-36 using the If performing TX Audit
alternate Steg3a to perform the BTS TX Path Audit test.

3-86

1X SC 4812T-MC Multicarrier BTS Optimization/ATP Sept 2003




68P64115A21-B

TX Calibration Audit

Download BLO Procedure

After a successful TX path calibration, download the BLO calibration
file data to the BBXs. BLO data is extracted from the CAL file for the
BTS and downloaded to the selected BBX devices.

NOTE

If a successful All Cal/Audit was completed, this procedure
does not need to be performed, as BLO is downloaded as part of
the All Cal/Audit.

Prerequisites

Ensure the following prerequisites have been met before proceeding:
* BBXs being downloaded are OOS—-RAM (yellow).

® TX calibration is successfully completed.

Test Procedure

Follow the procedure iqj"able 3-37 to download the BLO data to the
BBXs.

Table 3-37: Download BLO

v~ Step Action

1 Select the BBX(s) to be downloaded.

2 Click Device in the BTS menu bar, and select Download
> BLO from the pull-down menus. A status report
window displays the result of the download.

NOTE

Selected device(s) do not change color when BLO is
downloaded.

3 Click on OK to close the status report window.
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Create CAL File

The Create Cal File function gets the BLO data from BBXs and
creates/updates the CAL file in the LMF for the BTS. If a CAL file does
not exist, a new one is created. If a CAL file already exists, it is updated.
After a BTS has been fully optimized, a copy of the CAL file must exist
so it can be transferred to the CBSC. If TX calibration has been
successfully performed for all BBXs and BLO data has been
downloaded, a CAL file exists. Note the following:

* Create Cal File function only applies to selected (highlighted) BBXs.

WARNING The user is not encouraged to edit the CAL file as this action can

cause interface problems between the BTS and the LMF. To
manually edit the CAL file, you must first logout of the BTS. If
you manually edit the CAL file and then use the Create Cal File
function, the edited information is lost.

Prerequisites

Before running this test, the following should be done:
* LMF is logged into the BTS.
¢ BBXs are OOS_RAM with BLO downloaded.

Creating a CAL File

Table 3-38: Create CAL File

v~ Step Action

1 Select the applicable BBXs.

NOTE
The CAL file is only updated for the selected BBXs.

Click on the Device menu.

3 Click on the Create Cal File menu item.
A status report window displays the results of the action.

4 Click OK to close the status report window.
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BTS Redundancy/Alarm Testing

Objective

Test Equipment

Redundancy/Alarm Test

This section tests the redundancy options that could be included in the
cell site. These tests verify, under a fault condition, that all modules
equipped with redundancy switch operations to their redundant partner
and resume operation. An example would be to pull the currently active
CSM and verity the standby CSM takes over distribution of the CDMA
reference signal.

Redundancy covers many BTS modules. Confirm the redundant options
included in the BTS, and proceed as required. If the BTS has only basic
power supply redundancy, the tests and procedures detailed in the
following tables should be bypassed.

*Jable 3-41. Miscellancous Alarm Tests (BTS Frame)
*Jable 3-42. BBX Redundancy Tests (BTS Frame)

°|j"able 3-43. CSM, GPS, and HSO Redundancy Alarm Tests
*Jable 3-44. MGLI/GLI Redundancy Test

During redundancy verification of the test, alarms reported by the master
GLI (displayed via the alarm monitor) will also be verified/noted.

The following pieces of test equipment are required to perform this test:
e LMF

e Communications Test Set

Perform each of the following tests to verify BTS redundancy and to
confirm all alarms are received and reported by the BTS equipment. The
procedures should be performed on the following modules/boards:

* Power supply/converter modules in all frames

¢ Distribution shelf modules in the BTS frame

C—CCP shelf modules in the BTS frame (except MCCs)
PA modules in the BTS frame

AMR Customer defined input/output tests

Sept 2003 1X SC 4812T-MC Multicarrier BTS Optimization/ATP 3-89




-l

BTS Redundancy/Alarm Testing

68P64115A21-B

Test Equipment Setup

Follow the procedure iqj"able 3-39 to set up test equipment:

|NOTE

All alarm tests are performed using TX antenna 1

Table 3-39: Test Equipment Setup for Redundancy/Alarm Tests

Step

Action

1

Interface the LMF computer to the BTS LAN A connector on
the BTS frame (refer tqJable 3-5, pagq3-16).

Login to the BTS.

Set up test equipment for TX Calibration at TXOUT1 (see
igure 3-14).
NOTE

If site is not equipped for redundancy, remove all GLI and
BBX boards installed in any redundant slot positions at this
time.

Display the alarm monitor by selecting Util>Alarm Monitor.

Unequip all customer defined AMR alarms reported via the
AMR Alarm connector (A & B) by clicking on MGLI, then
selecting Device>Set Alarm Relays>Unequipped.

NOTE

During configuration of MGLI alarm reporting, spurious
alarms may report. Allow the BTS to stabilize for 10 seconds.
If any alarms are actively being reported after the BTS has
stabilized, determine the cause before proceeding further.
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Power Supply Redundancy

Follow the steps iJable 3-40 to verify redundancy of the power supply
modules. Alarms reported by the master GLI (displayed via the alarm
monitor) are also verified.

Table 3-40: Power Supply/Converter Redundancy (BTS Frame)

Step Action

1 Select the BBX—1 (highlight) and from the pulldown menu select:

Device>BBX/MAWI>Set Redundant Sector>Carrier—#-1-1

Device>BBX/MAWI>Set Pilot Only>Carrier—#-1-1

Device>BBX/MAWI>Set Pilot Gain>Carrier—#-1-1 and Pilot Gain = 262

Select (highlight) BBX—1 and from the pulldown menu select Device>BBX/MAWI>Key.

Set XCVR gain to 40 and enter the correct XCVR channel number.

4 Remove PS—1 from the power distribution shelf (seqfjigure 3-25).

— Observe that an alarm message is reported via the MGLI as displayed on the alarm monitor.

— Verity no other modules went OOS.

5 Re-install PS—1.

Observe the alarm clears on the alarm monitor.
Repeat stepg# anqJ for PS-2 and PS-3.

Verify that all PWR/ALM LEDs are GREEN.
Select BBX-1 and Device>BBX/MAWI>Dekey

Figure 3-25: C-CCP Shelf
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Miscellaneous Alarm/Redundancy Tests

Follow steps iqj"able 3-41 to verify that alarms reported by the master
GLI are displayed via the alarm monitor if a BTS frame module failure
occurs.

Table 3-41: Miscellaneous Alarm Tests

Step Action

1 Select Util>Alarm Monitor to display the alarm monitor window.

2 Perform the following to verify fan module alarms:

® Unseat a fan module (seqHigure 3-26).

® Observe an alarm message was reported via the MGLI (as displayed on the alarm monitor).
® Replace fan module and verify the alarm monitor reports that the alarm clears.

® Repeat for all other fan modules in the BTS frame.

NOTE
Follow Step3 for Starter Frames and Steg# for Expansion Frames.

3 Starter Frames Only: Perform the following to verify MPC module alarms.
® Unseat MPC modules (seqfjigure 3-25) one at a time.
® Observe that an alarm message was reported via the MGLI as displayed on the alarm monitor.

® Replace the MPC modules and verify the alarm monitor reports the alarm clears.

4 Expansion Frames Only: Perform the following to verify EMPC module alarms.
® Unseat EMPC modules (seqfjigure 3-25) one at a time
® Observe that an alarm message was reported via the MGLI as displayed on the alarm monitor.

® Replace the EMPC modules and verify the alarm monitor reports that the alarm clears.

5 If equipped with AMR redundancy, perform the following to verify AMR module redundancy/alarms.
® Unseat AMR 2 (seqfigure 3-25).

® Observe that an alarm message is reported via the MGLI (as displayed on the alarm monitor).

® Repeat Stepg 93 anqJ (starter frame) or Stepg (3 anqd4 (expansion frame).

® Replace the AMR module and verify the alarm monitor reports that the alarm clears.

® Unseat AMR 1; observe alarm message was reported via MGLI (as displayed on the alarm monitor).
® Replace the AMR module and verify the LMF reports the alarm has cleared.

NOTE
All PWR/ALM LEDs should be GREEN at the completion of this test.

Figure 3-26: Fan Modules
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BBX Redundancy
Follow the steps ir¥able 3-42 to verify redundancy of the BBXs in the
C—CCP shelf. Alarms reported by the master GLI (displayed via the
alarm monitor) are also verified. This test can be repeated for additional
sectors at the customer’s discretion.
Table 3-42: BBX Redundancy Alarms
Step Action
A WARNING
Any BBXs enabled will immediately key-up. Before enabling any BBX, always verify that the TX
output assigned to the BBX is terminated into a 50 W non-radiating RF load! Failure to do so could
result in serious personal injury and/or damage to the equipment.
1 Enable the primary, then the redundant BBX assigned to ANT 1 by selecting the BBX and
Device>BBX/MAWI>Key.
2 Observe that primary BBXs key up, and a carrier is present at each respective frequency.
3 Remove the primary BBX.
4 Observe a carrier is still present. The Redundant BBX is now the active BBX for Antenna 1.
5 Replace the primary BBX and reload the BBX with code and data.
6 Re-enable the primary BBX assigned to ANT 1 and observe that a carrier is present at each respective
frequency.
7 Remove the redundant BBX and observe a carrier is still present.
8 The Primary BBX is now the active BBX for ANT 1.
9 Replace the redundant BBX and reload the BBX with code and data.
10 | Re-enable the redundant BBX assigned to ANT 1 and observe that a carrier is present at each
respective frequency:
11 | De-key the Xcvr by selecting Device>BBX/MAWI>Dekey.
12 | Repeat StepgH througlyj1 for additional BBXs/antennas, if equipped.
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CSM, GPS, & HSO Redundancy/Alarm Tests

Follow the procedure irrJable 3-43 to verify the manual redundancy of
the CSM, GPS, and HSO boards. Verification of alarms reported is also
covered.

NOTE DO NOT perform the procedure irjable 3-43, unless the site is
configured with a HSO timebase as a backup for the GPS.

Table 3-43: CSM, GPS, & HSO, Redundancy/Alarm Tests

Step

Action

A WARNING

Any BBXs enabled will immediately key-up. Before enabling any BBX, always verify that the TX
output assigned to the BBX is terminated into a 50 W non-radiating RF load! Failure to do so could
result in serious personal injury and/or damage to the equipment.

Enable the primary, then the redundant BBXs assigned to ANT 1 by selecting the BBX and
Device>BBX/MAWI>Key.

Disconnect the GPS antenna cable, located on top of the BTS frame. This forces the HSO board
timebase to become the CDMA timing source.

Observe a CDMA timing reference alarm and source change is reported by the alarm monitor.

Allow the HSO to become the active timing source.

® Verify the BBXs remain keyed and INS.

* Verify no other modules went OOS due to the transfer to HSO reference.

* Observe the PWR/ALM LEDs on the CSM 1 front panel are steady GREEN.

Reconnect the GPS antenna cable.

Allow the GPS to become the active timing source.

* Verify the BBXs remain keyed and INS.

* Verify no other modules went OOS due to the transfer back to the GPS reference.
* Observe the PWR/ALM LEDs on CSM 1 are steady GREEN.

Disable CSM 1 and enable CSM 2.
* Various CSM source and clock alarms are now reported and the site comes down.

* Alarms clear when the site comes back up.

Allow the CSM 2 board to go INS_ACT.

* Verify the BBXs are dekeyed and OOS, and the MCCs are OOS_RAM.

* Verify no other modules went OOS due to the transfer to CSM 2 reference.
* Observe the PWR/ALM LEDs on CSM 2 front panels are steady GREEN.

NOTE

It can take up to 20 minutes for the CSM to re-establish the GPS link and go INS. MCCs go
OOS_RAM.

Key BBXs 1 and R and observe a carrier is present.

10

Repeat Stepg3 througlrt to verify CSM source redundancy with CSM 2.

... continued on next page
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ﬂable 3-43: CSM, GPS, & HSO, Redundancy/Alarm Tests

Step Action

NOTE
DO NOT ENABLE the redundant CSM.

11 Disable CSM 2 and enable CSM 1.

® Various CSM Source and Clock alarms are reported and the site comes down.

® Alarms clear when the site comes back up.

12 | De-key the Xcvr by selecting Device>BBX/MAWI>Dekey.

13 | Allow the CSM 1 board to go INS_ACT.

* Verify the BBXs are de-keyed and OOS.

* Verify no other modules went OOS due to the transfer to CSM 1 reference.
* Observe PWR/ALM LEDs on the CSM 1 front panels are steady GREEN.

14 | Disable the primary and redundant BBXs.

MGLI/GLI Redundancy Test

CAUTION This test can only be performed when the MM path is established
by the MM (not just with LAPD link connected). Attempting to
force the GLIs to “hot swap” under alarm monitor control, when
isolated from the MM, causes MGLIs to hang up.

Table 3-44: MGLI/GLI Redundancy Test (with MM Connection Established)

Step Action
NOTE

* This test assumes the alarm monitor is NOT connected to the BTS and the T1/E1 span is connected
and communication is established with the MM.

* BOTH GLIs must be INS before continuing.

Verify the BBXs are enabled and a CDMA carrier is present.

Identify the primary and redundant MGLI pairs.

Pull the MGLI that is currently INS~ACT and has cage control.

Observe the BBX remains GREEN, and the redundant MGLI is now active.

Verify no other modules go OOS due to the transfer of control to the redundant module.

Verify that the BBXs are enabled and a CDMA carrier is present.

Reinstall the MGLI and have the OMCR/CBSC place it back in-service.

0| NN AW

Repeat StepsE]I througl]j to verify the other MGLI/GLI board.
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Alarms Testing
Alarm Verification

Alarm Reporting Display

ALARM connectors provide Customer Defined Alarm Inputs and
Outputs. The customer can connect BTS site alarm input sensors and
output devices to the BTS, thus providing alarm reporting of active
sensors as well controlling output devices.

The SC 4812T is capable of concurrently monitoring 35 input signals.
These inputs are divided between 2 Alarm connectors marked ‘ALARM
A’ and ‘ALARM B’ located at the top of the frame (seqdjigure 3-27).
The ALARM A connector is always functional; ALARM B is
functional when an AMR module is equipped in the AMR 2 slot in the
distribution shelf. ALARM A port monitors input numbers 1 through
18, while ALARM B port monitors input numbers 19, 20, and 22
through 36 (seqfigure 3-28). Alarm 21 is reserved for system use. State
transitions on these input lines are reported to the LMF and OMCR as
MGLI Input Relay alarms.

ALARM A and ALARM B connectors each provide 18 inputs and 8
outputs. If both A and B are functional, 36 inputs and 16 outputs are

available. They may be configured as redundant. The configuration is set
by the CBSC.

The Alarm Monitor window can be displayed to list alarms that occur
after the window is displayed. To access the Alarm Monitor window,
select Util>Alarm Monitor.

The following buttons are included:

* The Options button allows for a severity level (Warning, Minor, and
Major) selection. The default is all levels. To change the level of
alarms reported click on the Options button and highlight the desired
alarm level(s). To select multiple levels press the <Ctrl> key (for
individual selections) or <Shift> key (for a range of selections) while
clicking on the desired levels.

* The Pause button pauses/stops the display of alarms. When the Pause
button is clicked the name of the button changes to Continue. When
the Continue button is clicked, the display of alarms continues.
Alarms that occur between the time the Pause button is clicked and
the Continue button is clicked are not displayed.

* The Clear button clears the Alarm Monitor display. New alarms that
occur after the Clear button is clicked are displayed.

* The Dismiss button dismisses/closes the Alarm Monitor display.
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Figure 3-27: Alarm Connector Location and Connector Pin Numbering

\\ / ti-CDMA-WP-00041-v01-ildoc-ftw

The following procedures verify the customer defined alarms and relay
contacts are functioning properly. These tests are performed on all AMR
alarms/relays in a sequential manner until all have been verified. Perform
these procedures periodically to ensure the external alarms are reported
properly. Following these procedures ensures continued peak system
performance.

Purpose

Study the site engineering documents and perform the following tests
only after first verifying that the AMR cabling configuration required to
interconnect the BTS frame with external alarm sensors and/or relays
meet requirements called out in the 71X SC 4812T-MC BTS Hardware
Installation .

NOTE Motorola highly recommends that you read and understand this
procedure in its entirety before starting this procedure.

Test Equipment

The following test equipment is required to perform these tests:

¢ LMF
¢ Alarms Test Box (CGDSCMIS00014) —optional

NOTE Abbreviations used in the following figures and tables are
defined as:

* NC = normally closed

® NO = normally open

* COM or C = common

* CDO = Customer Defined (Relay) Output
* CDI = Customer Defined (Alarm) Input
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Figure 3-28: AMR Connector Pin Numbering
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NOTE The preferred method to verify alarms is to follow the Alarms

Test Box Procedure irrfable 3-45. If not using an Alarm Test
Box, follow the procedure irrfable 3-46.

CDI Alarm Input Verification with Alarms Test Box

q‘able 3-45 describes how to test the CDI alarm input verification using
the Alarm Test Box. Follow the steps as instructed and compare results
with the LMF display.

NOTE It may take a few seconds for alarms to be reported. The default
delay is 5 seconds. Leave the alarms test box switches in the new
position until the alarms have been reported.

Table 3-45: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

1 Connect the LMF to the BTS and log into the BTS.

2 Select the MGLI.

3 Click on the Device menu.

4 Click on the Set Alarm Relays menu item.

5 Click on Normally Open.
A status report window displays the results of the action.

6 Click on the OK button to close the status report window.

7 Set all switches on the alarms test box to the Open position.

8 Connect the alarms test box to the ALARM A connector (seqijigure 3-27).

9 Set all of the switches on the alarms test box to the Closed position. An alarm should be reported for
each switch setting.

10 | Set all of the switches on the alarms test box to the Open position. A clear alarm should be reported
for each switch setting.

11 | Disconnect the alarms test box from the ALARM A connector.

12 | Connect the alarms test box to the ALARM B connector.

13 Set all switches on the alarms test box to the Closed position. An alarm should be reported for each
switch setting

... continued on next page
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[Table 3-45: CDI Alarm Input Verification Using the Alarms Test Box

Step Action
14 Set all switches on the alarms test box to the Open position. A clear alarm should be reported for each
switch setting.
15 Disconnect the alarms test box from the ALARM B connector.
16 Select the MGLI.
17 Click on the Device menu.
18 | Click on the Set Alarm Relays menu item.
19 | Click on Normally Closed. A status report window displays the results of the action.
20 | Click OK to close the status report window.
Alarms should be reported for alarm inputs 1 through 36.
21 Set all switches on the alarms test box to the Closed position.
22 Connect the alarms test box to the ALARM A connector.
Alarms should be reported for alarm inputs 1 through 18.
23 Set all switches on the alarms test box to the Open position.
An alarm should be reported for each switch setting.
24 | Set all switches on the alarms test box to the Closed position.
A clear alarm should be reported for each switch setting.
25 Disconnect the alarms test box from the ALARM A connector.
NOTE
Input 21 (pins 29 and 30) on the Alarm B connector is reserved for the Power Supply Modules alarm.
26 Connect the alarms test box to the ALARM B connector.
A clear alarm should be reported for alarm inputs 19 through 36.
27 | Set all switches on the alarms test box to the Open position.
An alarm should be reported for each switch setting.
28 | Set all switches on the alarms test box to the Closed position.
A clear alarm should be reported for each switch setting.
29 Disconnect the alarms test box from the ALARM B connector.
30 Select the MGLI.
31 Click on the Device menu.
32 | Click on the Set Alarm Relays menu item.
33 | Click on Unequipped.
A status report window displays the results of the action.
34 Click on the OK button to close the status report window.
35 Connect the alarms test box to the ALARM A connector.
... continued on next page
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[Table 3-45: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

36 | Set all switches on the alarms test box to both the Open and the Closed position.
No alarm should be reported for any switch settings.

37 | Disconnect the alarms test box from the ALARM A connector.

38 | Connect the alarms test box to the ALARM B connector.

39 | Set all switches on the alarms test box to both the Open and the Closed position.
No alarm should be reported for any switch settings.

40 | Disconnect the alarms test box from the ALARM B connector.

41 Load data to the MGLI to reset the alarm relay conditions according to the CDF file.

CDI Alarm Input Verification without Alarms Test Box

able 3-46 describes how to test the CDI alarm input verification
without the use of the Alarms Test Box. Follow the steps as instructed
and compare results with the LMF display.

NOTE It may take a few seconds for alarms to be reported. The default
delay is 5 seconds. When shorting alarm pins wait for the alarm
report before removing the short.

Table 3-46: CDI Alarm Input Verification Without the Alarms Test Box

Step

Action

Connect the LMF to the BTS and log into the BTS.

Select the MGLI.

Click on the Device menu.

Click on the Set Alarm Relays menu item.

D AW N

Click on Normally Open.
A status report window displays the results of the action.

(@)}

Click on OK to close the status report window.

Refer tqfigure 3-28 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25-26 through 59-60) together.

An alarm should be reported for each pair of pins that are shorted.
A clear alarm should be reported for each pair of pins when the short is removed.

NOTE
Input 21 (pins 29 and 30) on the Alarm B connector is reserved for the Power Supply Modules alarm.

Refer tqFigure 3-28 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25-26 through 59-60) together.
An alarm should be reported for each pair of pins that are shorted.

A clear alarm should be reported for each pair of pins when the short is removed.

. .. continued on next page
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[Table 3-46: CDI Alarm Input Verification Without the Alarms Test Box

Step Action

9 Select the MGLI.

10 Click on the Device menu.

11 Click on the Set Alarm Relays menu item.

12 | Click on Normally Closed.
A status report window displays the results of the action.

13 | Click on OK to close the status report window.
Alarms should be reported for alarm inputs 1 through 36.

14 | Refer tqfigure 3-28 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25-26 through 59-60) together.

A clear alarm should be reported for each pair of pins that are shorted.
An alarm should be reported for each pair of pins when the short is removed.

NOTE
Input 21 (pins 29 and 30) on the Alarm B connector is reserved for the Power Supply Modules alarm.

15 | Refer tqfigure 3-28 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25-26 through 59-60) together.
A clear alarm should be reported for each pair of pins that are shorted.

An alarm should be reported for each pair of pins when the short is removed.

16 Select the MGLI.

17 Click on the Device menu.

18 | Click on the Set Alarm Relays menu item.

19 | Click on Unequipped.
A status report window displays the results of the action.

20 | Click on OK to close the status report window.

21 Refer tqfigure 3-28 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25-26 through 59-60) together.

No alarms should be displayed.

NOTE
Input 21 (pins 29 and 30) on the Alarm B connector is reserved for the Power Supply Modules alarm.

22 | Refer tqFigure 3-28 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25-26 through 59-60) together.

No alarms should be displayed.

23 | Load data to the MGLI to reset the alarm relay conditions according to the CDF file.
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Pin and Signal Information for Alarm Connectors

Qable 3-47 lists the pins, wire color codes, and signal names for Alarms

and B.

Table 3-47: Pin and Signal Information for Alarm Connectors

*For —48V, reserved for Power Supply Module Alarm signal. NOT for use as CDOs or CDIs.
All Cust Rtrn 1-18 are electronically tied together at the RFMF.
All Cust Rtrn 19-36 are electronically tied together at the RFMF.

CDO = Customer Defined Output; CDI = Customer Defined Input;
NC - normally closed, NO — normally open, Com — common

The “A CDI” numbering is from the LMF/OMCR/CBSC perspective. LMF/OMCR/CBSC starts the numbering at 19
(giving 19 — 36). Actual cable hardware starts the numbering at O (giving 0-17)

Wire Signal Name Wire Signal Name

Pin | Color Alarm A Alarm B Pin | Color Alarm A Alarm B

1 | Blu/Wht A CDO1 NC B CDO9 NC 31 | Blu/Yel Cust Retn 4 B CDI 22

2 | Wht/Blu A CDO1 Com B CDOY Com 32 | Yel/Blu A CDI4 Cust Retn 22
3 | Org/Wht A CDO1 NO B CDO9 NO 33 | Org/Yel Cust Retn 5 B CDI 23

4 | Wht/Org A CDO2 NC B CDO10 NC 34 | Yel/Org A CDI 5 Cust Retn 23
5 | Grn/Wht A CDO2 Com B CDO10 Com 35 | Grn/Yel Cust Retn 6 B CDI 24

6 | Wht/Grn A CDO2 NO B CDO10 NO 36 | Yel/Grn A CDI 6 Cust Retn 24
7 | Brn/Wht A CDO3 NC B CDO11 NC 37 | Brn/Yel Cust Retn 7 B CDI 25

8 | Wht/Brn A CDO3 Com B CDO11 Com 38 | Yel/Brn ACDI7 Cust Retn 25
9 | Slt/Wht A CDO3 NO B CDO11 NO 39 | Slt/Yel Cust Retn 8 B CDI 26

10 | Wht/Slt A CDO4 NC B CDO12 NC 40 | Yel/Slt A CDI 8 Cust Retn 26
11 | Blu/Red A CDO4 Com B CDO12 Com 41 | Blu/Vio Cust Retn 9 B CDI 27

12 | Red/Blu A CDO4 NO B CDO12 NO 42 | Vio/Blu A CDI9 Cust Retn 27
13 | Org/Red A CDO5 NC B CDO13 NC 43 | Org/Vio Cust Retn 10 B CDI 28

14 | Red/Org A CDOS5 Com B CDO13 Com 44 | Vio/Blu A CDI 10 Cust Retn 28
15 | Grn/Red A CDO5 NO B CDO13 NO 45 | Grn/Vio Cust Retn 11 B CDI 29

16 | Red/Gm A CDO6 NC B CDO14 NC 46 | Vio/Grn A CDI 11 Cust Retn 29
17 | Brn/Red A CDO6 Com B CDO14 Com 47 | Brn/Vio Cust Retn 12 B CDI 30

18 | Red/Brn A CDO6 NO B CDO14 NO 48 | Vio/Brn ACDI 12 Cust Retn 30
19 | Slt/Red A CDO7 NC B CDO15 NC 49 | Slt/Vio Cust Retn 13 B CDI 31

20 | Red/Slt A CDO7 Com B CDO15 Com 50 | Vio/Slt A CDI 13 Cust Retn 31
21 | Blu/Blk A CDO7 NO B CDO15 NO 51 | Red/Wht Cust Retn 14 B CDI 32

22 | Blk/Blu A CDO8 NC B CDO16 NC 52 | Wht/Red |ACDI 14 Cust Retn 32
23 | Org/Blk A CDOS8 Com B CDO16 Com 53 | Blk/Wht Cust Retn 15 B CDI 33

24 | Blk/Org A CDO8 NO B CDO16 NO 54 | Wht/BIk A CDI 15 Cust Retn 33
25 | Grn/Blk Cust Retn 1 B CDI 19 55 | Yel/Wht Cust Retn 16 B CDI 34
26 | Blk/Gmn ACDI1 Cust Retn 19 56 | Wht/Yel A CDI 16 Cust Retn 34
27 | Brn/BIk Cust Retn 2 B CDI 20 57 | Vio/Wht Cust Retn 17 B CDI 35

28 | BIk/Brn A CDI 2 Cust Retn 20 58 | Wht/Vio A CDI 17 Cust Retn 35
29 | Slt/Blk Cust Retn 3 B CDI 21 +27V | 59 |BIk/Red Cust Retn 18 B CDI 36

*Pwr Conv Alm —48V
30 | BIKk/SIt A CDI 3 Cust Retn 21 +27V | 60 | Red/Blk A CDI 18 Cust Retn 36
*Pwr Conv Retn —48V
NOTE
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Automated Acceptance Test Procedures — All-inclusive TX & RX

Introduction

The Automated Acceptance Test Procedure (ATP) allows Cellular Field
Engineers (CFEs) to run automated acceptance tests on all equipped BTS
subsystem devices using the Local Maintenance Facility (LMF) and
supported test equipment per the current Cell Site Data File (CDF)
assignment.

The results of these tests (at the option of the operator) are written to a
file that can be printed. All tests are controlled from the LMF platform
using the GPIB interface, therefore, only recommended test equipment
supported by the LMF can be used.

This chapter describes the tests run from the GUI environment, which is
the recommended method. The GUI provides the advantages of
simplifying the LMF user interface, reducing the potential for miskeying
commmands and associated parameters, and speeding up the execution
of complex operations involving multiple command strings. If you feel
the command line interface (CLI) will provide additional insight into the
progress of ATPs and problems that could possibly be encountered, refer
to LMF CLI Commands.

CAUTION Before performing any tests, use an editor to view the

“CAVEATS” section of the “readme.txt” file in the c:\wlmf
folder for any applicable information.

The ATP test is to be performed on out-of-service (OOS) sectors
only.

DO NOT substitute test equipment not supported by the LMF.

NOTE

Refer to Chapter for detailed information on test set
connections for calibrating equipment, cables and other test set
components, if required.

4-2

1X SC 4812T-MC Multicarrier BTS Optimization/ATP Sept 2003




68P64115A21-B

Automated Acceptance Test Procedures — All-inclusive TX & RX

Reduced ATP

NOTE

Equipment has been factory—tested for FCC compliance. If
license—governing bodies require documentation supporting
SITE compliance with regulations, a full ATP may be necessary.
Perform the Reduced ATP only if reports for the specific BTS
site are NOT required.

After downloading the proper operational software to the BTS, the CFE
must perform these procedures (minimal recommendation):

* Verify the TX/RX paths by performing TX Calibration, TX Audit and
FER tests.

* Retrieve Calibration Data required for normal site operation.

Should failures occur while performing the specified tests, refer to the

Basic Troubleshooting section of this manual for help in determining the

failure point. Once the point of failure has been identified and corrected, .

refer to the BTS Optimization and ATP Test Matrix ﬂ" able C-3, page 4
|j2—4) section to determine the applicable test that must be performed.

In the unlikely event that the BTS passes these tests but has a forward
link problem during normal operation, the CFE should then perform the
additional TX tests for troubleshooting: TX spectral mask, TX rho, and
TX code domain.

Sept 2003
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Required Test Equipment

The following test equipment is required:

* LMF

* Power meter (used with HP8921A/600 and Advantest R3465)
¢ Communications system analyzer

* Signal generator for FER testing (required for a// communications
system analyzers for 1X FER)

WARNING — Before installing any test equipment directly to any BTS

TX OUT connector, verify that there are no CDMA
channels keyed.

— At active sites, have the OMCR/CBSC place the carrier
assigned to the PAs under test OOS. Failure to do so can
result in serious personal injury and/or equipment damage.

NOTE

The test equipment must be re—calibrated before using it to
perform the TX Acceptance Tests.

ATP Test Prerequisites

Before attempting to run any ATP tests, ensure the following have been
completed:

* BTS has been optimized and calibrated (see Chapter3).

* LMF is logged into the BTS.

e CSMs, GLIs, BBXs, and MCCs have correct code load and data load.
® Primary CSM, GLI, and MCCs are INS_ACT (bright green).

* BBXs are calibrated and BLOs are downloaded.

* No BBXs are keyed (transmitting).

* BBXs are OOS_RAM (flashing green).

¢ Test cables are calibrated.

® Test equipment is connected for ATP tests (seqjigure 3-18 through
jigure 3-22 starting on pagq3-60).

¢ Test equipment has been warmed up 60 minutes and calibrated.
¢ GPIB is on.

* BTS transmit connectors are properly terminated for the test(s) to be
performed.
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WARNING Before performing the FER, be sure that all PAs are turned OFF
(circuit breakers pulled) or that all transmitter ports are properly
terminated.

All transmit ports must be properly terminated for all ATP tests.

Failure to observe these warnings may result in bodily injury or
equipment damage.

TX OUT Connection

NOTE Many of the acceptance test procedures require taking
measurements at the TX OUT connector. All measurements will
be via the BTS TX OUT connector.

ATP Test Options

NOTE Only one carrier can be tested at a time. All PAs must be INS
during testing. For the carriers not under test, key one BBX per
carrier to a minimum power level. (Refer tqfable 3-36).

The tests can be run individually or as one of the following groups:
e All TX/RX: Executes all the TX and RX tests.

e All TX: TX tests verify the performance of the BTS transmit line up.
These include the GLI, MCC, BBX, and MCIO cards, the PAs and
passive components including ETMs, (S)PLCs, TX filters, and RF
cables.

* All RX: RX tests verify the performance of the BTS receiver line up.
These include the MPC (for starter frames), EMPC (for expansion
frames), MCIO, BBX, MCC, and GLI cards and the passive
components including RX filters (starter frame only), and RF cables.

e Full Optimization: Executes the TX calibration, downloads the BLO,
and executes the TX audit before running all of the TX and RX tests.

NOTE The Full Optimization test can be run if you want the TX path
calibrated before all the TX and RX tests are run.

If manual testing has been performed with the HP analyzer,
remove the manual control/system memory card from the card
slot and set the I/O Config to the Talk & Lstn mode before
starting the automated testing.

NOTE The STOP button can be used to stop the testing process.
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Individual Acceptance Tests

The following individual tests can be used to verify the results of
specific tests.

Spectral Purity TX Mask (Primary & Redundant BBX)

This test verifies that the transmitted CDMA carrier waveform generated
on each sector meets the transmit spectral mask specification with
respect to the assigned CDF file values.

NOTE

Prior to Spectral Mask Testing, key at least one BBX from each
carrier to at least minimum level and adjust the frequency of the
selected BBX by 200 AMP channels left or right of the
frequency of the carrier under test. Repeat for other carriers
under test. This is described il]j"able 4-1, Steﬂj.

Waveform Quality (rho)

This test verifies that the transmitted Pilot channel element digital
waveform quality (rho) exceeds the minimum specified value in
ANSI-J_STD-019. “Rho” represents the correlation between actual and
perfect CDMA modulation spectrum. A rho value of 1.0000 represents
100% (or perfect correlation).

Pilot Time Offset

The Pilot Time Offset is the difference between the CDMA analyzer
measurement interval (based on the BTS system time reference) and the
incoming block of transmitted data from the BTS (Pilot only, Pilot
Gain = 262, PN Offset = 0).

Code Domain Power (Primary & Redundant BBX)

This test verifies the code domain power levels, which have been set for
all ODD numbered Walsh channels, using the OCNS command. This is
done by verifying that the ratio of PILOT divided by OCNS is equal to
10.2 + 2 dB, and, that the noise floor of all EVEN numbered “OFF”
Walsh channels measures < 27 dB (with respect to total COMA channel
power).

Frame Error Rate

The Frame Error Rate (FER) test verifies RX operation of the entire
CDMA Reverse Link using all equipped MCCs assigned to all
respective sectors/antennas. This test verifies the BTS sensitivity on all
traffic channel elements currently configured on all equipped MCCs at
an RF input level of =119 dBm (or —116 dBm if using TMPC).
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ATP Test Procedure

Follow the procedure irﬂ" able 4-1 to perform any ATP test.

Table 4-1: ATP Test Procedure

»~| Step

Action

Be sure that all prerequisites have been met.

Select the device(s) to be tested.

IMPORTANT! Only one carrier can be tested at a time. All PAs must be INS during testing. For
the carriers not under test, key one BBX per carrier to a minimum power level. Refer to Stepg
through sub-steg g of Fable 3-36 for testing.

NOTE

If the LMF has been logged into the BTS with a different Multi-Channel Preselector setting than
the one to be used for this test, the LMF must be logged out of the BTS and logged in again with
the new Multi—-Channel Preselector setting. Using the wrong MPC setting can cause a false test
failure.

From the Tests menu, select the test you want to run.

Select the appropriate carrier (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier
pick list.

NOTE

To select multiple items, hold down the <Shift> or <Ctrl> key while making the selections.

Enter the appropriate channel number in the Carrier n Channels box.

The default channel number displayed is determined by the CdmaChans[n] number in the
cbsc—n.cdf file for the BTS.

6a
6b
6¢

Spectral Mask Testing requires channel adjustments made for other carriers (if equipped):

Where: F Actual Customer Channel Channel Offset for other carriers (if equipped)
F1 Channel for other carrier F+200 AMPS channels

F2 Channel for other carrier F1+42 AMPS channels
F3 Channel for other carrier F2+42 AMPS channels

Example: Carrier under test at Channel 283 and three other carriers installed in BTS:

F Channel 283

F1 Channel 483 (new channel)
F2 483442 Channel 525 (new channel)
F3 525+42 Channel 567 (new channel)

— Key all other carriers to the new channels determined above.

2834200

— Run Spectral Mask Test.

— Dekey BBX(s) and repeats steps for Spectral Mask Testing for remaining carriers.
NOTE

Offset Channels can be shifted either left or right to the carrier under test, but not both and must
remain between Channels 1013 and 777.

If applicable, select Verify BLO (default) or Single-sided BLO.
NOTE

Single-sided BLO is only used when checking non-redundant transceivers.

If applicable, select a test pattern from the Test Pattern pick list.

... continued on next page
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ﬂable 4-1: ATP Test Procedure

Step

Action

NOTE

¢ Selecting Pilot (default) performs tests using only a pilot signal.

¢ Selecting Standard performs tests using pilot, synch, paging and 6 traffic channels. This
requires an MCC to be selected.

¢ Selecting CDFPilot performs tests using only a pilot signal, however, the gain for the channel
elements is specified in the CDF file.

¢ Selecting CDF performs tests using pilot, synch, paging and 6 traffic channels, however, the
gain for the channel elements is specified in the CDF file.

Click on the OK button.
The status report window and a Directions pop-up are displayed.

10

Follow the cable connection directions as they are displayed.
The test results are displayed in the status report window.

11

Click on Save Results or Dismiss.

NOTE

If Dismiss is used, the test results will not be saved in the test report file.

12

Refer to Stepg through sub-steg=c of Jable 3-36 to dekey.

4-8
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TX Spectral Purity Transmit Mask Acceptance Test

Tx Mask Test

This test verifies the spectral purity of each BBX carrier keyed up at a
specific frequency, per the current CDF file assignment. All tests are
performed using the external calibrated test set, controlled by the same
command. All measurements are via the appropriate TX OUT connector.

The Pilot Gain is set to 541 for each antenna, and all channel elements
from the MCCs are forward-link disabled. The BBX is keyed up, using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only). BBX power output is set to obtain +40 dBm as
measured at the TX OUT connector (on the BTS directional coupler).

NOTE TX output power is set to +40 dBm by setting BTS power level
to +33.5 dBm to compensate for 6.5 dB increase from pilot gain
set to 541.

The calibrated communications test set measures and returns the
attenuation level of all spurious and IM products in a 30 kHz resolution
bandwidth. With respect to the mean power of the CDMA channel
measured in a 1.23 MHz bandwidth in dB, verify that results meet
system tolerances at the following test points:

— at least 45 dB @ + 750 kHz from center frequency
— at least —45 dB @ — 750 kHz from center frequency
— at least =60 dB @ — 1980 kHz from center frequency
— at least =60 dB @ — 1980 kHz from center frequency
The BBX then de-keys, and, if selected, the MCC is re-configured to

assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated. SeqJable 4-1 to perform this test.
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68P64115A21-B

Figure 4-1: TX Mask Verification Spectrum Analyzer Display
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TX Waveform Quality (rho) Acceptance Test

Rho Test

This test verifies the transmitted Pilot channel element digital waveform
quality of each BBX carrier keyed up at a specific frequency per the
current CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT connector.

The Pilot Gain is set to 262 for each antenna, and all channel elements
from the MCCs are forward link disabled. The BBX is keyed up using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to

40 dBm as measured at the TX OUT connector (on the BTS directional
coupler).

The calibrated communications test set measures and returns the Pilot
channel element digital waveform quality (rho) in dB, verifying that the
result meets system tolerances:

* Waveform quality (rho) should be = 0.912 (0.4 dB).

The BBX then de-keys and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then be repeated. SeqJable 4-1 to perform this
test.
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TX Pilot Time Offset Acceptance Test

Pilot Offset Acceptance Test

This test verifies the transmitted Pilot channel element Pilot Time Offset
of each BBX carrier keyed up at a specific frequency per the current
CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT connector.

The Pilot Gain is set to 262 for each antenna, and all TCH elements from
the MCCs are forward link disabled. The BBX is keyed up, using both
bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to

40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
Time Offset in ps, verifying results meet system tolerances:

¢ Pilot Time Offset should be within + 3 us of the target PT
Offset (0 pus).

The BBX then de-keys, and if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated. SeqJable 4-1 to perform this test.
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TX Code Domain Power/Noise Floor Acceptance Test

Code Domain Power Test

This test verifies the Code Domain Power/Noise of each BBX carrier
keyed up at a specific frequency per the current CDF file assignment.
All tests are performed using the external calibrated test set controlled by
the same command. All measurements are via the appropriate TX OUT
connector.

For each sector/antenna under test, the Pilot Gain is set to 262. All MCC
channel elements under test are configured to generate Orthogonal
Channel Noise Source (OCNS) on different odd Walsh codes and to be
assigned a full-rate gain of 81. The maximum number of MCC/CEs to
be tested at any one time is 32 (32 odd Walsh codes). If more than 32
CEs exist, then multiple sets of measurements are made; so all channel
elements are verified on all sectors.

BBX power output is set to 40 dBm as measured at the TX OUT
connector.

You verify the code domain power levels, which have been set for all
ODD numbered Walsh channels, using the OCNS command. This is
done by verifying that Pilot Power (dBm) minus OCNS Power (dBm) is
equal to 10.2 + 2 dB and that the noise floor of all “OFF” Walsh channels
measures < —27 dB (with respect to total CDMA channel power).

NOTE

When performing this test using the LMF and the MCC is an
MCCSE or MCC24E, the redundant BBX may fail or show
marginal performance. This is due to a timing mismatch that the
LMF does not address. Performing this test from the CBSC will
not have this timing problem.

The BBX then de-keys and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated. Upon completion of the test, OCNS
is disabled on the specified MCC/CE.

NOTE

If using Advantest test equipment, Code Domain Test MUST be
configured in RC-1 mode.

Seqjable 4-1 to perform this test.
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Figure 4-2: Code Domain Power and Noise Floor Levels
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RX Frame Error Rate (FER) Acceptance Test

FER Test

This test verifies the BTS FER on all traffic channel elements currently
configured on all equipped MCCs (full rate at 1% FER) at an RF input
level of =119 dBm [or —116 dBm if using Tower Top

Amplifier (TMPC)]. All tests are performed using the external calibrated
test set as the signal source controlled by the same command. All
measurements are via the LMF.

The Pilot Gain is set to 262 for each TX antenna, and all channel
elements from the MCCs are forward-link disabled. The BBX is keyed
up, using only bbxlvl level offsets, to generate a CDMA carrier (with
pilot channel element only). BBX power output is set to —20 dBm as
measured at the TX OUT connector. The BBX must be keyed to enable
the RX receive circuitry.

The LMF prompts the MCC/CE under test to measure all zero longcode
and provide the FER report on the selected active MCC on the reverse
link for both the main and diversity RX antenna paths, verifying that
results meet the following specification:

¢ FER returned less than 1% and total frames measured is 1500

All MCC/CE:s selected are tested on the specified RX antenna path. The
BBX then de-keys and, if selected, the MCC is re-configured to assign
the applicable redundant BBX to the current RX antenna paths under
test. The test is then repeated. SeqJable 4-1 to perform this test.
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Generate an ATP Report

Background

Each time an ATP test is run, an ATP report is updated to include the
results of the most recent ATP tests if the Save Results button is used to
close the status report window. The ATP report is not updated if the
status reports window is closed using the Dismiss button.

ATP Report

Each time an ATP test is run, a separate report is created for each BTS
and includes the following for each test:

Test name

BBX number
Channel number
Carrier number
Sector number
Upper test limit
Lower test limit
Test result
PASS or FAIL
Description information (if applicable)
Time stamp

Details/Warning information (if applicable)

The report can be printed if the LMF computer is connected to a printer.
Follow the procedure in thqable 4-2 to view and/or print the ATP
report for a BTS.

Table 4-2: Generating an ATP Report

| Step

Action

1 Click on the Login tab (if not in the forefront).

2 Select the desired BTS from the available Base Station
pick list.

3 Click on the Report button.

Click on a column heading to sort the report.

5 — If not desiring a printable file copy, click on the
Dismiss button.

— If requiring a printable file copy, select the desired
file type in the picklist and click on the Save button.

4-16
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Updating Calibration Data Files

Software Release caveats

With Software Release 2.16.1.x, the packet BTS will NOT detect a new
calibration file on the OMC-R. A manual workaround is available in

bulletin cdma_g_bts_059. This will be corrected in Software Release
2.16.3.

Software Release 2.16.3 will allow the user to load the calibration file
from the LMF directly onto the MGLI. The MGLI will then ftp the new
calibration file to the OMC-R, thereby eliminating the need for the user
to place the calibration file at the OMC-R.

Copy and Load Cal File to to CBSC

Updated calibration (CAL) file information must be moved from the
LMF Windows environment back to the CBSC, which resides in a Unix
environment. The procedures that follow detail how to move files from
one environment to the other.

Backup CAL Data to a Diskette

The BLO calibration files should be backed up to a diskette (per BTS).
Follow the procedure irrfable 5-1 to copy CAL files from a CDMA
LMF computer to a diskette.

Table 5-1: Backup CAL Data to a Diskette

Step Action

1 With Windows running on the LMF computer, insert a disk into Drive A:\.

Launch the Windows Explorer application program from the Start > Programs menu list.

Select the applicable <x>:\<lmf home directory/cdma/bts—# folder.

Drag the bts—#.cal file to Drive A.

D AW N

Repeat Steps 3 and 4, as required, for other bts—# folders.
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Copying CAL Files from Diskette to the CBSC

Follow the procedure irfable 5-2 to copy CAL files from a diskette to
the CBSC.

Table 5-2: Procedures to Copy CAL Files from Diskette to the CBSC

Step Action

1 Log into the CBSC on the OMC-R Unix workstation using your account name and password.

2 Place the diskette containing calibration files (cal files) in the workstation diskette drive.

3 Type eject —q and press the Enter key.

4 Type mount and press the Enter key. Verify that £loppy/no_name is displayed.
NOTE
If the eject command has been previously entered, floppy/no_name will be appended with a
number. Use the explicit £loppy/no_name reference displayed.

5 Type in cd /floppy/no_name and press the Enter key.

6 Type in Is -lia and press the Enter key. Verify the bts—#.cal file filename appears in the displayed
directory listing.

7 Type in cd and press the Enter key.

8 Type in pwd and press the Enter key. Verify the displayed response shows the correct home directory
(/home/<user’s name>).

9 With Solaris versions of Unix, create a Unix—formatted version of the bts—#.cal file in the home
directory by performing the following:

9a — Type in dos2unix /floppy/no_name/bts—#.cal bts—#.cal and press the Enter key.

Where: # = BTS number for which the CAL file was created

NOTE
Other versions of Unix do not support the dos2unix command. In these cases, use the Unix cp (copy)
command. The copied files will contain DOS line feed characters which must be edited out with a
Unix text editor.

10 | Type in Is -1 *.cal and press the Enter key. Verify the CAL files have been copied. Verify all CAL
files to be transferred appear in the displayed listing.

11 Type eject and press the Enter key.

12 | Remove the diskette from the workstation.
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Prepare to Leave the Site

External Test Equipment Removal

Perform the procedure iqj"able 5-3 to disconnect the test equipment and
configure the BTS for active service.

Table 5-3: External Test Equipment Removal

Step Action

1 Disconnect all external test equipment from all TX and RX
connectors on the top of the frame.

2 Reconnect and visually inspect all TX and RX antenna feed
lines at the top of the frame.

CAUTION Verify that all sector antenna feed lines are connected to the
correct ports on the frame. Crossed antenna cables will cause
system degradation of call processing.

NOTE Each module or device can be in any state prior to downloading.
Each module or device will be in an OOS_RAM state after
downloading has completed.

— For all LMF commands, information in italics represents
valid ranges for that command field.

— Only those fields requiring an input will be specified.
Default values for other fields will be assumed.

— For more complete command examples (including system
response details), refer to the CDMA LMF User Guide.
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BTS Site Span Configuration Verification

Perform the procedure imJable 5-4 to verify the current Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI/GLI boards
in all C—CCP shelves that terminate a T1/E1 span should be verified.

Table 5-4: BTS Span Parameter Configuration

Step Action

1 Connect a serial cable from the LMF COM1 port (via null modem board) to the front panel of the
MGLI MMI port (seqFigure 5-1).

2 Start an MMI communication session with MGLI by using the Windows desktop shortcut icon (see
[Jable 3-3 on pagq3-12).
NOTE

The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

3 Enter the following MMI command to display the current MGLI/GLI framing format and line code
configuration (in bold type):

span view <cr>

Observe a display similar to the options shown below:

COMMAND ACCEPTED: span view

The parameter in NVM is set to T1_2.

The frame format in flash is set to use T1_2.
Equalization:
Span A — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span B — Default (0-131 feet for T1/J1, 120 Ohm for El)
(

Span C — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span D — Default (0-131 feet for T1/J1, 120 Ohm for E1l)
Span E — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span F — Default (0-131 feet for T1/J1, 120 Ohm for El)

Linkspeed: Default (56K for Tl D4 AMI, 64K otherwise)
Currently, the link is running at the default rate
The actual rate is 0

NOTE
Defaults for span equalization are 0—131 feet for T1/J1 spans and 120 Ohm for E1.

Default linkspeed is 56 kbps for T1 D4 AMI spans and 64 kbps for all other types.
There is no need to change from defaults unless the OMC-R/CBSC span configuration requires it.

If the current MGLI/GLI framing format and line code configuration does not display the correct
choice, proceed tqjable 5-5.

Repeat stepg througl3 for all remaining GLIs.

Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then EXit from the drop—down menu.
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Figure 5-1: MGLI/GLI MMI Port Connection
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Set BTS Site Span Configuration

Perform the procedure irpJable 5-5 to configure the Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI/GLI boards
in all C—CCP shelves that terminate a T1/E1 span must be configured.

NOTE

Perform the following procedure ONLY if span configurations
loaded in the MGLI/GLIs do not match those in the
OMCR/CBSC data base, AND ONLY when the exact
configuration data is available. Loading incorrect span
configuration data will render the site inoperable.

Table 5-5: Set BTS Span Parameter Configuration

Step

Action

1 If not already done, connect a serial cable from the LMF COM1 port (via null modem board) to the

front panel of the MGLI MMI port (se

qijigure 5-1).

2 Start an MMI communication session with MGLI1 by using the Windows desktop shortcut icon (see

[Jable 3-3 on pagq3-12).
NOTE

used for the MMI session.

The LMF program must not be running when a Hyperterminal session is started if COM1 is being

... continued on next page
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[Table 5-5: Set BTS Span Parameter Configuration

Step

Action

Enter the following MMI command to determine the current BTS span parameters:

GLI#> config ni current

The frame format in flash is set to use T1_2.

Equalization:
Span A — 0-—131 feet.
Span B — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span C — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span D — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span E — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span F — 0—131 feet.

Linkspeed: 64K

Currently, the link is running at the default rate

The actual rate is 0

Enter the following MMI commands to configure the equalization for each span:
GLI#> config ni equal <letter> < value>

Where: letter = : 0-131 feet (default for T1/J1)
: 132262 feet

: 263-393 feet

: 394-524 feet

1 525-655 feet

: LONG HAUL

: 75 OHM

: 120 OHM (default for E1)

a: Span A and value =
b : Span B
c:Span C
d:Span D
e :Span E
f:Span F

NN W= O

An example of the command and response:

GLI#> config niequala0
The value has been programmed. It will take effect after the next reset.

Enter the following MMI command to configure the span type:
GLI#> config ni format <type>

Where: type = E1_1:E1 1-E1 HDB3 CRC4 no TS16
El 2 :E1_2-E1 HDB3 no CRC4 no TS16
El1 3 :E1_3-E1 HDB3 CRC4 TS16

El 4 : E1_4 - E1 HDB3 no CRC4 TS16
T1 1:T1_1-D4, AMI, No ZCS

T1 2 :T1_2 - ESF, B8ZS

J1_1 :J1_1-ESF, B8ZS (Japan) — Default
J1 2 :J1_2 - ESF, B8ZS

T1 3 :T1_3 - D4, AMI, ZCS

An example of the command and response:

GLI#> config ni format T1_1

The value has been programmed. It will take effect after the next reset.

. .. continued on next pa
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[Table 5-5: Set BTS Span Parameter Configuration

Step Action

6 Enter the following MMI command to configure the link speed on the spans:
GLI#> config ni linkspeed <speed>

Where speed = 56K : 56K(default for T1_1 and T1_3 systems)
64K : 64K(default for all other span configurations)

An example of the command and response:

GLI#> config ni linkspeed 56K
The value has been programmed. It will take effect after the next reset.

7 Enter the following MMI command to turn loopback on or off:
GLI#> config ni loopback <on or off>
Loopback commands and responses:

GLI#> config ni loopback on
Loopback request SUCCESSFUL: All framers have been placed in loopback.
They will remain in loopback for 1 hour.

GLI#> config ni loopback off
Loopback request SUCCESSFUL: All framers have been removed from loopback.

8 Press the RESET button on the GLI for changes to take effect.

This completes the site specific BTS Span setup for this GLI. Move the MMI cable to the next GLI
and repeat stepg an¢§ for ALL MGLI/GLI boards.

-l

10 | Terminate the Hyperterm session and disconnect the LMF from the MGLI/SGLI.

LMF Removal
CAUTION DO NOT power down the LMF without performing the

procedure indicated below. Corrupted/lost data files may result,
and in some cases, the LMF may lock up.

Follow the procedure iqj"able 5-6 to terminate the LMF session and

remove the terminal.

Table 5-6: LMF Termination and Removal
»~| Step Action

1 From the CDMA window select File>Exit.
NOTE

The “File > Exit” command will prompt you to confirm the logout procedure. The “File > Logout
and Exit” command will not prompt you and continues to shut down LMF.

2 From the Windows Task Bar click Start>Shutdown.
Click Yes when the Shut Down Windows message appears.

3 Disconnect the LMF terminal Ethernet connector from the BTS cabinet.

4 Disconnect the LMF serial port, the RS-232 to GPIB interface box, and the GPIB cables as
required for equipment transport.
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Re—connect BTS T1/E1 Spans and Integrated Frame Modem

Before leaving the site, connect any T1 span TELCO connectors that
were removed to allow the LMF to control the BTS. Refer tqJable 5-7
andjigure 5-2 as required.

Table 5-7: T1/E1 Span/IFM Connections

Step Action

1 Connect the 50-pin TELCO cables to the BTS span I/O board 50—pin TELCO connectors.

2 If used, connect the dial-up modem RS-232 serial cable to the Site I/O board RS-232 9—pin
sub D connector.

* IMPORTANT
Verify that you connect both SPAN cables (if removed previously), and the Integrated Frame
Modem (IFM) “TELCO” connector.

Figure 5-2: Site and Span I/O Boards T1 Span Connections
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Reset All Devices and Initialize Site Remotely

Devices in the BTS should not be left with data and code loaded from
the LMF. The configuration data and code loads used for normal
operation could be different from those stored in the LMF files. Perform
the procedure irrFable 5-8 to reset all devices and initialize site remotely.

Table 5-8: Reset BTS Devices and Remote Site Initialization

Step Action
1 Terminate the LMF session by following the procedures irrable 5-6.
2 Reconnect spans by following the procedure irrable 5-7.
3 — If BTS is configured for circuit operation, go to Ster4.
— If BTS is configured for packet operation, go to Stef 3.
4 Circuit BTS Procedure:
4a | From the BTS site, contact the OMC-R and request the operator to perform a BTS reset.
or
At the BTS site:
— unseat one GLI card at a time and wait for 30 seconds;
— reseat the GLI and wait for it to complete its initialization (this takes about one minute);
— repeat for the second GLI.
4b | Depending on the number of installed operational GLI cards, perform one of the following:
— With fully redundant GLIs, contact the OMC-R and request the operator to run the ACTIVATE
command for the BTS.
— For a non-redundant GLI or a frame where the redundant GLI is not operational, contact the
OMC-R and request the operator:
¢ ACTIVATE the GLI to set the Nextload attribute for the GLI to the one for the current BSS
software version;
¢ Disable the GLI;
¢ Enable the GLI to allow the MM to load the software version specified by the Nextload
attribute;
* Once the GLI is INS_ACT, contact the OMC-R and request the operator ACTIVATE the BTS.
— Once the GLI cards are loaded with the specified code version, the active GLI will verify and
update, as required, the RAM and, if it is necessary, ROM code loads for the installed CSM,
MCC, and BBX cards using the DLM.
... continued on next page
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ﬂable 5-8: Reset BTS Devices and Remote Site Initialization

Step

Action

Sa

Packet BTS procedure:

From the BTS site, contact the OMC-R and request the operator to PREACTIVATE the BTS to the
required software version for the BSS. There are two types of PREACTIVATE load processes:

— Rolling Upgrade: This load process is only available when the BTS cards are populated for full
redundancy as applicable.

— Quick Reboot: This process is used when there is not full redundancy for the BTS cards. The
GLI3 will disable and reboot to the new load. This will cause all the other cards to go out of
service. Once it is rebooted, the GLI3 determines which cards require a new load and then
downloads the cards in the order which they establish communication with the GLI3 following
their reboot. The GLI3 can reload up to 16 devices simultaneously.

After all activities at the site have been completed, contact the OMC-R and confirm that the BTS is
under OMC-R control.
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Basic Troubleshooting Overview

Overview

The information in this section addresses some of the scenarios likely to
be encountered by Cellular Field Engineering (CFE) team members.
This troubleshooting guide was created as an interim reference document
for use in the field. It provides basic “what to do if” basic
troubleshooting suggestions when the BTS equipment does not perform
per the procedure documented in the manual.

Comments are consolidated from inputs provided by CFEs in the field
and information gained form experience in Motorola labs and
classrooms.

6-2
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Troubleshooting: Installation

Cannot Log into Cell-Site

Follow the procedure iqj"able 6-1 to troubleshoot a login failure.

Table 6-1: Login Failure Troubleshooting Procedures

v~ Step Action

1 If MGLI LED is solid RED, it implies a hardware failure. Reset MGLI by re-seating it. If this
persists, install a known good MGLI card in MGLI slot and retry. A Red LED may also indicate
no Ethernet termination at top of frame.

2 Verify that T1 is disconnected (seqFable 3-4 on pagq3-15).
If T1 is still connected, verify the CBSC has disabled the BTS.

3 Try pinging the MGLI (seqj"able 3-11 on pagqj—?)l).

Verify the LMF is connected to the Primary LMF port (LAN A) in the front of the BTS (see
[Jable 3-5 on pagq3-16).

Verify the LMF was configured properly (see Preparing the LMF section starting on page 3—0).
Verify the BTS-LMF cable is RG-58 [flexible black cable of less than 76 cm (2.5 feet) length].

o

Verify the Ethernet ports are terminated properly (seqijigure 3-9 on pagq3-30).

(e <IN B o NV

Verify a T-adapter is not used on the LMF side port if connected to the BTS front LMF primary
port.

9 Try connecting to the I/O panel (top of frame). Use BNC T-adapters at the LMF port for this
connection.

10 | Re-boot the LMF and retry.

11 Re-seat the MGLI and retry.

12 | Verify IP addresses are configured properly.

Cannot Communicate to Power Meter

Follow the procedure irﬂable 6-2 to troubleshoot a power meter
communication failure.

Table 6-2: Troubleshooting a Power Meter Communication Failure

v~ Step Action

1 Verify the Power Meter is connected to the LMF with a GPIB adapter.

2 Verify the cable setup as specified in Chapter 3.

3 Verify the GPIB address of the power meter is set to the same value displayed in the applicable
GPIB address box of the LMF Options window Test Equipment tab. Refer tqJable 3-24 or
[Jable 3-25 and the GPIB Addresses section of Appendix T for details.

4 Verify the GPIB adapter DIP switch settings are correct.
Refer to the Test Equipment setup section for details.

... continued on next page
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Table 6-2: Troubleshooting a Power Meter Communication Failure

v~ Step Action
5 Verify the GPIB adapter is not locked up. Under normal conditions, only two green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, then power-cycle the GPIB Box
and retry.
6 Verify the LMF computer COM1 port is not used by another application; for example, if a
HyperTerminal window is open for MMI, close it.
7 Reset all test equipment by clicking Util in the BTS menu bar and selecting

Test Equipment>Reset from the pull-down lists.

Cannot Communicate to Communications Analyzer

Follow the procedure irrfable 6-3 to troubleshoot a communications
analyzer communication failure.

Table 6-3: Troubleshooting a Communications Analyzer Communication Failure

v~ Step Action

1 Verify the analyzer is connected to the LMF with GPIB adapter.

2 Verify the cable setup.

3 Verify the signal generator GPIB address is set to the same value displayed in the applicable GPIB
address box of the LMF Options window Test Equipment tab. Refer tqJable 3-24 orfable 3-25
and the GPIB Address section of Appendix for details.

4 Verify the GPIB adapter DIP switch settings are correct. Refer to the CDMA 2000 Test Equipment
Preparation section of AppendixT for details.

5 Verify the GPIB adapter is not locked up. Under normal conditions, only two green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, then cycle the GPIB box power
and retry.

6 Verify the LMF computer COM1 port is not used by another application; for example, if a
HyperTerminal window is open for MMI, close it.

7 Reset all test equipment by clicking Util in the BTS menu bar and selecting
Test Equipment>Reset from the pull-down lists.
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Troubleshooting: Download

Cannot Download CODE to Any Device (card)

Follow the procedure irﬂ" able 6-4 to troubleshoot a code download
failure.

Table 6-4: Troubleshooting Code Download Failure

v~ Step Action

1 Verify T1 is disconnected from the BTS.

2 Verify the LMF can communicate with the BTS device using the Status function.

3 Communication to the MGLI2 must first be established before trying to talk to any other BTS

device.
The MGLI2 must be INS_ACT state (green).

4 Verify the card is physically present in the cage and powered-up.

5 If the card LED is solid RED, it implies hardware failure.
Reset the card by re-seating it.
If the LED remains solid red, replace with a card from another slot & retry.

NOTE

The card can only be replaced by a card of the same type.

6 Re-seat the card and try again.

7 If BBX reports a failure message and is OOS_RAM, the code load was OK.

8 If the download portion completes and the reset portion fails, reset the device by selecting the
device and Reset.

9 If a BBX or an MCC remains OOS_ROM (blue) after code download, use the LMF
Device > Status function to verify that the code load was accepted.

10 If the code load was accepted, use LMF Device > Download > Flash to load RAM code into flash
memory.

Cannot Download DATA to Any Device (Card)

Perform the procedure iqj"able 6-5 to troubleshoot a data download
failure.

Table 6-5: Troubleshooting Data Download Failure

»~| Step Action

1 Re-seat the card and repeat code and data load procedure.
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Cannot ENABLE Device

Before a device can be enabled (placed in-service), it must be in the
OOS_RAM state (yellow) with data downloaded to the device. The color
of the device changes to green once it is enabled.

The three states that devices can be changed to are as follows:
* Enabled (green, INS)

* Disabled (yellow, OOS_RAM)

* Reset (blue, OOS_ROM)

Follow the procedure iqj“able 6-6 to troubleshoot a device enable
failure.

Table 6-6: Troubleshooting Device Enable (INS) Failure

v~ Step Action

1 Re-seat the card and repeat the code and data load procedure.

2 If the CSM cannot be enabled, verify the CDF file has correct latitude and longitude data for cell
site location and GPS sync.

3 Ensure the primary CSM is in INS_ACT state.
NOTE
MCCs will not go INS without the CSM being INS.

4 Verify the 19.6608 MHz CSM clock; MCCs will not go INS otherwise.

5 The BBX should not be enabled for ATP tests.

6 If MCCs give “invalid or no system time”, verify the CSM is operable.

Miscellaneous Errors
Perform the procedure irpfable 6-7 to troubleshoot miscellaneous
failures.
Table 6-7: Miscellaneous Failures
v~ Step Action

1 If PAs continue to give alarms, even after cycling power at the circuit breakers, then connect an
MMI cable to the PA and set up a Hyperterminal connection (seqj"able 3-3 on pagqj—12).

2 Enter ALARMS in the Hyperterminal window.
The resulting LMF display may provide an indication of the problem.
(Call Field Support for further assistance.)
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Troubleshooting: Calibration

Bay Level Offset Calibration Failure

Perform the procedure iqj"able 6-8 to troubleshoot a BLO calibration
failure.

NOTE Only one carrier can be tested at a time. All PAs must be INS
during testing. For the carriers not under test, key one BBX per
carrier to a minimum power level. (Refer tq-fable 3-36).

Table 6-8: Troubleshooting BLO Calibration Failure
v~ Step Action
1 Verify the Power Meter is configured correctly (see the test equipment setup section in Chapter 3)
and connection is made to the proper TX port.
2 Verify the parameters in the bts—#.cdf file are set correctly for SO0MHz:
Bandclass=0; Freq_Band=8; SSType=8
3 Verify that no PA is in alarm state (flashing red LED).
Reset the PA by pulling the circuit breaker and, after 5 seconds, pushing back in.
4 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from the sensor
head.
5 Verify the GPIB adapter is not locked up.
Under normal conditions, only two green LEDs must be ‘ON’ (Power and Ready).
If any other LED is continuously ‘ON’, power-cycle (turn power off and on) the GPIB Box and
retry.
6 Verify the sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power Ref
signal.
7 If communication between the LMF and Power Meter is operatonal, the Meter display will show
CCRES”.
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Cannot Load BLO

For Load BLO failures seqj"able 6-7.

Calibration Audit Failure

Follow the procedure iqj"able 6-9 to troubleshoot a calibration audit
failure.

NOTE Only one carrier can be tested at a time. All PAs must be INS
during testing. For the carriers not under test, key one BBX per
carrier to a minimum power level. (Refer tqfable 3-36).

Table 6-9: Troubleshooting Calibration Audit Failure
v~ Step Action
1 Verify the Power Meter is configured correctly (refer to the test equipment setup section of
Chapter 3).
2 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from the sensor
head.
3 Verify that no PA is in alarm state (rapidly flashing red LED).
Reset the PA by pulling the circuit breaker and, after 5 seconds, pushing back in.
4 Verify that no sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power
Ref signal.
5 After calibration, the BLO data must be re-loaded to the BBXs before auditing.
Click on the BBX(s) and select Device>Download BLO.
Re-try the audit.
6 Verify the GPIB adapter is not locked up.
Under normal conditions, only two green LEDs must be “ON” (Power and Ready).
If any other LED is continuously “ON”, power-cycle (turn power off and on) the GPIB Box and
retry.
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Troubleshooting: Transmit ATP

BTS passed Reduced ATP tests but has forward link problem during normal
operation

Follow the procedure iqj"able 6-10 to troubleshoot a Forward Link
problem during normal operation.

Table 6-10: Troubleshooting Forward Link Failure (BTS Passed Reduced ATP)

»~| Step Action
1 Perform these additional TX tests to troubleshoot a forward link problem:
— TX mask
— TX ho
— TX code domain

Cannot Perform TX Mask Measurement

Follow the procedure iqj"able 6-11 to troubleshoot a TX mask
measurement failure.

NOTE Only one carrier can be tested at a time. All PAs must be INS
during testing. For the carriers not under test, key one BBX per
carrier to a minimum power level. (Refer tqfable 3-36).

Table 6-11: Troubleshooting TX Mask Measurement Failure

v~ Step Action

1 Verify that TX audit passes for the BBX(s).

2 If performing manual measurement, verify analyzer setup.

3 Verify that no PA in the sector is in alarm state (flashing red LED).
Re-set the PA by pulling the circuit breaker and, after 5 seconds, pushing it back in.

Cannot Perform Rho or Pilot Time Offset Measurement

Follow the procedure irrable 6-12 to troubleshoot a rho or pilot time
offset measurement failure.

Table 6-12: Troubleshooting Rho and Pilot Time Offset Measurement Failure

v~ Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

Verify PN offsets displayed on the analyzer is the same as the PN offset in the CDF file.

2
3 Re-load BBX data and repeat the test.
4

If performing manual measurement, verify analyzer setup.

... continued on next page
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Table 6-12: Troubleshooting Rho and Pilot Time Offset Measurement Failure

v~ Step Action
5 Verify that no PA in the sector is in alarm state (flashing red LED). Reset the PA by pulling the
circuit breaker and, after 5 seconds, pushing back in.
6 If Rho value is unstable and varies considerably (e.g. .95,.92,.93), this may indicate that the GPS

is still phasing (i.e., trying to reach and maintain O freq. error).

Go to the freq. bar in the upper right corner of the Rho meter and select Hz. Press <Shift-avg>
and enter 10, to obtain an average Rho value. This is an indication the GPS has not stabilized
before going INS and may need to be re-initialized.

Cannot Perform Code Domain Power and Noise Floor Measurement

Perform the procedure iqj"able 6-13 to troubleshoot a code domain and
noise floor measurement failure.

Table 6-13: Troubleshooting Code Domain Power and Noise Floor Measurement Failure

v~ Step Action
1 Verify presence of RF signal by switching to spectrum analyzer screen.
2 Verify PN offset displayed on analyzer is same as PN offset being used in the CDF file.
3 Disable and re-enable MCC (one or more MCCs based on extent of failure).

6-10
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Troubleshooting: Receive ATP

Multi—-FER Test Failure

Perform the procedure iqj"able 6-14 to troubleshoot a Multi-FER
failure.

Table 6-14: Troubleshooting Multi-FER Failure

v~ Step Action
1 Verify the test equipment set up is correct for an FER test.
2 Verify the test equipment is locked to 19.6608 and even second clocks.
On the HP8921A test set, the yellow LED (REF UNLOCK) must be OFF.
3 Verify the MCCs have been loaded with data and are INS-ACT.
4 Disable and re-enable the MCC (one or more based on extent of failure).
5 Disable, re-load code and data, and re-enable the MCC (one or more MCCs based on extent of
failure).
6 Verify the antenna connections to frame are correct based on the directions messages.
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Troubleshooting: CSM Checklist

Problem Description

Many of the Clock Synchronization Manager (CSM) board failures may
be resolved in the field before sending the boards to the factory for
repair. This section describes known CSM problems identified in field
returns, some of which are field-repairable. Check these problems before
returning suspect CSM boards.

Intermittent 19.6608 MHz Reference Clock/GPS Receiver Operation

No GPS Reference Source

Checksum Failure

If having any problems with CSM board kit numbers, SGLN1145 or
SGLN4132, check the suffix with the kit number. If the kit has version
“AB?”, then replace with version “BC” or higher, and return model “AB”
to the repair center.

Check the CSM boards for proper hardware configuration. CSM kit
SGLN1145, in Slot 1, has an on-board GPS receiver; while kit
SGLN4132, in Slot 2, does not have a GPS receiver. Any incorrectly
configured board must be returned to the repair center. Do not attempt to
change hardware configuration in the field. Also, verify the GPS
antenna is not damaged and is installed per recommended guidelines.

The CSM could have corrupted data in its firmware resulting in a
non-executable code. The problem is usually caused by either electrical
disturbance or interruption of data during a download. Attempt another
download with no interruptions in the data transfer. Return the CSM
board back to the repair center if the attempt to reload fails.

GPS Bad RX Message Type

This problem is believed to be caused by a later version of CSM
software (3.5 or higher) being downloaded, via LMF, followed by an
earlier version of CSM software (3.4 or lower), being downloaded from
the CBSC. Download again with CSM software code 3.5 or higher.
Return the CSM board back to the repair center if the attempt to reload
fails.

CSM Reference Source Configuration Error

This problem is caused by incorrect reference source configuration
performed in the field by software download. CSM kits SGLN1145 and
SGLN4132 must have proper reference sources configured (as shown
below) to function correctly.

CSM Kit Hardware CSM Slot Reference Source CDF Value
No. Configuration No. Configuration
SGLN1145 | With GPS Receiver 1 Primary = Local GPS 0
Backup = HSO 2or18
SGLN4132 | Without GPS Receiver 2 Primary = Remote GPS 1
Backup = HSO 2or18
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Takes Too Long for CSM to Come INS

This problem may be caused by a delay in GPS acquisition. Check the
accuracy flag status and/or current position. Refer to the GSM system
time/GPS and HSO verification section in Chapter 3. At least one
satellite should be visible and tracked for the “surveyed” mode and four
satellites should be visible and tracked for the “estimated” mode. Also,
verify correct base site position data used in “surveyed” mode.
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Troubleshooting: C—CCP Backplane

Introduction

Connector Functionality

The C—CCP backplane is a multi-layer board that interconnects all the
C—CCP modules. The complexity of this board lends itself to possible
improper diagnoses when problems occur.

The following connector overview describes the major types of

backplane connectors along with the functionality of each. This

information allows the CFE to:

* Determine which connector(s) is associated with a specific problem
type.

¢ Jsolate problems to a specific cable or connector.

Primary “A” and Redundant “B” Inter Shelf Bus
Connectors

The 40 pin Inter Shelf Bus (ISB) connectors provide an interface bus
from the master GLI to all other GLIs in the modem frame. Their basic
function is to provide clock synchronization from the master GLI to all
other GLIs in the frame.

The ISB also provides the following functions:
* Span line grooming when a single span is used for multiple cages.
* MMI connection to/from the master GLI to cell site modem.

* Interface between GLIs and the AMR (for reporting BTS alarms).

Span Line Connector

The 50—pin span line connector provides a primary and secondary (if
used) span line interface to each GLI in the C—CCP shelf. The span line
is used for MM/EMX switch control of the Master GLI and also all the
BBX traffic.

Primary “A” and Redundant “B” Reference Distribution
Module Input/Output

The Reference Distribution Module (RDM) connectors route the 3 MHz
reference signals from the CSMs to the GLIs and all BBXs in the
backplane. The signals are used to phase lock loop all clock circuits on
the GLIs and BBX boards to produce precise clock and signal
frequencies.

Power Input (Return A, B, and C connectors)

For —48 V configuration — Provides a —48 volt input for use by the
power supply modules.

For +27 V configuration — Provides input for regulated +27 Volts.

6-14 1X SC 4812T-MC Multicarrier BTS Optimization/ATP Sept 2003



68P64115A21-B Troubleshooting: C—-CCP Backplane

Power Supply Interface

Each C—CCP power supply has a series of three different connectors to
provide the needed inputs/outputs to the C—CCP backplane. These
include a VCC/Ground input connector, a Harting style multiple pin
interface, and a +15 V/Analog Ground output connector. The C—CCP
Power Supplies convert +27 Volts to a regulated +15, +6.5, and +5.0
Volts to be used by the C—CCP shelf cards.

For —48V BTS only, the power supply modules convert —48 Volts to a
regulated +27 Volts.

GLI Connector

This connector consists of a Harting 4SU digital connector and a
6—conductor coaxial connector for RDM distribution. The connectors
provide inputs/outputs for the GLIs in the C—CCP backplane.

GLI 10Base-2 Ethernet “A” and “B” Connections

These BNC connectors are located on the C—CCP backplane and routed
to the GLI board. This interface provides all the control and data
communications between the master GLI and the other GLI, between
gateways, and for the LMF on the LAN.

BBX Connector

Each BBX connector consists of a Harting 2SU/1SU digital connector
and two 6—conductor coaxial connectors. These connectors provide DC,
digital, and RF inputs/outputs for the BBXs in the C—CCP backplane.

MCIO Connectors

* RX RF antenna path signal inputs are routed through RX Tri-Filters
(on the I/O plate), and via coaxial cables to the two MPC modules —
the six “A” (main) signals go to one MPC; the six “B” (diversity) to
the other. The MPC outputs the low—noise—amplified signals via the
C—CCP backplane to the MCIO where the signals are split and sent to
the appropriate BBX.

* A digital bus then routes the baseband signal through the BBX, to the
backplane, then on to the MCC slots.

* Digital TX antenna path signals originate at the MCCs. Each output
is routed from the MCC slot via the backplane appropriate BBX.

e TX RF path signal originates from the BBX, through the backplane to
the MCIO, through the MCIO, and via multi-conductor coaxial
cabling to the PAs in the PA shelf.

C-CCP Backplane Troubleshooting Procedure

[Jable 6-15 througlFable 6-24 provide procedures for troubleshooting
problems that appear to be related to a defective C—CCP backplane. The
tables are broken down into possible problems and steps that should be
taken in an attempt to find the root cause.

NOTE IMPORTANT[Jable 6-15 througlyjable 6-24 must be completed
before replacing ANY C—CCP backplane.
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Digital Control Problems

No GLI Control via LMF (all GLIs)

Follow the procedure iqj"able 6-15 to troubleshoot a GLI control via
LMEF failure.

Table 6-15: No GLI Control via LMF (all GLIs)

v~ Step Action

Check the 10Base-2 ethernet connector for proper connection, damage, shorts, or opens.

Verify the C—CCP backplane Shelf ID DIP switch is set correctly.

Visually check the master GLI connector (both board and backplane) for damage.

Replace the master GLI with a known good GLI.

No GLI Control through Span Line Connection (All GLlIs)

Follow the procedures iqj"able 6-16 an¢-Jable 6-17 to troubleshoot GLI
control failures.

Table 6-16: No GLI Control through Span Line Connection (Both GLIs)

Step Action
1 Verify the C—CCP backplane Shelf ID DIP switch is set correctly.
2 Verify that the BTS and GLIs are correctly configured in the OMCR/CBSC data base.
3 Visually check the master GLI connector (both board and backplane) for damage.
4 Replace the master GLI with a known good GLI.
5 Check the span line inputs from the top of the frame to the master GLI for proper connection and
damage.
6 Check the span line configuration on the MGLI (seqJable 5-4 on pagq3-5).
Table 6-17: MGLI Control Good — No Control over Co—located GLI
Step Action
1 Verify that the BTS and GLIs are correctly configured in the OMCR CBSC data base.
2 Check the 10Base—2 ethernet connector for proper connection, damage, shorts, or opens.
3 Visually check all GLI connectors (both board and backplane) for damage.
4 Replace the remaining GLI with a known good GLI.
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No AMR Control (MGLI good)

Perform the procedure imrJable 6-18 to troubleshoot an AMR control
failure when the MGLI control is good.

Table 6-18: MGLI Control Good — No Control over AMR
Step Action

1 Visually check the master GLI connector (both board and backplane) for damage.
2 Replace the master GLI with a known good GLI.
3 Replace the AMR with a known good AMR.

No BBX Control in the Shelf — (No Control over
Co-located GLlIs)

Perform the procedure iqj"able 6-19 to troubleshoot a BBX control in
the shelf failure.

Table 6-19: No BBX Control in the Shelf — No Control over Co—located GLIs

Step Action

1 Visually check all GLI connectors (both board and backplane) for damage.

Replace the remaining GLI with a known good GLI.

Visually check BBX connectors (both board and backplane) for damage.

AW

Replace the BBX with a known good BBX.

No (or Missing) Span Line Traffic

Perform the procedure irﬂ" able 6-20 to troubleshoot a span line traffic
failure.

Table 6-20: MGLI Control Good — No (or Missing) Span Line Traffic

Step Action

1 Visually check all GLI connectors (both board and backplane) for damage.

Replace the remaining GLI with a known good GLI.

Visually check all span line distribution (both connectors and cables) for damage.

If the problem seems to be limited to one BBX, replace the MGLI with a known good MGLI.

Perform the BTS Span Parameter Configuration ( seqFable 5-4 on pagq3-5).

QN N B W N

Ensure that ISB cabling is correct.
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No (or Missing) MCC Channel Elements

Perform the procedure iqj"able 6-21 to troubleshoot a channel elements

failure.

Table 6-21: No MCC Channel Elements

Step Action
1 Verify CEs on a co-located MCC (MCC24 TYPE=2).
2 If the problem seems to be limited to one MCC, replace the MCC with a known good MCC.
— Check connectors (both board and backplane) for damage.
3 If no CEs on any MCC:
— Verity clock reference to MCIO.
4 Check the CDF for MCCTYPE=2 (MCC24E); MCCTYPE=0 (MCCS8E) or MCCTYPE=3 (MCC-1X)
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DC Power Problems

Perform the procedure irﬂ" able 6-22 to troubleshoot a DC input voltage
to power supply module failure.

WARNING Potentially lethal voltage and current levels are routed to the
BTS equipment. This test must be carried out with a second
person present, acting in a safety role. Remove all rings, jewelry,
and wrist watches prior to beginning this test.

No DC Input Voltage to Power Supply Module

Table 6-22: No DC Input Voltage to Power Supply Module

Step Action

1 Verify DC power is applied to the BTS frame.

2 Verify there are no breakers tripped.

* IMPORTANT
If a breaker has tripped, remove all modules from the applicable shelf supplied by the breaker and
attempt to reset it.

— If the breaker trips again, there is probably a cable or breaker problem within the frame.
— If the breaker does not trip, there is probably a defective module or sub—assembly within the shelf.
Verify that the C—CCP shelf breaker on the BTS frame breaker panel is functional.

Use a voltmeter to determine if the input voltage is being routed to the C—CCP backplane by
measuring the DC voltage level on the PWR_IN cable.

— If the voltage is not present, there is probably a cable or breaker problem within the frame.

— If the voltage is present at the connector, reconnect and measure the level at the “VCC” power
feed clip on the distribution backplane.

— If the voltage is correct at the power clip, inspect the clip for damage.

5 —48 V configuration only — If everything appears to be correct, visually inspect the power supply
module and verify LEDs are green.

6 —48 V configuration only — If LED is red, then replace the power suppy module with a known good
module and verify LEDs are green.

7 If steps%]] througl fail to indicate a problem, a C—CCP backplane failure (possibly an open trace) has
occurred.
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No DC Voltage (+5, +6.5, or +15 Volts) to a Specific GLI,
BBX, or Switchboard

Perform the procedure irﬂ" able 6-23 to troubleshoot a DC input voltage
to GLI, BBX, or Switchboard failure.

Table 6-23: No DC Input Voltage to any C—CCP Shelf Module

Step Action
1 Verify the steps irjable 6-22 have been performed.
2 Inspect the defective board/module (both board and backplane) connector for damage.
3 Replace suspect board/module with known good board/module.

TX and RX Signal Routing Problems

Perform the procedure irﬂ" able 6-24 to troubleshoot TX and RX signal
routing problems.

Table 6-24: TX and RX Signal Routing Problems

Step

Action

Inspect all Harting Cable connectors and back—plane connectors for damage in all the affected board
slots.

Perform steps in the RF path troubleshooting flowchart in this manual.

6-20
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Troubleshooting: Span Control Link

Span Problems (No Control Link)

Perform the procedure iqj"able 6-25 to troubleshoot a control link
failure.

Table 6-25: Troubleshoot Control Link Failure

| Step

Action

Connect the CDMA LMF computer to the MMI port on the applicable MGLI/GLI as shown in
igure 6-1 orfjigure 6-2.

Start an MMI communication session with the applicable MGLI/GLI by using the Windows
desktop shortcut icon.

Once the connection window opens, press the CDMA LMF computer Enter key until the GLI
prompt is obtained.

At the GLT prompt, enter:
config ni current <cr> (equivalent of span view command)
The system will respond with a display similar to the following:

The frame format in flash is set to use T1_2.
Equalization:

Span A — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span B — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span — Default (0-131 feet for T1/J1, 120 Ohm for E1)
Span Default (0-131 feet for T1/J1, 120 Ohm for E1)
Span — Default (0-131 feet for T1/J1, 120 Ohm for E1)
(

Span — Default (0-131 feet for T1/J1, 120 Ohm for E1)

HE OO
I

Linkspeed: Default (56K for T1 D4 AMI, 64K otherwise)
Currently, the link is running at the default rate
The actual rate is 0

NOTE

Defaults for span equalization are 0—131 feet for T1/J1 spans and 120 Ohm for E1.

Default linkspeed is 56 kbps for T1 D4 AMI spans and 64 kbps for all other types.

There is no need to change from defaults unless the OMC-R/CBSC span configuration requires it.

The span configurations loaded in the GLI must match those in the OMCR/CBSC database for the
BTS. If they do not, proceed tqFable 6-26.

Repeat stepg througl3 for all remaining GLIs.

If the span settings are correct, verify the edlc parameters using the show command.
Any alarm conditions indicate that the span is not operating correctly.

* Try looping back the span line from the DSX panel back to the MM, and verify that the looped
signal is good.

¢ Listen for control tone on the appropriate timeslot from the Base Site and MM.

Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then Exit from the dropdown menu.

If no TCHs in groomed MCCs (or in whole SCCP shelf) can process calls, verify that the ISB
cabling is correct and that ISB A and ISB B cables are not swapped.
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Figure 6-1: GLI2 Board MMI Connection Detail
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Figure 6-2: GLI3 Board MMI Connection Detail
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Set BTS Site Span Configuration

Perform the procedure iqj"able 6-26 to set the span parameter
configuration.

NOTE IMPORTANT: Perform the following procedure ONLY if span
configurations loaded in the MGLI/GLIs do not match those in
the OMCR/CBSC data base, AND ONLY when the exact
configuration data is available. Loading incorrect span
configuration data will render the site inoperable.

Table 6-26: Set BTS Span Parameter Configuration

v~ Step Action
1 If not previously done, connect the CDMA LMF computer to the MMI port on the applicable
MGLI/GLI as shown irffjigure 6-1.
2 If there is no MMI communication session in progress with the applicable MGLI/GLI, initiate one
by using the Windows desktop shortcut icon.
3 At the GLT prompt, enter:
config ni format <option> <cr>
The terminal will display a response similar to the following:
COMMAND SYNTAX: config ni format option
Next available options:
LIST — option : Span Option
El1 1 : El_1 — E1 HDB3 CRC4 no TS16
El 2 : El 2 — E1 HDB3 no CRC4 no TS16
El 3 : E1_3 — E1 HDB3 CRC4 TS16
El 4 : El_ 4 — E1 HDB3 no CRC4 TS16
T1 1 : T1_1 — D4, AMI, No ZCS
T1 2 : T1 2 — ESF, B8ZS
Jl_ 1 : Jl1_1 — ESF, B8ZS (Japan) — Default
Jl 2 : J1 2 — ESF, B8ZS
Tl 3 : Tl 3 — D4, AMI, ZCS
>
NOTE
With this command, all active (in—use) spans will be set to the same format.
4 To set or change the span type, enter the correct option from the list at the entry prompt (>), as
shown in the following example:
> T1_2 <cr>
NOTE
The entry is case—sensitive and must be typed exactly as it appears in the list. If the entry is typed
incorrectly, a response similar to the following will be displayed:
CP: Invalid command
GLI>
... continued on next page
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[Table 6-26: Set BTS Span Parameter Configuration

v~ Step Action
5 An acknowledgement similar to the following will be displayed:
The value has been programmed. It will take effect after the next
reset.
GLI>
6 If the current MGLI/GLI span rate must be changed, enter the following MMI command:
config ni linkspeed <cr>
The terminal will display a response similar to the following:
Next available options:
LIST — 1linkspeed : Span Linkspeed
56K : 56K (default for Tl 1 and T1l_3 systems)
64K : 64K (default for all other span configurations)
>
NOTE
With this command, all active (in—use) spans will be set to the same linkspeed.
7 To set or change the span linkspeed, enter the required option from the list at the entry prompt (>),
as shown in the following example:
> 64K <cr>
NOTE
The entry is case—sensitive and must be typed exactly as it appears in the list. If the entry is typed
incorrectly, a response similar to the following will be displayed:
CP: Invalid command
GLI>
8 An acknowledgement similar to the following will be displayed:
The value has been programmed. It will take effect after the next
reset.
GLI>
9 If the span equalization must be changed, enter the following MMI command:
config ni equal <cr>
The terminal will display a response similar to the following:
COMMAND SYNTAX: config ni equal span equal
Next available options:
LIST — span : Span
a : Span A
b : Span B
c : Span C
d : Span D
e : Span E
f : Span F
>
. .. continued on next page
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[Table 6-26: Set BTS Span Parameter Configuration

Step

Action

10

At the entry prompt (>), enter the designator from the list for the span to be changed as shown in
the following example:

> a <cr>
The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni equal a equal
Next available options:

LIST — equal : Span Equalization

: 0—131 feet (default for T1/J1)

: 132262 feet
: 263-393 feet
: 394-524 feet
: 525—655 feet
: LONG HAUL
75 OHM
120 OHM (default for E1)

No ok WN P O
T . .

>

11

At the entry prompt (>), enter the code for the required equalization from the list as shown in the
following example:

>0 <cr>
The terminal will display a response similar to the following:

>0

The value has been programmed. It will take effect after the next
reset.

GLI>

12

Repeat stequ througl}jl for each in—use span.

13

NOTE

After executing the config ni format, config ni linkspeed, and/or config ni equal commands,
the affected MGLI/GLI board MUST be reset and reloaded for changes to take effect.

Although defaults are shown, always consult site specific documentation for span type and
linkspeed used at the site.

Press the RESET button on the MGLI/GLI for changes to take effect.

... continued on next page

6-26
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[Table 6-26: Set BTS Span Parameter Configuration

v~ Step Action

14 | Once the MGLI/GLI has reset, execute the following command to verify span settings are as
required:
config ni current <cr> (equivalent of span view command)
The system will respond with a display similar to the following:
The frame format in flash is set to use T1_2.
Equalization:

Span A — 0-—-131 feet
Span B — 0—131 feet

Span C — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span D — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span E — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span F — Default (0-131 feet for T1/J1, 120 Ohm for El)

Linkspeed: 64K
Currently, the link is running at 64K
The actual rate is 0

15 | If the span configuration is not correct, perform the applicable step from this table to change it and
repeat stepy}3 and34 to verify required changes have been programmed.

16 Return to steqj ofj"able 6-25.
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Module Front Panel LED Indicators and Connectors

Module Status Indicators

Each of the non-passive plug-in modules has a bi-color (green & red)
LED status indicator located on the module front panel. The indicator is
labeled PWR/ALM. If both colors are turned on, the indicator is yellow.

Each plug-in module, except for the fan module, has its own alarm
(fault) detection circuitry that controls the state of the PWR/ALM LED.

The fan TACH signal of each fan module is monitored by the AMR.
Based on the status of this signal, the AMR controls the state of the
PWR/ALM LED on the fan module.

LED Status Combinations for All Modules (except GLI, CSM, BBX, MCC)

PWR/ALM LED

The following list describes the states of the module status indicator.
* Solid GREEN — module operating in a normal (fault free) condition.

* Solid RED — module is operating in a fault (alarm) condition due to
electrical hardware failure.

Note that a fault (alarm) indication may or may not be due to a complete
module failure and normal service may or may not be reduced or
interrupted.

DC/DC Converter LED Status Combinations

The PWR CNVTR has alarm (fault) detection circuitry that controls the
state of the PWR/ALM LED. This is true for both the C-CCP and PA
power converters.

PWR/ALM LED

The following list describes the states of the bi-color LED.
* Solid GREEN — module operating in a normal (fault free) condition.

* Solid RED — module is operating in a fault (alarm) condition due to
electrical hardware problem.
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CSM LED Status Combinations

The CSMs include on-board alarm detection. Hardware and
software/firmware alarms are indicated via the front panel indicators (see

Higure 6-3).
Figure 6-3: CSM Front Panel Indicators & Monitor Ports

5o SYNC

o%@“ MONITOR

aE PWR/ALM
£ Indicator

°§@H FREQ

g MONITOR

FW00303

PWR/ALM LED

After the memory tests, the CSM loads OOS—-RAM code from the Flash
EPROM, if available. If not available, the OOS—ROM code is loaded
from the Flash EPROM.

* Solid GREEN — module is INS_ACT or INS_STBY no alarm.

¢ Solid RED — Initial power up or module is operating in a fault (alarm)
condition.

¢ Slowly Flashing GREEN — OOS_ROM no alarm.
* Long RED/Short GREEN — OOS_ROM alarm.

¢ Rapidly Flashing GREEN — OOS_RAM no alarm or INS_ACT in
DUMB mode.

e Short RED/Short GREEN — OOS_RAM alarm.
* Long GREEN/Short RED — INS_ACT or INS_STBY alarm.
* Off —no DC power or on-board fuse is open.

* Solid YELLOW — After a reset, the CSMs begin to boot. During
SRAM test and Flash EPROM code check, the LED is yellow. (If
SRAM or Flash EPROM fail, the LED changes to a solid RED and
the CSM attempts to reboot.)
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FREQ Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the 19.6608 MHz clock generated by the CSM. When
both CSM 1 and CSM 2 are in an in-service (INS) condition, the CSM 2
clock signal frequency is the same as that output by CSM 1.

The clock is a sine wave signal with a minimum amplitude of +2 dBm
(800 mVpp) into a 50 €2 load connected to this port.

SYNC Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the “Even Second Tick” reference signal generated by the
CSMs.

At this port, the reference signal is a TTL active high signal with a pulse
width of 153 nanoseconds.

MMI Connector

Only accessible behind front panel. The RS-232 MMI port connector is
intended to be used primarily in the development or factory
environment, but may be used in the field for debug/maintenance
purposes.

6-30
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Module Front Panel LED Indicators and Connectors

GLI LED Status Combinations

NOTE

GLIs may be GLI2 or GLI3. Either supports the 1X
SC™4812T-MC BTS.

GLI

The GLI module has indicators, controls and connectors as described
below and shown iJable 6-27 (GLI2) and-Fable 6-28 (GLI3).

The operating states of the LEDs are:

ACTIVE

Solid GREEN — GLI is active. This means that the GLI has shelf
control and is providing control of the digital interfaces.

Off — GLI is not active (i.e., Standby). The mate GLI should be active.

MASTER (not on GLI3)
* Solid GREEN — GLI is Master (sometimes referred to as MGLI).
e Off — GLI is non-master (i.e., Slave).

ALARM
e Solid RED — GLI is in a fault condition or in reset.

® While in reset transition, STATUS LED is OFF while GLI is
performing ROM boot (about 12 seconds for normal boot).

* While in reset transition, STATUS LED is ON while GLI is
performing RAM boot (about 4 seconds for normal boot).

e Off — No Alarm.

STATUS

* Flashing GREEN- GLI is in service (INS), in a stable operating
condition.

* On - GLIis in OOS RAM state operating downloaded code.
¢ Off — GLI is in OOS ROM state operating boot code.

SPANS
* Solid GREEN - Span line is connected and operating.

* Solid RED — Span line is disconnected or a fault condition exists.
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68P64115A21-B

GLI Pushbuttons and Connectors

RESET Pushbutton — Depressing the RESET pushbutton causes a
partial reset of the CPU and a reset of all board devices. The GLI2 is

placed in the OOS_ROM state

MMI Connector — The RS—-232MMI port connector is intended to be
used primarily in the development or factory environment but may be
used in the field for debug/maintenance purposes.

LAN Connectors (A & B) — The two 10BASE2 Ethernet circuit board
mounted BNC connectors are located on the bottom front edge of the
GLI2; one for each LAN interface, A & B. Ethernet cabling is connected
to tee connectors fastened to these BNC connectors.

GLI2 Front Panel

[Jable 6-27 shows the front panel of the GLI2 card and includes a

description of the components.

Table 6-27: GLI2 Front Panel

LED

Operating Status

Diagram

STATUS

OFF — operating normally
ON - briefly during power-up when the Alarm LED turns OFF
SLOW GREEN - when the GLI2 is INS (in-service)

RESET

Pressing and releasing the switch resets all functions on the GLI2.

ALARM

OFF — operating normally
ON - briefly during power-up when the Alarm LED turns OFF
SLOW GREEN - when the GLI2 is INS (in-service)

SPANS

OFF — card is powered down, in initialization, or in standby

GREEN - operating normally

YELLOW - one or more of the equipped initialized spans is receiving
a remote alarm indication signal from the far end

RED - one or more of the equipped initialized spans is in an alarm
state

MASTER

The pair of GLI2 cards include a redundant status. The card in the top
shelf is designated by hardware as the active card; the card in the
bottom shelf is in the standby mode.

ON - operating normally in active card
OFF — operating normally in standby card

MMI

An RS-232, serial, asynchronous communications link for use as an
MMI port. This port supports 300 baud, up to a maximum of 115,200
baud communications.

ACTIVE

Shows the operating status of the redundant cards. The redundant card
toggles automatically if the active card is removed or fails

ON - active card operating normally
OFF - standby card operating normally

STATUSLED ——1|

RESET
PUSHBUTTON

ALARM LED —>]

SPANSLED — ]

MASTER LED ————> |

MMIPORT —— | I

CONNECTOR

ACTIVELED — 1]

SN1VLS

o

HILSVIN SNVdS WHVYIY 13834

INWN

JAILLOVY
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GLI3 Front Panel

[Jable 6-28 shows the front panel of the GLI3 card and includes a
description of the components.

Table 6-28: GLI3 Front Panel

LED Operating Status Diagram

BPR A Connects to either a BPR or expansion cage and is wired as an
ethernet client.

BPR B Connects to either a BPR or expansion cage and is wired as an
ethernet client.

AUX Wired as an ethernet client for direct connection to a personal
computer with a standard ethernet cable. It allows connection of
ethernet “sniffer” when the ethernet switch is properly configured
for port monitoring.

[

GLI Supports the cross—coupled ethernet circuits to the mate GLI using
a double crossover cable.

vV Hdg

100BASE-T to BTS Packet

RESET Pressing and releasing the switch resets all functions on the GLI3. Router or Expansion cage

ALARM | OFF - operating normally
ON - briefly during power-up when the Alarm LED turns OFF
SLOW GREEN — when the GLI3 is INS (in-service)

100BASE-T Auxiliary
i Monitor Port

XNy

fatars

SPAN OFF — card is powered down, in initialization, or in standby
GREEN - operating normally
YELLOW - one or more of the equipped initialized spans is

| Dual 100BASE-T in a single
RJ45 to Redundant (Mate)
GLI3

£o

receiving a remote alarm indication signal from the far end 7 G Reset Switch
RED - one or more of the equipped initialized spans is in an alarm 8,7,
state éE‘}’C‘,\H Span (LED)
. .. . = | Alarm (LED)
MMI An RS-232, serial, asynchronous communications link for use as an Elde——— MMI Port

MMI port. This port supports 300 baud, up to a maximum of

7] 2 .
115,200 baud communications. QG Active (LED)

Status (LED)

STATUS | OFF - operating normally
ON - briefly during power-up when the Alarm LED turns OFF
SLOW GREEN — when the GLI3 is INS (in-service)

ACTIVE | Shows the operating status of the redundant cards. The redundant
card toggles automatically if the active card is removed or fails

ti-CDMA-WP-00064-v01-ildoc-ftw

ON - active card operating normally
OFF - standby card operating normally
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BBX LED Status Combinations

PWR/ALM LED

The BBX module has its own alarm (fault) detection circuitry that
controls the state of the PWR/ALM LED.

The following list describes the states of the bi-color LED:
* Solid GREEN — INS_ACT no alarm

¢ Solid RED Red - initializing or power-up alarm

¢ Slowly Flashing GREEN — OOS_ROM no alarm

* Long RED/Short GREEN — OOS_ROM alarm

¢ Rapidly Flashing GREEN — OOS_RAM no alarm

e Short RED/Short GREEN — OOS_RAM alarm

* Long GREEN/Short RED — INS_ACT alarm

PA Shelf LED Status Combinations

PA Module LED

Each PA module contains a bi—color LED just above the MMI connector
on the front panel of the module. Interpret this LED as follows:

* GREEN — PA module is active and is reporting no alarms (Normal
condition).

* Flashing GREEN/RED — PA module is active but is reporting an low
input power condition. If no BBX is keyed, this is normal and does
not constitute a failure.
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Module Front Panel LED Indicators and Connectors

MCC LED Status Combinations

Figure 6-4: MCC Front Panel

PWR/ALM LED ———{]

ACTIVE LED — 1]

INTV/HMd

JAILOV

| LENS

(REMOVABLE) bus inactive on power-up

The MCC module has LED indicators and connectors as described
below (seqjigure 6-4). Note that the figure does not show the
connectors as they are concealed by the removable lens.

The LED indicators and their states are as follows:

PWR/ALM LED
e RED - fault on module

ACTIVE LED

¢ Off — module is inactive, off-line, or not processing traffic.

¢ Slowly Flashing GREEN — OOS_ROM no alarm.

¢ Rapidly Flashing Green — OOS_RAM no alarm.

¢ Solid GREEN — module is INS_ACT, on-line, processing traffic.

PWR/ALM and ACTIVE LEDs

* Solid RED — module is powered but is in reset or the BCP is inactive.

MMI Connectors

* The RS-232 MMI port connector (four-pin) is intended to be used
primarily in the development or factory environment but may be used
in the field for debugging purposes.

* The RJ-11 ethernet port connector (eight-pin) is intended to be used

primarily in the development environment but may be used in the field
for high data rate debugging purposes.

LED COLOR OPERATING STATUS

PWR/ALM RED OFF — operating normally

ON — briefly during power-up and during failure
conditions

An alarm is generated in the event of a failure

ACTIVE GREEN | RAPIDLY BLINKING — Card is code-loaded but
not enabled

SLOW BLINKING — Card is not code-loaded

ON — card is code-loaded and enabled
(INS_ACTIVE)

RED ON — fault condition
SLOW FLASHING (alternating with green) — CHI

Sept 2003

1X SC 4812T-MC Multicarrier BTS Optimization/ATP 6-35




-l

Module Front Panel LED Indicators and Connectors

68P64115A21-B

Notes
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Optimization (Pre—ATP) Data Sheets for Multicarrier

68P64115A21-B

Optimization (Pre—ATP) Data Sheets for Multicarrier

Verification of Test Equipment Used

Table A-1: Verification of Test Equipment Used

Manufacturer

Model

Serial Number

Comments:

A-2
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68P64115A21-B Optimization (Pre—ATP) Data Sheets for Multicarrier

Site Checklist A

Table A-2: Site Checklist

OK Parameter Specification Comments
] | Deliveries Per established procedures
(] | Floor Plan Verified

Inter Frame Cables:
| Ethernet Per procedure
| Frame Ground Per procedure
U Power Per procedure

Factory Data:
| BBX Per procedure
U Test Panel Per procedure
[ | Site Temperature
L] | Dress Covers/Brackets

Comments:

Preliminary Operations

Table A-3: Preliminary Operations
OK Parameter Specification Comments
] | Shelf ID Dip Switches Per site equipage
(L | BBX Jumpers Verified per procedure
] | Ethernet LAN verification Verified per procedure
Comments:
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ﬁ Pre—Power and Initial Power Tests
Table A-4: Pre—power Checklist
OK Parameter Specification Comments
] | Pre—power—up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications
Internal Cables:
U ISB (all cages) verified
U CSM (all cages) verified
U Power (all cages) verified
Ethernet Connectors
U LAN A ohms verified
U LAN B ohms verified
U LAN A shield isolated
U LAN B shield isolated
U Ethernet Boots installed
L] | Air Impedance Cage (single cage) installed
[ | Initial power—up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications:
Comments:
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Optimization (Pre—ATP) Data Sheets for Multicarrier

General Optimization Checklist

Table A-5: Pre—power Checklist

OK Parameter Specification Comments
(1 | LEDs illuminated
] | Frame fans operational

LMF to BTS Connection
| Preparing the LMF per procedure
U Log into the LMF PC per procedure
| Create site specific BTS directory per procedure
| Create master—bts—cdma directory per procedure
| Download device loads per procedure
| Moving/Linking files per procedure
] | PingLANA per procedure
(] | PingLANB per procedure
(1] | Download/Enable MGLIs per procedure
(] | Download/Enable GLIs per procedure
L] | Set Site Span Configuration per procedure
] | Download CSMs per procedure
(] | Download per procedure
] | Enable CSMs per procedure
1] | Download/Enable MCCs per procedure
] | Download BBXs per procedure
] | Test Set Calibration per procedure
Comments:
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68P64115A21-B

GPS Receiver Operation

Table A-6: GPS Receiver Operation

OK Parameter Specification Comments

L1 | GPS Receiver Control Task State: Verify parameter
tracking satellites

[ | Initial Position Accuracy: Verify Estimated

or Surveyed

] | Current Position: RECORD in ms
lat and cm also
lon convert to deg
height min sec

L] | Current Position: satellites tracked Verify parameter
Estimated: as appropriate:
(>4) satellites tracked,(>4) satellites visible
Surveyed:
(>1) satellite tracked,(>4) satellites visible

L1 | GPS Receiver Status:Current Dilution of Verify parameter
Precision
(PDOP or HDOP): (<30)

U Current reference source: Verify parameter
Number: 0; Status: Good; Valid: Yes

Comments:
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PA IM Reduction A
Table A-7: PA IM Reduction — TX Filter
oK P: 3_Sect°(;‘arrie;_5 ctor | Specification Comments
ad 1A Cl1 C1 No Alarms
J 1B Cl1 C1 No Alarms
ad | 1C Cl1 C1 No Alarms
J | 1D Cl1 C1 No Alarms
J | 2A C2 C2 No Alarms
J 2B C2 C2 No Alarms
e C2 C2 No Alarms
J 2D C2 C2 No Alarms
d | 3A C3 C1 No Alarms
J 3B C3 C1 No Alarms
d | 3C C3 C1 No Alarms
J 3D C3 C1 No Alarms
d [ 4A C4 C2 No Alarms
J 4B C4 C2 No Alarms
d | 4C C4 C2 No Alarms
d 4D C4 C2 No Alarms

Comments:
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PA Convergence

Table A-8: PA Convergence (Multicarrier grouping)

OK | PA # Converged Specification Data
| 1A Verify per procedure & upload
0 A convergence data
| 3A
O 4A
| 1B Verify per procedure & upload
0 B convergence data
| 3B
O 4B
| 1C Verify per procedure & upload
0 2C convergence data
| 3C
O 4C
| 1D Verify per procedure & upload
0 D convergence data
| 3D
O 4D
Comments:
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Optimization (Pre—ATP) Data Sheets for Multicarrier

TX Bay Level Offset/Power Output Verification for 3—Sector Configurations

1-Carrier

2—Carrier Non—adjacent Channels
4—Carrier Non—adjacent Channels

Table A-9: TX BLO Calibration (3—Sector: 1; 2; and 4—Carrier Non—adjacent Channels)
OK | Parameter Specification Comments

BBX-1, ANT-1 = dB

- BBX-r, ANT-1 = dB

Calibrate | TX Bay Level Offset = 40 dB (+5 dB) | BBX-2, ANT-2=__ dB

. carrier 1 prior to calibration BBX-r, ANT-2 = dB

BBX-3, ANT-3 = dB

- BBX-r, ANT-3 = dB

BBX-7, ANT-1 = dB

- BBX-r, ANT-1 = dB

Calibrate | TX Bay Level Offset = 40 dB (+5 dB) | BBX-8, ANT-2=__ dB

. carrier 2 | prior to calibration BBX-r, ANT-2 = dB

BBX-9, ANT-3 = dB

- BBX-r, ANT-3 = dB

BBX—4, ANT-1 = dB

- BBX-r, ANT-1 = dB

Calibrate | TX Bay Level Offset = 40 dB (+5 dB) | BBX-5,ANT-2=__ dB

d carrier 3 prior to calibration BBX-r, ANT-2 = dB

BBX-6, ANT-3 = dB

a BBX-r, ANT-3= _ dB

BBX-10, ANT-1= __dB

- BBX-1, ANT-1 = dB

Calibrate | TX Bay Level Offset = 40 dB (+5 dB) | BBX-11, ANT-2=__ dB

d carrier 4 prior to calibration BBX-r, ANT-2 = dB

BBX-12, ANT-3= __ dB

- BBX-r, ANT-3 = dB

BBX-1, ANT-1 = dB

- BBX-r, ANT-1 = dB

Cagbr(ail.ttlon 0 dB (+0.5 dB) for gain set resolution | BBX-2, ANT-2=__ dB

u uct post calibration BBX-1, ANT-2 = dB
carrier 1 -

BBX-3, ANT-3 = dB

- BBX-r, ANT-3 = dB

... continued on next page
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A
Table A-9: TX BLO Calibration (3—Sector: 1; 2; and 4—Carrier Non—adjacent Channels)
. OK | Parameter Specification Comments
BBX-7, ANT-1 = dB
a BBX-1, ANT-1 = dB
Cagbr(ail.ttlon 0 dB (+0.5 dB) for gain set resolution | BBX-8, ANT-2=__ dB
u ut post calibration BBX-1, ANT-2 = dB
carrier 2
BBX-9, ANT-3 = dB
a BBX-r, ANT-3 = dB
BBX-4, ANT-1 = dB
a BBX-1, ANT-1 = dB
Cagbr(ailittlon 0 dB (+0.5 dB) for gain set resolution | BBX=5, ANT-2=__ dB
u u post calibration BBX-1, ANT-2 = dB
carrier 3 —
BBX-6, ANT-3 = dB
a BBX-r, ANT-3= __ dB
BBX-10, ANT-1=__ dB
a BBX-1, ANT-1 = dB
Cagbr(ail.ttlon 0 dB (+0.5 dB) for gain set resolution | BBX-11, ANT-2=__ dB
u uct post calibration BBX-r, ANT-2 = dB
carrier 4 -
BBX-12, ANT-3=__ dB
a BBX-r, ANT-3= __ dB
Comments:
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Optimization (Pre—ATP) Data Sheets for Multicarrier

2—Carrier Adjacent Channel

Table A-10: TX Bay Level Offset Calibration (3—Sector: 2—Carrier Adjacent Channels)

OK | Parameter Specification Comments

BBX-1, ANT-1 = dB

- BBX-r, ANT-1 = dB

Calibrate | TX Bay Level Offset = 40 dB (typical), BBX-2, ANT-2=__ dB

u carrier 1 35 dB (minimum) prior to calibration BBX-1, ANT-2 = dB

BBX-3, ANT-3 = dB

- BBX-r, ANT-3 = dB

BBX-7, ANT-4 = dB

- BBX-r, ANT—4 = dB

Calibrate | TX Bay Level Offset = 40 dB (typical), BBX-8, ANT-5=__ dB

u carrier 2 35 dB (minimum) prior to calibration BBX-1, ANT-5 = dB

BBX-9, ANT-6 = dB

- BBX-r, ANT-6 = dB

BBX-1, ANT-1 = dB

- BBX-r, ANT-1 = dB

Cagbr(ailittlon 0 dB (+0.5 dB) for gain set resolution BBX-2, ANT-2 = dB

u u post calibration BBX-1, ANT-2 = dB
carrier 1 -

BBX-3, ANT-3 = dB

- BBX-r, ANT-3 = dB

BBX-7, ANT-4 = dB

- BBX-r, ANT—4 = dB

0 Caglzlr(ailittlon 0 dB (+0.5 dB) for gain set resolution BBX-8, ANT-5 = dB

carrier 2. post calibration BBX-1, ANT-5 = dB

BBX-9, ANT-6 = dB

- BBX-r, ANT-6 = dB

Comments:
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3—Carrier Adjacent Channels
4—Carrier Adjacent Channels

Table A-11: TX Bay Level Offset Calibration (3—Sector: 3 or 4—Carrier Adjacent Channels)

OK | Parameter Specification Comments

BBX-1,ANT-1=___ dB

a BBX-r, ANT-1=____ dB

0 Calibrate | TX Bay Level Offset = 40 dB (+5 dB) | BBX-2, ANT-2=__ dB

carrier 1 prior to calibration BBX-r, ANT-2=_ dB

BBX-3, ANT-3= ___dB

a BBX-r, ANT-3= ___ dB

BBX-7, ANT-1=___ dB

- BBX-r, ANT-1= ___dB

o | Caibraic | TX Bay Level Offsct = 40 dB (&5 dB) BBX-8, ANT-2=___ dB

carrier 2 | prior to calibration BBX-r, ANT-2=___ dB

BBX-9, ANT-3=__ dB

- BBX-r, ANT-3= ___dB

BBX-4, ANT-4=___ dB

a BBX-r, ANT-4= __ dB

0 Calibrate | TX Bay Level Offset = 40 dB (+5 dB) | BBX-5,ANT-5=__ dB

carrier 3 | prior to calibration BBX-1, ANT-5=_ dB

BBX-6, ANT-6=____dB

a BBX-r, ANT-6= ___dB

BBX-10, ANT-4=__ dB

. BBX-3, ANT-4= _ dB

0 Calibrate | TX Bay Level Offset = 40 dB (+5 dB) | BBX-11, ANT-5=__ dB

carrier 4 | prior to calibration BBX-r, ANT-5=___ dB

BBX-12, ANT-6=__ dB

a BBX-r, ANT-6= ___dB

BBX-1,ANT-1=___ dB

. BBX-r, ANT-1= B

CalibraF ion 0 dB (+0.5 dB) for gain set resolution | BBX-2, ANT-2=__ dB

u Au.dlt post calibration BBX-r. ANT-2 = dB
carrier 1 > -

BBX-3,ANT-3=___ dB

- BBX-r, ANT-3= ___dB

. .. continued on next page
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Optimization (Pre—ATP) Data Sheets for Multicarrier

[Table A-11: TX Bay Level Offset Calibration (3—Sector: 3 or 4—Carrier Adjacent Channels)

OK | Parameter Specification Comments

BBX-7,ANT-1=__ dB

a BBX-1, ANT-1=__ dB
0 Caglzlr(ailittlon 0 dB (+0.5 dB) for gain set resolution | BBX-8, ANT-2=___dB
carrier 2. post calibration BBX-r, ANT-2= _ dB
BBX-9, ANT-3=__ dB

a BBX-r, ANT-3=_ dB
BBX-4, ANT-4=__ dB

a BBX-1, ANT-4=__ dB
0 Caglzlr(ailittlon 0 dB (+0.5 dB) for gain set resolution | BBX-5, ANT-5=___ dB
carrier 3 post calibration BBX-r, ANT-5= _ dB
BBX-6, ANT-6=__ dB

a BBX-r, ANT-6=_ dB
BBX-10, ANT-4=__ dB

a BBX-1, ANT-4=__ dB
0 Caglzlr(ailittlon 0 dB (+0.5 dB) for gain set resolution | BBX-11, ANT-5=___dB
carrier 4 post calibration BBX-r, ANT-5=  dB
BBX-12, ANT-6=__ dB

a BBX-r, ANT-6=_ dB

Comments:
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TX Bay Level Offset/Power Output Verification for 6-Sector Configurations

1-Carrier

2—Carrier Non—adjacent Channels

Table A-12: TX BLO Calibration (6—Sector: 1-Carrier, 2—Carrier Non—adjacent Channels)
OK | Parameter Specification Comments

BBX-1,ANT-1=___ dB

a BBX-1, ANT-1=__ dB
BBX-2, ANT-2=__ dB

a BBX-1, ANT-2=_ dB
BBX-3, ANT-3=__ dB

- Calibrate | TX Bay Level Offset = 42 dB (typical), BBX-r, ANT-3=___dB
carrier 1 | 38 dB (minimum) prior to calibration BBX—4, ANT—4 = dB

a BBX-1, ANT-4 = :dB
BBX-5,ANT-5=_ dB

a BBX-r, ANT-5=_ dB
BBX-6, ANT-6=__ dB

a BBX-r, ANT-6=_ dB
BBX-7,ANT-1=__ dB

a BBX-1, ANT-1=__ dB
BBX-8, ANT-2=__ dB

a BBX-1, ANT-2=_ dB
BBX-9, ANT-3=__ dB

- Calibrate | TX Bay Level Offset = 42 dB (typical), BBX-r, ANT-3=___dB
carrier 2 | 38 dB (minimum) prior to calibration BBX-10, ANT—4 = dB

- BBX-3, ANT-4 = :dB
BBX-11, ANT-5=_ dB

a BBX-r, ANT-5=_ dB
BBX-12, ANT-6=__ dB

- BBX-r, ANT-5=_ dB

... continued on next page
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Optimization (Pre—ATP) Data Sheets for Multicarrier

[Table A-12: TX BLO Calibration (6-Sector: 1—-Carrier, 2—Carrier Non—adjacent Channels)

OK | Parameter Specification Comments

BBX-1,ANT-1=___ dB
a BBX-1, ANT-1=___ dB
BBX-2, ANT-2 = dB
a BBX-1, ANT-2 = :dB
BBX-3,ANT-3=___ dB
- Caglzlr(allitson 0 dB (+0.5 dB) for gain set resolution BBX-r, ANT-3=___ dB
. post calibration BBX-4. ANT-4 = dB

0 carrier 1 s o
BBX-1, ANT-4=__ dB
BBX-5, ANT-5=_ dB
a BBX-1, ANT-5=_ dB
BBX-6, ANT-6=__ dB
a BBX-1, ANT-6=___ dB
BBX-7, ANT-1 = dB
a BBX-1, ANT-1 = :dB
BBX-8, ANT-2=__ dB
a BBX-1, ANT-2=___ dB
BBX-9, ANT-3=__ dB
- Caglzlr(allitson 0dB (iQ.5 dB) for gain set resolution BBX-r, ANT-3=___ dB
q carrier 2. post calibration BBX-10, ANT-4= __ dB
BBX-1, ANT-4=__ dB
BBX-11, ANT-5=__ dB
a BBX-1, ANT-5=_ dB
BBX-12, ANT-6=__ dB
a BBX-1, ANT-6=___ dB

Comments:
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BTS Redundancy/Alarm Tests

Table A-13: BTS Redundancy/Alarm Tests

OK Parameter Specification Data
(] |SIF: Misc. alarm tests Verify per procedure
[ |MGLI redundancy test Verify per procedure
(] |GLIredundancy test Verify per procedure
Power supply/converter Verify per procedure
u redundancy
[ |Misc. alarm tests Verify per procedure
CSM & GPS Verify per procedure
- redundancy/alarm tests
[] |PAredundancy test Verify per procedure
Comments:
TX Antenna VSWR
Table A-14: TX Antenna VSWR
OK Parameter Specification Data
VSWR - <(15:1)
- Antenna 1
VSWR - <(15:1)
- Antenna 2
VSWR - <(15:1)
u Antenna 3
VSWR - <(15:1)
u Antenna 4
VSWR - <(15:1)
u Antenna 5
VSWR - <(15:1)
u Antenna 6
Comments:
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RX Antenna VSWR A

Table A-15: RX Antenna VSWR
OK Parameter Specification Data
VSWR - <(15:1)
- Antenna 1
VSWR — <(15:1)
- Antenna 2
VSWR — <(15:1)
| Antenna 3
VSWR — <(15:1)
. Antenna 4
VSWR — <(15:1)
| Antenna 5
VSWR — <(15:1)
3 | Antenna 6
Comments:
AMR Verification
Table A-16: AMR CDI Alarm Input Verification
OK Parameter Specification Data
Verify CDI alarm input BTS Relay #XX —
[] |operation (“ALARM A” Contact Alarm
(numbers 1 -18) Sets/Clears
Verify CDI alarm input BTS Relay #XX —
] |operation (“ALARM B” Contact Alarm
(numbers 19 -36) Sets/Clears
Comments:
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Site Serial Number Check List

Date Site

C-CCP Shelf

Site /O A & B

C-CCP Shelf

CSM-1

CSM-2

HSO

CCD-1

CCD-2

AMR-1

AMR-2

MPC-1

MPC-2

Fans 1-3

GLI-1

GLI-2

BBX-1

BBX-2

BBX-3

BBX—+4

BBX-5

BBX-6

BBX-7

BBX-8

BBX-9

BBX-10

BBX-11

BBX-12

BBX-r

MCC-1

MCC-2

MCC-3

MCC—4

MCC-5

MCC-6

MCC-7

MCC-8

MCC-H

... continued on next page
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MCC-10 A
MCC-11 B
MCC-12
MCIO
SWITCH
C-CCP PS-1
C-CCP PS-2
C-CCP PS-3
Power Amplifiers

Multicarrier Grouping
PA 1A
PA 2A
PA 3A
PA 4A

PA 1B
PA 2B
PA 3B
PA 4B

PA 1C
PA 2C
PA 3C
PA 4C

PA 1D
PA 2D
PA 3D
PA 4D

PLC/SPLC1
PLC/SPLC2
PLC/SPLC3
PLC/SPLC4

ETM1
ETM2

TX Filter 1
TX Filter 2
TX Filter 3

Terminator 1

Terminator 2
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A Power Supply Modules (—48 V Only)

Multicarrier Grouping
PSM#1
PSM#2
PSM#3
PSM#4
PSM#5
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PN Offset/l & Q Offset Register

Programming Information
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PN Offset Programming Information

PN Offset Background

PN Offset Usage

All channel elements transmitted from a BTS in a particular 1.25 MHz
CDMA channel are orthonogonally spread by 1 of 128 possible Walsh
code functions; additionally, they are also spread by a quadrature pair of
PN sequences unique to each sector.

Opverall, the mobile uses this to differentiate multiple signals transmitted
from the same BTS (and surrounding BTS) sectors, and to synchronize
to the next strongest sector.

The PN offset per sector is stored on the BBXs, where the corresponding
I & Q registers reside.

The PN offset values are determined on a per BTS/per sector(antenna)
basis as determined by the appropriate cdf file content. A breakdown of
this information is found iJable B-1.

Only the 14—chip delay is currently in use. It is important to determine
the RF chip delay to be able to test the BTS functionality. This can be
done by ascertaining if the CDF file FineTxAdj value was set to “on”
when the MCC was downloaded with “image data”. The FineTxAdj
value is used to compensate for the processing delay (approximately
20 uS) in the BTS using any type of mobile meeting [S-97
specifications.

If the FineTxAdj value in the cdf file is 213 (D5 HEX), FineTxAdj has
been set for the 74 chip table.

NOTE

CDF file I and Q values can be represented in DECIMAL or
HEX. If using HEX, add Ox before the HEX value. If necessary,
convert HEX values irfable B-1 to decimal before comparing
them to cdf file I & Q value assignments.

B-2
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PN Offset Programming Information

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot I Q I Q
PN (Dec.) (Hex.)
0 17523 23459 4473 5BA3
1 32292 32589 7E24 7F4D
2 4700 17398 125C 43F6
3 14406 26333 3846 66DD
4 14899 4011 3A33 OFAB
5 17025 2256 4281 08D0
6 14745 18651 3999 48DB
7 2783 1094 OADF 0446
8 5832 21202 16C8 52D2
9 12407 13841 3077 3611
10 31295 31767 7A3F 7C17
11 7581 18890 1D9D 49CA
12 18523 30999 485B 7917
13 29920 22420 74E0 5794
14 25184 20168 6260 4EC8
15 26282 12354 66AA 3042
16 30623 11187 779F 2BB3
17 15540 11834 3CB4 2E3A
18 23026 10395 59F2 289B
19 20019 28035 4E33 6D83
20 4050 27399 0FD2 6B07
21 1557 22087 0615 5647
22 30262 2077 7636 081D
23 18000 13758 4650 35BE
24 20056 11778 4E58 2E02
25 12143 3543 2F6F 0DD7
26 17437 7184 441D 1C10
27 17438 2362 441E 093A
28 5102 25840 13EE 64F0
29 9302 12177 2456 2F91
30 17154 10402 4302 28A2
31 5198 1917 144E 077D
32 4606 17708 11FE 452C
33 24804 10630 60E4 2986
34 17180 6812 431C 1A9C
35 10507 14350 290B 380E
36 10157 10999 27AD 2AF7
37 23850 25003 5D2A 61AB
38 31425 2652 7AC1 0A5C
39 4075 19898 OFEB 4DBA
40 10030 2010 272E 07DA
41 16984 25936 4258 6550
42 14225 28531 3791 6F73
43 26519 11952 6797 2EBO
44 27775 31947 6C7F 7CCB
45 30100 25589 7594 63F5
46 7922 11345 1EF2 2C51
47 14199 28198 3777 6E26
48 17637 13947 44E5 367B
49 23081 8462 5A29 210E
50 5099 9595 13EB 257B

.. . continued on next page
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ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot | Q | Q
PN (Dec.) (Hex.)
51 32743 4670 7FE7 123E
52 7114 14672 1BCA 3950
53 7699 29415 1E13 72E7
54 19339 20610 4B8B 5082
55 28212 6479 6E34 194F
56 29587 10957 7393 2ACD
57 19715 18426 4D03 47FA
58 14901 22726 3A35 58C6
59 20160 5247 4ECO 147F
60 22249 29953 56E9 7501
61 26582 5796 67D6 16A4
62 7153 16829 1BF1 41BD
63 15127 4528 3B17 11B0
64 15274 5415 3BAA 1527
65 23149 10294 5A6D 2836
66 16340 17046 3FD4 4296
67 27052 7846 69AC 1EA6
68 13519 10762 34CF 2A0A
69 10620 13814 297¢C 35F6
70 15978 16854 3E6A 41D6
71 27966 795 6D3E 031B
72 12479 9774 30BF 262E
73 1536 24291 0600 5EE3
74 3199 3172 0C7F 0C64
75 4549 2229 11c5 08B5
76 17888 21283 45E0 5323
77 13117 16905 333D 4209
78 7506 7062 1D52 1B96
79 27626 7532 6BEA 1D6C
80 31109 25575 7985 63E7
81 29755 14244 743B 37A4
82 26711 28053 6857 6D95
83 20397 30408 4FAD 76C8
84 18608 5094 48B0 13E6
85 7391 16222 1CDF 3F5E
86 23168 7159 5A80 1BF7
87 23466 174 5BAA 00AE
88 15932 25530 3E3C 63BA
89 25798 2320 64C6 0910
90 28134 23113 6DE6 5A49
91 28024 23985 6D78 5DB1
92 6335 2604 18BF 0A2C
93 21508 1826 5404 0722
94 26338 30853 66E2 7885
95 17186 15699 4322 3D53
96 22462 2589 57BE 0A1D
97 3908 25000 0F44 61A8
98 25390 18163 632E 46F3
99 27891 12555 6CF3 310B
100| 9620 8670 2594 21DE

.. . continued on next page
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ﬂable B-1: PnMask I and PnMask Q Values for PilotPn
14-Chip Delay

Pilot | Q I Q

PN (Dec.) (Hex.)
101| 6491 1290 195B 0504
102| 16876 4407 41EC 1137
103| 17034 1163 428a 048B
104| 32405 12215 7E95 2FB7
105| 27417 7253 6B19 1¢55
106 8382 8978 20BE 2312
107| 5624 25547 15F8 63CB
108 1424 3130 0590 0Cc3a
109 13034 31406 32EA 7AAE
110| 15682 6222 3D42 184E
111| 27101 20340 69DD 4F74
112| 8521 25094 2149 6206
113 30232 23380 7618 5B54
114 6429 10926 191D 2AAE
115| 27116 22821 69EC 5925
116 | 4238 31634 108E 7B92
117| 5128 4403 1408 1133
118 14846 689 39FE 02B1
119| 13024 27045 32E0 69A5
120| 10625 27557 2981 6BA5
121| 31724 16307 7BEC 3FB3
122| 13811 22338 35F3 5742
123| 24915 27550 6153 6BIE
124| 1213 22096 04BD 5650
125 2290 23136 08F2 5260
126 31551 12199 7B3F 2FA7
127| 12088 1213 2F38 04BD
128| 7722 936 1E2A 03A8
129 | 27312 6272 6AB0 1880
130 23130 32446 S5A5A 7EBE
131 594 13555 0252 34F3
132 25804 8789 64CC 2255
133 31013 24821 7925 60F5
134 32585 21068 TF49 524C
135 3077 31891 0CO05 7C93
136 17231 5321 434F 14C9
137| 31554 551 7B42 0227
138| 8764 12115 223C 2F53
139 15375 4902 3COF 1326
140 13428 1991 3474 07¢7
141| 17658 14404 44FA 3844
142| 13475 17982 34A3 463E
143 22095 19566 564F 4C6E
144 | 24805 2970 60E5 0B9A
145 4307 23055 10D3 S5A0F
146 23292 15158 5AFC 3B36
147| 1377 29094 0561 71A6
148 28654 653 6FEE 028D
149 6350 19155 18CE 4AD3
150 16770 23588 4182 5C24

.. . continued on next page
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ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot | Q | Q
PN (Dec.) (Hex.)
151| 14726 10878 3986 2A7E
152| 25685 31060 6455 7954
153| 21356 30875 536C 789B
154 | 12149 11496 2F75 2CES8
155| 28966 24545 7126 5FE1
156| 22898 9586 5972 2572
157 1713 20984 06B1 51F8
158| 30010 30389 753A 76B5
159 | 2365 7298 093D 1c82
160| 27179 18934 6A2B 49F6
161| 29740 23137 742C 5A61
162| 5665 24597 1621 6015
163| 23671 23301 5C77 5B05
164| 1680 7764 0690 1E54
165| 25861 14518 6505 38B6
166 | 25712 21634 6470 5482
167| 19245 11546 4B2D 2D1A
168| 26887 26454 6907 6756
169| 30897 15938 78B1 3E42
170| 11496 9050 2CE8 235A
171 1278 3103 04FE OC1F
172| 31555 758 7B43 02F6
173| 29171 16528 71F3 4090
174| 20472 20375 4FF8 4F97
175| 5816 10208 16B8 27E0
176 | 30270 17698 763E 4522
177| 22188 8405 56AC 20D5
178| 6182 28634 1826 6FDA
179 32333 1951 7E4D 079F
180 | 14046 20344 36DE 4F78
181| 15873 26696 3E01 6848
182| 19843 3355 4D83 0D1B
183| 29367 11975 72B7 2EC7
184 13352 31942 3428 7CcC6
185 22977 9737 59C1 2609
186| 31691 9638 7BCB 25A6
187| 10637 30643 298D 77B3
188| 25454 13230 636E 33AE
189| 18610 22185 48B2 56A9
190| 6368 2055 18E0 0807
191 7887 8767 1ECF 223F
192 7730 15852 1E32 3DEC
193| 23476 16125 5BB4 3EFD
194| 889 6074 0379 17BA
195| 21141 31245 5295 7A0D
196 20520 15880 5028 3E08
197| 21669 20371 54A5 4F93
198| 15967 8666 3ESF 21DA
199| 21639 816 5487 0330
200| 31120 22309 7990 5725

.. . continued on next page
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PN Offset Programming Information

ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot | Q | Q
PN (Dec.) (Hex.)
201| 3698 29563 0E72 737B
202 16322 13078 3FC2 3316
203 | 17429 10460 4415 28DC
204 21730 17590 54E2 44B6
205| 17808 20277 4590 4F35
206| 30068 19988 7574 4E14
207 | 12737 6781 31c1 1A7D
208 | 28241 32501 6E51 7EF5
209| 20371 6024 4F93 1788
210| 13829 20520 3605 5028
211| 13366 31951 3436 7CCF
212 25732 26063 6484 65CF
213 19864 27203 4D98 6A43
214 5187 6614 1443 19D6
215 23219 10970 5AB3 2ADA
216 28242 5511 6E52 1587
217 | 6243 17119 1863 42DF
218 445 16064 01BD 3ECO
219 21346 31614 5362 7B7E
220| 13256 4660 33cs8 1234
221 18472 13881 4828 3639
222 25945 16819 6559 41B3
223 31051 6371 794B 18E3
224 1093 24673 0445 6061
225| 5829 6055 16C5 17A7
226| 31546 10009 7B3A 2719
227| 29833 5957 7489 1745
228 18146 11597 46E2 2D4D
229 24813 22155 60ED 568B
230| 47 15050 002F 3ACA
231| 3202 16450 0Cc82 4042
232 21571 27899 5443 6CFB
233| 7469 2016 1D2D 07E0
234 25297 17153 62D1 4301
235| 8175 15849 1FEF 3DE9
236| 28519 30581 6F67 7775
237| 4991 3600 137F 0E10
238| 7907 4097 1EE3 1001
239 17728 671 4540 029F
240 14415 20774 384F 5126
241 30976 24471 7900 5F97
242 26376 27341 6708 6ACD
243| 19063 19388 4A77 4BBC
244 19160 25278 4AD8 62BE
245| 3800 9505 0ED8 2521
246| 8307 26143 2073 661F
247 12918 13359 3276 342F
248 19642 2154 4CBA 086A
249 24873 13747 6129 35B3
250 22071 27646 5637 6BFE

.. . continued on next page
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ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot I Q I Q
PN (Dec.) (Hex.)
251| 13904 1056 3650 0420
252 27198 1413 6A3E 0585
253 | 3685 3311 0E65 OCEF
254| 16820 4951 41B4 1357
255| 22479 749 57CF 02ED
256 6850 6307 1AC2 18A3
257| 15434 961 3c4a 03C1
258 | 19332 2358 4B84 0936
259 8518 28350 2146 6EBE
260 14698 31198 396A 79DE
261| 21476 11467 53E4 2CCB
262 30475 8862 7708 229E
263 23984 6327 5DB0 18B7
264 1912 7443 0778 1D13
265| 26735 28574 686F 6F9E
266 15705 25093 3D59 6205
267 | 3881 6139 0F29 17FB
268| 20434 22047 4FD2 561F
269 16779 32545 418B 7F21
270| 31413 7112 7AB5 1BC8
271| 16860 28535 41DC 6F77
272| 8322 10378 2082 288A
273| 28530 15065 6F72 3AD9
274| 26934 5125 6936 1405
275| 18806 12528 4976 30F0
276| 20216 23215 4EF8 5AAF
277| 9245 20959 241D 51DF
278| 8271 3568 204F ODFO
279 18684 26453 48FC 6755
280 | 8220 29421 201C 72ED
281 6837 24555 1AB5 5FEB
282 9613 10779 258D 2A1B
283 31632 25260 7B90 62AC
284 | 27448 16084 6B38 3ED4
285| 12417 26028 3081 65AC
286 30901 29852 78B5 749C
287| 9366 14978 2496 3A82
288| 12225 12182 2FC1 2F96
289 | 21458 25143 53D2 6237
290 | 6466 15838 1942 3DDE
291 8999 5336 2327 14D8
292| 26718 21885 685E 557D
293 3230 20561 0C9E 5051
294 27961 30097 6D39 7591
295| 28465 21877 6F31 5575
296 6791 23589 1A87 5C25
297 | 17338 26060 43BA 65CC
298| 11832 9964 2E38 26EC
299 11407 25959 2C8F 6567
300 15553 3294 3ccl OCDE

.. . continued on next page
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PN Offset Programming Information

ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot | Q | Q
PN (Dec.) (Hex.)
301| 17418 30173 440A 75DD
302| 14952 15515 3168 3C9B
303| 52 5371 0034 14FB
304 27254 10242 6A76 2802
305| 15064 28052 3AD8 6D94
306 10942 14714 2ABE 397A
307| 377 19550 0179 4C5E
308| 14303 8866 37DF 22A2
309 | 24427 15297 5F6B 3BC1
310| 26629 10898 6805 2R92
311 20011 31315 4E2B 7A53
312| 16086 19475 3ED6 4c13
313 | 24374 1278 5F36 04FE
314 9969 11431 26F1 2CA7
315| 29364 31392 72B4 7AA0
316| 25560 4381 63D8 111D
317 28281 14898 6E79 3A32
318| 7327 23959 1C9F 5D97
319| 32449 16091 7EC1 3EDB
320| 26334 9037 66DE 234D
321 14760 24162 39A8 5E62
322| 15128 6383 3B18 18EF
323 29912 27183 74D8 6A2F
324 4244 16872 1094 41E8
325| 8499 9072 2133 2370
326| 9362 12966 2492 32R6
327 10175 28886 27BF 70D6
328| 30957 25118 78ED 621E
329 12755 20424 31D3 4FC8
330| 19350 6729 4B96 1A49
331 1153 20983 0481 51F7
332 29304 12372 7278 3054
333| 6041 13948 1799 367C
334 21668 27547 54A4 6B9B
335| 28048 8152 6D90 1FD8
336| 10096 17354 2770 43ca
337| 23388 17835 5B5C 45AB
338| 15542 14378 3CB6 382A
339| 24013 7453 5DCD 1D1D
340| 2684 26317 0A7C 66CD
341| 19018 5955 4R4A 1743
342| 25501 10346 639D 286A
343| 4489 13200 1189 3390
344 31011 30402 7923 76C2
345 29448 7311 7308 1C8F
346| 25461 3082 6375 0COA
347 11846 21398 2E46 5396
348| 30331 31104 767B 7980
349| 10588 24272 295¢C 5EDO
350 32154 27123 7D9A 69F3
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PN Offset Programming Information
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ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot | Q | Q
PN (Dec.) (Hex.)
351| 29572 5578 7384 15CA
352 13173 25731 3375 6483
353| 10735 10662 29EF 29A6
354| 224 11084 00E0 2B4C
355| 12083 31098 2F33 797A
356| 22822 16408 5926 4018
357| 2934 6362 0B76 18DA
358 | 27692 2719 6C2C 0A9F
359| 10205 14732 27DD 398C
360 7011 22744 1B63 58D8
361| 22098 1476 5652 05C4
362| 2640 8445 0A50 20FD
363| 4408 21118 1138 527E
364| 102 22198 0066 56B6
365| 27632 22030 6BFO 560E
366| 19646 10363 4CBE 287B
367| 26967 25802 6957 64CA
368| 32008 2496 7D08 09CO
369| 7873 31288 1EC1 7A38
370| 655 24248 028F 5EBS
371 25274 14327 62BA 37F7
372 16210 23154 3F52 5A72
373| 11631 13394 2D6F 3452
374| 8535 1806 2157 070E
375 19293 17179 4B5D 431B
376 12110 10856 2F4E 2A68
377 21538 25755 5422 649B
378| 10579 15674 2953 3D3A
379| 13032 7083 32E8 1BAB
380| 14717 29096 397D 71A8
381| 11666 3038 2D92 0BDE
382| 25809 16277 64D1 3F95
383| 5008 25525 1390 63B5
384| 32418 20465 7EA2 4FF1
385| 22175 28855 569F 70B7
386 11742 32732 2DDE 7FDC
387| 22546 20373 5812 4F95
388| 21413 9469 53A5 24FD
389| 133 26155 0085 662B
390| 4915 6957 1333 1B2D
391| 8736 12214 2220 2FB6
392 1397 21479 0575 53E7
393| 18024 31914 4668 7CAA
394| 15532 32311 3CAC 7E37
395| 26870 11276 68F6 2coc
396| 5904 20626 1710 5092
397 | 24341 423 5F15 01A7
398| 13041 2679 32F1 0A77
399| 23478 15537 5BB6 3CB1
400| 1862 10818 0746 2A42

.. . continued on next page
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PN Offset Programming Information

ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot | Q | Q
PN (Dec.) (Hex.)
401| 5850 23074 16DA 5A22
402| 5552 20250 15B0 4F1A
403| 12589 14629 312D 3925
404| 23008 29175 59E0 71F7
405| 27636 13943 6BF4 3677
406 17600 11072 44C0 2B40
407 | 17000 29492 4268 7334
408| 21913 5719 5599 1657
409| 30320 7347 7670 1CB3
410 28240 12156 6E50 2F7C
411 7260 25623 1c5C 6417
412 17906 27725 45F2 6C4D
413| 5882 28870 16FA 70C6
414 22080 31478 5640 7AF6
415 12183 28530 2F97 6F72
416 23082 24834 5A2A 6102
417| 17435 9075 441B 2373
418 18527 32265 485F 7E09
419 31902 3175 7C9E 0C67
420 18783 17434 495F 441A
421 20027 12178 4E3B 2F92
422 7982 25613 1F2E 640D
423| 20587 31692 506B 7BCC
424 10004 25384 2714 6328
425| 13459 18908 3493 49DC
426| 13383 25816 3447 64D8
427 28930 4661 7102 1235
428 4860 31115 12FC 798B
429| 13108 7691 3334 1E0B
430 24161 1311 5E61 051F
431 20067 16471 4E63 4057
432 2667 15771 0A6B 3D9B
433 13372 16112 343cC 3EF0
434 28743 21062 7047 5246
435| 24489 29690 5FA9 73FA
436 249 10141 00F9 279D
437| 19960 19014 4DF8 4A46
438 29682 22141 73F2 567D
439 31101 11852 797D 2E4C
440 27148 26404 6A0C 6724
441| 26706 30663 6852 77C7
442 5148 32524 141c 7F0C
443 4216 28644 1078 6FE4
444 5762 10228 1682 27F4
445 245 23536 00F5 5BF0
446 21882 18045 557A 467D
447 3763 25441 0EB3 6361
448| 206 27066 00CE 69BA
449 28798 13740 707E 35AC
450 | 32402 13815 7E92 35F7
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PN Offset Programming Information

68P64115A21-B

ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot | Q | Q
PN (Dec.) (Hex.)
451| 13463 3684 3497 0E64
452 15417 23715 3c39 5CA3
453 23101 15314 5A3D 3BD2
454 14957 32469 3A6D 7ED5
455| 23429 9816 5B85 2658
456 12990 4444 32BE 115¢C
457 12421 5664 3085 1620
458| 28875 7358 70CB 1CBE
459| 4009 27264 0FA9 6A80
460 1872 28128 0750 6DEO
461| 15203 30168 3B63 75D8
462| 30109 29971 759D 7513
463| 124001 3409 5DC1 0D51
464 4862 16910 12FE 420E
465| 14091 20739 370B 5103
466| 6702 10191 1A2E 27CF
467| 3067 12819 0BFB 3213
468| 28643 19295 6FE3 4BSF
469| 21379 10072 5383 2758
470 20276 15191 4F34 3B57
471| 25337 27748 62F9 6C64
472 19683 720 4CE3 02D0
473 10147 29799 27A3 7467
474 16791 27640 4197 6BF8
475| 17359 263 43CF 0107
476 13248 24734 33co 609E
477 22740 16615 58D4 40E7
478| 13095 20378 3327 4F9A
479 10345 25116 2869 621C
480| 30342 19669 7686 4CD5
481| 27866 14656 6CDA 3940
482| 9559 27151 2557 6A0F
483| 8808 28728 2268 7038
484 12744 25092 31c8 6204
485 11618 22601 2D62 5849
486 27162 2471 6A1A 09A7
487| 17899 25309 45EB 62DD
488| 29745 15358 7431 3BFE
489| 31892 17739 7C94 454B
490| 23964 12643 5D9C 3163
491| 23562 32730 5C0A 7FDA
492 2964 19122 0B94 4AB2
493| 18208 16870 4720 41E6
494 15028 10787 3AB4 2A23
495| 21901 18400 558D 47E0
496 | 24566 20295 5FF6 4F47
497 18994 1937 4A32 0791
498| 13608 17963 3528 462B
499 27492 7438 6B64 1DOE
500| 11706 12938 2DBA 328Aa

.. . continued on next page
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PN Offset Programming Information

ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot | Q | Q

PN (Dec.) (Hex.)
501 14301 19272 37DD 4B48
502| 23380 29989 5B54 7525
503| 11338 8526 2C4A 214E
504| 2995 18139 0BB3 46DB
505| 23390 3247 5B5E OCAF
506 | 14473 28919 3889 70F7
507| 6530 7292 1982 1c7c
508 | 20452 20740 4FE4 5104
509 | 12226 27994 2FC2 6D5A
510 1058 2224 0422 08B0
5111 12026 6827 2EFA 1AAB
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Sept 2003 1X SC 4812T-MC Multicarrier BTS Optimization/ATP C-1



HoN

FRU Optimization/ATP Test Matrix

68P64115A21-B

FRU Optimization/ATP Test Matrix

Usage & Background

Periodic maintenance of a site may also may mandate re—optimization of
specific portions of the site. An outline of some basic guidelines is
included in the following tables.

NOTE

Re—optimization steps listed for any assembly detailed in the
tables below must be performed anytime an RF cable associated

with it is replaced.

BTS Frame
Table C-1: When RF Optimization Is required on the BTS
Item Replaced Optimize:

C—CCP Shelf All sector TX and RX paths to all
Combined CDMA Channel Processor
(C-CCP) shelves.

Multicoupler/ The three or six affected sector RX paths for

Preselector Card the C—CCP shelf in the BTS frames.

BBX board RX and TX paths of the affected C-CCP
shelf / BBX board.

MCIO Card All RX and TX paths of the affected

CDMA carrier.

Any PA Module

All sector/carrier TX paths.

Parallel PA Combiner

All sector/carrier TX paths.

TX Filter

The affected sector TX path.

Enhanced Trunking
Module

All sector/carrier TX paths.

Ancillary Frame

Item Replaced

Optimize:

Directional Coupler

All affected sector RX and TX paths to all
BTS frame shelves.

Site filter

All affected RX sector paths in all shelves
in all BTS frames.

C-2 1X SC 4812T-MC Multicarrier BTS Optimization/ATP

Sept 2003




68P64115A21-B

FRU Optimization/ATP Test Matrix

Inter-frame Cabling

Optimization must be performed after the replacement of any RF cabling
between BTS frames.

Table C-2: When to Optimize Inter—frame Cabling

Item Replaced Optimize:
Ancillary frame to BTS The affected sector/antenna RX
frame (RX) cables paths.

BTS frame to ancillary frame | The affected sector/antenna TX paths.
(TX) cables

Detailed Optimization/ATP Test Matrix

able C-3 outlines in more detail the tests that would need to be
performed if one of the BTS components were to fail and be replaced. It
is also assumed that all modules are placed OOS—ROM via the LMF
until full redundancy of all applicable modules is implemented.

The following guidelines should also be noted when using this table.

NOTE

IMPORTANT: Not every procedure required to bring the site
back on line is indicated irrFable C-3. It is meant to be used as a
guideline ONLY. The table assumes that the user is familiar
enough with the BTS Optimization/ATP procedure to understand
which test equipment set ups, calibrations, and BTS site
preparation will be required before performing the Table #
procedures referenced.

Various passive BTS components (such as the TX and RX directional
couplers, Preselector IO, MCIO, etc.) only call for a TX or RX
calibration audit to be performed in lieu of a full path calibration. If the
RX or TX path calibration audit fails, the entire RF path calibration will
need to be repeated. If the RF path calibration fails, further
troubleshooting is warranted.

Whenever any C—-CCP BACKPLANE is replaced, it is assumed that
only power to the C—CCP shelf being replaced is turned off via the
breaker supplying that shelf.

Whenever any DISTRIBUTION BACKPLANE is replaced it is assumed
that the power to the entire RFM frame is removed and the Preselector
I/O is replaced. The modem frame should be brought up as if it were a
new installation.

NOTE

If any significant change in signal level results from any
component being replaced in the RX or TX signal flow paths, it
would be identified by re—running the RX and TX calibration
audit command.

When the MCIO is replaced, the C—CCP shelf remains powered up. The
BBX boards may need to be removed, then re—installed into their
original slots, and re~downloaded (code and BLO data). RX and TX
calibration audits should then be performed.
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Table C-3: SC 4812T-MC BTS Optimization and ATP Test Matrix

°
- (]
< <) 2 3
S o <}
€ e g 8 =
o o o b
5 5 g |2 o 2 £
3| 32 = ] ) c
Q| 2 a a =l 5 S
o2 5 | % S 2v | F
© o 0ol o [ E ol ® - | O
cC| S| » [
S 2 8333 |a 2 T02 8¢ 8
S 0= ©| O =
EEMEEERREHEREEEHEEE
Doc Thl # | Page | Description a ozl s=sd 8= SL & ol gIT5|&
Initial Boards/ Modules Install,
ET,abIe 2-1 B—S Preliminary Operations, CDF Site L ) oo/ o0 0 0 0 0 0 L S N N
Equipage; etc.
E:g 2421 q?o DC Power Pre-Test Physical Inspect . .
[Tpble2-5 211 Initial Power-up . °
"Tpble 3-11 331 | Ping Processors L N N ) ° °
Download/Enable
lijeSJS E334 MGLIs ° °
Download/Enable
lijeSJS E334 GLls ° °
Tpble 3-14 I35 | Download CSMs ° ° °
'Tlable3-14 335 Download MCCs, ° ° .
'Tlable3-14 335 Download BBXs o o
Tpble 3-16 337 Enable CSMs ° °
Tpble 3-17 338 | Enable MCCs ° °
'T[able3-20 345 GPS Initialization / Verification . ° °
'T[able 3-21 348 HSO Initialization/ Verification . °
Download Offsets
I:TFbIeS-37 |3-87 to BBX ° o o
Spectral Purity
|:T,able4-1 |j-7 TX Mask ATP o o ° e o 0| 0
Waveform Quality
|:T,able4-1 |j-7 (tho) ATP o  o| @ ° ° ° o  o| @
ET,abIe 41 |j-7 )I:_lllngme Offset o  o| @ ° ° ° o  o| @
Code Domain
[pole 4-1 %7 Power/Noise Floor *1®°
rTPbIe4-1 |—4|-7 FER Test o/ o 0|0 | @
NOTE

Replace power converters one card at a time so that power to the C—CCP or PA shelf is not lost. If power to the
C—CCP shelf is lost, all cards in the shelf must be downloaded again.
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BBX Gain Set Point vs BTS Output
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BBX Gain Set Point vs. BTS Output Considerations

Usage & Background

able D-1 outlines the relationship between the fotal of all code domain
channel element gain settings (digital root sum of the squares) and the
BBX Gain Set Point between 33.0 dBm and 44.0 dBm. The resultant RF
output (as measured at the top of the BTS in dBm) is shown in the table.
The table assumes that the BBX Bay Level Offset (BLO) values have
been calculated.

As an illustration, consider a BBX keyed up to produce a CDMA carrier
with only the Pilot channel (no MCCs forward link enabled). Pilot gain
is set to 262. In this case, the BBX Gain Set Point is shown to correlate
exactly to the actual RF output anywhere in the 33 to 44 dBm output
range. (This is the level used to calibrate the BTS).

Table D-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)

HcoH

dBm» 44 43 42 41 40 39 38 37 36 35 34 33
Gaine

541 - - - - - - - 43.3 423 413 403 393
533 - - - - - - - 432 422 412 402 39.2
525 - - - - - - 44 43 42 41 40 39

517 - - - - - - 439 429 419 409 399 389
509 - - - - - - 438 428 418 408 398 38.8
501 - - - - - - 436 426 416 406 39.6 38.6
493 - - - - - - 435 425 415 405 395 385
485 - - - - - - 434 424 414 404 394 384
477 - - - - - - 432 422 412 402 392 382
469 - - - - - - 431 421 411 401 39.1 381
461 - - - - - 439 429 419 409 399 389 37.9
453 - - - - - 438 428 418 408 39.8 388 37.8
445 - - - - - 436 426 416 406 396 38.6 37.6
437 - - - - - 434 424 414 404 394 384 374
429 - - - - - 433 423 413 403 393 383 373
421 - - - - - 431 421 411 401 391 38.1 37.1
413 - - - - 44 43 42 41 40 39 38 37

405 - - - - 438 428 418 408 398 388 37.8 36.8
397 - - - - 436 426 416 406 396 386 37.6 36.6
389 - - - - 434 424 414 404 394 384 374 364

... continued on next page

D-2 1X SC 4812T-MC Multicarrier BTS Optimization/ATP Sept 2003




68P64115A21-B BBX Gain Set Point vs. BTS Output Considerations

Table D-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)
dBm» 44 43 42 41 40 39 38 37 36 35 34 33
Gaine
381 - - - - 433 423 413 403 393 383 373 363
374 - - - - 431 421 411 401 391 381 37.1 36.1
366 - - - 439 429 419 409 399 389 379 369 359
358 - - - 43.7 427 417 407 397 387 377 36.7 357
350 - - - 435 425 415 405 395 385 375 365 355
342 - - - 433 423 413 403 393 383 373 36.3 353
334 - - - 431 421 411 401 391 381 37.1 36.1 351
326 - - 439 429 419 409 399 389 379 369 359 349
318 - - 43.7 427 417 40.7 39.7 38.7 37.7 36.7 357 347
310 - - 435 425 415 405 395 385 375 365 355 345
302 - - 432 422 412 402 392 382 372 362 352 342
294 - 44 43 42 41 40 39 38 37 36 35 34
286 - 43.8 428 418 408 39.8 388 378 368 358 348 338
278 - 435 425 415 405 395 385 375 365 355 345 335
270 - 433 423 413 403 393 383 373 363 353 343 333
262 44 43 42 41 40 39 38 37 36 35 34 33
254 43.7 427 417 407 397 387 37.7 36.7 357 347 337 -
246 434 424 414 404 394 384 374 364 354 344 334 -
238 432 422 412 402 392 382 372 362 352 342 332 -
230 429 419 409 399 389 379 369 359 349 339 - -
222 426 416 406 396 386 376 36.6 356 346 336 - -
214 422 412 402 392 382 372 362 352 342 332 - -
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CDMA Operating Frequency Programming Information

Introduction
Programming of each of the BTS BBX synthesizers is performed by the
BTS GLIs via the CHI bus. This programming data determines the
transmit and receive transceiver operating frequencies (channels) for
each BBX.

800 MHz CDMA Channels

igure E-1 shows the valid channels for the North American cellular
telephone frequency spectrum. There are 10 CDMA wireline or
non—wireline band channels used in a CDMA system (unique per
customer operating system).

Figure E-1: North American Cellular Telephone System Frequency Spectrum (CDMA Allocation)
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Calculating 800 MHz Center Frequencies

[Jable E-1 shows selected 800 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

® Channels 1-777
TX =870 + 0.03 * Channel#
Example: Channel 262
TX = 870 + 0.03%262 = 877.86 MHz

¢ Channels 1013-1023
TX =870 + 0.03 * (Channel# — 1023)
Example: Channel 1015
TX =870 +0.03 *(1015 — 1023) = 869.76 MHz

e RX =TX-45 MHz

Example: Channel 262
RX = 877.86 —45 = 832.86 MHz
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Table E-1: 800 MHz TX and RX Frequency vs. Channel
Channel Number Transmit Frequency (MHz) Receive Frequency (MHz)
Decimal Hex Center Frequency Center Frequency
1 0001 870.0300 825.0300
25 0019 870.7500 825.7500
50 0032 871.5000 826.5000
75 004B 872.2500 827.2500
100 0064 873.0000 828.0000
125 007D 873.7500 828.7500
150 0096 874.5000 829.5000
175 00AF 875.2500 830.2500
200 00C8 876.0000 831.0000
225 00E1 876.7500 831.7500
250 00FA 877.5000 832.5000
275 0113 878.2500 833.2500
300 012C 879.0000 834.0000
325 0145 879.7500 834.7500
350 015E 880.5000 835.5000
375 0177 881.2500 836.2500
400 0190 882.0000 837.0000
425 01A9 882.7500 837.7500
450 01C2 883.5000 838.5000
475 01DB 884.2500 839.2500
500 01F4 885.0000 840.0000
525 020D 885.7500 840.7500
550 0226 886.5000 841.5000
575 023F 887.2500 842.2500
600 0258 888.0000 843.0000
625 0271 888.7500 843.7500
650 028A 889.5000 844.5000
675 02A3 890.2500 845.2500
700 02BC 891.0000 846.0000
725 02D5 891.7500 846.7500
750 02EE 892.5000 847.5000
775 0307 893.2500 848.2500
NOTE
Channel numbers 778 through 1012 are not used.
1013 03F5 869.7000 824.7000
1023 03FF 870.0000 825.0000
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Test Equipment Preparation

Purpose

Pre—testing set—up information covered includes verification and setting
GPIB addresses, inter—unit cabling, connectivity testing, pre—test control
settings, and equipment calibration for items which are not calibrated
with the Calibrate Test Equipment function of the LMF.

The following procedures include verification and changing GPIB
addresses for the various items of CDMA test equipment supported by
the LMF.

Prepare test sets

This appendix provides information on pre—testing set—up for the
following test equipment items (not required for the Cybertest test set):

-
[ ]

Test Equipment Set-up

Calibrating test sets

Agilent E7495A test equipment setup
Agilent E4406A transmitter test set
Agilent E4432B signal generator
Advantest R3267 spectrum analyzer
Advantest R3562 signal generator
Agilent 8935 analyzer (formerly HP 8935)
HP 8921 with PCS interface analyzer
Advantest R3465 analyzer

Motorola CyberTest

HP 437 power meter

Gigatronics 8541C power meter
GPIB adapter

HP8921A System Connectivity Test
HP PCS Interface Test Equipment Setup for Manual Testing
Calibrating Test Cable Setup using Advantest R3465

Agilent E4406A Transmitter Tester Self-alignment (Calibration)
HP 437 Power Meter (Calibration)

Gigatronics 8542 power meter (Calibration)
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Agilent E7495A Test Equipment Setup

This test equipment requires a warm-up period of at least 30 minutes
before BTS testing or calibration begins.

Using the Agilent E7495A with the LMF

The Agilent E7495A does not require the use of the 19MHz frequency
reference; if connected, it will be ignored. The Even Sec SYNC
connection is required.

The Agilent E7495A signal generator is only calibrated down to —80db.
In order to achieve accurate FER testing, be sure the RX setup includes
at least 40db of attenuation. This will ensure the signal generator will
output sufficient power to operate in the calibrated range.

Set the IP Address as described iqj"able F-1.

Table F-1: Set IP Address on Agilent E7495A test set

v~ Step Action

1 Use the System Button > Controls >IPAdmin to set an
IP address on the E7495A as 128.0.0.49, and Netmask to
255.255.255.128.

Connections

It is recommended that you use a hub with BNC and RJ-45 connections.
[Suggested models: Netgear model EN104 (4 port) or EN108 (8 port).
Do NOT use model numbers ending with “TP”; those have no BNC
connectors.]

The LMF will connect to the hub which in turn is connected to the BTS
and to the Agilent E7495A.

Agilent E7495A to Hub — This is an Ethernet cable, RI—45 to RJ-45.

LMF to Hub — Use one of the following cables to connect the LMF to
the Hub:
— Ethernet cable, RJ-45 to RJ—45 (be sure that the LAN card is set for
either AUTO or to use the RI-45 only).
— Coax cable between LAN card and Hub. (Use a “T” on the hub and
connect a cable between the other end of the “T” and the BTS LAN
connection).

Hub to BTS - Use BNC “T” connector on the hub. [If your hub doesn’t
have BNC ports, use a BNC to UTP adapter.]
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Detecting Test Equipment

Check that no other equipment is connected to the LMF. Agilent
equipment must be connected to the LAN to detect it. Then perform the
procedures described irﬁable F-2.

Table F-2: Detecting Agilent E7495A Test Equipment

v~ Step Action
1 Click the Tools Menu.
2 Choose Options.
3 Check Agilent E7495A option in non—GPIB Test Equipment and enter its [P number.
4 Click Apply and wait a moment.
5 Click Dismiss.
Power Sensor Calibration
|j"able F-3 describes the E7495A Power Sensor Calibration.
Table F-3: E7495A Power Sensor Calibration
v~ Step Action
1 Display the power meter screen.

2 Zero the power meter. Make sure you are connected as shown iqjigure F-1.
— Press the Zero softkey.
— Press the Continue softkey.

3 Calibrate the power meter:
— Press Ref CF.
— Enter the reference cal factor, reading it off the label on the power sensor head.

-l

— Press Calibrate.

— Connect the power sensor (seqfigure F-2).
— Press Continue.

— Press Cal Factor.

— Enter the cal factor from the label on the power sensor head. Select a cal factor that’s within
the operating frequency of the base station.
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Figure F-1: Agilent E7495A Pre—Power Sensor Calibration connection
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Figure F-2: Agilent E7495A Power Sensor Calibration connection
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Cable Calibration

Follow the directions in the WinLMF program to calibrate cables.

— Calibrate the short cable (seqdfigure 3-12 on pagg3-54) and two 10
dB pads to get a base line and then calibrate the TX and RX setup.
Since you need at least 40 dB of loss when doing the FER test, the
setup for RX is the same as TX.
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Verifying and Setting GPIB Addresses
Agilent E4406A Transmitter Tester GPIB Address

Follow the procedure iJable F-4 and refer tqdjigure F-3 to verify and,
if necessary, change the Agilent E4406A GPIB address.

Figure F-3: Setting Agilent E4406A GPIB Address
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Table F-4: Verify and Change Agilent E4406A GPIB Address
Step Action
1 In the SYSTEM section of the instrument front panel, press the System key.
— The softkey labels displayed on the right side of the instrument screen will change.
2 Press the Config I/O softkey button to the right of the instrument screen.
— The softkey labels will change.
— The current instrument GPIB address will be displayed below the GPIB Address softkey label.
3 If the current GPIB address is not set to 18, perform the following to change it:
3a | Press the GPIB Address softkey button. In the on—screen Active Function Area, GPIB Address will
be displayed followed by the current GPIB address.
3b | On the front panel Data Entry keypad, enter the communications system analyzer GPIB address of 18.
— The GPIB Address label will change to Enter.
— Digits entered with the keypad will replace the current GPIB address in the display.
NOTE
To correct an entry, press the Bk Sp key at the upper right of the keypad to delete one character at a
time.
3c | Press the Enter softkey button or the keypad Enter key to set the new GPIB address.
— The Config I/O softkey labels will reappear.
— The new GPIB address will be displayed under the GPIB Address softkey label.
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Agilent E4432B Signal Generator GPIB Address

Follow the procedure iJable F-5 and refer tqdjigure F-4 to verify and,
if necessary, change the Agilent E4432B GPIB address.

Figure F-4: Setting Agilent E4432B GPIB Address
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Table F-5: Verify and Change Agilent E4432B GPIB Address

Step Action

1 In the MENUS section of the instrument front panel, press the Utility key.
— The softkey labels displayed on the right side of the instrument screen will change.

2 Press the GPIB/RS232 softkey button to the right of the instrument screen.
— The softkey labels will change.
— The current instrument GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 1, perform the following to change it:

3a | Press the GPIB Address softkey button.

— The GPIB Address label and current GPIB address will change to boldface.

— In the on—screen Active Entry Area, Address: will be displayed followed by the current GPIB
address.

3b | On the front panel Numeric keypad, enter the signal generator GPIB address of 1.

— The GPIB Address label will change to Enter.

— Digits entered with the keypad will replace the current GPIB address in the Active Entry display.

NOTE

To correct an entry, press the backspace key at the lower right of the keypad to delete one character at
a time.

3c | Press the Enter softkey button to set the new GPIB address.
— The new GPIB address will be displayed under the GPIB Address softkey label.
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Advantest R3267 Spectrum Analyzer GPIB Address

Perform the procedure irpJable F-6 and refer tqjigure F-5 to verify and,
if necessary, change the Advantest R3267 spectrum analyzer GPIB
address.

Figure F-5: Setting Advantest R3267 GPIB Address
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Table F-6: Verify and Change Advantest R3267 GPIB Address
Step Action
1 If the REMOTE LED is lighted, press the LCL key.
— The LED extinguishes.
2 Press the CONFIG key.
— The CONFIG softkey labels will appear in the softkey label display area of the instrument
display.
— The current GPIB address will be displayed below the GPIB Address softkey label.
3 If the current GPIB address is not set to 18, perform the following to change it:
3a | Press the GPIB Address softkey. A GPIB Address entry window will open in the instrument display
showing the current GPIB address.
3b | Enter 18 on the keypad in the ENTRY section of the instrument front panel. Characters typed on the
keypad will replace the address displayed in the GPIB Address entry window.
NOTE
To correct an entry, press the BS (backspace) key at the lower right of the keypad to delete one
character at a time.
3c | Press the ENTR key to the lower right of the keypad to enter the address.
— The GPIB Address entry window closes.
— The new address is displayed in the bottom portion of the GPIB Address softkey label.
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Advantest R3562 Signal Generator GPIB Address

Set the GP-IB ADDRESS switch on the rear of the Advantest R3562
signal generator to address 1 as shown irfjigure F-6.

Figure F-6: Advantest R3562 GPIB Address Switch Setting
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Agilent 8935 Series E6380 (formerly HP 8935) Test Set GPIB Address

Follow the procedure iJable F-7 and refer tqdjigure F-7 to verify and,
if necessary, change the HP8935 GPIB address.

Figure F-7: HP8935 Test Set
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NOTE This procedure assumes that the test equipment is set up and
ready for testing.
Table F-7: Verify and/or Change HP8935 GPIB Address
Step Action
NOTE

The HP I/O configuration MUST be set to Talk & Listen, or NO device on the GPIB bus will be
accessible. (Consult test equipment OEM documentation for additional information as required.)

1 To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the HP8935. The
current HP-IB address is displayed at the top of the screen.

NOTE

HP-IB is the same as GPIB.

2 If the current GPIB address is not set to 18, perform the following to change it:
— Press Shift and Inst Config.

Turn the Cursor Control knob to move the cursor to the HP-IB Adrs field.
Press the Cursor Control knob to select the field.

Turn the Cursor Control knob as required to change the address to 18.
Press the Cursor Control knob to set the address.

3 * Press Preset to return to normal operation.
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Hewlett Packard HP8921A and HP83236A/B GPIB Address

Follow the procedure irrFable F-8 and refer tqjigure F-8, to verify and,
if necessary, change the HP8921A HP83236A GPIB addresses.

Figure F-8: HP8921A and HP83236A/B
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NOTE This procedure assumes that the test equipment is set up and

ready for testing.

Table F-8: Verify and/or Change HP8921A and HP83236A GPIB Addresses
Step Action

1 To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the HP8921A. The
current HP-IB address is displayed at the top of the screen.

NOTE
HP-IB is the same as GPIB.

2 If the current HP-IB address is not set to 18, perform the following to change it:

— Turn the Cursor Control knob to move the cursor to More and press the knob to select the field.

— Turn the Cursor Control knob to move the cursor to I/O Config and press the knob to select the
field.

— Turn the Cursor Control knob to move the cursor to Adrs and press the knob to select the field.

— Turn the Cursor Control knob to change the HP-IB address to 18 and press the knob to set the
address.

— Press Shift and Preset to return to normal operation.

3 To set the HP83236A (or B) PCS Interface GPIB address=19, set the dip switches as follows:
- Al=1, A2=1, A3=0, A4=0, A5=1, HP-IB/Ser = 1

Sept 2003 1X SC 4812T-MC Multicarrier BTS Optimization/ATP F-11



-l

Verifying and Setting GPIB Addresses 68P64115A21-B

Advantest R3465 Communications Test Set GPIB Address

Follow the steps i Jable F-9 and refer tqfigure F-9 to verify and, if
necessary, change the GPIB address for the Advantest R3465.

Figure F-9: R3465 Communications Test Set
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NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-9: Verify and/or Change Advantest R3465 GPIB Address

Step Action

1 To verify that the GPIB address is set correctly, perform the following procedure:
— Press SHIFT then PRESET.

— Press LCL.

— Press the GPIB and Others CRT menu key to view the current address.

2 If the current GPIB address is not set to 18, perform the following to change it:
— Turn the vernier knob as required to select 18.
— Press the vernier knob to set the address.

3 To return to normal operation, press Shift and Preset.
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Motorola CyberTest GPIB Address

Follow the steps irJable F-10 to verify and, if necessary, change the
GPIB address on the Motorola CyberTest. Changing the GPIB address
requires the following items:

* Motorola CyberTest communications analyzer.
* Computer running Windows 3.1/Windows 95.
* Motorola CyberTAME software program “TAME”.
* Parallel printer port cable (shipped with CyberTest).

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-10: Verify and/or Change Motorola CyberTest GPIB Address

Step Action

1 On the LMF desktop, locate the CyberTAME icon. Double click on the icon to run the CyberTAME
application.

2 In the CyberTAME window taskbar, under Special, select IEEE.488.2.

3 CyberTAME software will query the CyberTest Analyzer for its current GPIB address. It then will
open the IEEE 488.2 dialog box. If the current GPIB address is not 18, perform the following
procedure to change it:

— Use the up or down increment arrows, or double—click in the field and type the number.

— Click on the OK button.
The new address will be written to the CyberTest via the parallel port and saved.

NOTE

Verify that the address has been set by repeating stepg 3 and 3. The new address should now appear in
the IEEE 488.2 dialog box Address field.
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HP437 Power Meter GPIB Address

Follow the steps irrJable F-11 and refer tqjigure F-10 to verify and, if
necessary, change the HP437 GPIB address.

Figure F-10: HP437 Power Meter
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NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-11: Verify and/or Change HP437 Power Meter GPIB Address

Step Action

1 Press Shift and PRESET.

2 Use the & arrow key to navigate to HP-IB ADRS and press ENTER.
The HP-IB address is displayed.

NOTE
HP-IB is the same as GPIB.

3 If the current GPIB address is not set to 13, perform the following to change it:
— Use the & ® arrow keys to change the HP-IB ADRS to 13.
— Press ENTER to set the address.

4 Press Shift and ENTER to return to a standard configuration.
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Gigatronics 8541C Power Meter GPIB Address

Follow the steps irJable F-12 and refer tqjigure F-11 to verify and, if
necessary, change the Gigatronics 8541C power meter GPIB address.

Figure F-

11: Gigatronics 8541C Power Meter Detail
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NOTE This procedure assumes that the test equipment is set up and

ready for testing.

Table F-12: Verify and/or Change Gigatronics 8541C Power Meter GPIB Address

Step

Action

! CAUTION

Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or miscalibration.

Press MENU.

Use the w arrow key to select CONFIG MENU and press ENTER.

Use the w arrow key to select GPIB and press ENTER.
The current Mode and GPIB Address are displayed.

If the Mode is not set to 8541C, perform the following to change it:
Use the 4 B arrow keys as required to select MODE.
Use the w & arrow keys as required to set MODE to 8541C.

If the GPIB address is not set to 13, perform the following to change it:
Use the # arrow key to select ADDRESS.
Use the w & arrow keys as required to set the GPIB address to 13.

Press ENTER to return to normal operation.
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RS232 GPIB Interface Box

Ensure that the RS232 GPIB interface box dip switches are set as shown
irfigure F-12.
Figure F-12: RS232 GPIB Interface Box
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Test Equipment Set-up

Purpose

This section covers other test equipment and peripherals not covered in
Chapter3. Procedures for the manual testing are covered here, along
with procedures to calibrate the TX and RX cables using the signal
generator and spectrum analyzer.

Equipment Warm up

NOTE Warm-up BTS equipment for a minimum of 60 minutes prior to
performing the BTS optimization procedure. This assures BTS
site stability and contributes to optimization accuracy. (Time
spent running initial power-up, hardware/firmware audit, and
BTS download counts as warm-up time.)

CAUTION If any piece of test equipment (i.e., test cable, RF adapter) has
been replaced, re-calibration must be performed. Failure to do so
could introduce measurement errors, resulting in incorrect
measurements and degradation to system performance.

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment after it has been
allowed to warm-up and stabilize for a minimum of 60 minutes.

Prerequisites

Prior to performing any of these procedures, all preparations for
preparing the LMF, updating LMF files, and any other pre-calibration
procedures, as stated in Chaptqj, must have been completed.
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HP8921A System Connectivity Test

Follow the steps irJ¥able F-13 to verify that the connections between the
PCS Interface and the HP8921A are correct, and cables are intact. The
software also performs basic functionality checks of each instrument.

NOTE Disconnect other GPIB devices, especially system controllers,
from the system before running the connectivity software.

Table F-13: System Connectivity

Step Action
NOTE
— Perform this procedure after test equipment has been allowed to warm—up and stabilize for a
minimum of 60 minutes.
1 Insert HP 83236A Manual Control/System card into memory card slot.
2 Press the [PRESET] pushbutton.
3 Press the Screen Control [TESTS] pushbutton to display the “Tests” Main Menu screen.
4 Position the cursor at Select Procedure Location and select by pressing the cursor control knob.
In the Choices selection box, select Card.
5 Position the cursor at Select Procedure Filename and select by pressing the cursor control knob.
In the Choices selection box, select SYS_CONN.
6 Position the cursor at RUN TEST and select it.
The software will prompt you through the connectivity setup.
7 When the test is complete, position the cursor on STOP TEST and select it; OR press the [KS5]
pushbutton.
8 To return to the main menu, press the [KS] pushbutton.
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HP PCS Interface Test Equipment Setup for Manual Testing

Follow the procedure iqj"able F-14 to setup the HP PCS Interface Box
for manual testing.

Table F-14: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

»~| Step

Action

NOTE
Verify GPIB controller is turned off.

Insert HP83236B Manual Control/System card into the memory card slot.

Under Screen Controls, press the [TESTS] push-button to display the TESTS (Main Menu)
screen.

Position the cursor at Select Procedure Location and select. In the Choices selection box, select
CARD.

Position the cursor at Select Procedure Filename and select. In the Choices selection box, select
MANUAL.

Position the cursor at RUN TEST and select OR press the K1 push-button.

Set channel number=<chan#>:
— Position cursor at Channel Number and select.
— Enter the chan# using the numeric keypad and then press [Enter] (the screen will blank).
— When the screen reappears, the chan# will be displayed on the channel number line.

NOTE
— If using a TMPC with Tower Top Amplifier (TTA) skip Stey 7.

Set RF Generator level= —119 dBm + Cal factor Example: =119 dBm + 2 dB = -117 dBm
— Continue with Steg9 (skip Steg§).

Set RF Generator level= —116 dBm + Cal factor. Example: =116 dBm + 2 dB = —114 dBm

Set the user fixed Attenuation Setting to 0 dB:
— Position cursor at RF Generator Level and select.
— Position cursor at User Fixed Atten Settings and select.
— Enter 0 (zero) using the numeric keypad and press [Enter].

10

Select Back to Previous Menu.

11

Select Quit, then select Yes.
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Calibrating Test Cable Setup using Advantest R3465

| NOTE Be sure the GPIB Interface is OFF for this procedure.

Perform the procedure irfable F-15 to calibrate the test cable setup
using the Advantest R3465. Advantest R3465 Manual Test setup and
calibration must be performed at both the TX and RX frequencies.

Table F-15: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

NOTE

— This procedure can only be performed after test equipment has been allowed to warm—up and
stabilize for a minimum of 60 minutes.

Press the SHIFT and the PRESET keys located below the display.

Press the ADVANCE key in the MEASUREMENT area of the control panel.

Select the CDMA Sig CRT menu key.

Select the Setup CRT menu key.

D A~ W N =

Using the vernier knob and the cursor keys set the following parameters:
NOTE

Fields not listed remain at default.

Generator Mode: SIGNAL

Link: FORWARD

Level Unit: dBm

CalCorrection: ON

Level Offset: OFF

Select the return CRT menu key.

Press FREQ key in the ENTRY area.

Set the frequency to the desired value using the keypad entry keys.

O 0| Q| D

Verify that the Mod CRT menu key is highlighting OFF; if not, press the Mod key to toggle it OFF.

10 | Verify that the Qutput CRT menu key is highlighting OFF; if not, press the Qutput key to toggle it
OFF.

11 Press the LEVEL key in the ENTRY area.

12 | Set the LEVEL to 0 dBm using the key pad entry keys.

13 | Zero power meter. Next connect the power sensor directly to the “RF OUT” port on the R3561L
CDMA Test Source Unit.

14 | Press the Output CRT menu key to toggle Output to ON.

15 | Record the power meter reading

16 | Disconnect the power meter sensor from the R3561L RF OUT jack.

. .. continued on next page
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[Table F-15: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

NOTE

The Power Meter sensor lower limit is =30 dBm. Thus, only components having losses < 30 dB
should be measured using this method. For best accuracy, always re—zero the power meter before
connecting the power sensor to the component being calibrated. Then, after connecting the
power sensor to the component, record the calibrated loss immediately.

17 | Disconnect all components in the the test setup and calibrate each one separately. Connect each
component one—at—a—time between the “RF OUT” port and the power sensor (seqjigure F-13,
“Setups A, B, and C”). Record the calibrated loss value displayed on the power meter for each
connection.

Example:  (A) 1st Test Cable = -0.5dB
(B) 2nd Test Cable = -14dB
(C) 20 dB Attenuator = -20.1dB
(D) 30 dB Directional Coupler = -29.8 dB

18 | Press the Output CRT menu key to toggle Output OFF.

19 | Calculate the total test setup loss by adding up all the individual losses:
Example: Total test setup loss = 0.5 + 1.4 + 20.1 + 29.8 = 51.8 dB
This calculated value will be used in the next series of tests.

20 | Press the FREQ key in the ENTRY area.

21 Using the keypad entry keys, set the test frequency to the RX frequency.

22 | Repeat stepg9 through39 for the RX frequency.

23 | Refer tqable 3-30 for assistance in manually setting the cable loss values into the LMF.
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Figure F-13: Cable Calibration using Advantest R3465
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Test Equipment Calibration

Agilent E4406A Transmitter Tester Self-alignment (Calibration)

Refer tqjigure F-14 and follow the procedure iqj"able F-16 to perform
the Agilent E4406A self—alignment (calibration).

Figure F-14: Agilent E4406A
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Table F-16: Perform Agilent E4406A Self-alignment (Calibration)
Step Action

1 In the SYSTEM section of the instrument front panel, press the System key.
— The softkey labels displayed on the right side of the instrument screen will change.

2 Press the Alignments softkey button to the right of the instrument screen.
— The softkey labels will change.

3 Press the Align All Now softkey button.
— All other instrument functions will be suspended during the alignment.
— The display will change to show progress and results of the alignments performed.

— The alignment will take less than one minute.
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HP 437 Power Meter (Calibration)

Precise transmit output power calibration measurements are made using
a bolometer—type broadband power meter with a sensitive power sensor.
Follow the steps iqj"able F-17 to enter information unique to the power
sensor before calibrating the test setup. Refer tqjigure F-15 as required.

NOTE This procedure must be done before the automated calibration to
enter power sensor specific calibration values.

Figure F-15: Power Meter Detail
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Table F-17: HP 437 Power Meter Calibration Procedure
Step Action
1 ! CAUTION
Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or mis—calibration.
Make sure the power meter AC LINE pushbutton is OFF.
2 Connect the power sensor cable to the SENSOR input.
Set the AC LINE pushbutton to ON.
NOTE
The calibration should be performed only after the power meter and sensor have been allowed to
warm—up and stabilize for a minimum of 60 minutes.
4 Perform the following to set or verify the correct power sensor model:
4a — Press [SHIFT] then [4] to select SENSOR.
4b — Identify the power sensor model number from the sensor label.
4c — Use the [«] or [#] button to select the appropriate model; then press [ENTER].
5 Refer to the illustration for steﬂﬁ, and perform the following to ensure the power reference output is
OFF:
S5a — Observe the instrument display and determine if the triangular indicator over PWR REF is
displayed.
5b — If the triangular indicator is displayed, press [SHIFT] then [#] to turn it off.
... continued on next page
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ﬂable F-17: HP 437 Power Meter Calibration Procedure

Step Action

6 Press [ZERO].
— Display will show “Zeroing ****%#* >

— Wait for process to complete.
Connect the power sensor to the POWER REF output.
Turn on the PWR REF by performing the following:

8a — Press [SHIFT] then [#].
8b — Verify that the triangular indicator (W) appears in the display above PWR REF as shown below.
b, 4
SHIFT ors RIY RNG PWR spoy RMT LSN TLK SRQ

9 Perform the following to set the REF CF %:

9a — Press ([SHIFT] then [ZERO]) for CAL.
9b — Enter the sensor’s REF CF% from the sensor’s decal using the arrow keys and press [ENTER].
(The power meter will display "CAL *****" for a few seconds.)
NOTE

If the REF CAL FACTOR (REF CF) is not shown on the power sensor, assume it to be 100%.
10 | Perform the following to set the CAL FAC %:

10a — Press [SHIFT] then [FREQ] for CAL FAC.
10b — On the sensor’s decal, locate an approximate calibration percentage factor (CF%) at 2 GHz.
10c — Enter the sensor’s calibration % (CF %) using the arrow keys and press [ENTER].

— When complete, the power meter will typically display 0.05 dBm. (Any reading between
0.00 and 0.10 is normal.)

11 To turn off the PWR REF, perform the following:
11a — Press [SHIFT] then [#].
11b — Disconnect the power sensor from the POWER REF output.
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Gigatronics 8542 power meter (Calibration)

Precise transmit output power calibration measurements are made using
a bolometer—type broadband power meter with a sensitive power sensor.
Follow the steps iqj"able F-18 to enter information unique to the power
sensor. Refer tqfjigure F-16 as necessary.

Table F-18: Calibrate Gigatronics 8542 Power Meter

Step Action
1 ! CAUTION

Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or miscalibration.

Make sure the power meter POWER pushbutton is OFF.

2 Connect the power sensor cable to the SENSOR input.

Set the POWER pushbutton to ON.
NOTE

Allow the power meter and sensor to warm up and stabilize for a minimum of 60 minutes before
performing the calibration procedure.

Connect the power sensor to the CALIBRATOR output connector.

Press ZERO.

— Wait for the process to complete. Sensor factory calibration data is read to power meter during this
process.

6 When the zeroing process is complete, disconnect the power sensor from the CALIBRATOR output.

Figure F-16: Gigatronics 8541C Power Meter
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Transmit & Receive Antenna VSWR

Purpose

Test equipment

The following procedures will verify that the Voltage Standing Wave
Ratio (VSWR) of all antennas and associated feed lines fall within
acceptable limits. The tests will be performed on all antennas in a
sequential manner (i.e., ANT 1, then ANT 2) until all antennas/feedlines
have been verified.

These procedures should be performed periodically by measuring each
respective antenna’s VSWR (reflected power) to verify that the antenna
system is within acceptable limits. This will ensure continued peak
system performance.

The antenna VSWR will be calculated at the CDMA carrier frequency
assigned to each antenna. Record and verify that they meet the test
specification of less than or equal to 1.5:1.

NOTE

* Motorola recommends that the installer be familiar with the
following procedure in its entirety before beginning the
actual procedure. Ensure that the entire site is currently not in
service.

* This test is used to test RX antennas by substituting RX
frequencies for TX frequencies.

Study the site engineering documents and perform the following tests
only after first verifying that the RF cabling configuration required to
interconnect the BTS frames and antennas meet requirements called out
in the BTS Installation Manual.

The following pieces of test equipment will be required to perform this
test:

e LMF
* Directional coupler

e Communications test set

WARNING Prior to performing antenna tests, insure that no CDMA BBX

channels are keyed. Failure to do so could result in personal
injury or serious equipment damage.

G-2
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Equipment Setup — HP Test Set

Follow the procedure iqj"able G-1 to set up test equipment required to
measure and calculate the VSWR for each antenna.

Table G-1: VSWR Measurement Procedure — HP Test Set

Step Action HP TEST SET
1 For manual VSWR testing, using external directional coupler, refer tqjigure G-1.
— Connect the communications test set RF IN/OUT port to the INPUT port of the directional
coupler.
— Connect the ANT IN port of the communication test set to the reverse (RVS) port on the
directional coupler. Terminate the forward port with a 50 ohm load.
— Install the antenna feed line to the output port on the directional coupler.
NOTE
Manual Communications Analyzer test setup (fields not indicated remain at default):
¢ Set screen to RF GEN.
— Set the RF Gen Freq to center frequency of actual CDMA carrier between 869-894 MHz for
TX and 824-849 MHz for RX.
— Set Amplitude to =30 dBm.
— Set Output Port to RF OUT.
— Set AFGenl & AFGen2 to OFF.

2 Remove the antenna feed line and install an “RF short” onto the directional coupler output port.
NOTE
Set—up communication test set as follows (fields not indicated remain at default):

* Set screen to SPEC ANL.
— Under Controls, set input port to ANT.
— Set Ref Level to —40 dBm.
— Under Controls, select Main, select Auxiliary.
— Under Controls, select AVG. Set Avg = 20.

3 — Record the reference level on the communications analyzer and Note as Pg for reference.

— Replace the short with the antenna feedline. Record the reference level on the communications
analyzer and Note for as P, reference.
— Record the difference of the two readings in dB.
4 Calculate the VSWR per the equation shown to the right.
Where: &
Rrp@B) = Pa@Bm) — PgdBm) 1+ 10
PA = Power reflected from antenna VSWR = RL
Ps = Power reflected from short 1-10
A calculated value of —13.98 dB equates to VSWR of better than 1.5:1.

5 If the readings indicate a potential problem, verify the physical integrity of all cables (including any
in—line components, pads, etc.) and associated connections up to the antenna. If problem still persists,
consult antenna OEM documentation for additional performance verification tests or replacement
information.

... continued on next page
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ﬂable G-1: VSWR Measurement Procedure — HP Test Set

Step Action HP TEST SET

6 Repeat stepg througl3 for all remaining TX sectors/antennas.

7 Repeat stepg througl3 for all remaining RX sectors/antennas.

Figure G-1: Manual VSWR Test Setup Using HP8921 Test Set

FEED LINETO
ANTENNA

/éy/ UNDER TEST
~ RF
S @) SHORT
RVS ~ ~
PORT o

OUTPUT
PORT

FWD (INCIDENT)
PORT 50—-OHM
TERMINATED LOAD

FW00343

G-4 1X SC 4812T-MC Multicarrier BTS Optimization/ATP Sept 2003



68P64115A21-B Transmit & Receive Antenna VSWR

Equipment Setup — Advantest Test Set

Follow the procedure iqj"able G-2 to set up test equipment required to
measure and calculate the VSWR for each antenna.

Table G-2: VSWR Measurement Procedure — Advantest Test Set

Step Action ADVANTEST

1 If you have not already done so, refer to the procedure irpfable 3-5 on pagq3-16 to set up test
equipment and interface the LMF computer to the BTS.

2 For manual VSWR testing using external directional coupler, refer tqfigure G-2.
— Connect the communications test set RF OUT port to the input port of the directional coupler.

— Connect the INPUT port of the communication test set to the forward port on the directional
coupler. Terminate the forward port with a 50 Ohm load.

— Connect the RF short to the directional coupler output port.

3 Preform the following to instruct the calibrated test set to generate a CDMA RF carrier (RVL call)
with all zero longcode at the assigned RX frequency at —10 dBm:

* Push the ADVANCE Measurement key.
* Push the CDMA Sig CRT menu key.
* Push the FREQ Entry key:

— Set RF Gen Freq to center frequency of actual CDMA carrier between 869-894 MHz for TX
and 824-849 MHz for RX.

* Push the LEVEL Entry key; set to 0 dBm (by entering 0 and pushing the —dBm key).
® Verify that ON is active in the Output CRT menu key.
* Verify that OFF is active in the Mod CRT menu key.
* Push the CW Measurement key.
* Push the FREQ Entry key.

— Push the more 1/2 CRT menu key.

— Set Preselect CRT menu key to 3.0G. G
* Push the Transient Measurement key.

— Push the Tx Power CRT menu key.

— Push the LEVEL entry key (set to 7 dBm by entering 7 and pushing the the dBm key).

— Set Avg Times CRT menu key to ON. Set to 20 (by entering 20 and pushing the Hz ENTER
key).
¢ Push the REPEAT Start key to take the measurement.

4 Record the Burst Power display on the communications analyzer and Note as Pg for reference.

Install the antenna feedline to the output port of the directional coupler.

* Push the Auto Level Set CRT menu key.
¢ Push the REPEAT Start key to take the measurement.

7 Record the Burst Power on the communications analyzer and Nofe as P level for reference.

Record the difference of the two readings in dBm.

. .. continued on next page
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ﬂable G-2: VSWR Measurement Procedure — Advantest Test Set

Action ADVANTEST

Step
8 Calculate the VSWR per the equation shown to the right.
Where: &
Rrp@B) = Pa@Bm) — PgdBm) 1+ 10
PA = Power reflected from antenna VSWR = RL
Ps = Power reflected from short 1-10
A calculated value of —13.98 dB equates to VSWR of better than 1.5:1.

9 If the readings indicate a potential problem, verify the physical integrity of all cables (including any
in—line components, pads, etc.) and associated connections up to the antenna. If problem still persists,
consult antenna OEM documentation for additional performance verification tests or replacement
information.

10 Repeat steps 2 through 9 for all remaining TX sectors/antennas.

11 Repeat steps 2 through 9 for all remaining RX sectors/antennas.

Figure G-2: Manual VSWR Test Setup Using Advantest R3465
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Download ROM Code
Download ROM Code

ROM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded changes to
OOS_ROM (blue) and remains OOS_ROM (blue). The same R-level
RAM code must then be downloaded to the device. This procedure
includes steps for both the ROM code download and the RAM code
download.

ROM code files cannot be selected automatically. The ROM code file
must be selected manually. Follow the procedure irjable H-1 to
download ROM code.

Prerequisite
e ROM and RAM code files exist for the device to be downloaded.

CAUTION The R-level of the ROM code to be downloaded must be the
same as the R—level of the ROM code for other devices in the
BTS. Code must not be mixed in a BTS. This procedure should
only be used to upgrade replacement devices for a BTS and it
should not be used to upgrade all devices in a BTS. If a BTS is
to be upgraded from one R—level to another, the optimization
and ATP procedures must first be performed with the BTS in the
original configuration. The upgrade should then be done by the
CBSC.

Table H-1: Download ROM Code

Step

Action

Click on the device to be downloaded.

NOTE

More than one device of the same type can be selected for download by either clicking on each one to
be downloaded or from the BTS menu bar Select pull-down menu, select the device item that applies.

Where: device = the type of device to be loaded (BBX, CSM, GLI, MCC)

Click on the Device menu.

Click on the Status menu item.
A status report window appears.

Make a note of the number in the HW Bin Type column.

NOTE

“HW Bin Type” is the Hardware Binary Type for the device. This code is used as the last four digits in
the filename of a device’s binary ROM code file. Using this part of the filename, the ROM code file
can be matched to the device in which it is to be loaded.

Click on the OK button to dismiss the status report window.

NOTE

ROM code is automatically selected for download from the <x>:\<1mf home
directory>\version folder>\<code folder> specified by the NextLoad property in
the bts—#.cdf file. To check the value of the NextLoad property, click on
Util>Examine>Display Nextload. A pop—up message will show the value of the NextLoad.

... continued on next page
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ETable H-1: Download ROM Code

Step Action

6 Click on the Download Code Manual menu item.
A file selection window appears.

Double—click on the version folder that contains the desired ROM code file.

8 Double—click on the Code folder.
A list of ROM and RAM code files is displayed.

! CAUTION

A ROM code file having the correct hardware binary type (HW Bin Type) needs to be chosen. The
hardware binary type (last four digits in the file name) was determined in steg4. Unpredictable results
can happen and the device may be damaged (may have to be replaced) if a ROM code file with wrong
binary type is downloaded.

9 Choose a ROM code file having the correct hardware binary type (HW Bin Type).
The hardware binary type (last four digits in the file name) was determined in steg4.

10 | Click on the ROM code file that matches the device type and HW Bin Type (e.g., bbx_rom.bin.0604
for a BBX having a HW Bin Type of 0604).

The file should be highlighted.

11 Click on the Load button.
A status report window displays the result of the download.

NOTE

If the ROM load failed for some devices, load them individually by clicking on one device, perform
stepyf througi1 for it, and repeat the process for each remaining device.

12 | Click on the Ok button to close the status report window.

13 Click on the Util menu.

14 Select the Tools menu item.

15 | Click on the Update NextLoad>CDMA menu item.

16 Select the version number of the folder that was used for the ROM code download.

17 | Click on the Save button.
A pop—up message indicates that the CDF file has been updated.

18 | Click on the OK button to dismiss the pop—up message.

19 Click on the device that was downloaded with ROM code.

20 Click on the Device menu.

21 Click on the Download Code menu item to download RAM code.
A status report window displays the result of the download.

NOTE

Data is automatically downloaded to GLI devices when the RAM code is downloaded. Use the
Download Data procedure to download data to other device types after they have been upgraded.

22 | Click on the Ok button to close the status report window.

The downloaded device should be OOS_RAM (yellow) unless it is a GLI in which case it should be
INS (green).

23 Click on the device that was downloaded.

... continued on next page
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ETable H-1: Download ROM Code

Step Action
24 | Click on the Device menu.
25 | Click on the Status menu item.
Verify that the status report window displays the correct ROM and RAM version numbers.
26 Click on the Ok button to close the status report window.
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BTS Router Initial Configuration

Overview

This appendix contains information and operations related to loading an
MWR 1941 BTS router with the minimum standard (canned)
configuration necessary for network communications. Once the router is
communicating on the network, the full, site-specific, operational
configuration can be downloaded to the router over the network. This
appendix includes sections on:

¢ Terminal Setup

* Downloading canned BTS router configuration files

* Veritying IOS canned version of CF memory card

* Replacing installed BTS router CF memory card IOS version
® Verify and upgrade rommon version

¢ Recovery from BTS router boot to rommon

* Entering or changing router FE interface IP address

* Preparation for site turn—over
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Terminal Setup

General

This section provides the procedures to configure and save a terminal
session for communicating with the MWR 1941 BTS router. Terminal
settings are the same as those used for BTS card and module
Man-Machine Interface (MMI) communication sessions. The procedures
are for a Pentium® processor—based computer operating with either
Windows 98 Second Edition (SE) or Windows 2000.

Using the LMF computer

LMF computer platforms can be used for communicating with the
routers, and the MMI terminal connection created for BTS card/module
optimization actions will operate with the BTS routers. See the
“Establishing a BTS Router Communication Session” section of this
appendix for additional interface hardware required for BTS router
communication.

Terminal Settings

Follow the procedure irﬂ" able I-1 to create a named HyperTerminal
connection for BTS router interface and generate a Windows desktop
shortcut for it.

NOTE There are differences between Windows 2000 and Windows 98 in
the menus and screens used for creating a HyperTerminal
connection. In the following procedure, items applicable to:

e Windows 2000 will be identified with Win2000
e Windows 98 will be identified with Win98

Table I-1: Establish HyperTerminal Connection

Step Action

1 From the Windows Start menu, select Programs > Accessories

2 Perform one of the following:

* For Win2000, select Hyperterminal and then click on HyperTerminal

* For Win98, select Communications, double click the Hyperterminal folder, and then double click
on the Hypertrm.exe icon in the window which opens.

NOTE

¢ If a Location Information Window appears, enter the required information, then click on the
Close button. (This is required the first time a HyperTerminal connection is configured, even if a
modem is not to be used.)

* If a You need to install a modem..... message appears, click on NO.

3 When the Connection Description box opens:

— Type a name for the connection being defined (for example, BTSRTR Session, MMI) in the
Name: window,

— Highlight any icon preferred for the named connection in the Icon: chooser window, and
— Click OK.

... continued on next page
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Table I-1: Establish HyperTerminal Connection

Step Action

4 From the Connect using: pick list in the Connect To box displayed, select the RS—232 port to be
used for the connection (e.g., COM1 or COM2 — Win2000 or Direct to Com 1 or Direct to Com 2 —
Win98), and click OK.

5 In the Port Settings tab of the COM# Properties window displayed, configure the RS—232 port
settings as follows:
* Bits per second: 9600
¢ Data bits: 8
¢ Parity: None
¢ Stop bits: 1
* Flow control: None

6 Click OK.

7 With the HyperTerminal window still open and the connection running, select:
File > Properties

8 Click the Settings tab, click the arrow in the Emulation window, and select VT100 from the
dropdown list.

9 Click the ASCII Setup button, uncheck all boxes in the ASCII Setup window which appears, and
click OK.

10 | Click OK for the connection Properties box.

11 Save the defined connection by selecting:
File > Save

12 | Close the HyperTerminal window by selecting:
File > Exit

13 Click the Yes button to disconnect when prompted.

14 | Perform one of the following:
* If the Hyperterminal folder window is still open (Win98), proceed to steg 36, or
* From the Windows Start menu, select Programs > Accessories

15 Perform one of the following:
* For Win2000, select Hyperterminal and release any pressed mouse buttons.
* For Win98, select Communications and double click the Hyperterminal folder.

16 | Highlight the newly—created connection icon by moving the cursor over it (Win2000) or clicking on it
(Win98).

17 | Right click and drag the highlighted connection icon to the Windows desktop and release the right
mouse button.

18 | From the popup menu displayed, select Create Shortcut(s) Here.

... continued on next page
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Table I-1: Establish HyperTerminal Connection

Step Action

19 | If desired, reposition the shortcut icon for the new connection by dragging it to another location on the
Windows desktop.
NOTE

The shortcut icon can now be double—clicked to open a BTS router or BTS card/module MMI
HyperTerminal session without the need to negotiate multiple menu levels.

BTS Router Serial Communication

For those procedures which require serial communication with BTS
routers, follow the procedures irpJable I-2 to initiate the communication
session. This procedure calls out the LMF computer platform, but any
VT100-equivalent terminal or computer equipped with terminal
emulation software and a hardware serial connector may be used.

Required Items

The following items are required to perform the verification:

¢ [ MF computer platform or equivalent (see this manual for
requirements)

¢ Eight—conductor (four—pair, unshielded twisted pair is acceptable)
rollover cable, two 8—contact modular plugs (seqdjigure I-1 for cable
wiring requirements)

¢ Adapter, DB-9 plug—to—8—contact modular plug, Global Computer
Supplies C4717 or equivalent (seqfigure I-2 for adapter wiring
requirements)

Figure I-1: Wiring Diagram, BTS Router Communication Rollover Cable

8—contact 8—contact
Modular Modular
Plug Plug
8-contact Plug 1 8
Contact Numbering

(Insertion End) 2 7

87654321 3 6
[T

4 5

= 5 4

\ 6 3

Locking
Clip 7 2
8 1
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Figure I-2: Wiring Diagram, DB—9 Plug—to—8—contact Modular Plug Adapter
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Table I-2: Establishing BTS Router Serial Communication

Step

Action

If it has not been done, start the computer and allow it to complete boot—up.

If a named HyperTerminal connection for BTS router serial communication or BTS card/module MMI
communication has not been created on the LMF computer, create one as described irJable I-1 in the
“Terminal Set—up” section of this appendix.

Connect the computer to the BTS router as shown ir‘jigure I-3.

Start the named HyperTerminal connection for BTS router communication sessions by double clicking
on its Windows desktop shortcut.

NOTE

If a Windows desktop shortcut was not created for the communication session, access the connection
from the Windows Start menu by selecting:

Programs > Accessories > Hyperterminal > HyperTerminal > <Named HyperTerminal
Connection (for example, BTSRTR)>

Once the connection window opens, establish communication with the BTS router by pressing the
computer Enter key until the prompt identified in the applicable procedure is obtained.
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Figure I-3: LMF Computer Connections to BTS Router
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Downloading Minimum Canned BTS Router Configuration Files

Downloading Overview

After they are generated on the OMC-R, the BTS router canned
configuration files must be transferred to another computer platform
from which they can be installed into the BTS routers. A number of
procedures may be used to move the canned configuration files from the
OMC-R to a platform from which they can be loaded into the routers.
Some alternatives are:

1. If a floppy diskette drive is available at the OMC-R, such as the one
for UNO workstations, the configuration files can be transferred to
an LMF computer or similar machine using the CDF file transfer
procedure in the Preparing the LMF section of this manual.
Directories identified ijable I-3 must be used rather than those in
the CDF file transfer procedure.

2. If a Windows—based server connection is available in the operator’s
network and it can provide an FTP or telnet connection to the
OMC-R, files may be transferred by either the FTP or telnet
methods.

3. [If a dial-up connection is available for accessing the OMC-R, an
FTP or telnet session may be possible to transfer files to the
computer used to load the CF memory cards.

The procedure provided in this section covers FTP transfer using a
Windows-based server in the operator’s network. Coordinate with the
local network administrator to determine the method and procedure to
use on a specific network.

Prerequisites

The following must be obtained from the local network administrator
before performing the canned configuration file FTP procedure in
[Jable I-3:

¢ User ID and password to log onto the OMC-R

* Name of the sub—directory where the specific BTS router group
canned configuration files to be downloaded were created

FTP File Transfer from the OMC-R

This procedure uses the Windows—based LMF computer platform to
download BTS router canned configuration files from the OMC-R.
Follow the procedure irFable I-3.

Table I-3: BTS Router Canned Configuration File FTP Transfer from the OMC-R

Step Action

1 If it has not been done, create a directory on the LMF computer where the BTS router canned
configuration files will be stored.

2 If it has not been done, obtain the OMC-R logon user ID and password from the local network
administrator.

... continued on next page
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[Table I-3: BTS Router Canned Configuration File FTP Transfer from the OMC-R

Step Action

3 Connect the LMF computer to the local network and log on.

NOTE

This procedure uses the command line FTP client supplied with Windows 98, Second Edition (Win98
SE) and Windows 2000 (Win2K); however, any commercially available FTP client application can be
used. Follow the manufacturer’s instructions for operation of an alternative application.

4 Open a command line (MS DOS) window by clicking on Start > Programs > Command Prompt.

5 When the command line window opens, change to the directory where the canned configuration files
will be stored on the LMF computer by entering:

cd pathname
Where pathname = the path to the required directory.
A response similar to the following will be displayed:

C:\> cd Can_Cfg
C:\Can_Cfg>

6 Check the contents of the directory by entering the following:
dir
A response similar to the following will be displayed:

C:\Can_Cfg>dir
Volume in drive C is MAIN
Volume Serial Number is F2AA—-1721

Directory of C:\Can_Cfg>

08/22/2002 03:46p <DIR>

08/22/2002 03:46p <DIR> .

08/22/2002 03:46p 2,223 btsrtr_canned.blue

08/22/2002 03:47p 2,223 btsrtr_canned.red
2 File(s) 4,644 bytes

2 Dir(s) 2,556,045,312 bytes free

C:\Can_Cfg>

7 If either or both of the following files are found in the directory, delete them or move them to another
directory:

® btsrtr_config.blue

® btsrtr_config.red

8 Begin the FTP session by entering the following:

ftp hostname
Where hostname = the OMC-R hostname or IP address.
A response similar to the following will be displayed:
C:\Can_Cfg> ftp OMCR-1
C:\Can_Cfg>
Connected to OMCR-1.

220 OMCR—1 FTP server (SunOS 5.6) ready.
User (OMCR—1:(none)):

. .. continued on next page
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[Table I-3: BTS Router Canned Configuration File FTP Transfer from the OMC-R

Step

Action

Enter the User ID and password when prompted, pressing the Enter key after each. A response
similar to the following will be displayed:

User (OMCR—1:(none)): scadm

331 Password required for scadm.
Password:

230 User scadm logged in.

ftp>

10

Change to the directory where the BTS router canned configuration file sub—directories are created and
verify the present working directory by entering the following, pressing the Enter key after each:

cd /home/scadm/btsrtr_canned_configs
pwd
A response similar to the following will be displayed:

ftp> cd /home/scadm/btsrtr_canned configs

240 CWD command successful.

ftp> pwd

245 "/home/scadm/btsrtr_canned_configs” is current directory.

11

Enter the Is command to list the contents of the directory and be sure the specific canned configuration
directory name provided by the administrator exists. A response similar to the following will be
displayed:

ftp> 1s

200 PORT command successful.

150 ASCII data connection for /bin/ls (10.182.29.117,80) (0 bytes).
Mon_Jul 2 01:55:07_CDT 2002

Wed _Jul 24 09:35:41 CDT 2002

Tue_Aug 04_10:35:22_CDT_2002

226 ASCII Transfer complete.

ftp: 30 bytes received in 0.02Seconds 1.50Kbytes/sec.

ftp>

NOTE

Directory names where canned configuration files are located will consist of the
weekday_month_day_time_year when the canned configuration files were created on the OMC—R.

12

Change to the directory specified for the BTS router group to be configured and list the directory
contents by entering the following, pressing the Enter key after each command:

cd weekday_month_day_time_year
Is
A response similar to the following will be displayed:

ftp> cd Wed_Jul 24 09:35:41_CDT 2002

250 CWD command successful.

ftp> 1s

200 PORT command successful.

150 ASCII data connection for /bin/ls (10.182.29.117,80) (0 bytes).
btsrtr canned.blue

btsrtr_ canned.red

226 ASCII Transfer complete.

ftp: 39 bytes received in 0.05Seconds 0.78Kbytes/sec.

ftp>

... continued on next page
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[Table I-3: BTS Router Canned Configuration File FTP Transfer from the OMC-R

Step

Action

13

Change to the binary transfer mode and, if desired, turn on hash mark printing for transfer progress by
entering the following, pressing the Enter key after each command:

bin

hash
A response similar to the following will be displayed:

ftp> bin

200 Type set to I.

ftp> hash

Hash mark printing On ftp: (2048 bytes/hash mark)
ftp>

NOTE

With Win98 SE, turning on hash mark printing can slow down file transfer in certain circumstances,
but the canned configuration files are quite small (approximately 2.5 KB) so there should be little
noticeable effect.

14
14a

14b

Download the BTS router canned configuration files to the LMF computer by performing the following:

— Enter the following to download the first canned configuration file:
get btsrtr_canned.blue
A response similar to the following will be displayed:

ftp> get btsrtr canned.blue

200 PORT command successful.

150 Binary data connection for btsrtr canned.blue (10.182.29.117,80) (2223 bytes).
#

226 Binary Transfer complete.

ftp: 2223 bytes received in 0.59Seconds 3.76Kbytes/sec.

ftp>

— Enter the following to download the second BTS router canned configuration file:
get btsrir_canned.red
A response similar to the following will be displayed:

ftp> get btsrtr_canned.red

200 PORT command successful.

150 Binary data connection for btsrtr canned.red (10.182.29.117,80) (2223 bytes).
#

226 Binary Transfer complete.

ftp: 2223 bytes received in 0.59Seconds 3.76Kbytes/sec.

ftp>

... continued on next page
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[Table I-3: BTS Router Canned Configuration File FTP Transfer from the OMC-R

Step Action
15 | Before terminating the FTP session, open Windows Explorer and view the contents of the directory
where the canned configuration files are to be stored to be sure the files are present. Perform the
following:
15a — Click Start > Programs > Windows Explorer.
15b — In the left-hand pane of Windows Explorer, perform one of the following depending on the LMF
computer operating system:
— Win98 SE: If necessary, expand the directory display for the drive where the canned configu-
ration file storage directory is located by clicking on the + next to the drive icon.
— Win2K: Expand the user profile and directory display for the drive where the canned configu-
ration file storage directory is located by clicking on the + next to each icon, respectively.
15¢ — Expand any sub—directories as required to display the directory folder where the canned
configuration files are to be stored.
15d — Click on the directory folder icon where the canned configuration files are to be stored.
15¢ — In the right~hand pane, verify that the files btsrtr canned.blue and btsrtr_canned.red
appear.
15f — If the files appear, proceed to ste36.
15¢ — If the files do not appear, repeat steg 4, its sub—steps, ste}5 and its sub—steps.
16 | Close Windows Explorer, and, in the command line window, enter the bye command to terminate the
FTP session. A response similar to the following will be displayed:
ftp> bye
221 Goodbye.
C:\Can_Cfg>
17 | Close the command line window by entering the exit command.
18 | BTS router canned configuration files are now ready for transfer to a BTS router.
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Verifying I0S Canned Version of the CF Memory Card

Overview

This section covers the procedures and commands required to verify the
IOS version loaded on BTS router CF memory cards and copy standard
canned configuration files to the routers. Because of the set—up required
and the length of some of the procedures, Motorola recommends
performing the actions covered in this section at a central location to
prepare the BTS routers for installation prior to the site visit.

I0S Version Verification and File Sequence Position

Version verification — The 10S version loaded on the BTS router CF
memory card should be verified as the version required for operation on
the network where the routers will be installed. If the loaded 10S version
is not correct, it can be replaced with a different version. There are
several methods available to accomplish version verification. These
depend on the equipment and software applications the user selects to
use in installing the canned configuration files in the BTS routers.
Appropriate verification procedures are included in each of the two
canned configuration installation methods covered in this section.
Methods to change the loaded IOS version are provided in the Change
BTS Router I0S Version section of this appendix and are referenced at
the appropriate places in the canned configuration installation methods.

File sequence position — During initialization, the MWR 1941 router
will first search the startup—config file for a boot system command
line telling it in what directory and file to find the boot loader. If this line
is not found, the router will default to attempting to boot from the first
file in its flash memory. Flash memory for the MWR 1941 is the CF
memory card (software identifier slot0:). The canned configuration files
used for BTS router installation do not contain a boot system command
line because of the need to maintain flexibility for IOS version changes.
Because of this, it is critical that the IOS file is the first file listed on the
CF memory card. The canned configuration installation procedures
contain steps to assure that this is the case, and, if it is not, provide
guidance to correct the condition. It is important to remember that, if the
router boots and displays a rommon 1 > prompt, the IOS file is
missing, out of sequence, has a corrupted flash memory image or the
startup—config file contains a boot system line which specifies a
missing or incorrect IOS pathname/filename.

Canned Configuration File Installation

Filename and installation location requirements — The canned
configuration files for the BTS routers must be copied to the CF memory
card. The filename of the file on the CF memory card must be
canned—config. Canned configuration file location and filename
requirements are a result of Mobile Wireless Center (MWC) actions
during the process of switching a BTS from packet to circuit mode. In
this process, the MWC will query the BTS routers’ slotO: directory for a
file named canned—config. A missing or mis—named file will cause
problems with execution of the mode—switching process.
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Installation Methods — The startup—config configuration file used
by the BTS router during initialization is stored in NVRAM. This is a
memory device internal to the router and is separate from the CF
memory card. To install the canned configuration file so the router will
use it during boot—up, the file must be copied into the
startup—config file in NVRAM. There are two methods available to
accomplish this:

1. Using a tftp server application to copy the canned configuration file
from the Windows—based LMF computer to the CF memory card
installed in a router, and then copying it to the startup—config
file in the router’s NVRAM

2. Using a CF memory card reader to copy the canned configuration
file to a CF memory card, and then, once the CF memory card is
installed in the router, using a HyperTerminal communication
session to copy the file from the CF memory card to the
startup—config file in the router’s NVRAM

Comparison of methods — Preparation for using the tftp server
application method is extensive and requires setting up simultaneous
serial and FE communication sessions with the router. This method
offers the advantage of being able to verify 10S file sequence position
immediately and supporting direct file transfers between the router and
LMF computer without removing the CF memory card. As an
alternative, using a CF memory card reader to copy the canned
configuration file to a CF memory card, and from there to the
startup—config file requires very little set—up. With this method, the
IOS file sequence position can only be verified once the CF memory
card is installed in the router, and any file transfers between the router
and LMF computer require physically moving the CF memory card
between the router and card reader.

Procedures to use each method — Using the tftp server application to
copy the canned configuration file to a CF memory card is covered in the
Method 1 subsection. Performing the transfer process with a card reader
is covered in the Method 2 subsection. The applicable procedures for
verifying the loaded IOS version and file sequence position are included
in each method.

File operations using a CF memory card reader — Only file transfers
should be performed using the CF memory card reader. CF memory card
formatting should be performed in a BTS router using a HyperTerminal
connection. Attempting to format a CF memory card from a
Windows—based computer using a card reader could result in
unpredictable BTS router operation.

CAUTION Do not format BTS router CF memory cards using a
Windows—based computer. Only format CF memory cards in a
BTS router.
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Method 1: Using a TFTP Server to Load to CF Memory Card

Required Equipment and Software

The following items are required to perform this procedure:

A Windows—based computer which meets the requirements of the
LMF computer platform as specified in this manual.

One of the following operating systems for the Windows—based
computer:

— Windows 2000
— Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION

BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

One of the following for the Windows—based computer:

— Internal 10/100baseT Network Interface Card (NIC)

— PCMCIA 10/100baseT NIC

Cable, Ethernet crossover, Category SE or better, unshielded twisted

pair, two 8—contact modular plugs, in one of the following lengths, as
determined necessary:

— 0.3 m (11.8 in) (Motorola pn 3088643C07)

— 0.6 m (23.6 in)(Motorola pn 3088643C13)

— 1.0 m (39.4 in) (Motorola pn 3088643C15)

— 2.1 m (84 in) (Motorola pn 3088643C08)

— 3.0 m (120 in) (Motorola pn 3088643C09)

Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

DB-9 plug—to—8—contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

A tftp server software application (refer to the Setting Up the TFTP
Server — Procedure in Cellular System Administration — CDMA
OnLine Documentation, Release 2.16.1) such as:

— Cisco tftp server

— PumpKIN tftp server

— Any other equivalent tftp server application

A copy of the MWR 1941 router 10S version required for the network
where the routers are to be installed (contact the network administrator
or the Motorola account team for information on obtaining the
required MWR 1941 IOS version)

A +27 Vdc power supply to power the BTS router during
configuration file operations

Required Materials

The following material is required to perform this method:

Marking material to identify the BTS router and CF memory card with
the installed configuration (blue or red)
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Required Publications

The following publications are required to perform procedures in this
section:

® this manual

o Cellular System Administration — CDMA OnLine Documentation,
Release 2.16.1

* MWRI1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78—13983-01

Preparation for Canned Configuration File TFTP
Transfer to CF Memory Card

Preparation for a canned configuration file tftp transfer consists of the

following activities:

1. Setting the LMF computer NIC IP address

2. Creating a directory (folder) on the LMF computer to be used for all
tftp file transfers

3. Installing the tftp server application on the LMF computer, and
setting the tftp server application root directory to the directory
created in 2, above

4. Connecting the LMF computer to the BTS router for both
HyperTerminal (serial) and Ethernet communication

5. BTS router power—up and initial configuration for Ethernet
communication

The following procedures are used to accomplish all of these preparatory
actions.

Set LMF computer NIC TCP/IP address and create the default
TFTP directory — Follow the procedure ijable I-4 to set the NIC IP
address.

NOTE IMPORTANT! If the IP address for the LAN connection on an
LMF computer is being changed to support tftp downloads to a
BTS router, the BTS 10base—2 LAN IP address and subnet mask
for the NIC must be restored before the LMF can log into a BTS
to perform an optimization or ATP.

NOTE There are differences between Windows 2000 and Windows 98 in
the menus and screens used for setting or changing a NIC
connection. In the following procedure, items applicable
to: Windows 2000 will be identified with Win2000Windows 98
will be identified with Win98
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Table I-4: Set LMF Computer NIC IP Address and Create a Default TFTP Directory

Step Action

1 Start the computer.

2 Login and allow the computer to boot to the desktop.

3 Depending on the installed operating system, from the Windows Start menu, select one of the
following:

* Win2000: Settings > Network and Dial-up Connections
* Win98: Settings > Control Panel and double—click Network.

4 Perform one of the following as applicable for the installed operating system:

* For Win2000, in the list of displayed connections, locate the Local Area Network connection for the
NIC to be used for BTS router Ethernet communication.

* For Win98, in the Configuration tab of the Network dialog box, locate the TCP/IP connection for
the installed NIC.

— If TCP/IP does not appear in the displayed list of installed network components, refer to the
operating system documentation and install TCP/IP.

5 Perform one of the following as applicable for the installed operating system:

* For Win2000, highlight the connection for the NIC and right click the highlighted connection, and
select Properties from the pop—up menu.

* For Win98:
— Highlight the TCP/IP NIC connection in the displayed list of installed network components.
— Click the Properties button.

— Skip to stef§.

6 For Win2000 , in the Local Area Connection Properties dialog box which appears, if Internet
Protocol (TCP/IP) is not showing in the Components checked are used by this connection: listbox,
refer to the operating system documentation and install TCP/IP.

7 For Win2000, if the checkbox next to the Internet Protocol (TCP/IP) entry is not checked, click in the
box to check it.

8 Perform one of the following:

* Win2000: Highlight the Internet Protocol (TCP/IP) entry, and click on the Properties button below
the Components checked are used by this connection: listbox.

* Win98: From the tabs displayed in the TCP/IP Properties dialog box which opens, select the IP
Address tab if it is not at the front.

. .. continued on next page
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Table I-4: Set LMF Computer NIC IP Address and Create a Default TFTP Directory

Step Action
9 In the Internet Protocol (TCP/IP) Properties dialog box which appears (Win2000) or the IP Address
tab of the TCP/IP Properties dialog box (Win98), perform the following:
9a — If a black dot is not showing in the the radio button circle next to Use the following IP address:
(Win2000) or Specify an IP address (Win98), click on the radio button.
— A black dot will appear in the circle.
9b — If using an LMF computer, record the IP address and subnet mask used for LMF-BTS
communication so they can be re—entered when tftp transfer activities for the BTS router are
completed.
9¢ — Enter 100.100.100.1 in the IP address: box.
9d — Enter 255.255.255.252 in the Subnet mask: box.
10 | Click the OK button for the Internet Protocol (TCP/IP) Properties dialog box (Win2000) or the
TCP/IP Properties box (Win98).
11 | Click the OK button for the Local Area Connection Properties box (Win2000) or the Network box
(Win98).
12 In Win98, click File > Close to close the Control Panel window.
13 | Click Start > Programs > Windows Explorer to open Windows Explorer.
14 | If the default tftp directory will be the same directory in which the files downloaded from the OMC-R
are stored, proceed to steHjZ.
15 | In the left-hand pane of Windows Explorer, locate the icon for the drive where the default tftp
directory is to be created.
16 | Highlight the drive icon and click Files > New > Folder.
17 | While observing the new folder icon in the right—hand pane, type the name for the folder (for example,
tftp_files), and press the Enter key.
18 | In Windows Explorer, locate the directory where the canned configuration files downloaded from the
OMC-R are stored.
19 | In the left-hand pane, highlight the directory where the files are stored.
20 | Scroll the left—hand pane until the newly—created default tftp directory is visible.
21 In the right—hand pane, highlight the canned configuration files and drag them to the default tftp
directory.
22 | In the left—hand pane, click on the default tftp directory, and verify that the canned configuration files
appear in the right—hand pane.
23 | Load a copy of the required BTS router IOS version into the default tftp directory using FTP, internet
download, or media such as a Zip disk (file size is over 7 MB).
24 | Click Files > Close to close Windows Explorer.
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Install and configure tftp server application

To obtain, install, and configure the Cisco or PumpKIN tftp software
applications, refer to the Setting Up the TFTP Server — Procedure in
Cellular System Administration — CDMA OnLine Documentation,
Release 2.16.1 For other tftp server applications, install and configure
the application according to the manufacturer’s instructions.

NOTE Important: When entering the name of the tftp server root
directory while configuring the tftp server application, be sure to
use the name of the directory identified iqj"able I-4, steqj4, or
created irlj"able I-4, steq:]ﬂ, above.

Connect the LMF computer to the BTS router

Connect the LMF computer to the BTS router by following the
procedure irfJable I-5 and referring tqijigure I-4..

Figure I-4: LMF Computer TFTP Connections to BTS Router
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Table I-5: Connecting the LMF Computer to the BTS Router for TFTP File Transfer

Step Action

1 If the BTS router has not been connected to a power source, be sure the +27 Vdc power source is not
on, and connect it to the router.

2 Connect the LMF computer to the BTS router as shown i igure I-4, referring to the list of required
equipment in this section as required.

3 If the LMF computer has not been started, turn it on, login, and allow it to boot to the desktop.

4 Refer to the procedure irrfable I-2 of this appendix, and start a HyperTerminal communication session
for the BTS router.

5 Start the tftp server application as specified for the software (refer to the Setting Up the TFTP Server —
Procedure in Cellular System Administration — CDMA OnLine Documentation, Release 2.16.1 or the
manufacturer’s instructions).

BTS router power—up and initial configuration for
Ethernet communication
Follow the procedure iqj“able I-6 to apply power to the router and set
an initial configuration for Ethernet communication.
* The required version of the IOS is loaded on the CF memory card
* The CF memory card is installed in the BTS router
Table I-6: BTS Router Power—up and Initial Ethernet Configuration
Step Action
* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1

Be sure a CF memory card loaded with the Cisco IOS is installed in the BTS router (refer to the BTS Router
Card and Module Replacement section of the 1X SC 4812T-MC BTS FRU Guide 68P64115A20 for instruc-
tions to access the CF memory card slot).

* IMPORTANT

In this step do not touch the computer keyboard until the router completes the boot process. The router
will buffer any keystrokes made during the boot process and interpret them as commands to be
executed immediately following boot completion.

Apply power to the router and allow it to complete boot—up.

If a message similar to the following, is displayed, press the Enter key and proceed to stegJ:

Press RETURN to get started!

... continued on next page
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[Table I-6: BTS Router Power—up and Initial Ethernet Configuration

Step Action
4 If a message similar to the following, is displayed type no and press the Enter key:
Basic management setup configures only enough connectivity
for management of the system, extended setup will ask you
to configure each interface on the system
Would you like to enter basic management setup? [yes/no]:
A response similar to the following will be displayed:
Would you like to enter basic management setup? [yes/no]: no
Cisco Internetwork Operating System Software
I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(20020127:101239
Copyright (c) 1986—2002 by cisco Systems, Inc.
Compiled Sun 27—Jan—02 06:08 by walrobin
Router>
5 At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC mode:
enable
A response similar to the following will be displayed:
Router>enable
Router#
6 At the Router# privileged EXEC mode prompt, enter the following to access the configure submode:
configure terminal
A response similar to the following will be displayed:
Router#conf t
Enter configuration commands, one per line. End with CNTL/Z.
Router (config)#
The router is now in the global configuration mode and ready to accept configuration changes entered
from the keyboard.
... continued on next page
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[Table I-6: BTS Router Power—up and Initial Ethernet Configuration

Step

Action

At the global configuration mode prompt, type each of the following commands, pressing the Enter
key after each command:

hostname btsrtri
interface fa0/0

ip address 100.100.100.2 255.255.255.252
speed 100
duplex full

no shutdown

line con 0
exec—timeout 0 0
no login

line vty 0 4

no login

Responses similar to the following will be displayed:

Router (config)#hostname BTSRTR1
BTSRTR1 (config)#interface £a0/0
BTSRTR1 (config—if)#ip address 100.100.100.2 255.255.255.252
BTSRTR1 (config—if)#speed 100

BTSRTR1 (config—if)#duplex full
BTSRTR1 (config—if)#no shutdown
BTSRTR1 (config—if)#line con 0

BTSRTR1 (config—line)#exec—timeout 0 0
BTSRTR1 (config—line)#no login

BTSRTR1 (config—line)#line vty 0 4
BTSRTR1 (config—line)#no login

BTSRTR1 (config—line)#

Once the correct parameters have been set, return to the privileged EXEC mode prompt by holding
down the Ctrl key and pressing z (Ctrl+z). A response similar to the following will be displayed:

BTSRTR1 (config—line)# "z
01:11:27: %SYS—5—CONFIG I: Configured from console by console
BTSRTR1#

NOTE

Entering exit twice, pressing the Enter key after each entry, will also complete the configuration
process and return the router to the privileged EXEC mode.

Verify port FE 0 (fa0/0) is configured with the correct IP address by entering the following:
show ip interface brief

A response similar to the following will be displayed:

BTSRTR1#sh ip int br

Interface IP Address OK? Method Status Protocol
FastEthernet0/0 100.100.100.2YES manual up up
Serial0:0 unassigned YES unset administratively down down
FastEthernet0/1 unassigned YES unset administratively down down
Seriall:0 unassigned YES unset administratively down down

BTSRTR1#

10

The router is now configured for Ethernet communication on FE 0, and the canned configuration file
can be transferred by tftp. Proceed tqjable I-7.
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Verifying 10S Version and Canned Configuration File
TFTP Transfer to the BTS Router

Prerequisites — The following is required prior to performing this
procedure:

* A copy of the required MWR 1941 router 10S version file is installed
in the default tftp directory (transfer the file to the LMF computer
using FTP, internet download, or media such as a Zip disk; file size is
approximately 7-8 MB)

IOS verification and canned configuration file transfer — Follow the
procedure ir‘j"able I-7 to verify the loaded 10S version and transfer the
canned configuration files from the LMF computer to the BTS router CF
memory card.

NOTE IMPORTANT: MWR 1941 routers must be loaded with IOS
version mwr1900—i—mz.122-8.MC2d.bin or later. This router
model will not function properly with earlier IOS versions.

NOTE This procedure does not cover all aspects of BTS router
operation and programming. Before performing this procedure,
review BTS router initialization, operation, and programming
information and procedures in MWR1941 Wireless Mobile Edge
Router Software Configuration Guide; part number
78—13983-01. Have this publication available for reference
while performing this procedure.

Table I-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action

CAUTION

If personal firewall and/or intrusion detection software such as Black ICE is running on the LMF computer,
shut it down before performing this procedure. If this is not done, the tftp transfer process will not operate.

1 On the LMF computer, if it has not been done, start the tftp server according to the manufacturer’s
directions (refer to the Setting Up the TFTP Server — Procedure in the Cellular System Administration
— CDMA OnLine Documentation, Release 2.16.1).

* IMPORTANT

MWR 1941 routers must be loaded with I0S version mwr1900—i—-mz.122-8.MC2d.bin or later. This
router model will not function properly with earlier IOS versions.

2 If a HyperTerminal communication session with the BTS router is not running, start one following the
procedure irfable I-2.

3 In the HyperTerminal window, the router must be in the privileged EXEC mode, as indicated by a
number sign at the end of the prompt:

BTSRTR1#

4 Be sure the Ethernet crossover cable is connected between the LMF computer NIC port and the BTS
router FE 0 port (seqigure 1-4).

... continued on next page

Sept 2003 1X SC 4812T-MC Multicarrier BTS Optimization/ATP 1-23



Verifying 10S Canned Version of the CF Memory Card

68P64115A21-B

[Fable I-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action
5 Begin verification that the CF memory card contains the correct version of the Cisco IOS by entering

the following:
dir slot0:

A response similar to the following will be displayed:

BTSRTR1#dir slotO:

Directory of slot0:/
1 —rw— 7051976 Mar 01 1993 00:11:34 mwrl941—i—mz.122—8.MC2a.bin

31932416 bytes total (24879104 bytes free)

BTSRTR1#

NOTE

1. The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has
been changed using the ed command. Determine the present working directory by entering pwd.
If the present working directory has been changed, enter the command cd slot0: to return to the
default setting.

2. If slot0: is included in the command, be sure to include the colon (:) after slot0 when typing the
command.

3. The IOS filename will be similar to the following:
mwr1941-i-mz.122-8.MC2a.bin

. .. continued on next page
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[Fable I-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action
6 Direct the router to show the version information by entering the following:
show version

A response similar to the following will be displayed:
BTSRTR1#sh ver
Cisco Internetwork Operating System Software
I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(8)MC2a, EARLY DEPLOYMENT RELEASE
SOFTWARE (fcl)
TAC Support: http://www.cisco.com/tac
Copyright (c) 1986—2002 by cisco Systems, Inc.
Compiled Mon 05—Aug—02 11:07 by nmasa
Image text—base: 0x60008940, data—base: 0x60B54000
ROM: System Bootstrap, Version 12.2(20020113:235343) [sbose—wilma 109], DEVELOPMENT
SOFTWARE
ROM: 1941 Software (MWR1941-I-M), Version 12.2(8)MC2a, EARLY DEPLOYMENT RELEASE SOFT-
WARE (fcl)
Router uptime is 1 minute
System returned to ROM by power—on
System image file is ”slot0:mwrl941—i—mz.122—8.MC2a.bin”
cisco mwrl941 (R7000) processor (revision 0.1) with 121856K/18432K bytes of memory.
Processor board ID JMX0611K5TS
R7000 CPU at 240Mhz, Implementation 39, Rev 3.3, 256KB L2 Cache
Bridging software.
X.25 software, Version 3.0.0.
Primary Rate ISDN software, Version 1.1.
Toaster processor tmc is running.
2 FastEthernet/IEEE 802.3 interface(s)
2 Serial network interface(s)
2 Channelized T1/PRI port(s)
DRAM configuration is 64 bits wide with parity disabled.
55K bytes of non—volatile configuration memory.
31360K bytes of ATA Slot0 CompactFlash (Read/Write)
Configuration register is 0x101
BTSRTR1#

7 Compare the 10S filename returned in steg3 and the second line of the version information in ster§.
Note the correspondence between the filename and 10S version information.

8

If the IOS filename from the CF memory card returned in stepq is different than the filename of the
required IOS version loaded in the LMF computer default tftp directory, perform the procedure in
[Jable I-13 to load the required version, and then return to sterd, below.

. .. continued on next page
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[Fable I-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step

Action

9a

9
9¢

9d

CAUTION

The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.

If the IOS version is correct and there is more than one file loaded on the CF memory card, be sure the
1OS file is the first file listed in the directory content display. If it is not, perform the following:

— Backup all files on the CF memory card to the LMF computer default tftp directory by performing
stepgq througl30 ofJable I-13.

— Perform stepg35 throught39 ofjable I-13, as applicable.

— Type the following to delete a possible boot system line in the startup—config file, pressing the
Enter key after the command and at each prompt to confirm the filename and deletion operation:
del nvram:startup—config

A response similar to the following will be displayed:

BTSRTR1#del nvram:startup—config
Delete filename [startup—config]?
Delete nvram:startup—config? [confirm]
[OK]

BTSRTR1#

NOTE

Be sure to include the colon (:) after nvram when typing the command.

— Verify the startup—config file size has been reduced to a minimum by entering the following:
dir nvram:

A response similar to the following will be displayed:

Router#dir nvram:
Directory of nvram:/

53 —rw— 5 <no date> startup—config
54 5 <no date> private—config

57336 bytes total (57274 bytes free)
BTSRTR1#

10

At the privileged EXEC mode prompt, enter the following:
copy tftp:btsrtr_canned.color slot0:canned—config

Where color = blue or red, as applicable.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned—config
Address or name of remote host []?

. .. continued on next page
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[Fable I-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step

Action

11

At the prompt for the remote host address or name, enter the IP address of the LMF computer NIC:
100.100.100.1

A response similar to the following will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned—config

Address or name of remote host []? 100.100.100.1
Destination filename [canned—config]?

12

At the prompt for the destination filename, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned—config

Address or name of remote host []? 100.100.100.1

Destination filename [canned—config]?

Loading btsrtr canned.blue from 100.100.100.1 (via Ethernet0/0): !
[OK — 2457/4096 bytes]

2457 bytes copied in 84.724 secs (29 bytes/sec)
BTSRTR1#

13

Verify that the canned configuration file is saved on the CF memory card by entering dir command. A
response similar to the following will be displayed:

Directory of slot0:/

1 —rw— 7051976 Mar 01 1993 00:11:34 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2457 Mar 01 1993 00:14:48 canned—config

31932416 bytes total (24877983 bytes free)
BTSRTR1#

14

To allow the BTS router to boot using the canned configuration, enter the following:
copy canned-config startup—config

A response similar to the following will be displayed:

BTSRTR1#copy canned—config start
Destination filename [startup—config]?

15

When prompted for the destination file name, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy canned—config start
Destination filename [startup—config]?
2457 bytes copied in 3.52 secs
BTSRTR1#

16

Display and note the file size of startup—config by entering the following:
dir nvram:

A response similar to the following will be displayed:
Directory of nvram:/

26 —rw— 2457 <no date> startup—config
27 5 <no date> private—config

29688 bytes total (24774 bytes free)
BTSRTR1#

... continued on next page
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[Fable I-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action

17 | Scroll the HyperTerminal window back to the slot0: directory display obtained in ste 33, above.

18 | Compare the file size of startup—config to the canned configuration file to verify the copy operation.
File sizes should be the same.

19 | If desired, the contents of the startup—config file may be verified against the file listings at the end of
this appendix for the blue or red canned configuration, as applicable, by entering the following:

show startup—config
NOTE
Pressing the space bar at the MORE prompt will scroll another screen—full of data. Pressing the Enter
key will scroll the screen one line at a time.

20 | Verify the router will boot properly on the IOS and revised startup—config files by entering the
following:

reload
A response similar to the following will be displayed:
BTSRTR1#reload
System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

21 If prompted to save a modified configuration, enter n for “no,” and press the Enter key.

22 | When prompted to proceed with reload, press the Enter key to continue the reload operation.

23 | Verify the router reboots without displaying the rommon 1 > prompt or error messages related to port
configurations. If the router boots to the rommon prompt, proceed to the Recovery from BTS Router
Boot to rommon section of this appendix.

24 | Using the tagging materials, tag the router to clearly identify the installed configuration (blue
(BTSRTR1) or red (BTSRTR?2)).

25 | Remove the CF memory from the router following the procedure in the 1X SC 4812T-MC BTS FRU
Guide , mark the installed configuration (blue or red) on the card label, and install the card in the
router following the procedure in the FRU Guide.

26 | If an additional router must have the canned configuration installed, perform the following:

26a — Disconnect the cabling from the BTS router.

26b — Remove power from the router and disconnect it from the power supply.

26¢ — Repeat the procedures iqj"able I-5rFable I-6, and this table ﬂable 1-7) using the additional router.

27 | If no additional routers must be configured, perform stepg36a and36b.

28 | On the LMF computer, shut down the tftp server application and exit the HyperTerminal session.

29 | If no additional tftp transfer activities will be performed, change the NIC IP address and subnet mask
back to those for LMF-BTS communication recorded iqj" able I-4, steqﬁb.

CAUTION
If the BTS 10base—2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,
the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.
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Method 2: Using a CF Memory Card Reader to Load CF Memory Card

Required Equipment and Software

The following items are required to perform this procedure:

* A Windows-based computer which meets the requirements of the
LMF computer platform as specified in this manual.

* One of the following operating systems for the Windows—based
computer:
— Windows 2000
— Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

* Compact Flash memory card reader device and software driver for the
operating system installed on the LMF computer

CAUTION Card readers for other non—volatile, solid—state memory devices
such as Smart Media cards will not work with the CF memory
cards used in the MWR 1941 routers. Do not attempt to use a
card reader intended for another type of memory device.

* Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

* DB-9 plug—to—8—contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

* A copy of the MWR 1941 router 1OS version required for the network
where the routers are to be installed (contact the network administrator
and the Motorola account team for information on obtaining the
required MWR 1941 IOS version)

* A +27 Vdc power supply to power the BTS router during
configuration file operations

Required Materials

The following material is required to perform this method:

* Tagging and marking material to identify the BTS router and CF
memory card with the installed configuration (blue or red)

Required Publications
The following publications are required to perform procedures in this
section:

o Cellular System Administration — CDMA OnLine Documentation,
Release 2.16.1

* MWR1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78—13983-01

File Operations Using a CF Memory Card Reader

Only file transfers should be performed using the CF memory card
reader. CF memory card formatting should be performed in a BTS router
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using a HyperTerminal connection. Attempting to format a CF memory
card from a Windows—based computer using a card reader could result in
unpredictable BTS router operation.

CAUTION Do not format BTS router CF memory cards using a

Windows—based computer. Only format CF memory cards in a
BTS router.

Verifying 10S Version and Loading BTS Router Canned
Configuration File to CF Memory Card Using a CF
Memory Card Reader

The process of transferring a canned configuration file to a BTS router
using a CF memory card reader consists of the following activities:

1. Transfer the canned configuration file to the router’s CF memory
card using a CF memory card reader

2. Copy the file from the CF memory card to the router’s
startup—config file

The following procedures are used to accomplish these actions.

Prerequisites

The following is required prior to performing this procedure:

* A copy of the required MWR 1941 router 1OS version file is installed
in the default tftp directory (transfer the file to the LMF computer
using FTP, internet download, or media such as a Zip disk; file size is
approximately 7-8 MB)

Verifying 10S version and transferring canned
configuration file to the router’s CF memory card

NOTE

IMPORTANT: MWR 1941 routers must be loaded with IOS
version mwr1900—i—mz.122-8.MC2d.bin or later. This router
model will not function properly with earlier IOS versions.

Transfer canned configuration files from the LMF computer to a BTS
router CF memory card by following the procedure irjable I-8.

Table I-8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step

Action

* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 If it has not been done, install a CF memory card loaded with the IOS in the BTS router by following the

procedure in the 1X SC 4812T-MC BTS FRU Guide .

* IMPORTANT

MWR 1941 routers must be loaded with I0S version mwr1900—i—-mz.122-8.MC2d.bin or later. This
router model will not function properly with earlier IOS versions.

... continued on next page
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Table I-8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step

Action

2

Connect the LMF computer to the BTS router and start a HyperTerminal communication session with
the router by following the procedure irjable I-2.

If it has not been done, be sure the +27 Vdc power supply output is OFF, and connect the BTS router
to the +27 Vdc power supply.

* IMPORTANT

In this step do not touch the computer keyboard until the router completes the boot process. The router
will buffer any keystrokes made during the boot process and interpret them as commands to be
executed immediately following boot completion.

Apply power to the router and allow it to complete boot—up.

If a message similar to the following, is displayed, press the Enter key and proceed to steg7:

Press RETURN to get started!

If a message similar to the following, is displayed type no and press the Enter key:

Basic management setup configures only enough connectivity
for management of the system, extended setup will ask you
to configure each interface on the system

Would you like to enter basic management setup? [yes/no]:

A response similar to the following will be displayed:

Would you like to enter basic management setup? [yes/no]: no

Cisco Internetwork Operating System Software

I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(20020127:101239
Copyright (c) 1986—2002 by cisco Systems, Inc.

Compiled Sun 27—Jan—02 06:08 by walrobin

Router>

CAUTION

Use only a card reader specifically designed for CF memory cards to perform this procedure. Card
readers for other non—volatile, solid—state memory devices such as Smart Media cards will not work
with the CF memory cards used in the MWR 1941 routers.

If it has not been done, follow the CF memory card reader manufacturer’s instructions to load the CF
memory card driver application for the operating system being used onto the LMF computer.

Connect the CF memory card reader to the LMF computer following the card reader manufacturer’s
instructions.

Remove the CF memory card from the BTS router by following the procedure in the
1X SC 4812T-MC BTS FRU Guide

10

Insert the CF memory card into the card reader as specified by the card reader manufacturer’s
instructions.

11

On the LMF computer, click Start > Programs > Windows Explorer to open Windows Explorer.

... continued on next page
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Table I-8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step Action

12 | NOTE
The CF memory card reader will appear as a disk drive in Windows Explorer with a disk drive letter
and icon.

Scroll the left—hand pane of Windows Explorer to locate the icon for the CF memory card.

13 | Verify that the CF memory card contains the required version of the IOS by performing the following:

13a — In the left-hand pane of WindowsExplorer, highlight the CF memory card icon.

13b — In the right-hand pane, note the IOS filename loaded on the card, and record it.

NOTE
The IOS filename will be similar to mwr1941-i-mz.122-8.MC2a.bin.

14 | Scroll the left-hand pane of Windows Explorer to locate the icon for the directory where the canned
configuration files downloaded from the OMC-R and required IOS version are stored.

15 | In the left-hand pane, highlight the directory where the files are stored.

16 | In the the right—hand pane, locate the filename of the required IOS version and compare it to the
filename recorded in stepl:]pb, above.

17 | If filenames are different, proceed tqjable I-11 to replace the IOS on the CF memory card and return
to steqj& below.

18 | In the right—hand pane, highlight the canned configuration file to be transferred to the CF memory
card and drag it to the CF memory card disk drive icon.

19 | Verify the canned configuration file has been copied to the CF memory card by clicking on the CF
memory card disk drive icon in the left-—hand pane, and verifying that the canned configuration file
appears in the in the right—hand pane.

NOTE

Do not be concerned if the canned configuration file appears before the 10S file in the file sequence
displayed by Windows Explorer. The position of the 10S file in the sequence of files on the CF
memory card can not be verified until the CF memory card is installed in the BTS router.

20 | With the CF memory card disk drive icon still selected, change the name of the canned configuration
file on the card to canned—config by doing the following:

20a — In the right—hand pane of Windows Explorer, click on the canned configuration filename.
— The filename will be highlighted.
20b — Wait approximately two seconds, and then click on the canned configuration file filename again.
— A hair-line rectangle will appear around the highlighted filename.
20c — After the rectangle appears around the highlighted filename, type the following:
canned-—config
20d — Press the Enter key or click on the canned configuration file icon.
— The rectangle around the canned configuration filename will disappear and the filename will
remain highlighted.

21 Click Files > Close to close Windows Explorer.

... continued on next page
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Table I-8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step Action

22 | Remove the CF memory card with the IOS version and canned configuration file from the card reader,
and mark the card label with the canned configuration (blue or red) copied to it.

23 | Install the CF memory card in the BTS router by following the procedure in the 71X SC 4812T7-MC BTS
FRU Guide .

24 | Proceed tqFable I-9 to copy the canned configuration from the CF memory card to the BTS router’s
startup—configfile

Copy Canned Configuration File from the CF Memory Card to the
BTS Router’s Startup Configuration and verify 10S file sequence

To allow the BTS router to automatically boot using the canned
configuration, the configuration must be copied to the the router’s
startup—config file in NVRAM. Follow the procedure il]j"able I-9 to
accomplish this.

Table I-9: Copy Canned Configuration File to BTS Router Startup
Configuration and Verify 10S File Position

Step Action
* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 If it has not been done, install the CF memory card with the canned configuration and required I0S
version in the BTS router by following the procedure in the 1X SC 48127-MC BTS FRU Guide .

2 At this point, the router should be powered up and displaying the Router> prompt in the
HyperTerminal window of the LMF computer communication session. If it is not, perform stepg

througlr§ ofJable I-8.
3 At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC mode:

enable
A response similar to the following will be displayed:

Router>enable
Router#

... continued on next page
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Table I-9: Copy Canned Configuration File to BTS Router Startup
Configuration and Verify 10S File Position
Step Action
4 | NOTE
The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has
been changed using the ed command. Determine the present working directory by entering pwd. If
the present working directory has been changed, enter the command cd slotO: to return to the default
setting.
Display the directory listing of the CF memory card by entering the following:
dir
A response similar to the following will be displayed:
Router#dir slotO:
Directory of slot0:/
1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2212 Mar 01 1993 00:14:48 canned-config
31932416 bytes total (24885606 bytes free)
Router#
5 Be sure the [0S file is the first file listed in the directory content display. If it is not, perform the
procedure ir‘j"able I-12, and then return to steqj, below.
6 Copy the canned configuration to the BTS router’s startup configuration file by entering the following:
copy slot0:canned—config startup—config
A response similar to the following will be displayed:
Router#copy slot0:canned—config start
Destination filename [startup—config]?
7 When prompted for the destination file name, press the Enter key. A response similar to the following
will be displayed:
Router#copy slot0:canned—config start
Destination filename [startup—config]?
2218 bytes copied in 3.52 secs
Routerl#
8 Check the file size of the startup—config to verify the copy operation by entering the following:
dir nvram:
A response similar to the following will be displayed:
Directory of nvram:/
26 —rw— 2218 <no date> startup—config
27 5 <no date> private—config
29688 bytes total (25247 bytes free)
Router#
NOTE
Be sure to include the colon (:) after nvram when typing the command.
... continued on next page
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Table I-9: Copy Canned Configuration File to BTS Router Startup
Configuration and Verify 10S File Position

Step Action

9 If desired, the contents of the startup—config file may be verified against the file listings at the end of
this appendix for the blue or red canned configuration, as applicable, by entering the following:

show startup—config
NOTE

Pressing the space bar at the MORE prompt will scroll another screen—full of data. Pressing the Enter
key will scroll the screen one line at a time.

10 | Verify the router will boot properly on the I0S and revised startup—config files by entering the
following:

reload

A response similar to the following will be displayed:
Router#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

11 If prompted to save a modified configuration, enter n for “no,” and press the Enter key.

12 | When prompted to proceed with reload, press the Enter key to continue the reload operation.

13 | Verify the router reboots without displaying the rommon 1 > prompt or error messages related to port
configurations. If the router boots to the rommon prompt, proceed to the Recovery from BTS Router
Boot to rommon section of this appendix.

14 | Using the tagging materials, tag the router to clearly identify the installed configuration (blue
(BTSRTR1) or red (BTSRTR?2)).

15 | If an additional router must have the canned configuration installed, perform the following:

15a — Disconnect the cabling for the HyperTerminal communications session from the BTS router, and
minimize the HyperTerminal window on the LMF computer.

15b — Remove power from the router and disconnect it from the power supply.

15¢ — Repeat the procedures irﬂable I-8 and this table ﬂable 1-9) using the additional router.

16 | If no additional routers must be configured, perform stepg35a an¢55b.

17 | On the LMF computer, exit the HyperTerminal session.
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Replacing Installed BTS Router CF Memory Card I0S Version

Background

BTS routers are supplied with CF memory cards pre—loaded with a
version of the IOS. Prior to installing the routers in a BTS, the loaded
IOS version should be verified as being the one required for the network.
It is critical to also verify that the 10S file is the first file on the CF
memory card. If another file precedes the 10S file, the BTS router will
not boot properly and will not function in the network.

Equipment and Software Required for Verification Methods

The following items are required to perform this procedure:

A Windows—based computer which meets the requirements of the
LMF computer platform as specified in Chapter 3 of this manual:

One of the following operating systems for the Windows—based
computer:

— Windows 2000
— Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION

BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

DB-9 plug—to—8—contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

A copy of the MWR 1941 router 10S version required for the network
where the routers are to be installed

NOTE

Contact the network administrator or the Motorola Account
Team for assistance in determining and obtaining a copy of the
required IOS version.

Required Publications

The MWR 1941 will accept a voltage from —60 Vdc to + 60 Vdc
during configuration and file operations

The following publication is required to perform procedures in this
section:

MWR1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78—13983-01

1-36 1X SC 4812T-MC Multicarrier BTS Optimization/ATP Sept 2003




68P64115A21-B Replacing Installed BTS Router CF Memory Card 10S Version

Method 1: Replacement of Installed Router CF Card I0S Data

Description
This procedure covers using an LMF computer equipped with a tftp
server application to perform the following activities:

1. Verify the IOS version loaded on a CF memory card and running on
a BTS router

Replace the IOS version installed in a BTS router

Ensure the 10S file is the first file on the CF memory card

Additional required equipment/software
For this method, the following software application is required in
addition to the common items required for both methods:

* (Cable, Ethernet crossover, Category SE or better, unshielded twisted
pair, two 8—contact modular plugs, in one of the following lengths, as
determined necessary:

— 0.3 m (11.8 in) (Motorola pn 3088643C07)
— 0.6 m (23.6 in)(Motorola pn 3088643C13)
— 1.0 m (39.4 in) (Motorola pn 3088643C15)
— 2.1 m (84 in) (Motorola pn 3088643C08)

— 3.0 m (120 in) (Motorola pn 3088643C09)

* A tftp server software application (refer to the Setting Up the TFTP
Server — Procedure in Cellular System Administration — CDMA
OnLine Documentation, Release 2.16.1) such as:

— Cisco tftp server
— PumpKIN tftp server

— Any other equivalent tftp server application

Prerequisites

The following are required prior to performing this procedure:

* The LMF computer and BTS router have been prepared for tftp file
transfer and are operating as they would be after performing the
procedures iqj"able I—4|j"able I—5|j“able I-6, and stepsE]I througl]ﬁ of

[Jable I-7

* A copy of the required 10S version is loaded into the tftp default
directory of the LMF computer

Replacing installed 10S version and verifying file
sequence position

Follow the procedure irﬂable I-10 to replace the installed I0S version
using the tftp server application, and ensure the 10S file is first in the
stored file sequence on the CF memory card.
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Table I-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step

Action

* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1

This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures ijable I-4Fable I-5Fable I-6, and stepgT through
ﬂ oﬁable I-7. If necessary, perform these procedures now.

NOTE

The IOS present working directory defaults to the CF memory card (slot0:) directory unless the
present working directory has been changed using the ed command. Determine the present working
directory by entering pwd. If the present working directory has been changed, enter the command cd
slot0: to return to the default setting.

Identify the filename of the currently loaded IOS which must be replaced by entering dir command. A
response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

1 —rw— 7051844 Sep 23 2002 07:15:08 mwrl941—i—mz.07022002.bin
2 —rw— 2212 Mar 01 1993 00:11:00 canned—config

31932416 bytes total (24878360 bytes free)
BTSRTR1#

Begin to backup the currently installed version of the router’s IOS to the LMF computer’s default tftp
directory by entering the following:

copy old 10S filename tftp:

Where old_IOS_filename = the filename of the IOS currently loaded on the BTS router CF memory
card.

A response similar to the following will be displayed:

BTSRTR1#copy mwr1941—i—mz.07022002.bin tftp:
Address or name of remote host []?

At the remote host prompt, enter the following:
100.100.100.1
A response similar to the following will be displayed:

Address or name of remote host []? 100.100.100.1

Destination filename [mwr1941—i—-mz.07022002.bin]?

... continued on next page
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[Table I-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step

Action

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename.

A response similar to the following will be displayed if the default filename is selected:

Address or name of remote host []? 100.100.100.1
Destination filename [mwr1941—i-mz.07022002.bin]?

7051844 bytes copied in 109.92 secs (64697 bytes/sec)
BTSRTR1#

If additional files are stored on the CF memory card, begin backing them up to the LMF computer’s
default tftp directory by entering the following:

copy additional_filename tftp:

Where additional_filename = the filename of an additional file loaded on the BTS router CF memory
card.

A response similar to the following will be displayed:

BTSRTR1#copy canned—config tftp:
Address or name of remote host [100.100.100.1]?

If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer.

A response similar to the following will be displayed if the default filename is selected:

Address or name of remote host [100.100.100.1]?
Source filename [canned—config]?

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename.

A response similar to the following will be displayed if the default filename is selected:

Source filename [canned—config]?
Destination filename [canned—config]?

... continued on next page
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[Table I-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step Action

9 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed:
Destination filename [canned—config]?
!
[OK — 2212/4096 bytes]
2212 bytes copied in 0.152 secs
BTSRTR1#

10 | If more files are stored on the CF memory card, repeat stepg througir§ until all files have been
backed up to the LMF computer.

11 Delete all files from the CF memory card by entering the following command:

format slotO:

A response similar to the following will be displayed:
BTSRTR1#format slotO0:
Format operation may take a while. Continue? [confirm]

12 | Press the Enter key to continue the format operation. A response similar to the following will be
displayed:
Format operation may take a while. Continue? [confirm]
Format operation will destroy all data in ”slot0:”. Continue? [confirm]

13 | Press the Enter key to continue the format operation. A response similar to the following will be
displayed:
Format operation will destroy all data in ”slot0:”. Continue? [confirm]
Format: Drive communication & 1lst Sector Write OK...
Writing Monlib
=] =T o o o =
Monlib write complete
Format: All system sectors written. OK...
Format: Total sectors in formatted partition: 62560
Format: Total bytes in formatted partition: 32030720
Format: Operation completed successfully.
Format of slot0 complete
BTSRTR1#

14 | Verify all files have been deleted from the CF memory card by entering the dir command. A response
similar to the following will be displayed:
Directory of slot0:/
No files in directory
31932416 bytes total (31932416 bytes free)
BTSRTR1#

... continued on next page
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[Table I-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step

Action

15

Begin to copy the required version of the IOS from the LMF computer to the BTS router by entering the
following:

copy tftp:new IOS filename slotO:
Where new_IOS _filename = the filename of the required IOS for the BTS router.
A response similar to the following will be displayed:

BTSRTR1#copy tftp:mwrl941—i—mz.122—8.MC2a.bin slotO:
Address or name of remote host [100.100.100.1]?

16

If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer. A response similar to the
following will be displayed if the default filename is selected:

Address or name of remote host [100.100.100.1]?
Source filename [mwrl941—i—mz.122—-8.MC2a.bin]?

17

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Source filename [mwrl941—i—mz.122—-8.MC2a.bin]?
Destination filename [mwrl194l1—i-mz.122—-8.MC2a.bin]?

18

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is not
correct, enter the correct filename. A response similar to the following will be displayed if the default
filename is selected:

Destination filename [mwrl194l1—i-mz.122—-8.MC2a.bin]?
Accessing tftp://100.100.100.1/mwrl941—i—mz.122—8.MC2a.bin...
Loading mwrl941—i—mz.122—8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0): !!!!
Loading mwrl941—i—mz.122—8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0):
!

1
[OK — 7051976/14103552 bytes]

7051976 bytes copied in 145.108 secs (48634 bytes/sec)
BTSRTR1#

. .. continued on next page
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[Table I-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step Action
19 | Display the CF memory card directory to verify that the new 10S file is there by entering the dir
command. A response similar to the following will be displayed:
BTSRTR1#dir
Directory of slot0:/
1 —rw— 7051976 Sep 23 2002 07:25:36 mwrl941—i—mz.122—8.MC2a.bin
31932416 bytes total (24880440 bytes free)
BTSRTR1#
20 | If any additional files previously stored on the CF memory card are to be copied to the card, perform
the following:
copy tftp:filename slotO:
Where filename = the filename of the file to be copied to the CF memory card
A response similar to the following will be displayed:
BTSRTR1#copy tftp:canned—config slotO:
Address or name of remote host [100.100.100.1]?

21 | If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer. A response similar to the
following will be displayed if the default IP address is selected:

Address or name of remote host [100.100.100.1]?
Destination filename [canned—config]?

22 | If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Destination filename [canned—config]?

Accessing tftp://100.100.100.1/canned—config...

Loading basic _config from 100.100.100.1 (via FastEthernet0/0): !
[OK — 2212/4096 bytes]

2212 bytes copied in 0.152 secs

BTSRTR1#

23 | After the additional file is copied to the CF memory card, display the CF memory card directory by

entering the dir command. A response similar to the following will be displayed:
BTSRTR1#dir
Directory of slot0:/
1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2212 Mar 01 1993 00:09:06 canned—config
24 | The IOS file must be the first file listed for the BTS router to boot properly. If it is, proceed to ster39.
... continued on next page
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[Table I-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step Action
CAUTION
The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.
25 | If another file is listed before the 10S file, delete the file by performing stepgj1 through3 and
display the directory of the CF memory card as described in steg33 to be sure the file is deleted.
26 | Copy the file from the LMF computer to the CF memory card again by performing stepg 30 through
33
27 | If the file is again listed before the IOS file in the CF memory card directory display, format the CF
memory card by performing stepg 31 througl34 of this table.
28 | Copy the IOS file and any other required file to the formatted CF memory card by performing stepg 35
througl34.
29 | If additional files are to be transferred to the CF memory card, perform stepg 30 through34 for each
one.
30 | After making sure the 10S file is the first file on the CF memory card, restart the BTS router with the
new IOS version by entering the following:
reload
A response similar to the following will be displayed:
BTSRTR1#reload
System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]
31 If prompted to save a modified configuration, enter n for “no,” and press the Enter key.
32 | When prompted to proceed with reload, press the Enter key to continue the reload operation.
33 | Once the router has completed rebooting, change to the privileged EXEC mode and confirm the
booted IOS version is correct by entering the following:
show version
A response similar to the following partial example will be displayed:
BTSRTR1#sh ver
Cisco Internetwork Operating System Software
I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(8)MC2a, EARLY DEPLOYMENT RELEASE
SOFTWARE (fcl)
BTSRTR1#
34 | Verify the version number displayed in the second line of the version information is the correct IOS
version.
35 If this procedure was entered from steqﬁ oﬁable I-7, return tqj"able I-7, steqj.

... continued on next page
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[Table I-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step Action
36 | If no other BTS router file operations or configuration actions are required, perform the following:
36a — Remove power from the router and disconnect it from the power supply.
36b — Disconnect all other cabling from the BTS router.
36¢ — On the LMF computer, exit the HyperTerminal communications session.
37 | If no additional tftp transfer activities will be performed, change the NIC IP address and subnet mask

back to those for LMF-BTS communication recorded iqj" able I-4, steqﬁb.

CAUTION

If the BTS 10base—2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,
the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.

Method 2: Using a CF Memory Card Reader for Replacement of Installed 10S
Version and Changing File Sequence Position

This subsection contains the file replacement and file sequence
manipulation procedures to use when transferring files with a CF
memory card reader.

Replace 10S Version Installed on the CF Memory Card

Description — This procedure covers using an LMF computer equipped
with a CF memory card reader to perform the following activities:

1. Verify the IOS version loaded on a CF memory card and running on
a BTS router

2. Replace the IOS version installed in a BTS router
3. Ensure the 10S file is the first file on the CF memory card

Additional required equipment/software — For this method, the
following equipment item and associated software is required in addition
to the common items required for both methods:

* Compact Flash memory card reader device and software driver for the
operating system installed on the LMF computer

CAUTION Card readers for other non—volatile, solid—state memory devices
such as Smart Media cards will not work with the CF memory
cards used in the MWR 1941 routers. Do not attempt to use a
card reader intended for another type of memory device.

Prerequisites — The following are required prior to performing this
procedure:

® The LMF computer and BTS router have been prepared for CF
memory card reader file transfer and are operating as they would be
after performing the procedures in stepg througl§ of Jable I-8

* A copy of the required 10S version is loaded into the desired directory
of the LMF computer

1-44

1X SC 4812T-MC Multicarrier BTS Optimization/ATP Sept 2003



68P64115A21-B Replacing Installed BTS Router CF Memory Card 10S Version

File operations using a CF memory card reader — Only file transfers
should be performed using the CF memory card reader. CF memory card
formatting should be performed in a BTS router using a HyperTerminal
connection. Attempting to format a CF memory card from a
Windows-based computer using a card reader could result in
unpredictable BTS router operation.

CAUTION Do not format BTS router CF memory cards using a
Windows—based computer. Only format CF memory cards in a
BTS router.

Replacing installed IOS version — Follow the procedure iifJable I-11
to replace the installed IOS version using a CF memory card reader and
to ensure the 10S file is first in the stored file sequence on the CF
memory card.

Table I-11: Using a CF Memory Card Reader for Replacing
Loaded IOS Version and Verifying File Sequence Position

Step Action
* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures in stepg through7 of Fable I-8. If necessary,
perform these procedures now.

2 With the CF memory card in the CF memory card reader and the card reader icon highlighted in the
left—hand pane of Windows Explorer, perform the following to delete the 10S file from the card:

2a — In the right-hand pane of Windows Explorer, highlight the IOS file to be removed.
2b — Right—click and select Delete from the popup menu.
3 CAUTION

When performing the following step and its associated substeps, files should be moved to and from
the CF memory card one by one to reduce the potential for disrupting the the CF memory card file
sequence. Do not attempt to move multiple files by highlighting and dragging and dropping all of
them at one time.

If there are more files on the CF memory card which must be retained, perform the following:

3a — Scroll the left—hand pane of Windows Explorer to locate the LMF computer directory where the
required IOS version and canned configuration files are stored.

3b — In the right-hand pane, highlight the additional file on the CF memory card which is to be
retained.

3c — While holding down the Ctrl key on the LMF computer, drag and drop the highlighted file into
the directory in the left-hand pane where the required IOS and canned config files are stored.

3d — If additional files loaded on the CF memory card must be retained, repeat stepg3b anqjc for each
file until all files have been moved from the CF memory card to the directory on the LMF
computer.

... continued on next page
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Table I-11: Using a CF Memory Card Reader for Replacing
Loaded IOS Version and Verifying File Sequence Position

Step Action

4 When all files on the CF memory card have been deleted or moved, as applicable, highlight the
directory in the left-hand pane where the required IOS version and canned configuration files are
stored.

5 Verify that all files from the CF memory card which must be retained were moved to the directory by
checking the filenames in the right—hand pane.

6 Scroll the left—hand pane of Windows Explorer to locate the CF memory card reader icon.

7 In the right—hand pane, highlight the icon for the required version of the 10S.

8 Drag and drop the 10S icon to the CF memory card reader icon to copy it to the CF memory card.

9 If an additional file in the LMF computer directory must be moved to the CF memory card, perform
the following:

9a — In the right—-hand pane, highlight one additional file which is to be moved to the CF memory card.

9b — While holding down the Ctrl key on the LMF computer, drag and drop the highlighted file into

the CF memory card reader directory in the left—-hand pane.

9c — If additional files in the directory must be placed on the CF memory card, repeat stepg9a ang9b

for each file until all files have been moved one at a time from the LMF computer to the CF
memory card.

10 | In the left-hand pane, highlight the CF memory card reader icon.

11 | Verify that all required files were moved to the CF memory card by checking the filenames in the
right-hand pane.

12 | Scroll the left-hand pane of Windows Explorer to locate the LMF computer directory where the
required IOS version and canned configuration files are stored.

13 | Highlight the directory in the left—hand pane.

14 | If this procedure was entered from ste 37 of Fable I-8, return tq-Fable I-8, steg38.

15 | If no other file transfer activities between the LMF computer and CF memory card are required at this
time, click Files > Close to close Windows Explorer.

16 | Remove the CF memory card from the card reader and install it in the BTS router by following the
procedure in the 1X SC 4812T-MC BTS FRU Guide .

17 | At this point, the router should be powered up and displaying the user EXEC prompt in the
HyperTerminal window of the LMF computer communication session. If it is not, perform stepg
througlr§ ofJable I-8.

18 | At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC mode:

enable
A response similar to the following will be displayed:
Router>enable
Router#
... continued on next page
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Table I-11: Using a CF Memory Card Reader for Replacing
Loaded IOS Version and Verifying File Sequence Position

Step Action

NOTE

The IOS present working directory defaults to the CF memory card (slot0:) directory unless the
present working directory has been changed using the ed command. Determine the present working
directory by entering pwd. If the present working directory has been changed, enter the command cd
slot0: to return to the default setting.

19 | Display the directory listing of the CF memory card by entering the following:
dir
A response similar to the following will be displayed:

Router#dir slotO0:
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2212 Mar 01 1993 00:14:48 canned—config

31932416 bytes total (24885606 bytes free)
Router#

CAUTION

The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.

20 | Be sure the IOS file is the first file listed in the directory content display. If it is not, perform the
procedure ir‘j"able I-12, and then return to steqjl, below.

21 | Verify the router will boot properly on the IOS and revised startup—config files by entering the
following:

reload

A response similar to the following will be displayed:
Router#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

22 | If prompted to save a modified configuration, enter n for “no,” and press the Enter key.

23 | When prompted to proceed with reload, press the Enter key to continue the reload operation.

24 | Verify the router reboots without displaying the rommon 1 > prompt or error messages related to port
configurations.

25 If no other BTS router file operations or configuration actions are required, perform the following:

25a — Remove power from the router and disconnect it from the power supply.
25b — Disconnect all cabling from the BTS router.
25¢ — On the LMF computer, exit the HyperTerminal communications session.
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Change CF Memory Card File Sequence to Place I0S File First on the Card

This procedure covers using an LMF computer equipped with a CF
memory card reader to perform the following activities:

1. Change the sequence of files on a CF memory card to place the IOS
version file first

2. Formatting the CF memory card, if necessary, to achieve the
required file sequence positioning of the IOS version file

Prerequisites

The following are required prior to performing this procedure:

® The LMF computer and BTS router have been prepared for CF
memory card reader file transfer and are operating as they would be
after performing the procedures irpJable I-8 and stepg througl3 of
[Jable I-9

* Copies of the required IOS version and canned configuration files are
loaded into the desired directory of the LMF computer

Optional equipment/software
If they are available, the following items may be used to change the CF
memory card file sequence once the card is installed in the BTS router:

* (Cable, Ethernet crossover, Category SE or better, unshielded twisted
pair, two 8—contact modular plugs, in one of the following lengths, as
determined necessary:

— 0.3 m (11.8 in) (Motorola pn 3088643C07)
— 0.6 m (23.6 in)(Motorola pn 3088643C13)
— 1.0 m (39.4 in) (Motorola pn 3088643C15)
— 2.1 m (84 in) (Motorola pn 3088643C08)

— 3.0 m (120 in) (Motorola pn 3088643C09)

* A tftp server software application (refer to the Setting Up the TFTP
Server — Procedure in Cellular System Administration — CDMA
OnLine Documentation, Release 2.16.1) such as:

— Cisco tftp server
— PumpKIN tftp server
— Any other equivalent tftp server application

Changing CF memory card file sequence

Follow the procedure irﬂable I-12 to place the installed IOS version file
first in the stored file sequence on the CF memory card.
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Table I-12: Use CF Memory Card Reader to Place IOS File
First in CF Memory Card File Sequence

Step

Action

CAUTION

The file sequence on the CF memory card can not be verified with application programs which place the listed
file names in alphabetical order (for example, certain Unix telnet applications, Unix directory listing
commands, and Windows file managers such as Windows Explorer). This procedure is intended for use only
with applications, such as HyperTerminal, which do not list directory contents alphabetically.

This procedure assumes that the LMF computer and BTS router have been prepared for CF memory
card reader file transfer and are operating as they would be after performing the procedures in
[Jable I-8 and stepg througl3 of Jable I-9. If necessary, perform these procedures now.

NOTE

The IOS present working directory defaults to the CF memory card (slot0:) directory unless the
present working directory has been changed using the ed command. Determine the present working
directory by entering pwd. If the present working directory has been changed, enter the command cd
slot0: to return to the default setting.

With the CF memory card still installed in the router, display a CF memory card directory listing if
one is not showing by entering the dir command. A response similar to the following will be
displayed:

Router#dir slotO0:
Directory of slot0:/

2 —rw— 2212 Mar 01 1993 00:14:48 canned—config
1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin

31932416 bytes total (24878228 bytes free)
Router#

Verify that the IOS file is not the first file on the CF memory card.

If a tftp server application is not available on the LMF computer, skip to steg33.

If a tftp server is available on the LMF computer, connect the Ethernet crossover cable as shown in
Higure I-4.

If it has not been done, configure the LMF computer NIC as directed irrFable I-4.

... continued on next page
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Table I-12: Use CF Memory Card Reader to Place I0S File
First in CF Memory Card File Sequence

Step Action
7 Configure FE port FE 0 (fa0/0) by performing the following:
7a — At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC
mode:
enable

A response similar to the following will be displayed:

Router>enable
Router#

7b — At the Router# privileged EXEC mode prompt, enter the following to access the configure
submode:

configure terminal

A response similar to the following will be displayed:

Router#conf t
Enter configuration commands, one per line. End with CNTL/Z.
Router (config)#

7c — At the global configuration mode prompt, type each of the following commands, pressing the
Enter key after each command:

hostname btsrtri
interface fa0/0

ip address 100.100.100.2 255.255.255.252
speed 100
duplex full

no shutdown

line con 0
exec—timeout 0 0
no login

line vty 0 4

no login

Responses similar to the following will be displayed:

Router (config)#hostname BTSRTR1
BTSRTR1 (config)#interface £a0/0
BTSRTR1 (config—if)#ip address 100.100.100.2 255.255.255.252
BTSRTR1 (config—if)#speed 100

BTSRTR1 (config—if)#duplex full
BTSRTR1 (config—if)#no shutdown
BTSRTR1 (config—if)#line con 0

BTSRTR1 (config—line)#exec—timeout 0 0
BTSRTR1 (config—line)#no login

BTSRTR1 (config—line)#line vty 0 4
BTSRTR1 (config—line)#no login

BTSRTR1 (config—line)#

7d — Once the correct parameters have been set, return to the privileged EXEC mode prompt by
holding down the Ctrl key and pressing z (Ctrl+z). A response similar to the following will be
displayed:

BTSRTR1 (config—line)# "z
01:11:27: %SYS—5—CONFIG I: Configured from console by console
BTSRTR1#

... continued on next page
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Table I-12: Use CF Memory Card Reader to Place I0S File
First in CF Memory Card File Sequence

Step Action

7e — Verify port FE 0 (fa0/0) is configured with the correct IP address by entering the following:
show ip interface brief

A response similar to the following will be displayed:

BTSRTR1#sh ip int br

Interface IP Address OK? Method Status Protocol
FastEthernet0/0 100.100.100.2YES manual up up
Serial0:0 unassigned YES unset administratively down down
FastEthernet0/1 unassigned YES unset administratively down down
Seriall:0 unassigned YES unset administratively down down
BTSRTR1#

8 Be sure the required 10S file and canned configuration file for the BTS router are located in the tftp
server root directory (refer tqFable I-4, steg 44 or ste37, as applicable)

9 Delete files from the CF memory card by entering the del filename command. A response similar to
the following will be displayed:

Router#del canned—config
Delete filename [canned—config]?

10 | If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Delete filename [canned—config]?
Delete slot0O:canned—config? [confirm]

11 | Press the Enter key to confirm the deletion.
A response similar to the following will be displayed if the default filename is selected:
Delete filename [canned—config]?

Delete slot0O:canned—config? [confirm]
Router#

12 | Confirm the file deletion by entering the dir command. A response similar to the following will be
displayed:

Router#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin

31932416 bytes total (24887818 bytes free)
Router#

13 Repeat stequ througlE]I2 for each file until a/l files have been deleted from the CF memory card.

. .. continued on next page
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Table I-12: Use CF Memory Card Reader to Place I0S File
First in CF Memory Card File Sequence

Step

Action

14

Use the tftp server to copy the 10S file from the LMF computer to the CF memory card by enteringthe fol-
lowing:

copy tftp:/OS filename slot0:

Where I0S_filenamer = required 10S version filename in the LMF computer tftp server root
directory.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:mwrl941—i—mz.122—8.MC2a.bin slotO:
Address or name of remote host []?

15

At the prompt for the remote host address or name, enter the IP address of the LMF computer NIC:
100.100.100.1

A response similar to the following will be displayed:

BTSRTR1#copy tftp:mwrl941—i—mz.122—8.MC2a.bin slotO:

Address or name of remote host []? 100.100.100.1
Destination filename [mwrl194l1—i-mz.122-8.MC2a.bin]?

16

At the prompt for the destination filename, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy tftp:mwrl941—i—mz.122—-8.MC2a.bin slotO:

Address or name of remote host []? 100.100.100.1

Destination filename [mwrl194l1—i-mz.122—-8.MC2a.bin]?

Accessing tftp://100.100.100.1/mwrl941—i—mz.122—8.MC2a.bin...

Loading mwrl941—i—mz.122—8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0): !!!!
Loading mwrl941—i—mz.122—8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0):

1
[OK — 7051976/14103552 bytes]

7051976 bytes copied in 145.108 secs (48634 bytes/sec)

... continued on next page
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Table I-12: Use CF Memory Card Reader to Place I0S File
First in CF Memory Card File Sequence

Step Action

17 | Display the directory of the CF memory card to confirm the IOS file transfer by entering the dir
command. A response similar to the following will be displayed:

Router#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin

31932416 bytes total (248880440 bytes free)
Router#

18 | Copy the canned configuration file to the CF memory card by entering the following:
copy tftp:btsrtr_canned.color slot0:canned—-config

Where color = blue or red, as applicable.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned—config
Address or name of remote host [100.100.100.1]?

19 | If the default IP address for the LMF computer displayed in the prompt is correct, press the Enter key
to accept it. If it is missing or not correct, enter the correct IP address.

A response similar to the following will be displayed if the default filename is accepted:
Destination filename [canned—config]?

2212 bytes copied in 0.208 secs
Router#

20 | At the prompt for the destination filename, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned—config

Address or name of remote host []? 100.100.100.1

Destination filename [canned—config]?

Loading btsrtr canned.blue from 100.100.100.1 (via Ethernet0/0): !
[OK — 2457/4096 bytes]

2457 bytes copied in 84.724 secs (29 bytes/sec)
BTSRTR1#

21 | Determine if the IOS file is now the first file displayed in the directory listing by entering the dir
command. A response similar to the following will be displayed:

Router#dir
Directory of slot0:/

1 —rw— 7051976 Mar 01 1993 00:14:48 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2212 Sep 23 2002 07:24:18 canned—config

31932416 bytes total (24878228 bytes free)
Router#

22 If the 10S file is the first file displayed, as shown in steqjl, above, proceed to steHjO.

... continued on next page
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Table I-12: Use CF Memory Card Reader to Place I0S File
First in CF Memory Card File Sequence

Step

Action

23

If the IOS is not the first file displayed, as shown in ster3, above, format the CF memory card by
entering the following:

format slotO:

A response similar to the following will be displayed:

BTSRTR1#format slotO:
Format operation may take a while. Continue? [confirm]

24

Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation may take a while. Continue? [confirm]
Format operation will destroy all data in ”slot0:”. Continue? [confirm]

25

Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation will destroy all data in ”slot0:”. Continue? [confirm]
Format: Drive communication & lst Sector Write OK...

Writing Monlib

SECLO S e e ceoceccscccosscescssssoscssssosssescssassosscssssosocscsascsosscssasssse

Monlib write complete

Format: All system sectors written. OK...

Format: Total sectors in formatted partition: 62560
Format: Total bytes in formatted partition: 32030720

Format: Operation completed successfully.

Format of slot0 complete
BTSRTR1#

26

If a tftp server is available on the LMF computer, repeat stepg}4 through32 to transfer the IOS and
canned configuration files to the CF memory card.

27

Once the format operation is completed, remove the CF memory card from the router following the
procedure in the 1X SC 4812T-MC BTS FRU Guide , insert it in the card reader connected to the LMF
computer, and copy the 10S file to the card by performing ster% and stepg§ througl 31 of Jable I-11,
as required.

28

Remove the CF memory card from the card reader and install it in the router following the procedure
in the BTS FRU Guide.

29

Be sure that the IOS file is now the first file displayed in the directory listing by entering the dir
command. A response similar to the following will be displayed:

Router#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2212 Mar 01 1993 00:14:48 canned—config

31932416 bytes total (24885606 bytes free)
Router#

30

If this procedure was entered from steqj oﬁable 1-9, return tqj“able I1-9, steqj.

... continued on next page
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Table I-12: Use CF Memory Card Reader to Place I0S File
First in CF Memory Card File Sequence

Step Action

31 If this procedure was entered from steHjO oﬁable I-11, return tqj"able I-11, steqjl.

32 | If no other BTS router file operations or configuration actions are required, perform the following:
32a — Remove power from the router and disconnect it from the power supply.
32b — Disconnect all cabling from the BTS router.
32c — On the LMF computer, exit the HyperTerminal communications session.

33

If a tftp server was used in this procedure and no additional tftp transfer activities will be performed,
change the NIC IP address and subnet mask back to those for LMF-BTS communication recorded in

|j"able I-4, steqﬁb.
CAUTION
If the BTS 10base—2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,

the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.
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Verify and Upgrade rommon Version

Introduction

BTS routers are supplied pre—loaded with a version of the ROM monitor
(rommon) low—level operating system. Along with the 10S version, the
loaded rommon version should be verified as being the one required for
the network. Procedures in this section are used to verify the loaded
rommon version, and, if necessary, change it to the required version.
Methods are provided for using either a tftp server or CF memory card
reader to transfer the required rommon version to a BTS router’s CF
memory card.

Equipment and Software Required for Verification

The following items are required to perform rommon verification:

* A Windows-based computer which meets the requirements of the
LMF computer platform as specified in this manual.

* One of the following operating systems for the Windows—based
computer:

— Windows 2000
— Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

* Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

* DB-9 plug—to—8—contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

¢ A copy of the MWR 1941 router rommon version required for the
network where the routers are to be installed

NOTE Contact the network administrator or the Motorola Account
Team for assistance in determining and obtaining a copy of the
required rommon version.

* A +27 Vdc power supply to power the BTS router during
configuration file operations

Required Publications

The following publication is required to perform procedures in this
section:

* MWR1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78—13983-01
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Method 1: In—Router Verification and Replacement of Installed rommon
Version

Description

This procedure covers using an LMF computer equipped with a tftp
server application to perform the following activities:

1. Verify the rommon version loaded and running on a BTS router
2. Replace the rommon version installed in a BTS router

Additional required equipment/software
For this method, the following equipment and software application is
required in addition to the common items required for both methods:

* (Cable, Ethernet crossover, Category 5E or better, unshielded twisted
pair, two 8—contact modular plugs, in one of the following lengths, as
determined necessary:

— 0.3 m (11.8 in) (Motorola pn 3088643C07)
— 0.6 m (23.6 in)(Motorola pn 3088643C13)
— 1.0 m (39.4 in) (Motorola pn 3088643C15)
— 2.1 m (84 in) (Motorola pn 3088643C08)

— 3.0 m (120 in) (Motorola pn 3088643C09)

* A tftp server software application (refer to the Setting Up the TFTP
Server — Procedure in Cellular System Administration — CDMA
OnLine Documentation, Release 2.16.1) such as:

— Cisco tftp server
— PumpKIN tftp server
— Any other equivalent tftp server application

Prerequisites

The following are required prior to performing this procedure:

* The LMF computer and BTS router have been prepared for tftp file
transfer and are operating as they would be after performing the
procedures iqj"able I—4|j"able I—5|j“able I-6, and stepsE]I througl]ﬁ of

[Jable I-7

* A copy of the required rommon version is loaded into the tftp default
directory of the LMF computer
Verifying and replacing installed rommon version

Follow the procedure irﬁ able I-13 to verify and, if necessary, replace the
installed rommon version using the tftp server application.
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Table I-13: Verify and Replace Installed rommon Version Using a tftp Server

Step

Action

* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1

This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures ijable I-4Fable I-5Fable I-6, and stepgT through

|j oﬁable I-7. If necessary, perform these procedures now.

Determine the currently installed rommon version by entering the following at the router privileged
EXEC mode prompt:

show version

A response similar to the following will be displayed:

BTSRTR1#sh ver

Cisco Internetwork Operating System Software

I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE
SOFTWARE (fc3)

TAC Support: http://www.cisco.com/tac

Copyright (c) 1986—2002 by cisco Systems, Inc.

Compiled Mon 05—Aug—02 11:07 by nmasa

Image text—base: 0x60008940, data—base: 0x60B54000

ROM: System Bootstrap, Version 12.2(20020113:235343) [sbose—wilma 109], DEVELOPMENT
SOFTWARE

ROM: 1941 Software (MWR1941-I-M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE SOFT-
WARE (fc3)

Router uptime is 1 minute
System returned to ROM by power—on
System image file is ”slot0:mwrl941—i—mz.122—8.MC2b.bin”

cisco mwrl941 (R7000) processor (revision 0.1) with 121856K/18432K bytes of memory.
Processor board ID JMX0611K5TS

R7000 CPU at 240Mhz, Implementation 39, Rev 3.3, 256KB L2 Cache
Bridging software.

X.25 software, Version 3.0.0.

Primary Rate ISDN software, Version 1.1.

Toaster processor tmc is running.

2 FastEthernet/IEEE 802.3 interface(s)

2 Serial network interface(s)

2 Channelized T1/PRI port(s)

DRAM configuration is 64 bits wide with parity disabled.

55K bytes of non—volatile configuration memory.

31360K bytes of ATA Slot0 CompactFlash (Read/Write)

Configuration register is 0x101

BTSRTR1#

To determine the currently installed rommon version, examine the ROM: System Bootstrap line in the
response.

... continued on next page
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[Table I-13: Verify and Replace Installed rommon Version Using a tftp Server

Step

Action

Compare the installed rommon version information with the filename of the rommon version required
for the network.

NOTE

1. Rommon filename format is similar to the following:
MWR1941_RM2.srec.122-8r.MC3.bin

2. The rommon filename reflects the version number of the software (122—-8r.MC3).

If the installed version is the one required for the network skip to steg36.

If the installed rommon version is not the one required for the network, backup the current BTS router
configuration to the LMF computer by entering the following:

copy nvram:startup—config tftp
A response similar to the following will be displayed:

BTSRTR1#copy nvram:start tftp
Address or name of remote host []?

NOTE

Be sure to include the colon (:) after nvram when typing the command.

At the prompt for the remote host address or name, enter the IP address of the LMF computer NIC:
100.100.100.1
A response similar to the following will be displayed:

BTSRTR1#copy copy nvram:start tftp
Address or name of remote host []? 100.100.100.1
Source filename [startup—config]?

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Source filename [startup—config]?
Destination filename [startup—config]?

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed:

Destination filename [startup—config]?
!

[OK — 2212/4096 bytes]

2212 bytes copied in 0.152 secs
BTSRTR1#

... continued on next page
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[Table I-13: Verify and Replace Installed rommon Version Using a tftp Server

Step

Action

10

NOTE

The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has
been changed using the ed command. Determine the present working directory by entering pwd. If
the present working directory has been changed, enter the command cd slotO: to return to the default

setting.

Determine the amount of memory available (bytes free) on the CF memory card by entering the dir
command. A response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2b.bin
2 —rw— 2212 Mar 01 1993 00:14:48 canned—config

31932416 bytes total (24885606 bytes free)
Router#

11

Be sure there is at least 1 MB (1048580) of free memory.
NOTE

A rommon version file requires approximately 0.7 MB.

12

Begin to copy the required version of the rommon file from the LMF computer to the BTS router by entering
the following:

copy tftp:new_rommon_filename slot0:
Where new_rommon_filename = the filename of the required rommon version for the BTS router.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:MWR1941 RM2.srec.122—8r.MC3.bin slotO:
Address or name of remote host [100.100.100.1]?

13

If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer. A response similar to the
following will be displayed if the default filename is selected:

Address or name of remote host [100.100.100.1]?
Source filename [MWR1941 RM2.srec.122—8r.MC3.bin]?

14

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be

displayed if the default filename is selected:

Source filename [MWR1941 RM2.srec.122—8r.MC3.bin]?

Destination filename [MWR1941 RM2.srec.122—8r.MC3.bin]?

... continued on next page
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[Table I-13: Verify and Replace Installed rommon Version Using a tftp Server

Step Action
15 | If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is not
correct, enter the correct filename. A response similar to the following will be displayed if the default
filename is selected:
Destination filename [MWR1941 RM2.srec.122—8r.MC3.bin]?
Accessing tftp://100.100.100.1/MWR1941 RM2.srec.122—-8r.MC3.bin...
Loading MWR1941 RM2.srec.122—8r.MC3.bin from 100.100.100.1 (via FastEthernet0/0): !!!!
Loading MWR1941 RM2.srec.122—8r.MC3.bin from 100.100.100.1 (via FastEthernet0/0):
NN N N N NN N N N N NN RN RN RN RSN SR RN R R RN SR NN BRI
NN RN SN RN R RN R R RN SR NN R
[OK — 614306/14103552 bytes]
614306 bytes copied in 13.059 secs (48634 bytes/sec)
BTSRTR1#
16 | Display the CF memory card directory to verify that the new rommon version file is there by entering
the dir command. A response similar to the following will be displayed:
BTSRTR1#dir
Directory of slot0:/
1 —rw— 7051976 Sep 23 2002 07:25:36 mwrl941—i—mz.122—8.MC2b.bin
2 —rw— 2212 Mar 01 1993 00:09:06 canned—config
3 —rw— 614306 Dec 13 2002 14:59:36 MWR1941 RM2.srec.122—8r.MC3.bin
31932416 bytes total (24263922 bytes free)
BTSRTR1#
17 | Replace the existing rommon version with the new one copied to the CF memory card by entering the
following:
upgrade rom—monitor file slot0:MWR1941_RM2.srec.122-8r.MC3
A response similar to the following will be displayed:
BTSRTR1#This command will reload the router. Continue?[yes/no]
18 | When prompted to continue, enter yes and press the Enter key. A response similar to the following
will be displayed:
BTSRTR1#This command will reload the router. Continue?[yes/no] yes
ROMMON image upgrade in progress
Erasing boot flash
eeeeeeeceeceeceeeceeceeceeeceeceeceeceeeceeceeceeeceeceeceeeeeceeceeeeeceeceeceeeeeeeee
Programming boot flash pppp
Now reloading
19 | When the router has completed initialization, change to the router privileged EXEC mode by entering
the following:
enable
A response similar to the following will be displayed:
BTSRTR1>enable
BTSRTR1#
... continued on next page
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[Table I-13: Verify and Replace Installed rommon Version Using a tftp Server

Step

Action

20

Verify the router has initialized with the new rommon version by entering the following:
show version

A response similar to the following partial response will be displayed:

BTSRTR1#sh ver

Cisco Internetwork Operating System Software

I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE
SOFTWARE (fc3)

TAC Support: http://www.cisco.com/tac

Copyright (c) 1986—2002 by cisco Systems, Inc.

Compiled Mon 05—Aug—02 11:07 by nmasa

Image text—base: 0x60008940, data—base: 0x60B54000

ROM: System Bootstrap, Version 12.2(8r)MC3 RELEASE SOFTWARE (fcl)

21

Compare the version displayed in the response ROM: System Bootstrap line to the filename of the
new rommon version file copied to the CF memory card.

22

If the router successfully rebooted with the new rommon version, the rommon file can be deleted from
the CF memory card by entering the following:

delete slot0:new_rommon_filename

Where new_rommon_filename = the filename of the required rommon version copied to the CF
memory card in stepg 2 througl35, above.

A response similar to the following will be displayed:

BTSRTR1#del slot0:MWR1941 RM2.srec.122—8r.MC3.bin
Delete filename [MWR1941 RM2.srec.122—8r.MC3.bin]?

23

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Delete filename [MWR1941 RM2.srec.122—8r.MC3.bin]?
Delete slot0:MWR1941 RM2.srec.122—8r.MC3.bin? [confirm]

24

Press the Enter key to confirm the deletion. A response similar to the following will be displayed if
the default filename is selected:

Delete filename [MWR1941 RM2.srec.122—8r.MC3.bin]?
Delete slot0:MWR1941 RM2.srec.122—8r.MC3.bin? [confirm]
BTSRTR1#

25

CAUTION

In this step, do not delete the I0S and canned—config files from the CF memory card. The BTS router
must have these files on the card to properly boot or switch between packet and circuit mode.

If additional unnecessary files, such as a backup of the startup—configfile, are also on the CF
memory card, delete them by repeating stepg 42 through34 for each file.

26
26a
26b
26c¢

If no other BTS router file operations or configuration actions are required, perform the following:
— Remove power from the router and disconnect it from the power supply.
— Disconnect all cabling from the BTS router.

— On the LMF computer, exit the HyperTerminal communications session.

... continued on next page
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[Table I-13: Verify and Replace Installed rommon Version Using a tftp Server

Step

Action

CAUTION

27 | If no additional tftp transfer activities will be performed, change the NIC IP address and subnet mask
back to those for LMF-BTS communication recorded iqj" able I-4, steqﬁb.

If the BTS 10base—2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,
the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.

Method 2: Verification and Replacement of Installed rommon Version Using

a CF Memory Card Reader

Description

This procedure covers using an LMF computer equipped with a CF
memory card reader to perform the following activities:

1. Verify the rommon version loaded and running on a BTS router
2. Replace the rommon version installed in a BTS router

Additional required equipment/software
For this method, the following equipment item and associated software
is required in addition to the common items required for both methods:

* CF memory card reader device and software driver for the operating
system installed on the LMF computer

CAUTION Card readers for other non—volatile, solid—state memory devices

such as Smart Media cards will not work with the CF memory
cards used in the MWR 1941 routers. Do not attempt to use a
card reader intended for another type of memory device.

Prerequisites

The following are required prior to performing this procedure:

® The LMF computer and BTS router have been prepared for CF
memory card reader file transfer and are operating as they would be
after performing the procedures in stepg througl§ of Jable I-8

* A copy of the required rommon version is loaded into the desired
directory of the LMF computer

File operations using a CF memory card reader

Only file transfers should be performed using the CF memory card
reader. CF memory card formatting should be performed in a BTS router .
using a HyperTerminal connection. Attempting to format a CF memory |
card from a Windows—based computer using a card reader could result in

unpredictable BTS router operation. .

CAUTION Do not format BTS router CF memory cards using a

Windows—based computer. Only format CF memory cards in a
BTS router.
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Verifying and replacing installed rommon version

Follow the procedure irrJable I-14 to verify and, if necessary replace the
installed rommon version using a CF memory card reader.

Table I-14: Verify and Replace Installed rommon Version Using a CF Memory Card Reader

Step

Action

* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures in stepg through§ of Jable I-8. If necessary,
perform these procedures now.

2 Determine the currently installed rommon version by entering the following at the router privileged
EXEC mode prompt:

show version
A response similar to the following will be displayed:
BTSRTR1#sh ver
Cisco Internetwork Operating System Software
I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE
SOFTWARE (fc3)
TAC Support: http://www.cisco.com/tac
Copyright (c) 1986—2002 by cisco Systems, Inc.
Compiled Mon 05—Aug—02 11:07 by nmasa
Image text—base: 0x60008940, data—base: 0x60B54000
ROM: System Bootstrap, Version 12.2(20020113:235343) [sbose—wilma 109], DEVELOPMENT
SOFTWARE
ROM: 1941 Software (MWR1941-I-M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE SOFT-
WARE (fc3)
Router uptime is 1 minute
System returned to ROM by power—on
System image file is ”slot0O:mwrl941—i—mz.122—8.MC2b.bin”
cisco mwrl941 (R7000) processor (revision 0.1) with 121856K/18432K bytes of memory.
Processor board ID JMX0611K5TS
R7000 CPU at 240Mhz, Implementation 39, Rev 3.3, 256KB L2 Cache
Bridging software.
X.25 software, Version 3.0.0.
Primary Rate ISDN software, Version 1.1.
Toaster processor tmc is running.
2 FastEthernet/IEEE 802.3 interface(s)
2 Serial network interface(s)
2 Channelized T1/PRI port(s)
DRAM configuration is 64 bits wide with parity disabled.
55K bytes of non—volatile configuration memory.
31360K bytes of ATA Slot0 CompactFlash (Read/Write)
Configuration register is 0x101
BTSRTR1#

3 To determine the currently installed rommon version, examine the ROM: System Bootstrap line in
the response.

... continued on next page
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[Table I-14: Verify and Replace Installed rommon Version Using a CF Memory Card Reader

Step Action
4 Compare the installed rommon version information with the filename of the rommon version required
for the network.
NOTE

1. Rommon filename format is similar to the following:
MWR1941_RM2.srec.122-8r.MC3.bin
2. The rommon filename reflects the version number of the software (122—-8r.MC3).

5 If the installed version is the one required for the network skip to steg35.

6 | NOTE

The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has
been changed using the ed command. Determine the present working directory by entering pwd. If
the present working directory has been changed, enter the command cd slotO: to return to the default
setting.

If the installed rommon version is not the one required for the network, determine the amount of
memory available (bytes free) on the CF memory card by entering the following:

dir
A response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2b.bin
2 —rw— 2212 Mar 01 1993 00:14:48 canned—config

31932416 bytes total (24885606 bytes free)
Router#

7 Be sure there is at least 1 MB (1048580) of free memory.
NOTE

A rommon version file requires approximately 0.7 MB, and space must also be available for a backup
of the router’s startup—config file.

8 Create a backup of the current BTS router configuration on the CF memory card by entering the
following:

copy nvram:startup—config slot:0
A response similar to the following will be displayed:

BTSRTR1#copy nvram:startup—config slotO0:
Destination filename [startup—config]?

9 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed:

Destination filename [startup—config]?
2212 bytes copied in 4.96 secs (553 bytes/sec)
BTSRTR1#

10 | Remove the CF memory card from the router by following the procedure in the 1X SC 4812T-MC BTS
FRU Guide .

... continued on next page
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[Table I-14: Verify and Replace Installed rommon Version Using a CF Memory Card Reader

Step Action

11 Insert the CF memory card into the card reader as specified by the card reader manufacturer’s
instructions.

12 | On the LMF computer, click Start > Programs > Windows Explorer to open Windows Explorer.

13 | NOTE
The CF memory card reader will appear as a disk drive in Windows Explorer with a disk drive letter
and icon.

Scroll the left—hand pane of Windows Explorer to locate the icon for the CF memory card.

14 | In the left-hand pane of WindowsExplorer, highlight the CF memory card icon.

15 | In the right~hand pane, verify the files displayed in stefr§, above, appear.

16 | Scroll the left-hand pane of Windows Explorer to locate the icon for the directory where the required
rommon version file is stored.

17 | In the right—hand pane, highlight the startup—config file on the CF memory card, note its file size,
and drag it to the icon for the directory where the required rommon version file is stored.

NOTE

After highlighting the startup—config file in the right—hand pane, it may be necessary to scroll the
left—hand pane to see the directory icon where the required rommon version file is stored before
dragging the file.

18 | In the left-hand pane, highlight the directory where the required rommon version file is stored.

19 | In the right—hand pane, verify the startup—con£ig file is in the directory and the file size is the
same as the original on the CF memory card.

20 | In the right—hand pane, highlight the required rommon version file to be transferred to the CF memory
card and drag it to the CF memory card disk drive icon.

NOTE
After highlighting the rommon version file in the right—hand pane, it may be necessary to scroll the
left—hand pane to see the CF memory card disk drive icon before dragging the file.

21 | Verify the rommon version file has been copied to the CF memory card by clicking on the CF memory
card disk drive icon in the left-—hand pane, and being sure that the rommon version file appears in the
in the right—hand pane.

22 | Click Files > Close to close Windows Explorer.

23 | Remove the CF memory card with the rommon version file from the card reader.

24 | Install the CF memory card in the BTS router by following the procedure in the 71X SC 4812T-MC BTS
FRU Guide .

25 | Proceed to Replace installed rommon version, below.
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Recovery From BTS Router Boot to rommon

Introduction

ROM monitor boot conditions

Under certain circumstances the BTS router will initialize with the ROM
monitor (rommon) operating system rather than the IOS. These
circumstances include:

¢ [OS file is missing from the CF memory card
¢ [OS file is not the first file on the CF memory card
* [OS file image on the CF memory card is corrupted

 Startup—config file contains an outdated boot system line specifying
an IOS file which has been replaced with an updated version

» Startup—config file contains boot system line with typographical
error(s) in the IOS filename

Description

Router operation on rommon is signalled by the display of the rommon
# > prompt, where # is a number which increments each time a
command is issued. Rommon is a low—level operating system which
provides limited capabilities for router testing and troubleshooting
operations, but does not support any operations on files beyond viewing
directory contents or booting from a specified file. As a result, files can
not be copied or deleted when the router is operating on rommon.

Recovery methods

Two recovery methods are included in this section. The first is the
simplest and requires that a valid, uncorrupted IOS version is installed
on the CF memory card. The second method requires additional
equipment and must be used in instances such as when an 10S file is not
installed on the CF memory card or the installed IOS image is corrupted.

Simple Recovery from Boot to rommon

Requirements

Unless it is certain, that the IOS image on the CF memory card is
corrupted, this method should always be the first attempted to recover
the router from a rommon initialization. This method does not require
any additional equipment beyond the items necessary to load canned
configuration files into the BTS router. To be effective, this method does
require that a valid, uncorrupted IOS image file is installed on the
router’s CF memory card.

Recovery

Follow the procedure iqj“able I-15 to attempt a simple recovery from a
BTS router rommon initialization.
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Table I-15: Simple Recovery from BTS Router rommon Boot

Step Action
* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer is set up and connected to the BTS router with an active
HyperTerminal communication session. If it is not, follow the procedure irrFable I-2 to establish a
HyperTerminal communication session.

2 With the rommon 1 > prompt displayed in the HyperTerminal window, enter the following to identify
the 10S file on the CF memory card:

dir slot0:
A response similar to the following will be displayed:

rommon 1 > dir slotO:

program load complete, entry point: 0x80008000, size: 0xb2a0

Directory of slot0:

2 2212 —Irw— canned—config

3 7051976 —rw— mwrl941—i—mz.122—-8.MC2a.bin

rommon 2 >

... continued on next page
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Table I-15: Simple Recovery from BTS Router rommon Boot

Step Action

3 Note the IOS filename, and enter the following to begin recovery to an IOS boot:
boot slot0:/0S _filename
Where [0S _filename = the filename of the I0S noted in ste3, above.

A successful 10S re-boot operation will result in display of a response which begins and ends similar
to the following:

rommon 2 > boot slotO:mwrl941—i—mz.122—8.MC2a.bin

program load complete, entry point: 0x80008000, size: 0xb2a0

program load complete, entry point: 0x80008000, size: 0x6b99ac
Self decompressing the image :
HHAHHHHHHHHHHHHAAHHAHAAAAAAAAAAAAAAAAAAAAAAAA AR [OK ]
Smart Init is enabled
smart init is sizing iomem
ID MEMORY_REQ TYPE
00031A 0X005F3C00 MWR1941 Mainboard
0X000F3BB0 public buffer pools
0X00211000 public particle pools

TOTAL: 0X008F87B0

Press RETURN to get started!

4 If the router successfully reboots with the 10S, proceed to steqj.

5 If the router does not reboot with the IOS, perform the following:

S5a — Scroll the HyperTerminal display down until the directory display from stefr3, above, is visible.

5b — Compare the 10S filename from the directory display with the filename entered in performing step
3, above.

5c — If the filename was typed incorrectly, repeat ster 3, using care to type the filename correctly.

6 If the router does not reboot with the I0S after typing the filename correctly, proceed tqable I-16 and
perform the extended recovery procedure.

. .. continued on next page
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Table I-15: Simple Recovery from BTS Router rommon Boot

Step

Action

Ta

7b

7c
7d

CAUTION

The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.

After a successful reboot with 10S, perform the following to correct the cause of the boot to rommon:

— Enter the dir slot0: command to display the CF memory card directory, and, if the IOS file is
not the first file listed, perform the procedure iqj"able I-10, stequS througl}jZ, oﬁable 1-12, as
applicable, to correct the situation.

— If the IOS file is the first file, enter the following command to display the contents of the
startup—config file:

show startup—config

A response which begins similar to the following will be displayed:

BTSRTR1#sh start
Using 1589 out of 57336 bytes
!

version 12.2
service timestamps debug uptime
service timestamps log uptime
no service password—encryption
!
hostname BTSRTR1
!
boot system slot0O:mwrl1941—i—-m=z.07132002.bin
no logging console
!
username cisco password 0 cisco
!
redundancy

mode y—cable

standalone
!

— If the file listing contains a “boot system” line, examine it for the correct IOS filename.

— If the boot system slotQ: filename is incorrect, enter the following, using care to type the filename
correctly:

boot system slot0:/0S_filename
Where [0S _filename = the filename of the I0S noted in steg3, above.

7e — Replace the boot system line in the startup—config file with the line entered in steg7d, above, by
entering the following:
copy runing—config startup—config
... continued on next page
I-70
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Table I-15: Simple Recovery from BTS Router rommon Boot

Step Action

7f — Verify the correct IOS filename is now included in the listing by entering the following:
show startup—config

A response which begins similar to the following will be displayed:

BTSRTR1#sh start
Using 1589 out of 57336 bytes
!
version 12.2
service timestamps debug uptime
service timestamps log uptime
no service password—encryption
!
hostname BTSRTR1
!
boot system slot0O:mwrl941—i—mz.122—8.MC2a.bin
no logging console
!
username cisco password 0 cisco
!
redundancy

mode y—cable

standalone
!

g — If the filename is correctly written, enter the following to determine if the router will reboot to
IOS:

reload

A response similar to the following will be displayed:
BTSRTR1#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

8 If prompted to save a modified configuration, enter n for “no,” and press the Enter key.

9 When prompted to proceed with reload, press the Enter key to continue the reload operation.

10 | After a successful reboot with 10S, proceed with other BTS router activities or remove power from the
router and disconnect it

11 If the router still will not successfully boot with IOS, proceed tqable I-16 and perform the extended
recovery procedure.

Extended Recovery from Boot to rommon

Requirements

If rommon boot recovery attempts fail using the simple recovery
method, this method must be used to reboot a BTS router which has
initialized with rommon. This method requires additional equipment
beyond the items necessary to load canned configuration files into the
BTS router. Extended recovery requires formatting the CF memory card
from the rommon—initialized router and reloading the reformatted CF
memory card with the required IOS version.
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Additional equipment required

An additional, formatted, 32 MB CF memory card with the required
version of the IOS installed is required in addition to the equipment and
software required for BTS router canned configuration installation. This
card may be:

* A spare CF memory card which is loaded with the required IOS
version

* A CF memory card from an additional BTS router which is loaded
with the required 10S version

Recovery

Follow the procedure irrJable I-15 to perform an extended recovery
from a BTS router rommon initialization.

Table I-16: Extended Recovery from BTS Router rommon Boot

Step Action

1 This procedure assumes the BTS router is powered and operating on rommon with the LMF computer
set up and connected to the router with an active HyperTerminal communication session. If it is not,
follow the procedure irpJable I-2 to establish a HyperTerminal communication session.

2 Remove the CF memory card from the BTS router following the procedure in the 1X SC 4812T-MC
BTS FRU Guide .

3 Install the additional CF memory card in the router following the procedure in the BTS FRU Guide.

4 Enter the following to obtain the filename of the IOS version loaded on the CF memory card:
dir slot0:

A response similar to the following will be displayed:

rommon 1 > dir slotO:
program load complete, entry point: 0x80008000, size: 0xb2a0

Directory of slot0:

1 7051976 —rw— mwrl941—i—mz.122—-8.MC2a.bin

rommon 2 >

5 Note the exact filename displayed for the IOS version.

... continued on next page
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Table I-16: Extended Recovery from BTS Router rommon Boot

Step Action

6 Enter the following to initialize the router with the IOS on the additional CF memory card:
boot slot0:/0S _filename
Where [0S _filename = the filename of the I0S noted in stegj, above.

A successful 10S re-boot operation will result in display of a response which begins and ends similar
to the following:

rommon 2 > boot slotO:mwrl941—i—mz.122—8.MC2a.bin

program load complete, entry point: 0x80008000, size: 0xb2a0

program load complete, entry point: 0x80008000, size: 0x6b99ac
Self decompressing the image :
HHAHHHHHHHHHHHHAAHHAHAAAAAAAAAAAAAAAAAAAAAAAA AR [OK ]
Smart Init is enabled
smart init is sizing iomem
ID MEMORY_REQ TYPE
00031A 0X005F3C00 MWR1941 Mainboard
0X000F3BB0 public buffer pools
0X00211000 public particle pools

TOTAL: 0X008F87B0

—— System Configuration Dialog —

Would you like to enter the initial configuration dialog? [yes/no]: n

7 If the router prompts with a question to enter the initial dialog as shown in stefr§), above, type no and
press the Enter key to obtain the user EXEC mode prompt.

8 If the router prompts with Press RETURN to get started!, press the Enter key to obtain the user
EXEC mode prompt.

9 At the user EXEC mode prompt, enter the following to access the privileged EXEC mode:
enable

A response similar to the following will be displayed:

Router> enable
Router#

10 | Remove the additional CF memory card from the BTS router following the procedure in the 71X SC
4812T-MC BTS FRU Guide .

11 | Install the original CF memory card in the router following the procedure in the BTS FRU Guide.

... continued on next page
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Table I-16: Extended Recovery from BTS Router rommon Boot

Step Action

12 | Format the original CF memory card by entering the following:
format slotO:

A response similar to the following will be displayed:

Router#format slotO:
Format operation may take a while. Continue? [confirm]

13 | Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation may take a while. Continue? [confirm]
Format operation will destroy all data in ”slot0:”. Continue? [confirm]

14 | Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation will destroy all data in ”slot0:”. Continue? [confirm]
Format: Drive communication & lst Sector Write OK...
Writing Monlib

Monlib write complete

Format: All system sectors written. OK...

Format: Total sectors in formatted partition: 62560
Format: Total bytes in formatted partition: 32030720

Format: Operation completed successfully.

Format of slot0 complete
Router#

15 | Copy the required IOS version to the formatted original CF memory card by performing one of the
following:

¢ Use the LMF computer and a tftp server following the procedure irﬂ" able I-10
* Use the LMF computer and a CF memory card reader following the procedure ijable I-11

16 | If applicable, perform IOS initialization troubleshooting as described irrFable I-15, stepg™ through30.
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Entering or Changing Router FE Interface IP Address

It may be necessary to enter or change the IP addresses and/or operating
parameters for BTS router FE interfaces FE 0 and FE1 without making
other changes in the router configuration files. Procedures in this section
cover these operations.

Prerequisites

The following must be accomplished before entering or changing BTS
router FE port IP addresses and/or operating parameters:

¢ The user has read and understands the content of MWR1941 Wireless
Mobile Edge Router Software Configuration Guide; part number
78—13983-01

* BTS routers must have the required version of the IOS saved on their
installed CF memory card

* BTS routers must have power applied, be operating without alarms
other than span alarms, and have completed boot—up to the user EXEC
mode prompt (BTSRTR—bts#—1—1>)

* The BTS router privileged EXEC mode password has been obtained
from the network administrator

Entering or Changing FE Interface IP Addresses

To enter or change FE interface IP addresses, follow the procedure in
[Jable I-17.

Table I-17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step

Action

* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 Obtain the correct IP addresses and subnet masks for the BTS router FE interfaces from the network
administrator.

2 If a HyperTerminal connection for BTS card/module MMI or BTS router (BTSRTR) communication
has not been created, create one as described iqj"able I-1 of this appendix.

3 Connect the LMF computer to the BTS router, and start a communication session as described in

[Jable I-2 in this appendix.

. .. continued on next page
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Table I-17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step

Action

NOTE

Examples in this procedure show prompts for BTSRTR-bts#—1—1 and BTSRTR-bts#—1-2, but the
procedure can be used for any router in any BTS router group or a router running the canned
configuration file (BTSRTR1 or BTSRTR?2).

At the BTSRTR-bts#—1—1> user EXEC mode prompt, enter the following to access the privileged EXEC
mode:

enable
A response similar to the following will be displayed:

BTSRTR—DIs#—1—1> enable

Password:
5 Enter the privileged EXEC mode password. A response similar to the following will be displayed:
BTSRTR-DIs#—1—1> enable
Password:
BTSRTR-DIsH#—1—1#
6 At the BTSRTR-bts#—1—1# privileged EXEC mode prompt, display the FE interface IP addresses by
typing:
show ip interface brief
A response similar to the following will be displayed:
BTSRTR-DIs#—1—1# show ip interface brief
Interface IP Address OK? Method
Status Protocol
FastEthernet0/0 192.168.146.1YES
NVRAM up up
Serial0:0 unassigned YES unset
administratively down down
FastEthernet0/1 unassigned YES
unset administratively down down
Seriall:0 unassigned YES unset
administratively down down
BTSRTR-DIsH#—1—1#
7 For a FastEthernet0/0 (fa0/0) or FastEthernet0/1(fa0/1) interface which does not have a correct or an
assigned IP address, enter the following at the router prompt to access the global configuration mode:
configure terminal
A response similar to the following will be displayed:
BTSRTR-DIs#—1—-1# conf t
Enter configuration commands, one per line. End with CNTL/Z.
BTSRTR-DIs#—1—1 (config)#
. .. continued on next page
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Table I-17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step Action

8 At the global configure mode prompt, enter the following to access the configure interface submode
for the interface requiring IP address assignment/change:

interface fastethernetinterface#
Where interface# = 0/0 or 0/1, as applicable.
A response similar to the following will be displayed:

BTSRTR-DIs#—1—1 (config)# int fa0/1

BTSRTR-DIs#—1—1 (config—if)#

9 At the configure interface submode prompt, assign or change the interface IP address by entering:
ip address IP_addr subnet_mask

Where:
IP_addr = the required IP address for the interface; for example, 192.168.147.1
subnet_mask = the required subnet mask for the interface; for example, 255.255.255.0

A response similar to the following will be displayed:
BTSRTR-DIs#—1—1 (config—if)# ip address 192.168.147.1 255.255.255.0

BTSRTR-DIs#—1—1 (config—if)#

10 | To complete configuration of the interface, enter the following parameter settings, one at a time,
pressing Enter after each:

duplex full
speed 100
keepalive 1
no shutdown

11 Return to the global configuration mode by entering the exit command. A response similar to the
following will be displayed:

BTSRTR-DIs#—1—1 (config—if)# exit

BTSRTR-DIs#—1—1 (config)#

12 | If the IP address and/or parameters for the other FE interface on the router must be assigned or
changed at this time, repeat stepg{ througl1 for the other FE interface.

13 | Once the correct parameters have been set for all FE interfaces, return to the privileged EXEC mode
prompt by holding down the Ctrl key and pressing z (Ctrl +z). A response similar to the following
will be displayed:

BTSRTR-DIs#—1—1 (config—if)# "z
01:11:27: %SYS—5—CONFIG I: Configured from console by console
BTSRTR-DIsH#—1—1#

NOTE

Entering exit twice, pressing the Enter key after each entry, will also complete the interface
configuration and return the router to the privileged EXEC mode.

. .. continued on next page
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Table I-17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step Action
14 | Save the interface configuration changes to the startup configuration file on the CF memory card by
entering the following:
copy running—config startup—config
A response similar to the following will be displayed:
BTSRTR-DIs#—1—1# copy run start
BTSRTR-DIs#—1—1# Destination filename [startup—config]?
15 | Press Enter. A response similar to the following will be displayed:
BTSRTR-DIs#—1—1# copy run start
BTSRTR-DIs#—1—1# Destination filename [startup—config]?
Building configuration...
NN N RN NN N R N NN NN N NN RN NN RN SRR RN SRR SR RN R RN F R RN o):
BTSRTR-DIs#—1—1#
16 | If all FE IP address entries/changes for the router are complete, enter the following to return the router
to user EXEC mode:
disable
A response similar to the following will be displayed:
BTSRTR-DIs#—1-1# disable
BTSRTR-DIs#—1-1>
17 | If no other router requires the FE interfaces to be assigned/changed, proceed to ster30.
18 | If FE interfaces on another router must be assigned/changed, disconnect the 8—contact modular plug
from the current router CONSOLE port and connect it to the CONSOLE port of the other router.
19 Press the Enter key, and when the router user EXEC mode prompt appears repeat stequ througlE]I6
for the other router.
20 | When the router is in user EXEC mode, close the HyperTerminal session and disconnect the LMF
computer and additional components from the BTS router.
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BTS Router Canned Configuration File

This section presents listings of the blue and red router canned
configuration file contents for the MWR 1941 BTS routers. The blue
router is the primary router on the BTS LAN subnet 192.168.146.0, and
the red router is the primary on BTS LAN subnet 192.168.147.0. The
canned configuration files allow communication with the BTS routers
for both on-site FE cabling connectivity verification and for
downloading the routers from the network with the full, site—specific
operational configuration.

Obtaining the Latest Configuration File Content

The files included here are for example only. The correct canned
configuration file content for each BTS router should be generated at the
OMC-R using the /screl/active/bin/gen_btsrtr_canned_config.ksh script.

Configuration File Examples

Examples of both configuration files are provided in the following
subsections.
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“Blue” BTS Router Canned Configuration

! Canned Config file for BTSRTRI1

version 12.2

service timestamps debug uptime
service timestamps log uptime
no service password—encryption
!

hostname BTSRTR1

!

no logging console

!

!

ip subnet—zero

ip classless

ip pim bidir—enable

!

disable—eadi

!
redundancy
mode y—cable
standby use—interface Loopbackl01l health
standby use—interface Loopbackl02 revertive
standby use—interface Multilinkl backhaul

interface loopback 101
description BTSRTR health loopback
no ip address

interface loopback 102
description BTSRTR revertive loopback
no ip address
!
! configure 1 DSO for BTSRTRLINK
!
controller T1 0/0
description 1st span on BTSRTR
framing esf
linecode b8zs
cablelength short 133
clock source line
channel—group 0 timeslots 1-24 speed 64

! MLPPP bundle with BTSRTRLINK.
! This performs IPCP with RPM when BTSRTR is rebooted
interface Multilink 1
ip address negotiated
no ip route—cache
no cdp enable
ppp multilink
multilink—group 1
no shutdown
]
! Setup Serial Interface for PPP and IPCP, no MLPPP at this time
]
interface Serial0/0:0
no ip address
encapsulation ppp
keepalive 1
ppp multilink
multilink—group 1
no shutdown
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! Setup Ethernet Interfaces and HSRP between them
!
interface FastEthernet0/0
ip address 192.168.146.1 255.255.255.0
keepalive 1
speed 100
full—duplex
standby 1 timers 1 3
standby preempt
standby priority 100
standby ip 192.168.146.3
standby name one
standby track Fa0/1 10
standby 1 track Multilinkl 10
! Track the MWR 1941 health interface
standby 1 track Loopbackl0l 10
! Track the MWR 1941 revertive (compensation) interface
standby 1 track Loopbackl02 5
no shutdown
!
interface FastEthernet0/1
ip address 192.168.147.1 255.255.255.0
keepalive 1
speed 100
full—duplex
standby 2 timers 1 3
standby 2 preempt
standby 2 priority 100
standby 2 ip 192.168.147.3
2
2

e

standby name two

standby track Fa0/0 10

standby 2 track Multilinkl 10

! Track the MWR 1941 health interface

standby 2 track Loopbackl01l 10

! Track the MWR 1941 revertive (compensation) interface
standby 2 track Loopbackl02 5

no shutdown

!
! Set a default route to RPM thru BTSRTRLINK
1

ip route 0.0.0.0 0.0.0.0 Multilink 1
!

line con 0
exec—timeout 15 0
password cisco

line aux 0
login
password cisco

line vty 0 4
login
password cisco

end
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“Red” BTS Router Canned Configuration

! Canned Config file for BTSRTR2

version 12.2

service timestamps debug uptime
service timestamps log uptime
no service password—encryption
!

hostname BTSRTR2

!

no logging console

!

!

ip subnet—zero

ip classless

ip pim bidir—enable

!

disable—eadi

!
redundancy
mode y—cable
standby use—interface Loopbackl01l health
standby use—interface Loopbackl02 revertive
standby use—interface Multilinkl backhaul

interface loopback 101
description BTSRTR health loopback
no ip address

interface loopback 102
description BTSRTR revertive loopback
no ip address
!
! configure 1 DSO for BTSRTRLINK
!
controller T1 0/0
description 1st span on BTSRTR
framing esf
linecode b8zs
cablelength short 133
clock source line
channel—group 0 timeslots 1-24 speed 64

! MLPPP bundle with BTSRTRLINK.
! This performs IPCP with RPM when BTSRTR is rebooted
interface Multilink 1
ip address negotiated
no ip route—cache
no cdp enable
ppp multilink
multilink—group 1
no shutdown
]
! Setup Serial Interface for PPP and IPCP, no MLPPP at this time
]
interface Serial0/0:0
no ip address
encapsulation ppp
keepalive 1
ppp multilink
multilink—group 1
no shutdown
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! Setup Ethernet Interfaces and HSRP between them
!
interface FastEthernet0/0
ip address 192.168.146.2 255.255.255.0
keepalive 1
speed 100
full—duplex
standby 1 timers 1 3
standby preempt
standby priority 100
standby ip 192.168.146.3
standby name one
standby track Fa0/1 10
standby 1 track Multilinkl 10
! Track the MWR 1941 health interface
standby 1 track Loopbackl0l 10
! Track the MWR 1941 revertive (compensation) interface
standby 1 track Loopbackl02 5
no shutdown
!
interface FastEthernet0/1
ip address 192.168.147.2 255.255.255.0
keepalive 1
speed 100
full—duplex
standby 2 timers 1 3
standby 2 preempt
standby 2 priority 100
standby 2 ip 192.168.147.3
2
2

e

standby name two

standby track Fa0/0 10

standby 2 track Multilinkl 10

! Track the MWR 1941 health interface

standby 2 track Loopbackl01l 10

! Track the MWR 1941 revertive (compensation) interface
standby 2 track Loopbackl02 5

no shutdown

!
! Set a default route to RPM thru BTSRTRLINK
1

ip route 0.0.0.0 0.0.0.0 Multilink 1
!

line con 0
exec—timeout 15 0
password cisco

line aux 0
login
password cisco

line vty 0 4
login
password cisco

end
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Preparation for Site Turn—over

Prepare the BTS site for turn—over to the control of the OMC-R by
performing the procedures iqj"able I-18 anq-jable I-19.

Table I-18: Prepare for Site Turn—over
Step Action

1 After disconnecting it from the BTS router, shut down the LMF computer.

2 If any additional external support equipment was used during the installation process, shut it down,
disconnect it from the frame.

3 Account for all tools used and parts removed from the frame during the installation, being sure none
were left inside the frame.

4 Visually inspect the frame for any foreign objects left inside, and remove any discovered.

5 Visually inspect all cable connections, ensuring they are connected as required for normal BTS
operation.

6 Be sure all internal frame cables are routed and secured to prevent damage to them when the frame
doors are closed.

7 Be sure all external frame and BTS router cables are routed and secured so they will not interfere with
normal maintenance and operational activities at the site.

8 Be sure the BTS routers are powered up and not reporting alarms other than span alarms.

Returning the Site to OMC-R Control

Follow the procedure iqj"able I-19 to return the site to OMC-R control.

Table I-19: Returning the Site to Operational Control

Step Action

1 Contact the OMC-R, and notify the operator the installation is complete. Request notification from
the operator when the routers have been downloaded with the full site—specific configurations and are
verified as functioning normally.

2 When notified router operation has been verified and the OMC-R can assume control of the site,
perform the following:

2a — On any frames which were opened, close and secure the cabinet doors.

2b — Verify no alarm conditions are being reported to the OMC—R with the frame doors closed.

2c — Prepare all equipment, tools, and parts removed from the frame for transport from the site.

What to Do Next

The installation of the Packet Backhaul option is complete. When the
site is secured, there are no further actions to perform at the BTS site.
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Numbers

10BaseT/10Base2 Converter, 1-9
LMF to BTS connection, 3-16

2—way Splitter, 1-12

3C-PC-COMBO CBL, 1-9

800 MHz CDMA Channels, E-2

800 MHz Center Frequencies, Calculating, E-2

A

ACTIVE LED
GLI, 6-31
MCC, 6-35

Advantest R3267, GPIB Address, F-8

Advantest R3465, 3-50
Calibrating Test Cable, F-2, F-20

Advantest R3465 Communications Test Set GPIB
Address, F-12

Advantest R3562, GPIB Address, F-9

Agilent 8935 Series E6380 (formerly HP 8935) Test
Set GPIB Address, F-10

Agilent E4406A
calibration, F-2, F-23
GPIB Address, F-6

Agilent E4432B Signal Generator, GPIB Address,
F-7

Alarm Connector Location/Pin, 3-97
ALARM LED, GLI, 6-31

Alarm Monitor window, 3-96

alarm redundancy tests, BBX, 3-93
Alarm Reporting Display, 3-96
Alarm tests, redundancy, 3-89
Alarm/Redundancy Tests, Distribution Shelf, 3-92
All RX, 4-5

All TX, 4-5

All TX/RX, 4-5

AMR, No control, 6-17

AMR CDI Alarm Input Verification, test data sheets,
A-17

Ancillary frame, when to optimize, C-2

ATP, 4-2
Code Domain Power, 4-13
Frame Error Rate (FER), 4-15
generate report, 4-16
Pilot Time Offset, 4-12
Report, 4-16
Spectral Purity Transmit Mask, 4-9
test matrix/detailed optimization, C-3
Test Prerequisites, 4-4
Test Procedure, 4-7
Waveform Quality (rho), 4-11

ATP Setup, TX, 3-63

Automated Acceptance Test Procedure, 4-2

Backplane DIP switch settings, 2-4
Bay Level Offset calibration failure, 6-7

BBX
alarm redundancy tests, 3-93
Connector, 6-15
gain set point vs BTS output considerations, D-2
No control in the shelf, 6-17

BBX Configurations, 1-31

BLO
Calibration, 3-76
Calibration Audit, 3-86
calibration data file, 3-77
Calibration Failure, 6-7
Download, 3-87

Breaker Panel, 2-8

BTS
Ethernet LAN interconnect diagram, 3-30
LMF connection, 3-16
system software download, 3-4
test data sheets, redundancy/alarm tests, A-16
when to optimize, C-2

BTS frame, initial power—up, 2-11
BTS router communication session, establishing, I-6

BTS router connections
FE verification, 1-7
programming, 1-7

Create CAL File, 3-88
BTS Site Span Configuration Verification, 5-5

C

C—CCP Backplane, Troubleshooting, 6-14, 6-15
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Index

C-CCP Shelf, 1-29
Site Serial Number Check List, A-18

Cable
GPIB, 1-11
LAN Cable, 1-11
Calibrating, 3-70
Null Modem, 3-41
Setting Loss Values, 3-74
Timimg Reference, 1-11

Cable Calibration, Manual, 3-53

Cable Calibration Set—up, Automatic, 3-53
CAL File, 3-88

Calculating Center Frequencies, 800 MHz, E-2

Calibrate Test Cabling, Communications System
Analyzer, 3-71

Calibrating
Cables, 3-70
Test Equipment, 3-69

Calibrating Test Cable, Advantest R3465, F-2, F-20

Calibrating Test Cabling, Signal Generator &
Spectrum Analyzer, 3-72

Calibration
BLO, 3-76
Cable, 1-7
data file, BLO, 3-77
RF Path, Test Equipment Setup, 3-80
Test Equipment, 1-7
TX Path, 3-77, 3-80

Test Cable Calibration, 1-7

Test Equipment Calibration, 1-7

calibration, Gigatronics 8542B, F-2, F-26
Calibration Audit Failure, Troubleshooting, 6-8
Calibration Procedures Included, Automatic, 3-65

Cannot communicate to Communications Analyzer,
6-4

Cannot communicate to Power Meter, 6-3
Cannot download CODE to any device card, 6-5
Cannot Download DATA to any device card, 6-5
Cannot ENABLE device, 6-6

Cannot load BLO, 6-8

Cannot Log into cell-site, 6-3

Cannot perform Code Domain Noise Power
measurement, 6-10

Cannot perform Rho or pilot time offset
measurement, 6-9

Cannot perform Txmask measurement, 6-9

CDF, 3-3
site equipage verification, 3-4
site type and equipage data information, 2-2

CDF Files, Copy from CBSC, 3-10

CDI Alarm
with Alarms Test Box, 3-98
without Alarms Test Box, 3-100

CDMA LMF, Product Description, 1-8

Cell Site
equipage verification, 2-2
preliminary operations, 2-2
types, 3-3

Cell Site Data File. See CDF

Channel elements, No or missing, 6-18
Channels, 800 MHz, E-2

Checksum Failure, 6-12

CLI, 3-22
Command Line Interface, 3-17
Format Conventions, 3-23
Logging Out, 3-28

CLPA, 1-15

Code Domain Power, 4-6
ATP, 4-13

Code Domain Power and Noise Floor Measurement
Failure, Troubleshooting, 6-10

Code Domain Power Test, 4-13

Code Download Failure, Troubleshooting, 6-5
Command Line Interface, 3-22

command terminal, settings, [-3

Common power supply verification, 2-10

Communications Analyzer Communication Failure,
Troubleshooting, 6-4

Communications System Analyzer, 1-10
communications test set, TX acceptance tests, 4-4

Connector Functionality, Backplane,
Troubleshooting, 6-14

Copy and Load Cal File to to CBSC, 5-2

Copy CAL files from CDMA LMF to the CBSC, 5-2
Copy CAL Files From Diskette to the CBSC, 5-3
Copy CDF Files from CBSC, 3-10

Copy Files to a Diskette, 5-2
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Copy CAL files to the CBSC, 5-3

CSM
Clock Source, 3-36
Enable, 3-37
frequency verification, 3-41
functions, 3-39
LEDs, 3-39
MMI terminal connection, illustration, 3-43
redundancy/alarm tests, 3-94
Reference Source Configuration Error, 6-12
Troubleshooting, 6-12, 6-13

CyberTest, 3-50

D
Data Download Failure, Troubleshooting, 6-5
DC Power Pre—test, BTS Frame, 2-6

DC Power Problems, 6-19

DC/DC Converter, LED Status Combinations, 6-28

Device Enable (INS) Failure, Troubleshooting, 6-6

Digital Control Problems, C—CCP Backplane
Troubleshooting, 6-16

Digital Multimeter, 1-11
Directional Coupler, 1-11
Distribution shelf, alarm/redundancy tests, 3-92

Download
BLO, 3-87
BTS, 3-32
BTS system software, 3-4
Non—-GLI2 Devices, 3-35
ROM Code, H-2

E
E4406A, calibration, F-2, F-23

Enable
CSMs, 3-37
MCCs, 3-38
Redundant GLIs, 3-38

enhanced trunking modules, 1-30

Equipment setup, VSWR, HP Test Set, G-3

Ethernet LAN
interconnect diagram, 3-30
Transceiver, 1-9

Ethernet maintenance connector interface, illustration,
3-16

ETM, 1-30

External Test Equipment Removal, 5-4

F

FER test, 4-15

Folder Structure Overview, 3-7
Foreword, xviii

Frame Error Rate, 4-6
ATP, 4-15

FREQ Monitor Connector, CSM, 6-30
Frequency counter, optional test equipment, 1-12

Frequency Spectrum, North American Cellular
Telephone System (800 MHz), E-2

Full Optimization, 4-5

G

Gain set point, BBX, D-2

General Safety, xx

Generating an ATP Report, 4-16

General optimization checklist, test data sheets, A-5
Gigatronics 8542 power meter, calibration, F-2, F-26
Gigatronics 8542B power meter, illustration, F-15
Gigatronics Power Meter, 3-50

GLI
See also Master (MGLI2) and Slave (SGLI2) Group
Line Interface
LED Status, 6-31
No Control through span line connection, 6-16
No Control via LMF, 6-16

GLI2
Connector, 6-15
Ethernet Connections, 6-15

GLI3 Front Panel, 6-32, 6-33

GPIB
power meter
Gigatronics 8542B, F-15
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HP437B, F-14
set address, Motorola CyberTest, F-13

GPIB Cable, 1-11

GPIB Address
Advantest R3267, F-8
Advantest R3465, F-12
Advantest R3562, F-9
Agilent (formerly HP) 8935, F-10
Agilent E4406A, F-6
Agilent E4432B, F-7
Hewlett Packard HP8921a & HP83236A/B, F-11

GPS
Initialization/Verification, 3-44
receiver operation, test data sheets, A-6
redundancy alarm tests, 3-94
satellite system, 3-37
Test Equipment Setup, 3-42

GPS Bad RX Message Type, 6-12
Graphical User Interface, 3-18

GUI, 3-18
Graphical User Interface, 3-17
Logging Out, 3-27

H

LMF Hardware Requirements, 1-8

Hewlett Packard HP8921A and HP83236A/B GPIB
Address, F-11

High Stability 10 MHz Rubidium Standard, 1-12
High—impedance Conductive Wrist Strap, 1-11
HP 437, Pre—calibration, F-2, F-24

HP 437B, 3-50

HP 83236A, F-18

HP 8921, 3-50

HP 8921A, System Connectivity Test, F-2, F-18
HP 8935, 3-50

HP PCS Interface Test Equipment Setup for Manual
Testing, F-2, F-19

HP Test Set, VSWR, G-3

HSO
Initialization/Verification, 3-48
redundancy/alarm tests, 3-94

HyperTerminal Connection, Creating, 3-12

I and Q values, B-2

Initial Installation of Boards/Modules, preliminary
operations, 2-3

Initial power tests, test data sheets, A-4
Initial power—up, BTS frame, 2-11

Initialization/Verification
GPS, 3-44
HSO, 3-48

Intended reader profile, 1-13

Inter—frame cabling, when to optimize, C-3
IP Addresses, Agilent E7495A, 3-66
IS-97 specification, B-2

ISB connectors, 6-14

Isolate BTS from T1/E1 Spans, 3-15
Itasca Alarms Test Box, 1-12

L
1 TX ATP Setup, 3-63

LAN
BTS frame interconnect, illustration, 3-30
Tester, 1-12

LAN Connectors, GLI, 6-32
LED, CSM, 3-39

LED Status, 6-28
BBX, 6-34
CSM, 6-29
DC/DC Converter, 6-28
GLlI, 6-31
MCC, 6-35
PA, 6-34

LFR, redundancy/alarm tests, 3-94
LFR/HSO, Test Equipment Setup, 3-42
LIF, Load Information File, 3-8

Line Build Out parameters
configure, 5-6
verify, 5-5

LMEF, 3-5
1X FER acceptance test, 4-4
Ethernet maintenance connector interface detail,
illustration, 3-16
Installation and Update Procedures, 3-9
Termination and Removal, 5-8
to BTS connection, 3-16
TX acceptance tests, 4-4

LMEF BTS displays, 3-17
LMF Home Directory, 3-7
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LMF Operation, 3-17
LMF Removal, 5-8

Load Information File, 3-8
Loading Code, 3-32
Logging In to a BTS, 3-24

Logging Out, 3-27
CLI, 3-28
GUI, 3-27

Logical BTS, 1-18
Numbering, 1-18

Login
CLI, 3-26
GUIL, 3-24

Login Failure, Troubleshooting, 6-3

Manual
layout, 1-2
overview, 1-3

MASTER LED, GLI, 6-31

MCC, Enable, 3-38

MCIO, Connectors, 6-15

MCM, 1-30

MGLI, redundancy test RFM frame, 3-95
MGLI2, board detail, MMI port connections, 5-6
Miscellaneous errors, Troubleshooting, 6-6

MMI Connection, 3-29

MMI Connector
CSM, 6-30
GLI, 6-32
MCC, 6-35

MMI equipment setup, 3-29
Module status indicators, 6-28
Multi—FER test Failure, Troubleshooting, 6-11

multicarrier module, 1-30

N
NECF, 3-3

No DC input voltage to Power Supply Module, 6-19
No DC voltage +5 +65 or +15 Volts to a specific GLI,

Non-GLI2, Download, 3-35
Null Modem Cable, 3-41

(o)
Online Help, 3-17, 3-29

Optimization
Process, 3-2
purpose, 1-4
When, 1-6

Optimization/ATP Setup, 3-60

Optional Test Equipment, 1-12
frequency counter, 1-12

Oscilloscope, 1-12

P

PA, test data sheets
convergence, A-8
IM Reduction, A-7

PA Configurations, 32 W, 1-31

PA Module LED, 6-34

PA Shelves, 1-30

Parallel Linear amplifier Combiners, 1-30
PAs, Site Serial Number Check List, A-19

path
RX, 1-4
TX, 1-4

PCMCIA, Ethernet adapter, LMF to BTS connection,

3-16
Pilot Gain, 4-11, 4-12, 4-13, 4-15
Pilot Offset Acceptance test, 4-12
Pilot Time Offset, 4-6, 4-12
Pin/Signal Information for ARM A Cable, 3-102
Ping, 3-30
PLC, 1-30

PN Offset
programming information, B-2
usage, B-2

PnMask, I and PnMask Q Values, B-3
Power Input, 6-14
Power Meter, illustration, F-14

Power meter

. GPIB
BBX, or Switch board, 6-20 Gigatronics 8542B, F-15
No GPS Reference Source, 6-12 HP437B, F-14
Index-6 1X SC 4812T-MC Multicarrier BTS Optimization/ATP Sept
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illustration, Gigatronics 8542B, F-15
TX acceptance tests, 4-4

Power Meter Communication Failure,
Troubleshooting, 6-3

Power supply, converter redundancy, 3-91
Power Supply Interface, 6-15

power supply/converter redundancy, 3-91
Pre—calibration, HP 437, F-2, F-24
Pre—power tests, test data sheets, A-4

Preliminary operations
cell Site types, 2-2
test data sheets, A-3

Prepare to Leave the Site

BTS Site Span Configuration Verification, 5-5

External Test Equipment Removal, 5-4

LMF Removal, 5-8

Re—connect BTS T1/E1 Spans and Integrated
Frame Modem, 5-9

Reset All Devices and Initialize Site Remotely,
5-10

Set BTS Site Span Configuration, 5-6

Pushbuttons and Connectors, GLI, 6-32

PWR/ALM LED
BBX, 6-34
CSM, 6-29
DC/DC Converter, 6-28
generic, 6-28
MCC, 6-35

R

RDM, 6-14

Re—connect BTS T1/E1 Spans, 5-9
Re—connect Integrated Frame Modem, 5-9
Reduced ATP, 4-3, 6-9

redundancy/alarm tests, 3-89

Redundant GLIs, Enable, 3-38

Reference Distribution Module, 6-14
Required documents, 1-13

Required test equipment, communications system
analyzer, 1-10

Reset All Devices and Initialize Site Remotely, 5-10
RESET Pushbutton, GLI, 6-32

Revision History, xxii

RF
Adapters, 1-11
Load, 1-11

RF Path Calibration, 3-80

rho, 4-6

rho test, 4-11

ROM Code, Download, H-2

RS-232 to GPIB Interface, 1-9

RS232 GPIB Interface Box, F-16

RX, antenna VSWR, test data sheets, A-17
RX Acceptance Tests, Frame Error Rate, 4-6
RX ATP Setup, 3-64

RX path, 1-4

S

Selecting Test Equipment, 3-66

Set BTS Site Span Configuration, 5-6
Setting Cable Loss Values, 3-74

Setting TX Coupler Loss Value, 3-75

Setup for Optimization/ATP, 3-60

SGLI2, board detail, MMI port connections, 5-6
Shelf Configuration Switch, 2-4

Signal Generator, 3-73

signal generator, 1X FER acceptance test, 4-4
Site, equipage verification, 3-4

Site checklist, data sheets, A-3

Site equipage, CDF/NECEF, 3-3

Site I/O board, T1 span cable connection, 5-9
Site Serial Number Check List, A-18
Software Release caveats, 5-2

Span Framing Format
configure, 5-6
verify, 5-5
Span I/O board
E1 span isolation, illustration, 3-15
T1 span isolation, illustration, 3-15

Span Interface, 3-14

Span Line
connector , 6-14
T1/E1 Verification Equipment, 1-12

Span line, troubleshooting, 6-21

Span line configuration, troubleshooting, 6-24
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Span line traffic, No or missing, 6-17

SPANS LED, GLI, 6-31

Spectral Purity Transmit Mask ATP, 4-9
Spectral Purity TX Mask, 4-6

Spectrum Analyzer, 1-12, 3-73

Spectrum Analyzer , HPS594E, 3-50

SPLC, 1-30

STATUS LED, GLI, 6-31

Switched Parallel Linear amplifier Combiners , 1-30
SYNC Monitor Connector, CSM, 6-30

System Connectivity Test, HP8921A, F-2, F-18

T

T1, span connection, 5-9

T1/E1 Span Interface, 3-14

T1/E1 Span Isolation, 3-15

terminal communication settings, 1-3

Test data sheets
AMR CDI Alarm Input Verification, A-17
BTS redundancy/alarm tests, A-16
general optimization checklist, A-5
GPS receiver operation, A-6
initial power tests, A-4
PA
convergence, A-8
IM Reduction, A-7
pre—power tests, A-4
preliminary operations, A-3
RX antenna VSWR, A-17
site checklist, A-3
TX antenna VSWR, A-16
TX BLO
Offset/Power Output Verification, A-9
Power Output Verification, A-14

Test Equipment
Automatically Selecting, 3-67
Calibrating, 3-69
Connecting test equipment to the BTS, 3-49
Manually Selecting, 3-66
Reference Chart, 3-51
Selecting, 3-66
verification data sheets, A-2
VSWR, G-2

Test equipment
system analyzer, 1-10
TX acceptance tests, 4-4

Test Equipment Setup, 3-49
GPS & LFR/HSO, 3-42
RF path calibration, 3-80

Test Matrix, C-4
ATP optimization, C-3

Test Set Calibration, 3-65

Test Set Calibration , Background, 3-65
Timing Reference Cables, 1-11

Top Interconnect Plate, 1-26
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Troubleshooting
BBX Control Good — No (or Missing) Span Line
Traffic, 6-17
BLO Calibration Failure, 6-7
C-CCP Backplane, 6-14, 6-15
Calibration Audit Failure, 6-8

Code Domain Power and Noise Floor Measurement

Failure, 6-10
Code Download Failure, 6-5

Communications Analyzer Communication Failure,

6-4
CSM Checklist, 6-12
Data Download Failure, 6-5
DC Power Problems, 6-19
Device Enable (INS) Failure, 6-6
Login Failure, 6-3

MGLI Control Good — No Control over AMR, 6-17
MGLI Control Good — No Control over Co—located

GLI2, 6-16
Miscellaneous Failures, 6-6
Multi-FER Failure, 6-11

No BBX Control in the Shelf — No Control over
Co-located GLIs, 6-17

No DC Input Voltage to any C—CCP Shelf Module,

6-20

No DC Input Voltage to Power Supply Module,
6-19

No GLI Control through Span Line Connection,
6-16

No GLI Control via LMEF, 6-16

No MCC Channel Elements, 6-18

Power Meter Communication Failure, 6-3

Rho and Pilot Time Offset Measurement Failure,
6-9

Set span configuration, 6-24

span problems, 6-21

TX and RX Signal Routing, 6-20

TX Mask Measurement Failure, 6-9

X
acceptance tests, equipment setup, 4-4
antenna VSWR, test data sheets, A-16
TX & RX Path Calibration, 3-76
TX and RX Frequency vs Channel , 800 MHz, E-3

TX and RX Signal Routing, C—CCP Backplane
Troubleshooting, 6-20

TX ATP Setup, 3-63

TX BLO, test data sheets
Offset/Power Output Verification, A-9
Power Output Verification, A-14

TX calibration, 3-82
TX Mask test, 4-9

TX Mask Verification, spectrum analyzer display,
illustration, 4-10

TX OUT connection, 4-5

TX Output Acceptance Tests
Code domain power, 4-6, 4-13
Pilot Time Offset, 4-6, 4-12
Spectral purity TX mask, 4-6
Waveform quality (rho), 4-6, 4-11

TX Path, calibration, 3-77

TX path, 1-4
calibration, 3-80

TX path calibration, 3-82

U

Updating Calibration Data Files, 5-2
Copy and Load Cal File to to CBSC, 5-2
Software Release caveats, 5-2

UTP, LMF to BTS connection, 3-16

Vv

Verification of Test Equipment, data sheets, A-2
Verify GLI ROM code load, 3-33
Voltage Standing Wave Ratio. See VSWR

VSWR

Advantest Test Set, G-5

Calculation, G-3, G-6

Equation, G-3, G-6

manual test setup detail
Advantest illustration, G-6
HP illustration, G-4

required test equipment, G-2

transmit and receive antenna, G-2

w

Walsh channels, 4-13
Warm-up, 1-8

**Empty**, 3-53
Waveform Quality (tho), 4-6
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Waveform Quality (tho) ATP, 4-11

When to optimize
Ancillary — table, C-2
BTS, C-2
inter—frame cabling, C-3

X
Xircom Model PE3-10B2, LMF to BTS connection,
3-16
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